Quartus Il Handhook Version 13.1

101 Innovation Drive
San Jose, CA 95134
www.altera.com

Qllsv1-13.1.0

Volume 1: Design and Synthesis


http://www.altera.com

©2013 Altera Corporation. All rights reserved. ALTERA, ARRIA, CYCLONE, HARDCOPY, MAX, MEGACORE, NIOS, QUARTUS and STRATIX words and logos
are trademarks OF Altera Corporation and registered in the U.S. Patent and Trademark Office and in other countries. All other words and logos identified as
trademarks or service marks are the property of their respective holders as described at www.altera.com/common/legal.html. Altera warrants performance of its
semiconductor products to current specifications in accordance with Altera's standard warranty, but reserves the right to make changes to any products and
services at any time without notice. Altera assumes no responsibility or liability arising out of the application or use of any information, product, or service

described herein except as expressly agreed to in writing by Altera. Altera customers are advised to obtain the latest version of device specifications before relying
on any published information and before placing orders for products or services.

1SO
9001:2008
Registered

November 2013  Altera Corporation Quartus Il Handbook Version 13.1

Volume 1: Design and Synthesis


http://www.altera.com/common/legal.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html

ALTERANY

Chapter Revision Dates

Chapter 1.

Chapter 2.

Chapter 3.

Chapter 4.

Chapter 5.

Chapter 6.

Chapter 7.

Chapter 8.

Chapter 9.

Chapter 10.

Chapter 11.

Chapter 12.

The chapters in this document were revised on the following dates.

Managing Quartus II Projects
Revised: November2013
Part Number: QI152012-13.1.0

Design Planning with the Quartus II Software

Revised: November 2012
Part Number: QII51016-12.1.0

Quartus II Incremental Compilation for Hierarchical and Team-Based Design

Revised: November 2013
Part Number: QII51015-13.1.0

Design Planning for Partial Reconfiguration

Revised: November 2013
Part Number: QII51026-13.1.0

Quartus II Design Separation Flow
Revised: June 2012
Part Number: QII51019-12.0.0

Creating a System With Qsys
Revised: November 2013
Part Number: QII51020-13.1.0

Creating Qsys Components
Revised: November 2013
Part Number: QII51022-13.1.0

Qsys Interconnect
Revised: November 2013
Part Number: QII51021-13.1.0

Optimizing Qsys System Performance
Revised: May 2013
Part Number: QI151024-13.1.0

Component Interface Tcl Reference
Revised: November 2013
Part Number: QII51023-13.1.0

Qsys System Design Components
Revised: November 2013
Part Number: QI151025-13.1.0

Recommended Design Practices
Revised: November 2013
Part Number: QII51006-13.1.0

November 2013  Altera Corporation

Quartus Il Handbook Version 13.1
Volume 1: Design and Synthesis



Chapter Revision Dates

Chapter 13.

Chapter 14.

Chapter 15.

Chapter 16.

Chapter 17.

Chapter 18.

Chapter 19.

Recommended HDL Coding Styles
Revised: November 2013
Part Number: QII51007-13.1.0

Managing Metastability with the Quartus II Software
Revised: June 2012
Part Number: QII51018-12.0.0

Best Practices for Incremental Compilation Partitions and Floorplan Assignments
Revised: November 2013
Part Number: QII51017-13.1.0

Quartus II Integrated Synthesis
Revised: May 2013
Part Number: QII51008-13.0.0

Synopsys Synplify Support
Revised: November 2013
Part Number: QII51009-13.1.0

Mentor Graphics Precision Synthesis Support
Revised: June 2012
Part Number: QII51011-12.0.0

Analyzing Designs with Quartus II Netlist Viewers
Revised: November 2013
Part Number: QII51013-13.1.0

Quartus Il Handbook Version 13.1 November 2013  Altera Corporation
Volume 1: Design and Synthesis



A |:| =/ Section 1. Design Flows

The Altera® Quartus® II design software provides a complete design environment
that easily adapts to your specific design requirements. This handbook is arranged in
chapters, sections, and volumes that correspond to the major stages in the overall
design flow. For a general introduction to features and the standard design flow in the
software, refer to the Introduction to the Quartus II Software manual.

This section is an introduction to design planning. It documents various specialized
design flows in the following chapters:

m Chapter 1, Managing Quartus II Projects

Describes how to manage all the elements in your Quartus II project. You can save
multiple revisions of your project to experiment with settings that achieve your
design goals. Quartus II projects also support team-based, distributed work flows
and a scripting interface

m Chapter 2, Design Planning with the Quartus II Software

This chapter is an overview of various design planning considerations: device
selection, early power estimation, I/O pin planning, and design planning. To help
you improve design productivity, it provides recommendations and describes
various tools available for Altera FPGAs.

m  Chapter 3, Quartus II Incremental Compilation for Hierarchical and Team-Based
Design

This chapter documents Altera’s incremental design and compilation flow, which
allows you to preserve the results and performance for unchanged logic in your
design as you make changes elsewhere, reduces design iteration time by up to 70%
so you achieve timing closure efficiently, and facilitates modular hierarchical and
team-based design flows using top-down or bottom-up methodologies.

m  Chapter 4, Design Planning for Partial Reconfiguration

This chapter provides a high-level guide to the use of partial reconfiguration in the
Quartus II software. Partial reconfiguration allows you to reconfigure a portion of
the FPGA dynamically, while the remainder of the device continues to operate.

m Chapter 5, Quartus II Design Separation Flow

This chapter describes rules and guidelines for creating a floorplan with the
Design Separation flow. The Quartus II Design Separation flow provides the
ability to design physically independent structures on a single device. This allows
system designers to achieve a higher level of integration on a single FPGA, and
alleviates increasingly strict Size Weight and Power (SWaP) requirements.
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The Quartus II software organizes and manages the elements of your design within a project. The project
encapsulates information about your design hierarchy, libraries, constraints, and project settings. Click File

> New Project Wizard to quickly create a new project and specify basic project settings

When you open a project, a unified GUI displays integrated project information. The Project Navigator
allows you to view and edit the elements of your project. The Messages window lists important information

about project processing.

You can save multiple revisions of your project to experiment with settings that achieve your design goals.

Quartus II projects support team-based, distributed work flows and a scripting interface.

Quick Start
To quickly create a project and specify basic settings, click File > New Project Wizard.
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A single Quartus II Project File (.qpf) represents each project. The text-based . qpf references the Quartus
IT Settings File (.qsf), that lists all project files and stores project and entity settings. When you make project
changes in the GUI, these text files automatically store the changes. The GUI provides access to all project
settings and helps to manage all aspects of your project, including:

« Managing logic design, EDA, IP core, and Qsys system files

« Specifying and optimizing project settings and constraints

o Archiving and migrating projects

Figure 1-1: Quartus Il Project Files

Project>Revisions

File Type Stores Glick to Access File Formatis)
File=New Project Wizard
Project file Project and revision name | View>Project Navigator Quartus Il Project File (.qpf)

Project settings

Filas list, settings, davice,
synthesis directives, and pin
and placement constraints

Assignments=Settings
Assignments=Device
Assignments=Assignment Editor

Quartus 11 Settings File (.qsf)

Project database

Compilation results

Project>Export Database
Project=Export Design Partition
Project > Clean Project

Quartus Il Exported Partition
(.qxp)

Timing constraints

Clock properties,
axceptions, setup/hold time

Tools=TimeQuest Timing
Analyzer

Synopsys Design Constraints
(.5de)

Logic design files

RTL and other dasign logic
source files

View=Project Navigator
File=New

Verilog Design File (.v)

WHOL Design File {.vhd)

Block Design File (.bdf)

EDA Tool Synthesis File (.vgm)

Programming files

Davice programming
options and information

Assigniments>Settings
Tools=Programmer

Chain Description File {.cdf)
SRAM Object File {.sof)
Programmar Object File {.pof)

Project libraries

Project and global library
information

Assignments>Settings

quartus2.ini file {(global)
-gsf (project)

IP core logic, synthesis, and

View=Project Navigatar
Tools=0sys

Verilog Design File (.v)
systemVerilog File(.sv)
VHDL Design File (.vhd)

compressad file

. simulation information | 7role oL PAR T BOMRONENS | Quartus 11 1P Fil (.aip)
et Quartus Il Simulation IP (.sip)
Various EDA simulation files
Verilog Ouiput File (.va)
VHDL Output File (.vho)
Verilog Quartus Mapping (.vqm)
— Files generated for third- | Assignments>Settings Stamp model files
party EDA tools Tools>Options>EDA Tool Options | PartMiner XML-Format {_xmi)
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IBIS Qutput Files (.ibs)
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Figure 1-2: Basic Project Directory (Gray Files and Directories Optional)

("] <Quartus Il Project Directory>
_ﬂ <project_name>_ gpf - Quartus Il Project file

—G <revision_name= bsf - represents design in schematics
_E| <revision_name=.gsf - stores revision’s project seftings and constraints
_D <revision_name>_assignments_default gof- stores default project seftings and constraints

—D <revision_name> sdc - stores timing constraints in Synopsys Design Constraints format
_ﬂ <logic_design_file>. v or .whd - RTL source code

—G <Qsys_system_name>_gsys - Qsys system file

—D <logic_design_file>.vgm - logic from EDA synthesis tool
{1 <instance name> - QIl IP synthesis files

—D <instance name>_sim - Qll IP simulation files

—El <Qsys_system_name> - Qsys system and IP files
—D simulation - EDA simulation files

—I:I symbols - EDA board-level symbol tool files
_D board - EDA board-level signal integrity tool files
—Cl timing - EDA board-level timing analysis tool files

Viewing Basic Project Information

View basic information about your project in the Project Navigator, Report panel, and Messages window.
View project elements in the Project Navigator ( View > Utility Windows > Project Navigator). The Project
Navigator displays key project information, including design files, IP components, and revisions of your
project. Use the Project Navigator to:

 View and modify the design hierarchy (right-click > Set as Top-Level Entity)

o Set the project revision (right-click > Set Current Revision)

« View and update logic design files and constraint files (right-click > Open)

« Update IP component version information (right-click > Upgrade IP Component)

Figure 1-3: Project Navigator Hierarchy, Files, Revisions, and IP

Project Navigator x
Project Navigator l
. Enti IP Component Name Version
Project Navigator # Compile All I By :
= i = PL Altera PLL 121 PLL.gip
= Files g 1 1
Project Navigator § Revision | Type | | PLL_0DOZ altera_pll 121 PLL gip
—— | | —
eum 7 filtref Base | it altera_pll 121 PLL.gip
accum.v ;
I ————————] mult LPM_MULT NI /datafjbrossar/sim,
Ay Cyclone V: 5C i pyalges v @ = . k
= Y mutt Sy 4 taps.wv
= B tpm_mu| b8 state_mv
?"5 altsh e gccy
= ot B fiewwf
5 Hd | B Pap 4 | |
= b on =
#| B Pwsip &y Hierarchy | E]Files | 5 DesignUnits  *% IP Components | ) Revisions
B PLL.vhd
= #| & chunkyv T Hierarchy | EFiles | * Design Units | “% IP Components 57 Revisions |J|
N | A Hierarchy [ E|Files || o Design Units | “ 1P Components | ¥ Revisions |

&y Hierarchy | B Files | 7 Design Units | “% IP Components | 7 Revisions | |
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Viewing Project Reports

The Report panel (Processing > Compilation Report) displays detailed reports after project processing,
including the following:

Analysis & Synthesis reports

Fitter reports

Timing analysis reports
Power analysis reports
Signal integrity reports

Analyze the detailed project information in these reports to determine correct implementation. Right-click

report data to locate and edit the source in project files.

Figure 1-4: Report Panel

Flow Status Successful - Mon Apr 1 11:42:34 2013
=2 Flow Settings Quartus Il 64-Bit Version 13.0.0 Build 151 03/20/2013 5) Full Version
=7 Flow Non-Default Gl |Revision Name firtref
=% Flow Elapsed Time | Top-level Entity Name it 3
= Flow OS Summary |Family Cyclone V
[El Flow Log Device SCGXFCTCTF23C8

# 1 Analysis & Synthesis | Timing Models Preliminary
+ 1 Fitter Legic utilization (in ALMs) 18/56480(<1%)
+ 7 Assembler Total registers 4]
+ [ TimeQuest Timing A |Total pins 227268 (8% )
+ ] EDA Netlist Writer Total virtual pins 0
1) Flow Messages Total block memory bits 0/7.024,640 (0% )
1) Flow Suppressed Me | Total DSP Blocks 0/156(0%)
Total HSSI RX PCSs 0/6(0%)
Total HSSI PMA RX Deserializers 0/6(0%)
Total HSSI PMA RX ATT Deserializers 0
Total HSSI TX PCSs 0/6(0%)
Total HSSI PMA TX Serializers 0/6(0%)
Total HSSI PMA TX ATT Serializers 0/6(0%)
Total PLLS 0/13(0%)
- ] Total DLLs 0/a(0%)
100%  00:02:49
Related Information

List of Compilation Reports

Viewing Project Messages

The Messages window (View > Utility Windows > Messages) displays information, warning, and error
messages about Quartus II processes. Right-click messages to locate the source or get message help.

Processing tab—displays messages from the most recent process
System tab—displays messages unrelated to design processing
Search—locates specific messages

Messages are written to St dout when you use command-line executables.
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Figure 1-5: Messages Window
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You can suppress display of unimportant messages so they do not obscure valid messages.

Figure 1-6: Message Suppression by Message ID Num

¢

Exact Message Suppression:

Message Suppression Manager

ber

D | Message Text

Supprassion by ID:

o] Message Text

1| ==<news=>

Found =numbers design

. Delete | Import Rules .| Export Rules..

units, including <number> entities. in
2|12021 source file =mames=
3332140 Mo <Analysis Type> paths to report
Suppression By Keyword:
Keywaord
ﬂ<<n!\\'>:\-

| E 0K | Cancel

Help

Suppressing Messages

To supress messages, right-click a message and choose any of the following:
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+ Suppress Message—suppresses all messages matching exact text

+ Suppress Messages with Matching ID—suppresses all messages matching the message ID number,
ignoring variables

» Suppress Messages with Matching Keyword—suppresses all messages matching keyword or hierarchy

Message Suppression Guidelines

« You cannot suppress error or Altera legal agreement messages.

 Suppressing a message also suppresses any submessages.

» Message suppression is revision-specific. Derivative revisions inherit any suppression.
» You cannot edit messages or suppression rules during compilation.

Managing Logic Design Files

The Quartus II software helps you create and manage the logic design files in your project. Logic design files
contain the logic that implements your design. When you add a logic design file to the project, the Compiler
automatically compiles that file as part of the project. The Compiler synthesizes your logic design files to
generate programming files for your target device.

The Quartus II software includes full-featured schematic and text editors, as well as HDL templates to
accelerate your design work. The Quartus II software supports VHDL Design Files (.vhd), Verilog HDL
Design Files (.v), SystemVerilog (. sv) and schematic Block Design Files (. bdf). The Quartus II software also
supports Verilog Quartus Mapping (.vqm) design files generated by other design entry and synthesis tools.
In addition, you can combine your logic design files with Altera and third-party IP core design files, including
combining components into a Qsys system (. gsys).

The New Project Wizard prompts you to identify logic design files. Add or remove project files by clicking
Project > Add/Remove Files in Project. View the project’s logic design files in the Project Navigator.

Figure 1-7: Design and IP Files in Project Navigator

Project Navigator x

L Files
= [
gbﬂ accum.v
,‘,"ﬂ hvalues.v
i taps.v
it state_m.v
il accv
E] firvwf
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Right-click files in the Project Navigator to:

o Open and edit the file

+ Remove File from Project

+ Set as Top-Level Entity for the project revision

« Create a Symbol File for Current File for display in schematic editors
« Edit file Properties

Including Design Libraries

You can include design files libraries in your project. Specify libraries for a single project, or for all Quartus
IT projects. The.qsf stores project library information.

The quartus2.ini file stores global library information.

Related Information

Design Library Migration Guidelines on page 1-21
Specifying Design Libraries
To specify project libraries from the GUI:

1. Click Assignment > Settings.

2. Click Libraries andspecify the Project Library name or Global Library name.Alternatively, you can
specify project libraries with SEARCH_PATH in the .qsf, and global libraries in the quartus2.ini file.

Related Information

» Recommended Design Practices

o Recommended HDL Coding Styles

Managing Project Settings

The New Project Wizard helps you initially assign basic project settings. Optimizing project settings enables
the Compiler to generate programming files that meet or exceed your specifications.

The .qsf stores each revision’s project settings.
Click Assignments > Settings to access global project settings, including:

 Project files list

« Synthesis directives and constraints

 Logic options and compiler effort levels

« Placement constraints

« Timing constraint files

o Operating temperature limits and conditions
« File generation for other EDA tools

« Target device (click Assignments > Device)

The Quartus I Default Settings File (<revision name>_assignment_defaults.qdf) stores initial settings and
constraints for each new project revision.
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Figure 1-8: Settings Dialog Box for Global Project Settings
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The Assignment Editor (Tools > Assignment Editor) provides a spreadsheet-like interface for assigning all
instance-specific settings and constraints.

Figure 1-9: Assignment Editor Spreadsheet
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Optimizing Project Settings
Optimize project settings to meet your design goals. The Quartus II Design Space Explorer iteratively compiles
your project with various setting combinations to find the optimal setting for your goals. Alternatively, you
can create a project revision or project copy to manually compare various project settings and design

combinations.
Optimizing with Design Space Explorer
Use the Design Space Explorer (Tools > Launch Design Space Explorer) to find optimal project settings

for resource, performance, or power optimization goals. Design Space Explorer (DSE) processes your design
using various setting and constraint combinations, and reports the best settings for your design.

DSE attempts multiple seeds to identify one meeting your requirements. DSE can run different compilations
on multiple computers in parallel to streamline timing closure.

Figure 1-10: Design Space Explorer
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-1 Point Quartus Il 64-Bit Version 13.0.0 Build 151 03/20/2013 5] Full Version

Optimizing with Project Revisions
You can save multiple, named project revisions within your Quartus II project (Project > Revisions).

Each revision captures a unique set of project settings and constraints, but does not capture any logic design
file changes. Use revisions to experiment with different settings while preserving the original.You can compare
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Copying Your Project

Copying Your Project
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revisions to determine the best combination, or optimize different revisions for various applications. Use
revisions for the following:

Create a unique revision to optimize a design for different criteria, such as by area in one revision and
by fyax in another revision.

When you create a new revision the default Quartus II settings initially apply.

Create a revision of a revision to experiment with settings and constraints. The child revision includes
all the assignments and settings of the parent revision.

You create, delete, specify current, and compare revisions in the Revisions dialog box. Each time you create
a new project revision, the Quartus II software creates a new .qsf using the revision name.

To compare each revision’s synthesis, fitting, and timing analysis results side-by-side, click Project > Revisions
and then click Compare.

In addition to viewing the compilation results of each revision, you can also compare the assignments for
each revision. This comparison reveals how different optimization options affect your design.

Figure 1-11: Comparing Project Revisions
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Click Project > Copy Project to create a separate copy of your project, rather than just a revision within the

same project.

The project copy includes all design files, .qsf(s), and project revisions. Use this technique to optimize project
copies for different applications. For example, optimize one project to interface with a 32-bit data bus, and
optimize a project copy to interface with a 64-bit data bus.

Managing Timing Constraints

Altera Corporation

View basic information about your project in the Project Navigator, Report panel, and Messages window.

Apply appropriate timing constraints to correctly optimize fitting and analyze timing for your design. The

Fitter optimizes the placement of logic in the device to meet your specified timing and routing constraints.
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Managing System and IP Components

1-11

Specify timing constraints in the TimeQuest Timing Analyzer (Tools > TimeQuest Timing Analyzer), or
in an .sdc file. Specify constraints for clock characteristics, timing exceptions, and external signal setup and
hold times before running analysis. TimeQuest reports the detailed information about the performance of
your design compared with constraints in the Compilation Report panel.

Save the constraints you specify in the GUI in an industry-standard Synopsys Design Constraints File (.sdc).
You can subsequently edit the text-based .sdc file directly.

Figure 1-12: TimeQuest Timing Analyzer and SDC Syntax Example
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Virtually all complex FPGA designs include integrated IP cores. The Quartus II GUI helps you define,
integrate, and update the IP files in your project. Use Altera’s optimized and verified IP in your project to
shorten design cycles and maximize performance.

The Quartus II software includes many basic and complex IP cores, and supports IP from other sources.
You can combine IP with other design elements to quickly create a complete system using the Qsys system
integration tool.
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Integrating System and IP Files

You can easily customize and quickly integrate Qsys system and IP core files in your project. The Quartus II
software implements your specified system or IP core parameters and generates files for synthesis and
simulation in the Quartus II software and other EDA tools.

IP components are represented as design elements in your project. The Quartus II software includes the
following IP and system integration tools:

Table 1-1: IP Integration Tools

MegaWizard Plug-In Manager Parameterize individual IP cores and generate HDL
synthesis files, simulation models, and testbenches.

Qsys Parameterize and connect all components in a system-
level hardware design, automating integration of
customized HDL components.

Figure 1-13: Qsys System Integration Tool and MegaWizard IP Core Editor
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Updating Outdated IP Files

Some Altera IP components are version-specific with the Quartus II software. Click Project > Upgrade IP
Components to easily upgrade outdated IP in the Project Navigator.
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Failure to upgrade outdated IP components can result in a mismatch between the outdated IP core variation
and the current supporting libraries.

Altera verifies that the current version of the Quartus II software compiles the previous version of each IP
core. The MegaCore IP Library Release Notes and Errata reports any verification exceptions. Altera does not
verify compilation for IP cores older than the previous release.

Figure 1-14: Upgrading IP Components in Project Navigator
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Related Information

MegaCore IP Library Release Notes and Errata

System and IP File Locations

When you generate an Altera IP core variation with the MegaWizard Plug-In Manager or Qsys, the Quartus II
software generates files in the following locations.

Figure 1-15: System and IP Files Generated by MegaWizard Plug-In Manager and Qsys
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Processing Encrypted IP Files
Projects may include encrypted Altera or third-party IP cores that prevent unlicensed viewing of source
code. The Compiler processes encrypted IP files along with the rest of your project. The Quartus II software

provides a black-box representation of Altera megafunctions and encrypted IP cores for synthesis in other
EDA tools.

The Quartus II software also includes IEEE-encrypted Verilog HDL models for both Verilog HDL and
VHDL simulation models for Altera IP cores. Use these files to simulate encrypted IP in other EDA tools.
The Quartus II software does not provide IP core encryption or decryption functions.

IP File Search Path

If your project includes two IP core files of the same name, the search path precedence rules how similarly
named files are resolved. The Quartus II software recognizes the following file naming precedence:

1. Project directory.
2. Project database directory.

3. Projectlibraries specified in Assignments > Settings > Libraries, or with the SEARCH_PATHassignment
in the revision .qsf.

4. Globallibraries specified in Assignments > Settings > Libraries, or with the SEARCH_PATHassignment
in the quartus2.ini file.

5. Quartus II software libraries directory, such as <Quartus II Installation>\libraries.

Use the SEARCH_PATHassignment to define the project libraries. The Quartus II software supports multiple
SEARCH_PATH assignments. Specify only one source directory for each SEARCH_PATH assignment.

Related Information
o IP and Megafunctions Documentation

+ Creating a System with Qsys

Integrating Other EDA Tools

You can integrate supported EDA design entry, synthesis, simulation, physical synthesis, and formal
verification tools into the Quartus II design flow. The Quartus II software supports netlist files from other
EDA design entry and synthesis tools. The Quartus II software optionally generates various files for use in
other EDA tools.

The Quartus II software manages EDA tool files and provides the following integration capabilities:

« Automatically generate files for synthesis and simulation and automatically launch other EDA tools
(Assignments > Settings > EDA Tool Settings > NativeLink Settings ).

« Compile all RTL and gate-level simulation model libraries for your device, simulator, and design language
automatically (Tools > Launch Simulation Library Compiler).

 Include files (.edf, .vqm) generated by other EDA design entry or synthesis tools in your project as
synthesized design files (Project > Add/Remove File from Project) .

« Automatically generate optional filesfor board-level verification (Assignments > Settings > EDA Tool
Settings).
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Figure 1-16: EDA Tool Settings
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EDA Tool Settings

Specify the other EDA tools used with the Quartus Il seftware to develop your project.
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Figure 1-17: Quartus Il Generated Files for Other EDA Tools
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Related Information
o Mentor Graphics Precision Synthesis SupportGraphics

« Simulating Altera Designs

Managing Team-based Projects

The Quartus II software supports multiple designers, design iterations, and platforms. You can use the
following techniques to preserve and track project changes in a team-based environment. These techniques
may also be helpful for individual designers.

Related Information

+ Preserving Compilation Results on page 1-16
o Archiving Projects on page 1-18

+ Using External Revision Control on page 1-19

o Migrating Projects Across Operating Systems on page 1-20

Preserving Compilation Results

The Quartus II software maintains a database of compilation results for each project revision. The databases
files store results of incremental or full compilation. Do not edit these files directly. However, you can use
the database files in the following ways:

o Preserve compilation results for migration to a new version of the Quartus II software. Export a post-
synthesis or post-fit, version-compatible database (Project > Export Database), and then import it into
a newer version of the Quartus II software (Project > Import Database), or into another project.

o Optimize and lock down the compilation results for individual blocks. Export the post-synthesis or post-
fit netlist as a Quartus II Exported Partition File (.qxp) (Project > Export Design Partition). You can
then import the partition as a new project design file.

 Purge the content of the project database (Project > Clean Project) to remove unwanted previous
compilation results at any time.

Factors Affecting Compilation Results
Changes to any of the following factors can impact compilation results:

 Project Files—project settings (. qsf), design files, and timing constraints (.sdc).
« Hardware—CPU architecture, not including hard disk or memory size differences. Windows XP x32
results are not identical to Windows XP x64 results. Linux x86 results is not identical to Linux x86_64.

o Quartus II Software Version—including build number and installed patches. Click Help > About to
obtain this information.

o Operating System—Windows or Linux operating system, excluding version updates. For example,
Windows XP, Windows Vista, and Windows 7 results are identical. Similarly, Linux RHEL, CentOS 4,
and CentOS 5 results are identical.

Related Information

o Quartus II Incremental Compilation for Hierarchical and Team-Based Design
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Migrating Results Across Quartus Il Software Versions 1-17

Design Planning for Partial Reconfiguration

Migrating Results Across Quartus Il Software Versions

View basic information about your project in the Project Navigator, Report panel, and Messages window.

To preserve compilation results for migration to a later version of the Quartus II software, export a version-
compatible database file, and then import it into the later version of the Quartus II software. A few device
families do not support version-compatible database generation, as indicated by project messages.

Exporting and Importing the Results Database
To save the compilation results in a version-compatible format for migration to a later version of the Quartus
IT software, follow these steps:

1.
2,

Open the project for migration in the original version of the Quartus II software.
Generate the project database and netlist with one of the following:

o Click Processing > Start > Start Analysis & Synthesis to generate a post-synthesis netlist.
« Click Processing > Start Compilation to generate a post-fit netlist.

Click Project > Export Database and specify the Export directory.

In a later version of the Quartus II software, click New Project Wizard and create a new project with the
same top-level design entity name as the migrated project.

Click Project > Import Database and select the <project directory> /export_db/exported database
directory. The Quartus II software opens the compiled project and displays compilation results.

Note: You can turn on Assignments > Settings > Compilation Process Settings > Export version-

compatible database if you want to always export the database following compilation.

Figure 1-18: Quartus Il Version-Compatible Database Structure
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Cleaning the Project Database
To clean the project database and remove all prior compilation results, follow these steps:
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1. Click Project > Clean Project.

2. Select All revisions to remove the databases for all revisions of the current project, or specify a Revision
name to remove only that revision’s database.

3. Click OK. A message indicates when the database is clean.

Archiving Projects

You can save the elements of a project in a single, compressed Quartus II Archive File (. qar) by clicking
Project > Archive Project.

The .qar captures logic design, project, and settings files required to restore the project.

Use this technique to share projects between designers, or to transfer your project to a new version of the
Quartus IT software, or to Altera support. You can optionally add compilation results, Qsys system files, and
third-party EDA tool files to the archive. If you restore the archive in a different version of the Quartus II
software, you must include the original .qdf in the archive to preserve original compilation results.

Manually Adding Files To Archives

To manually add files to an archive:

1. Click Project > Archive Project and specify the archive file name.

Click Advanced.

Select the File set for archive or select Custom. Turn on File subsets for archive.
Click Add and select Qsys system or EDA tool files. Click OK.

Click Archive.

DAl ol

Archiving Compilation Results
You can include compilation results in a project archive to avoid recompilation and preserve original results
in the restored project. To archive compilation results, export the post-synthesis or post-fit version compatible
database and include this file in the archive.

Export the project database.

Click Project > Archive Project and specify the archive file name.

Click Advanced.

Under File subsets, turn on Version-compatible database files and click OK.
Click Archive.

A

To restore an archive containing a version-compatible database, follow these steps:

1. Click Project > Restore Archived Project.
2. Select the archive name and destination folder and click OK.

3. After restoring the archived project, click Project > Import Database and import the version-compatible
database.

Related Information

Exporting and Importing the Results Database on page 1-17
Archiving Projects for Altera Service Requests

When archiving projects for an Altera service request, include all of the following file types for proper
debugging by Altera Support:
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To quickly identify and include appropriate archive files for an Altera service request:

1. Click Project > Archive Project and specify the archive file name.
2. Click Advanced.
3. In File set, select Service Request to include files for Altera Support.

Project source and setting files (.v, .vhd, .vqm, .qsf, .sdc, .qip, .qpf, .cmp,
Automatically detected source files (various)

Programming output files (. jdi, .sof, .pof)

Report files (.rpt, .pin, .summary, .smsg)

Qsys system and IP files (.qsys, . qip)

4. Click OK, and then click Archive.

Figure 1-19: Archiving Project for Service Request
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Help

Using External Revision Control

Your project may involve different team members with distributed responsibilities, such as sub-module
design, device and system integration, simulation, and timing closure. In such cases, it may be useful to track
and protect file revisions in an external revision control system.

While Quartus II project revisions preserve various project setting and constraint combinations, external
revision control systems can also track and merge RTL source code, simulation testbenches, and build scripts.
External revision control supports design file version experimentation through branching and merging
different versions of source code from multiple designers. Refer to your external revision control
documentation for setup information.

Files to Include In External Revision Control
Include the following Quartus II project file types in external revision control systems:
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o Logic design files (.v, .vdh, .bdf, edf, .vqm)
« Timing constraint files (.sdc)
 Quartus II project settings and constraints (.qdf, .qpf, .qsf)
o MegaWizard-generated IP files (.v, .sv, .vhd, .qip, .sip)
o Qsys-generated files (.qsys, .qip, .sip)
o EDA tool files (.vo, .vho )

You can generate or modify these files manually if you use a scripted design flow. If you use an external
source code control system, you can check-in project files anytime you modify assignments and settings in
the Quartus II software.

Migrating Projects Across Operating Systems

Consider the following cross-platform issues when moving your project from one operating system to
another (for example, from Windows to Linux).

Migrating Design Files and Libraries
Consider the following file naming differences when migrating projects across operating systems:

« Use appropriate case for your platform in file path references.
+ Use a character set common to both platforms.

« Do not change the forward-slash (/ ) and back-slash (\ ) path separators in the .qsf. The Quartus II
software automatically changes all back-slash (\ ) path separators to forward-slashes (/ ) in the .gsf.

« Observe the target platform’s file name length limit.

« Use underscore instead of spaces in file and directory names.

« Change library absolute path references to relative paths in the .qsf.

+ Ensure that any external project library exists in the new platform’s file system.

 Specify file and directory paths as relative to the project directory. For example, for a project titled
foo_design , specify the source files as: top.v, foo_folder /fool.v, foo_folder /foo2.v, and
foo_folder/bar_folder/barl.vhdl.

 Ensure that all the subdirectories are in the same hierarchical structure and relative path as in the original
platform.

Figure 1-20: All Inclusive Project Directory Structure

T.. [ ] foo_design

fon_design.gsf

top.w

foo_folder

] fool.wv
1) foce
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Use Relative Paths
Express file paths using relative path notation (.. /).
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For example, in the directory structure shown you can specify top.v as ../source/top.v and fool.v as
../source/foo_folder/fool.v.

Figure 1-21: Quartus Il Project Directory Separate from Design Files

i
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foo_design.gsf
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Design Library Migration Guidelines

The following guidelines apply to library migration across computing platforms:

1. The project directory takes precedence over the project libraries.

2. For Linux, the Quartus II software creates the file in the altera.quartus directory under the <home>
directory.

3. Alllibrary files are relative to the libraries. For example, if you specify the user_lib1 directory as a project
library and you want to add the /user_lib1/fool.v file to the library, you can specify the fool.v file in the
.qsf as fool.v. The Quartus II software includes files in specified libraries.

4. If the directory is outside of the project directory, an absolute path is created by default. Change the
absolute path to a relative path before migration.

5. When copying projects that include libraries, you must either copy your project library files along with
the project directory or ensure that your project library files exist in the target platform.

o On Windows, the Quartus II software searches for the quartus2.ini file in the following directories
and order:

o USERPROFILE, for example, C:\Documents and Settings\ <user name>
« Directory specified by the TMP environmental variable

+ Directory specified by the TEMP environmental variable

« Root directory, for example, C:\

Scripting API

You can use command-line executables or scripts to execute project commands, rather than using the GUL
The following commands are available for scripting project management.
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Scripting Project Settings
You can use a Tcl script to specify settings and constraints, rather than using the GUI. This can be helpful
if you have many settings and wish to track them in a single file or spreadsheet for iterative comparison. The
.qsf supports only a limited subset of Tcl commands. Therefore, pass settings and constraints using a Tcl
script:

1. Create a text file with the extension.tcl that contains your assignments in Tcl format.

2. Source the Tcl script file by adding the following line to the .qsf: set _gl obal _assi gnnent - nane
SOURCE_TCL_SCR | PT_FI LE <file nanme>.

Project Revision Commands

Use the following commands for scripting project revisions.

Create Revision Command on page 1-22
Set Current Revision Command on page 1-22
Get Project Revisions Command on page 1-22

Delete Revision Command on page 1-22

Create Revision Command

create_revision <name> -based_on <revision_name> -copy_results -set_current

I

based_on (optional) Specifies the revision name on which the new revision bases
its settings.

copy_results Sets the new revision as the current revision.

set _current (optional) Copies the results from the "based_on" revision.

Set Current Revision Command

The - f or ce option enables you to open the revision that you specify under revision name and overwrite
the compilation database if the database version is incompatible.

set _current_revision -force <revision nanme>

Get Project Revisions Command

get _project_revisions <project_nane>

Delete Revision Command

del ete_revision <revision name>
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Project Archive Commands

You can use Tcl commands and the quar t us_sh executable to create and manage archives of a Quartus
II project.

Creating a Project Archive

in a Tcl script or from a Tcl prompt, you can use the following command to create a Quartus archive:
proj ect _archi ve <name>. gar

You can specify the following other options:

« -all _revisions

e -include_libraries

e -include_outputs

o -use file set <file set>

e -version_conpati bl e _dat abase

Note: Version-compatible databases are not available for some device families. If you require the database
files to reproduce the compilation results in the same Quartus II software version, use the -
use_file_set full _db option toarchive the complete database.

Restoring an Archived Project

Use the following Tcl command to restore a Quartus II project:

project_restore <nanme>.qar -destination restored -overwite

This example restores to a destination directory named "restored".

Project Database Commands
Use the following commands for managing Quartus II project databases:
Import and Export Version-Compatible Databases on page 1-23
Import and Export Version-Compatible Databases from a Flow Package on page 1-23
Generate Version-Compatible Database After Compilation on page 1-24

quartus_cdb and quartus_sh Executables to Manage Version-Compatible Databases on page 1-24

Import and Export Version-Compatible Databases

Use the following commands to import or export a version-compatible database:

« inport_database <directory>
o export_database <directory>

Import and Export Version-Compatible Databases from a Flow Package

The following are Tcl commands from the f | owpackage to import or export version-compatible databases.
If you use the f | owpackage, you must specify the database directory variable name. f | owand
dat abase_manager packages contain commands to manage version-compatible databases.
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« set gl obal assignhment -name VER COVPATIBLE DB DI R <directory>
« execute flow —fl ow export_dat abase
+ execute_flow -flow import_database

Generate Version-Compatible Database After Compilation
Use the following commands to generate a version-compatible database after compilation:
o set_gl obal _assi gnnent -nanme AUTO_EXPORT_VER COVPATI BLE_DB ON
« set gl obal assi gnment - nane VER COMPATI BLE DB DI R <di rectory>
quartus_cdb and quartus_sh Executables to Manage Version-Compatible Databases
Use the following commands to manage version-compatible databases:

o quartus_cdb <project> -c <revision>-export_database=<directory>
e« quartus_cdb <project> -c <revision> --inport_dat abase=<di rectory>
o« quartus_sh —fl ow export_ dat abase <project> -c \ <revision>

o quartus_sh —flow i nport_database <project> -c \ <revision>

Project Library Commands
Use the following commands to script project library changes.
Specify Project Libraries With SEARCH_PATH Assignment on page 1-24
Report Specified Project Libraries Commands on page 1-24

Specify Project Libraries With SEARCH_PATH Assignment

In Tcl, use commands in the : : quartus : : proj ect package to specify project libraries, and the
set gl obal _assi gnnment command.

Use the following commands to script project library changes:

o set_gl obal _assi gnnent -nane SEARCH PATH "../other _dir/libraryl”

« set gl obal assignnent -nane SEARCH PATH "../other _dir/library2"

o set _gl obal _assi gnnent -nane SEARCH PATH "../other _dir/library3"
Report Specified Project Libraries Commands

To report any project libraries specified for a project and any global libraries specified for the current
installation of the Quartus II software, use the get _gl obal _assi gnnment and get _user _opti on
Tcl commands.

Use the following commands to report specified project libraries:

« get gl obal assignnent -nane SEARCH PATH
o get_user_option -nane SEARCH PATH

Document Revision History

View basic information about your project in the Project Navigator, Report panel, and Messages window.
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Table 1-2: Document Revision History

November 2013

13.1.0

Document Revision History 1-25

Conversion to DITA format

May 2013

13.0.0

Overhaul for improved usability and updated
information.

June 2012

12.0.0

Removed survey link.
Updated information about VERI LOG _
| NCLUDE_FI LE.

November 2011

10.1.1

Template update.

December 2010

10.1.0

Changed to new document template.
Removed Figure 4-1, Figure 4-6, Table 4-2.
Moved “Hiding Messages” to Help.

Removed references about the set _user _
opti on command.

Removed Classic Timing Analyzer references.

July 2010

10.0.0

Major reorganization done to this chapter.
Updated “

Working with Messages” on page 4-17. Added
a link to Help. Removed Figure 4-2 on

page 4-7, Figure 4-11 on page 23, and Figure
4-12 on page.

Updated “Specifying Libraries” on page 4-14
section. Changed “User Libraries” to
“Libraries”. Removed “Reducing Compilation
Time

” on page 4-26.

Added “Managing Projects in a Team-Based
Design Environment” on page 4-22 and “File
Association

” on page 4-2.

Updated Figure 4-1 on page 4-6, Figure 4-2
on page 4-8, Figure 4-6 on page 4-18,

Figure 4-6 on page 4-19, and Figure 4-7 on
page 4-21.

November 2009

Updated “Creating a New Project” on page 4-4,
“Archiving a Project” on page 4-9, “Restoring
an Archived Project” on page 4-11.

Added “Quartus II Text Editor” on page 4-2,
“Reducing Compilation Time” on page 4-32.
Updated Table 4-1 on page 4-10, Table 4-2 on
page 4-20.

Updated Figure 4-4 on page 4-9, Figure 4-7
on page 4-19.
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Design
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on page 4-11, “Quartus II Project Platform
Migration” on page 4-12, “Filenames and
Hierarchies” on page 4-12, “Quartus II Search
Path Precedence Rules” on page 4-15,
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EDA Tools” on page 4-15, “Migrating Database
Files between Platforms” on page 4-16,
“Message Suppression” on page 4-20,
“Quartus IT Settings File” on page 4-24,
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“Managing Revisions

o 7 on page 4-26, “Archiving Projects

o 7 on page 4-26 and “Archiving Projects

o with the Quartus IT Archive Project Feature”
on page 4-7, “Importing and Exporting
Version-Compatible Databases

« ”on page 4-27, “Specifying Libraries Using
Scripts” on page 4-28, “

« Conclusion

o 7 on page 4-30.
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This chapter discusses key FPGA design planning considerations, provides
recommendations, and describes various tools available for you to improve your
design productivity with Altera® FPGAs.

Because of the significant increase in FPGA device densities, designs are complex and
can sometimes involve multiple designers. System architects must also resolve design
issues when integrating design blocks. However, you can solve potential problems
early in the design cycle by following the design planning considerations in this
chapter.

This chapter contains the following sections:

m “Creating Design Specifications” on page 2-2

“Selecting Intellectual Property” on page 2-2

“Using Qsys and Standard Interfaces in System Design” on page 2-3
“Selecting a Device” on page 2-3

“Planning for Device Programming or Configuration” on page 2—4

“Estimating Power” on page 2-5

“Early Pin Planning and I/O Analysis” on page 2-6

“Selecting Third-Party EDA Tools” on page 2-8

m “Planning for On-Chip Debugging Tools” on page 2-10

m “Design Practices and HDL Coding Styles” on page 2-11

m “Planning for Hierarchical and Team-Based Design” on page 2-13

m “Fast Synthesis and Early Timing Estimation” on page 2-15
“ e This chapter provides only an introduction to various design planning features in the
Quartus® II software. For more information about Quartus II features and
methodologies, this chapter provides references to other appropriate chapters in the
Quartus I Handbook.

Before reading the design planning guidelines discussed in this chapter, consider your
design priorities. More device features, density, or performance requirements can
increase system cost. Signal integrity and board issues can impact I/O pin locations.
Power, timing performance, and area utilization all affect each other, and compilation
time is affected when optimizing these priorities.
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Creating Design Specifications

The Quartus II software optimizes designs for the best overall results; however, you
can change the settings to better optimize one aspect of your design, such as power
utilization. Certain tools or debugging options can lead to restrictions in your design
flow. Your design priorities help you choose the tools, features, and methodologies to
use for your design.

After you select a device family, to check if additional guidelines are available, refer to
the design guidelines section of the appropriate device handbook.

Creating Design Specifications

Before you create your design logic or complete your system design, create detailed
design specifications that define the system, specify the I/O interfaces for the FPGA,
identify the different clock domains, and include a block diagram of basic design
functions.

In addition, creating a test plan helps you to design for verification and
manufacturability. For example, you might need to validate interfaces incorporated in
your design. To perform any built-in self-test functions to drive interfaces, you can
use a UART interface with a Nios® II processor inside the FPGA device. For
guidelines related to analyzing and debugging the device after it is in the system, refer
to “Planning for On-Chip Debugging Tools” on page 2-10.

If more than one designer works on your design, you must consider a common design
directory structure or source control system to make design integration easier. For
more suggestions on team-based designs, refer to “Planning for Hierarchical and
Team-Based Design” on page 2-13. Consider whether you want to standardize on an
interface protocol for each design block. To improve reusability and ease of
integration, refer to “Using Qsys and Standard Interfaces in System Design”.

Selecting Intellectual Property

Altera and its third-party intellectual property (IP) partners offer a large selection of
standardized IP cores optimized for Altera devices. The IP you select often affects
system design, especially if the FPGA interfaces with other devices in the system.
Consider which I/O interfaces or other blocks in your system design are implemented
using IP cores, and plan to incorporate these cores in your FPGA design.

The OpenCore Plus feature, which is available for many IP cores, allows you to
program the FPGA to verify your design in the hardware before you purchase the IP
license. The evaluation supports the following modes:

m Untethered—the design runs for a limited time.

B Tethered—the design requires an Altera serial JTAG cable connected between the
JTAG port on your board and a host computer running the Quartus II Programmer
for the duration of the hardware evaluation period.

For descriptions of available IP cores, refer to the Intellectual Property page of the
Altera website.
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Using Qsys and Standard Interfaces in System Design

Using Qsys and Standard Interfaces in System Design

You can use the Quartus II Qsys system integration tool to create your design with
fast and easy system-level integration. With Qsys, you can specify system components
in a GUI and generate the required interconnect logic automatically, along with
adapters for clock crossing and width differences. Because system design tools change
the design entry methodology, you must plan to start developing your design within
the tool. Ensure all design blocks use appropriate standard interfaces from the
beginning of the design cycle so that you do not need to make changes later.

Qsys components use Avalon® standard interfaces for the physical connection of
components, and you can connect any logical device (either on-chip or off-chip) that
has an Avalon interface. The Avalon Memory-Mapped interface allows a component
to use an address mapped read or write protocol that enables flexible topologies for
connecting master components to any slave components. The Avalon Streaming
interface enables point-to-point connections between streaming components that send
and receive data using a high-speed, unidirectional system interconnect between
source and sink ports.

In addition to enabling the use of a system integration tool such as Qsys, using
standard interfaces ensures compatibility between design blocks from different
design teams or vendors. Standard interfaces simplify the interface logic to each
design block and enable individual team members to test their individual design
blocks against the specification for the interface protocol to ease system integration.

For more information about using Qsys to improve your productivity, refer to the
System Design with Qsys section in volume 1 of the Quartus II Handbook.

Qsys replaces the SOPC Builder system integration tool for new designs. For more
information about SOPC Builder, refer to the SOPC Builder User Guide.

Selecting a Device

@

The device you choose affects board specification and layout. This section provides
guidelines in the device selection process.

Choose the device family that best suits your design requirements. Families differ in
cost, performance, logic and memory density, I/O density, power utilization, and
packaging. You must also consider feature requirements, such as I/O standards
support, high-speed transceivers, global or regional clock networks, and the number
of phase-locked loops (PLLs) available in the device.

You can use the Altera Product Selector available on the Altera website to help you
choose your device. You can also review important features of each device family in
the Selector Guides page of the Altera website. Each device family also has a device
handbook, including a data sheet, which documents device features in detail. You can
also see a summary of the resources for each device in the Device dialog box in the
Quartus II software.

For a list of device selection guides, refer to Devices and Adapters in Quartus II Help.
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Carefully study the device density requirements for your design. Devices with more
logic resources and higher I/O counts can implement larger and more complex
designs, but at a higher cost. Smaller devices use lower static power. Select a device
larger than what your design requires if you want to add more logic later in the
design cycle to upgrade or expand your design, and reserve logic and memory for
on-chip debugging (refer to “Planning for On-Chip Debugging Tools” on page 2-10).
Consider requirements for types of dedicated logic blocks, such as memory blocks of
different sizes, or digital signal processing (DSP) blocks to implement certain
arithmetic functions.

If you have older designs that target an Altera device, you can use their resources as
an estimate for your design. Compile existing designs in the Quartus II software with
the Auto device selected by the Fitter option in the Settings dialog box. Review the
resource utilization to learn which device density fits your design. Consider coding
style, device architecture, and the optimization options used in the Quartus II
software, which can significantly affect the resource utilization and timing
performance of your design.

To obtain resource utilization estimates for certain configurations of Altera’s IP, refer
to the user guides for Altera megafunctions and IP MegaCores on the IP’ and
Megafunctions literature page of the Altera website.

Device Migration Planning

Determine whether you want to migrate your design to another device density to
allow flexibility when your design nears completion. You may want to target a
smaller (and less expensive) device and then move to a larger device if necessary to
meet your design requirements. Other designers may prototype their design in a
larger device to reduce optimization time and achieve timing closure more quickly,
and then migrate to a smaller device after prototyping. If you want the flexibility to
migrate your design, you must specify these migration options in the Quartus II
software at the beginning of your design cycle.

For more information about specifying the target migration devices, refer to Specifying
Devices for Device Migration in Quartus II Help.

Selecting a migration device impacts pin placement because some pins may serve
different functions in different device densities or package sizes. If you make pin
assignments in the Quartus II software, the Pin Migration View in the Pin Planner
highlights pins that change function between your migration devices. (For more
information, refer to “Early Pin Planning and I/O Analysis” on page 2-6.)

Planning for Device Programming or Configuration

Planning how to program or configure the device in your system allows system and
board designers to determine what companion devices, if any, your system requires.
Your board layout also depends on the type of programming or configuration method
you plan to use for programmable devices. Many programming options require a
JTAG interface to connect to the devices, so you might have to set up a JTAG chain on
the board. Additionally, the Quartus II software uses the settings for the configuration
scheme, configuration device, and configuration device voltage to enable the
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appropriate dual purpose pins as regular I/O pins after you complete configuration.
The Quartus II software performs voltage compatibility checks of those pins during
I/0O assignment analysis and compilation of your design. You can use the
Configuration tab of the Device and Pin Options dialog box to select your
configuration scheme.

The device family handbooks describe the configuration options available for a device
family. For more details about configuration options, refer to the Configuration
Handbook. For information about programming CPLD devices, refer to your device
data sheet or handbook.

Estimating Power

You can use the Quartus II power estimation and analysis tools to provide
information to PCB board and system designers. Power consumption in FPGA
devices depends on the design logic, which can make planning difficult. You can
estimate power before you create any source code, or when you have a preliminary
version of the design source code, and then perform the most accurate analysis with
the PowerPlay Power Analyzer when you complete your design.

You must accurately estimate device power consumption to develop an appropriate
power budget and to design the power supplies, voltage regulators, heat sink, and
cooling system. Power estimation and analysis helps you satisfy two important
planning requirements:

m Thermal—ensure that the cooling solution is sufficient to dissipate the heat
generated by the device. The computed junction temperature must fall within
normal device specifications.

m Power supply—ensure that the power supplies provide adequate current to
support device operation.

The PowerPlay Early Power Estimator (EPE) spreadsheet allows you to estimate
power utilization for your design.

You can manually enter data into the EPE spreadsheet, or use the Quartus II software
to generate device resource information for your design.

To manually enter data into the EPE spreadsheet, enter the device resources,
operating frequency, toggle rates, and other parameters for your design. If you do not
have an existing design, estimate the number of device resources used in your design,
and then enter the data into the EPE spreadsheet manually.

If you have an existing design or a partially completed design, you can use the
Quartus II software to generate the PowerPlay Early Power Estimator File (.txt, .csv)
to assist you in completing the PowerPlay EPE spreadsheet.

For more information about generating the PowerPlay EPE File, refer to Performing an
Early Power Estimate Using the PowerPlay Early Power Estimator in Quartus II Help.
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The PowerPlay EPE spreadsheet includes the Import Data macro that parses the
information in the PowerPlay EPE File and transfers the information into the
spreadsheet. If you do not want to use the macro, you can manually transfer the data
into the EPE spreadsheet. For example, after importing the PowerPlay EPE File
information into the PowerPlay EPE spreadsheet, you can add device resource
information. If the existing Quartus II project represents only a portion of your full
design, manually enter the additional device resources you use in the final design.

Estimating power consumption early in the design cycle allows planning of power
budgets and avoids unexpected results when designing the PCB.
“ e The PowerPlay EPE spreadsheets for each supported device family are available on
the PowerPlay Early Power Estimator and Power Analyzer page of the Altera
website.

When you complete your design, perform a complete power analysis to check the
power consumption more accurately. The PowerPlay Power Analyzer tool in the
Quartus II software provides an accurate estimation of power, ensuring that thermal
and supply limitations are met.
“ e For more information about power estimation and analysis, refer to the PowerPlay
Power Analysis chapter in volume 3 of the Quartus II Handbook.

Early Pin Planning and 1/0 Analysis

This section describes early pin planning and I/O analysis features for different stages
of the design flow.

In many design environments, FPGA designers want to plan the top-level FPGA 1/O
pins early to help board designers begin the PCB design and layout. The I/O
capabilities and board layout guidelines of the FPGA device influence pin locations
and other types of assignments. If the board design team specifies an FPGA pin-out,
the pin locations must be verified in the FPGA placement and routing software to
avoid board design changes.

You can create a preliminary pin-out for an Altera FPGA with the Quartus II Pin
Planner before you develop the source code, based on standard I/O interfaces (such
as memory and bus interfaces) and any other I/O requirements for your system. The
Quartus I I/O Assignment Analysis checks that the pin locations and assignments
are supported in the target FPGA architecture. You can then use I/O Assignment
Analysis to validate I/O-related assignments that you create or modify throughout
the design process. When you compile your design in the Quartus II software, I/O
Assignment Analysis runs automatically in the Fitter to validate that the assignments
meet all the device requirements and generates error messages.

Early in the design process, before creating the source code, the system architect has
information about the standard I/O interfaces (such as memory and bus interfaces),
the IP cores in your design, and any other I/ O-related assignments defined by system
requirements. You can use this information with the Early Pin Planning feature in the
Pin Planner to specify details about the design I/O interfaces. You can then create a
top-level design file that includes all I/O information.
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The Pin Planner interfaces with the IP core parameter editor, which allows you to
create or import custom megafunctions and IP cores that use I/0O interfaces. You can
configure how to connect the functions and cores to each other by specifying
matching node names for selected ports. You can create other I/O-related
assignments for these interfaces or other design I/O pins in the Pin Planner, as
described in this section. The Pin Planner creates virtual pin assignments for internal
nodes, so internal nodes are not assigned to device pins during compilation. After
analysis and synthesis of the newly generated top-level wrapper file, use the
generated netlist to perform I/O Analysis with the Start I/O Assignment Analysis
command.

(?) For more information about setting up the nodes in your design, refer to Set Up
Top-Level Design File Window (Edit Menu) in Quartus II Help.

You can use the I/O analysis results to change pin assignments or IP parameters even
before you create your design, and repeat the checking process until the I/O interface
meets your design requirements and passes the pin checks in the Quartus II software.
When you complete initial pin planning, you can create a revision based on the
Quartus II-generated netlist. You can then use the generated netlist to develop the top-
level design file for your design, or disregard the generated netlist and use the
generated Quartus II Settings File (.gsf) with your design.

During this early pin planning, after you have generated a top-level design file, or
when you have developed your design source code, you can assign pin locations and
assignments with the Pin Planner.

With the Pin Planner, you can identify I/O banks, voltage reference (VREF) groups,
and differential pin pairings to help you through the I/O planning process. If
migration devices are selected as described in “Device Migration Planning” on

page 2—4, the Pin Migration View highlights the pins that have changed functions in
the migration device when compared to the currently selected device. Selecting the
pins in the Device Migration view cross-probes to the rest of the Pin Planner, so that
you can use device migration information when planning your pin assignments. You
can also configure board trace models of selected pins for use in “board-aware” signal
integrity reports generated with the Enable Advanced I/O Timing option. This
option ensures that you get accurate I/O timing analysis. You can use a Microsoft
Excel spreadsheet to start the I/O planning process if you normally use a spreadsheet
in your design flow, and you can export a Comma-Separated Value File (.csv)
containing your I/O assignments for spreadsheet use when you assign all pins.

When you complete your pin planning, you can pass pin location information to PCB
designers. The Pin Planner is tightly integrated with certain PCB design EDA tools,
and can read pin location changes from these tools to check suggested changes. Your
pin assignments must match between the Quartus II software and your schematic and
board layout tools to ensure the FPGA works correctly on the board, especially if you
must make changes to the pin-out. The system architect uses the Quartus II software
to pass pin information to team members designing individual logic blocks, allowing
them to achieve better timing closure when they compile their design.
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Start FPGA planning before you complete the HDL for your design to improve the
confidence in early board layouts, reduce the chance of error, and improve the overall
time to market of the design. When you complete your design, use the Fitter reports
for the final sign-off of pin assignments. After compilation, the Quartus II software
generates the Pin-Out File (.pin), and you can use this file to verify that each pin is
correctly connected in board schematics.

“ e For more information about I/O assignment and analysis, refer to the [/O Management
chapter in volume 2 of the Quartus II Handbook. For more information about passing
I/0 information between the Quartus II software and third-party EDA tools, refer to
the Mentor Graphics PCB Design Tools Support and Cadence PCB Design Tools Support
chapters in the I/O and PCB Tools section in volume 2 of the Quartus II Handbook.

Simultaneous Switching Noise Analysis

Simultaneous switching noise (SSN) is a noise voltage inducted onto a victim I/O pin
of a device due to the switching behavior of other aggressor I/O pins in the device.
Altera provides tools for SSN analysis and estimation, including SSN characterization
reports, an Early SSN Estimator (ESE) spreadsheet tool, and the SSN Analyzer in the
Quartus II software. SSN often leads to the degradation of signal integrity by causing
signal distortion, thereby reducing the noise margin of a system. You must address
SSN with estimation early in your system design, to minimize later board design
changes. When your design is complete, verify your board design by performing a
complete SSN analysis of your FPGA in the Quartus II software.

“ %@ For more information and device support for the ESE spreadsheet tool, refer to
Altera’s Signal Integrity Center on the Altera website. For more information about the
SSN Analyzer, refer to the Simultaneous Switching Noise (SSN) Analysis and
Optimizations chapter in volume 2 of the Quartus II Handbook.

Selecting Third-Party EDA Tools

Your complete FPGA design flow may include third-party EDA tools in addition to
the Quartus II software. Determine which tools you want to use with the Quartus II
software to ensure that they are supported and set up properly, and that you are
aware of their capabilities.

Synthesis Tool

The Quartus II software includes integrated synthesis that supports Verilog HDL,
VHDL, Altera Hardware Description Language (AHDL), and schematic design entry.
You can also use supported standard third-party EDA synthesis tools to synthesize
your Verilog HDL or VHDL design, and then compile the resulting output netlist file
in the Quartus II software. Different synthesis tools may give different results for each
design. To determine the best tool for your application, you can experiment by
synthesizing typical designs for your application and coding style. Perform
placement and routing in the Quartus II software to get accurate timing analysis and
logic utilization results.
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Because tool vendors frequently add new features, fix tool issues, and enhance
performance for Altera devices, you must use the most recent version of third-party
synthesis tools. The Quartus II Software Release Notes lists the version of each synthesis
tool that is supported by a given version of the Quartus II software.

The synthesis tool you choose may allow you to create a Quartus II project and pass
constraints, such as the EDA tool setting, device selection, and timing requirements

that you specified in your synthesis project. You can save time when setting up your
Quartus II project for placement and routing.

To use incremental compilation, you must partition your design for synthesis and
generate multiple output netlist files. For more information, refer to “Incremental
Compilation with Design Partitions” on page 2-13.

For more information about synthesis tool flows, refer to Volume 1: Design and
Synthesis of the Quartus 11 Handbook.

Simulation Tool

Altera provides the Mentor Graphics ModelSim®-Altera Starter Edition with the
Quartus II software. You can also purchase the ModelSim-Altera Edition or a full
license of the ModelSim software to support large designs and achieve faster
simulation performance. The Quartus II software can generate both functional and
timing netlist files for ModelSim and other third-party simulators.

Use the simulator version that your Quartus II software version supports for best
results. You must also use the model libraries provided with your Quartus II software
version. Libraries can change between versions, which might cause a mismatch with
your simulation netlist.

For a list of the version of each simulation tool that is supported with a given version

of the Quartus II software, refer to the Quartus II Software Release Notes.

For more information about simulation tool flows, refer to the appropriate chapter in
the Simulation section in volume 3 of the Quartus II Handbook.

Formal Verification Tool

Consider whether the Quartus II software supports the formal verification tool that
you want to use, and whether the flow impacts your design and compilation stages of
your design.

For more information about formal verification flows and the supported tools, refer to
Volume 3: Verification of the Quartus II Handbook.
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Using a formal verification tool can impact performance results because performing
formal verification requires turning off certain logic optimizations, such as register
retiming, and forces you to preserve hierarchy blocks, which can restrict optimization.
Formal verification treats memory blocks as black boxes. Therefore, you must keep
memory in a separate hierarchy block so other logic does not get incorporated into the
black box for verification. Other restrictions may limit your design, and you must
consult Volume 3: Verification of the Quartus II Handbook for details. If formal
verification is important to your design, plan for limitations and restrictions at the
beginning of the design cycle rather than make changes later.

Planning for On-Chip Debugging Tools

In-system debugging tools offer different advantages and trade-offs. A particular
debugging tool may work better for different systems and designers. You must
evaluate on-chip debugging tools early in your design process, to ensure that your
system board, Quartus II project, and design can support the appropriate tools. You
can reduce debugging time and avoid making changes to accommodate your
preferred debugging tools later.

For an overview of debugging tools that can help you decide which tools to use, refer
to the Systemn Debugging Tools Overview chapter in volume 3 of the Quartus 1I Handbook.

If you intend to use any of these tools, you may have to plan for the tools when
developing your system board, Quartus II project, and design. Consider the following
debugging requirements when you plan your design:

m JTAG connections—required to perform in-system debugging with JTAG tools.
Plan your system and board with JTAG ports that are available for debugging.

m Additional logic resources—required to implement JTAG hub logic. If you set up
the appropriate tool early in your design cycle, you can include these device
resources in your early resource estimations to ensure that you do not overload the
device with logic.

B Reserve device memory—required if your tool uses device memory to capture
data during system operation. To ensure that you have enough memory resources
to take advantage of this debugging technique, consider reserving device memory
to use during debugging.

m Reserve I/O pins—required if you use the Logic Analyzer Interface (LAI) or
SignalProbe tools, which require I/O pins for debugging. If you reserve I/O pins
for debugging, you do not have to later change your design or board. The LAI can
multiplex signals with design I/O pins if required. Ensure that your board
supports a debugging mode, in which debugging signals do not affect system
operation.

m Instantiate a megafunction in your HDL code—required if your debugging tool
uses a Quartus II megafunction.

m Instantiate the SignalTap II Logic Analyzer as a megafunction—required if you
want to manually connect the SignalTap II Logic Analyzer to nodes in your design
and ensure that the tapped node names do not change during synthesis. You can
add the analyzer as a separate design partition for incremental compilation to
minimize recompilation times.
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“ e For more information, refer to Design Debugging Using the SignalTap II Logic

Analyzer chapter in volume 3 of the Quartus II Handbook.
Table 2-1 lists which factors are important for each debugging tool.

Tahle 2-1. Factors to Consider When Using Debugging Tools During Design Planning Stages
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Instantiate a megafunction in your HDL . . . . . v v
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Design Practices and HDL Coding Styles

When you develop complex FPGA designs, design practices and coding styles have
an enormous impact on the timing performance, logic utilization, and system
reliability of your device.

Design Recommendations

Use synchronous design practices to consistently meet your design goals. Problems
with asynchronous design techniques include reliance on propagation delays in a
device, incomplete timing analysis, and possible glitches. In a synchronous design, a
clock signal triggers all events. When you meet all register timing requirements, a
synchronous design behaves in a predictable and reliable manner for all process,
voltage, and temperature (PVT) conditions. You can easily target synchronous designs
to different device families or speed grades.

Clock signals have a large effect on the timing accuracy, performance, and reliability
of your design. Problems with clock signals can cause functional and timing problems
in your design. Use dedicated clock pins and clock routing for best results, and if you
have PLLs in your target device, use the PLLs for clock inversion, multiplication, and
division. For clock multiplexing and gating, use the dedicated clock control block or
PLL clock switchover feature instead of combinational logic, if these features are
available in your device. If you must use internally-generated clock signals, register
the output of any combinational logic used as a clock signal to reduce glitches.

The Design Assistant in the Quartus II software is a design-rule checking tool that
enables you to verify design issues. The Design Assistant checks your design for
adherence to Altera-recommended design guidelines. You can also use third-party
lint tools to check your coding style.
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@

For more information about running the Design Assistant, refer to About the Design
Assistant in Quartus II Help.

Consider the architecture of the device you choose so that you can use specific
features in your design. For example, the control signals should use the dedicated
control signals in the device architecture. Sometimes, you might need to limit the
number of different control signals used in your design to achieve the best results.

For more information about design recommendations and using the Design Assistant,
refer to the Recommended Design Practices chapter in volume 1 of the Quartus 11
Handbook. You can also refer to industry papers for more information about multiple
clock design. For a good analysis, refer to Synthesis and Scripting Techniques for
Designing Multi-Asynchronous Clock Designs under Papers (www.sunburst-
design.com).

Recommended HDL Coding Styles

HDL coding styles can have a significant effect on the quality of results for
programmable logic designs. If you design memory and DSP functions, you must
understand the target architecture of your device so you can use the dedicated logic
block sizes and configurations. Follow the coding guidelines for inferring
megafunctions and targeting dedicated device hardware, such as memory and DSP
blocks.

For HDL coding examples and recommendations, refer to the Recommended HDL
Coding Styles chapter in volume 1 of the Quartus II Handbook. For additional
tool-specific guidelines, refer to the documentation of your synthesis tool.

Managing Metastability

Metastability problems can occur in digital design when a signal is transferred
between circuitry in unrelated or asynchronous clock domains, because the designer
cannot guarantee that the signal meets the setup and hold time requirements during
the signal transfer. Designers commonly use a synchronization chain to minimize the
occurrence of metastable events. Ensure that your design accounts for
synchronization between any asynchronous clock domains. Consider using a
synchronizer chain of more than two registers for high-frequency clocks and
frequently-toggling data signals to reduce the chance of a metastability failure.

You can use the Quartus II software to analyze the average mean time between
failures (MTBF) due to metastability when a design synchronizes asynchronous
signals, and optimize your design to improve the metastability MTBE. The MTBF due
to metastability is an estimate of the average time between instances when
metastability could cause a design failure. A high MTBF (such as hundreds or
thousands of years between metastability failures) indicates a more robust design.
Determine an acceptable target MTBF given the context of your entire system and the
fact that MTBF calculations are statistical estimates.

The Quartus II software can help you determine whether you have enough
synchronization registers in your design to produce a high enough MTBF at your
clock and data frequencies.

Quartus Il Handbook Version 13.1 November 2013  Altera Corporation
Volume 1: Design and Synthesis


http://quartushelp.altera.com/current/master.htm#mergedProjects/verify/da/comp_view_doctor.htm
http://quartushelp.altera.com/current/master.htm#mergedProjects/verify/da/comp_view_doctor.htm
http://www.altera.com/literature/hb/qts/qts_qii51006.pdf
http://www.sunburst-design.com
http://www.sunburst-design.com
http://www.altera.com/literature/hb/qts/qts_qii51007.pdf
http://www.altera.com/literature/hb/qts/qts_qii51007.pdf

Chapter 2: Design Planning with the Quartus Il Software 2-13
Planning for Hierarchical and Team-Based Design

"% e For information about metastability analysis, reporting, and optimization features in
the Quartus II software, refer to the Managing Metastability with the Quartus II Software
chapter in volume 1 of the Quartus II Handbook.

Planning for Hierarchical and Team-Based Design

To create a hierarchical design so that you can use compilation-time savings and
performance preservation with the Quartus II software incremental compilation
feature, plan for an incremental compilation flow from the beginning of your design
cycle. The following subsections describe the flat compilation flow, in which the
design hierarchy is flattened without design partitions, and then the incremental
compilation flow that uses design partitions. Incremental compilation flows offer
several advantages, but require more design planning to ensure effective results. The
last subsections discuss planning an incremental compilation flow, planning design
partitions, and optionally creating a design floorplan.
“ e Forinformation about using the incremental compilation flow methodology in the
Quartus II software, refer to the Quartus II Incremental Compilation for Hierarchical and
Team-Based Design chapter in volume 1 of the Quartus 1I Handbook.

Flat Compilation Flow with No Design Partitions

In the flat compilation flow with no design partitions in the Quartus II software, the
Quartus II software compiles the entire design in a “flat” netlist. Your source code can
have hierarchy, but the Quartus II software flattens your design during compilation
and synthesizes all the design source code and fits in the target device whenever the
software recompile your design after any change in your design. By processing the
entire design, the software performs all available logic and placement optimizations
on the entire design to improve area and performance. You can use debugging tools in
an incremental design flow, such as the SignalTap II Logic Analyzer, but you do not
specify any design partitions to preserve design hierarchy during compilation.

The flat compilation flow is easy to use; you do not have to plan any design partitions.
However, because the Quartus II software recompiles the entire design whenever you
change your design, compilation times can be slow for large devices. Additionally,
you may find that the results for one part of the design change when you change a
different part of your design. You can turn on the Rapid Recompile option to instruct
the software to preserve compatible placement and routing results when the design
changes in subsequent compilations. This option can reduce your compilation time in
a flat or partitioned design when you make small changes to your design.

Incremental Compilation with Design Partitions

In an incremental compilation flow, the system architect splits a large design into
partitions. When hierarchical design partitions are well chosen and placed in the
device floorplan, you can speed up your design compilation time while maintaining
the quality of results.
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Incremental compilation preserves the compilation results and performance of
unchanged partitions in the design, greatly reducing design iteration time by focusing
new compilations on changed design partitions only. Incremental compilation then
merges new compilation results with the previous compilation results from
unchanged design partitions. Additionally, you can target optimization techniques,
such as physical synthesis, to specific design partitions while leaving other partitions
unchanged. You can also use empty partitions to indicate that parts of your design are
incomplete or missing, while you compile the rest of your design.

Third-party IP designers can also export logic blocks to be integrated into the
top-level design. Team members can work on partitions independently, which can
simplify the design process and reduce compilation time. With exported partitions,
the system architect must provide guidance to designers or IP providers to ensure that
each partition uses the appropriate device resources. Because the designs may be
developed independently, each designer has no information about the overall design
or how their partition connects with other partitions. This lack of information can lead
to problems during system integration. The top-level project information, including
pin locations, physical constraints, and timing requirements, must be communicated
to the designers of lower-level partitions before they start their design.

The system architect plans design partitions at the top level and allows third-party
designs to access the top-level project framework. By designing in a copy of the top-
level project (or by checking out the project files in a source control environment), the
designers of the lower-level block have full information about the entire project,
which helps to ensure optimal results.

When you plan your design code and hierarchy, ensure that each design entity is
created in a separate file so that the entities remain independent when you make
source code changes in the file. If you use a third-party synthesis tool, create separate
Verilog Quartus Mapping or EDIF netlists for each design partition in your synthesis
tool. You may have to create separate projects in your synthesis tool, so that the tool
synthesizes each partition separately and generates separate output netlist files. The
netlists are then considered the source files for incremental compilation.

For more information about support for Quartus II incremental compilation, refer to
the Quartus II Incremental Compilation for Hierarchical and Team-Based Design chapter of
the Quartus II Handbook.

Planning Design Partitions and Floorplan Location Assignments

Partitioning a design for an FPGA requires planning to ensure optimal results when
you integrate the partitions. Following Altera’s recommendations for creating design
partitions should improve the overall quality of results. For example, registering
partition I/O boundaries keeps critical timing paths inside one partition that can be
optimized independently. When you specify the design partitions, you can use the
Incremental Compilation Advisor to ensure that partitions meet Altera’s
recommendations.

If you have timing-critical partitions that are changing through the design flow, or
partitions exported from another Quartus II project, you can create design floorplan
assignments to constrain the placement of the affected partitions. Good partition and
floorplan design helps partitions meet top-level design requirements when integrated
with the rest of your design, reducing time you spend integrating and verifying the
timing of the top-level design.
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For detailed guidelines about creating design partitions and organizing your source
code, as well as information about when and how to create floorplan assignments,
refer to the Best Practices for Incremental Compilation Partitions and Floorplan
Assignments chapter in volume 1 of the Quartus II Handbook.

For more information about creating floorplan assignments in the Chip Planner, refer
to the Analyzing and Optimizing the Design Floorplan chapter in volume 2 of the
Quartus I Handbook.

Fast Synthesis and Early Timing Estimation

Conclusion

You save time when you find design issues early in the design cycle rather than in the
final timing closure stages. When the first version of the design source code is
complete, you might want to perform a quick compilation to create a kind of silicon
virtual prototype (SVP) that you can use to perform timing analysis.

If you synthesize with the Quartus II software, you can choose to perform a Fast
synthesis, which reduces the compilation time, but may give reduced quality of
results.

For more information about Fast synthesis, refer to Synthesis Effort logic option in
Quartus I Help.

Regardless of your compilation flow, you can run an early timing estimate to perform
a quick placement and routing, and a timing analysis of your design. The software
chooses a device automatically if required, places any LogicLock regions to create a
floorplan, finds a quick initial placement for all the design logic, and provides a useful
estimate of the final design performance. If you have entered timing constraints,
timing analysis reports on these constraints.

For more information about how to run an early timing estimate, refer to Running a
Timing Analysis in Quartus II Help.

If you design individual design blocks or partitions separately, you can use the Fast
synthesis and early timing estimate features as you develop your design. Any issues
highlighted in the lower-level design blocks are communicated to the system
architect. Resolving these issues might require allocating additional device resources
to the individual partition, or changing the timing budget of the partition.

Expert designers can also use fast synthesis and early timing estimation to prototype
the entire design. Incomplete partitions are marked as empty in an incremental
compilation flow, while the rest of the design is compiled to get an early timing
estimate and detect any problems with design integration.

Modern FPGAs support large, complex designs with fast timing performance. By
planning several aspects of your design early, you can reduce time in later stages of
the development cycle. Use features of the Quartus II software to quickly plan your
design and achieve the best possible results. Following the guidelines presented in
this chapter can improve productivity, which can reduce cost and development time.
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Table 2-2 shows the revision history for this chapter.

Table 2-2. Document Revision History (Part 1 of 2)

Date Version Changes
November 2013 13.1.0 | Removed HardCopy device information.
November, 2012 12.1.0 Update for changes to early pin planning feature
June 2012 12.0.0 Editorial update.
November 2011 11.01 Template update.
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m Updated “Simultaneous Switching Noise Analysis” on page 1-8
May 2011 11.0.0 | w Updated “Planning for On-Chip Debugging Tools” on page 1-10
m Removed information from “Planning Design Partitions and Floorplan Location
Assignments” on page 1-15
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m Updated “System Design and Standard Interfaces” on page 1-3 to include information
about the Qsys system integration tool
m Added link to the Altera Product Selector in “Device Selection” on page 1-3
m Converted information into new table (Table 1-1) in “Planning for On-Chip Debugging
December 2010 10.1.0 Options™ on page 1-10
m Simplified description of incremental compilation usages in “Incremental Compilation
with Design Partitions” on page 1-14
m Added information about the Rapid Recompile option in “Flat Compilation Flow with No
Design Partitions” on page 1-14
m Removed details and linked to Quartus Il Help in “Fast Synthesis and Early Timing
Estimation” on page 1-16
m Added new section “System Design” on page 1-3
m Removed details about debugging tools from “Planning for On-Chip Debugging Options”
on page 1-10 and referred to other handbook chapters for more information
m Updated information on recommended design flows in “Incremental Compilation with
Design Partitions” on page 1-14 and removed “Single-Project Versus Multiple-Project
Incremental Flows” heading
July 2010 10.0.0

Merged the “Planning Design Partitions” section with the “Creating a Design Floorplan”
section. Changed heading title to “Planning Design Partitions and Floorplan Location
Assignments” on page 1-15

Removed “Creating a Design Floorplan” section
Removed “Referenced Documents” section
Minor updates throughout chapter
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Date

Version
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November 2009

9.1.0

Added details to “Creating Design Specifications” on page 1-2
Added details to “Intellectual Property Selection” on page 1-2
Updated information on “Device Selection” on page 1-3
Added reference to “Device Migration Planning” on page 1-4

Removed information from “Planning for Device Programming or Gonfiguration” on
page 1-4

Added details to “Early Power Estimation” on page 1-5

Updated information on “Early Pin Planning and I/0 Analysis” on page 1-6

Updated information on “Creating a Top-Level Design File for /0 Analysis” on page 1-8
Added new “Simultaneous Switching Noise Analysis” section

Updated information on “Synthesis Tools” on page 1-9

Updated information on “Simulation Tools” on page 1-9

Updated information on “Planning for On-Chip Debugging Options” on page 1-10
Added new “Managing Metastability” section

Changed heading title “Top-Down Versus Bottom-Up Incremental Flows” to “Single-
Project Versus Multiple-Project Incremental Flows”

Updated information on “Creating a Design Floorplan” on page 1-18
Removed information from “Fast Synthesis and Early Timing Estimation” on page 1-18

March 2009

9.0.0

No change to content

November 2008

8.1.0

Changed to 8-1/2 x 11 page size. No change to content.

May 2008

8.0.0

Organization changes

Added “Creating Design Specifications” section

Added reference to new details in the In-System Design Debugging section of volume 3
Added more details to the “Design Practices and HDL Coding Styles” section

Added references to the new Best Practices for Incremental Compilation and Floorplan
Assignments chapter

m Added reference to the Quartus Il Language Templates
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A |:| =0/ 3. Quartus Il Incremental Compilation for
® Hierarchical and Team-Based Design

Ql151015-13.1.0

This chapter provides information and design scenarios to help you partition your
design to take advantage of the Quartus®II incremental compilation feature.

The ability to iterate rapidly through FPGA design and debugging stages is critical.
The Quartus II software introduced the FPGA industry’s first true incremental design
and compilation flow, with the following benefits:

m Preserves the results and performance for unchanged logic in your design as you
make changes elsewhere.

B Reduces design iteration time by an average of 75% for small changes in large
designs, so that you can perform more design iterations per day and achieve
timing closure efficiently.

m Facilitates modular hierarchical and team-based design flows, as well as design

reuse and intellectual property (IP) delivery.

=~ Quartus Il incremental compilation supports the Arria®, Stratix®, and Cyclone® series
of devices.
This document contains the following sections:
m “Deciding Whether to Use an Incremental Compilation Flow” on page 3-1
m “Incremental Compilation Summary” on page 3-7
m “Common Design Scenarios Using Incremental Compilation” on page 3-10
m “Deciding Which Design Blocks Should Be Design Partitions” on page 3-19

m “Specifying the Level of Results Preservation for Subsequent Compilations” on
page 3-25

m “Exporting Design Partitions from Separate Quartus II Projects” on page 3-30

m “Team-Based Design Optimization and Third-Party IP Delivery Scenarios” on
page 3-39

m “Creating a Design Floorplan With LogicLock Regions” on page 3-48
B “Incremental Compilation Restrictions” on page 3-51

m “Scripting Support” on page 3-57

Deciding Whether to Use an Incremental Compilation Flow

The Quartus II incremental compilation feature enhances the standard Quartus II
design flow by allowing you to preserve satisfactory compilation results and
performance of unchanged blocks of your design.
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This section outlines the flat compilation flow with no design partitions, the
incremental flow when you divide the design into partitions, and the differences
between the flat compilation and incremental compilation flows. This section also
explains when a flat compilation flow is satisfactory, and highlights some of the
reasons why you might want to create design partitions and use the incremental
compilation flow. A discussion about incremental and team design flows in “Team-
Based Design Flows and IP Delivery” on page 3—6 describes how it is beneficial to
keep your design within one project, as well as when it might be necessary for other
team members or IP providers to develop particular design blocks or partitions
separately, and then later integrate their partitions into the top-level design.

Flat Compilation Flow with No Design Partitions

In the flat compilation flow with no design partitions, all the source code is processed
and mapped during the Analysis and Synthesis stage, and placed and routed during
the Fitter stage whenever the design is recompiled after a change in any part of the
design. One reason for this behavior is to ensure optimal push-button quality of
results. By processing the entire design, the Compiler can perform global
optimizations to improve area and performance.

You can use a flat compilation flow for small designs, such as designs in CPLD
devices or low-density FPGA devices, when the timing requirements are met easily
with a single compilation. A flat design is satisfactory when compilation time and
preserving results for timing closure are not concerns.

For more information on how to reduce compilation time when you use a flat
compilation for your design, refer to the Reducing Compilation Time chapter in volume
2 of the Quartus II Handbook.

Incremental Capabilities Available When A Design Has No Partitions

The Quartus II software has incremental compilation features available even when
you do not partition your design, including Smart Compilation, incremental
debugging, and Rapid Recompile. These features work in either an incremental or flat
compilation flow.

In any Quartus II compilation flow, you can use Smart Compilation to allow the
Compiler to determine which compilation stages are required, based on the changes
made to the design since the last smart compilation, and then skip any stages that are
not required. For example, when Smart Compilation is turned on, the Compiler skips
the Analysis and Synthesis stage if all the design source files are unchanged. When
Smart Compilation is turned on, if you make any changes to the logic of a design, the
Compiler does not skip any compilation stage. You can turn on Smart Compilation on
the Compilation Process Settings page of the Setting dialog box.

The Quartus II software also includes a Rapid Recompile feature that instructs the
Compiler to reuse the compatible compilation results if most of the design has not
changed since the last compilation. This feature reduces compilation times for small
and isolated design changes. You do not have control over which parts of the design
are recompiled using this option; the Compiler determines which parts of the design
must be recompiled. The Rapid Recompile feature preserves performance and can
save compilation time by reducing the amount of changed logic that must be
recompiled.
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(?) For more information on Rapid Recompile, refer to About Rapid Recompile in

Quartus II Help.

During the debugging stage of the design cycle, you can use incremental compilation
to add the SignalTap® II Logic Analyzer incrementally to your design, even if the
design does not have partitions. To preserve the compilation netlist for the entire
design, instruct the software to reuse the compilation results for the
automatically-created "Top" partition that contains the entire design. For more
information, refer to “Debugging Incrementally With the SignalTap II Logic
Analyzer” on page 3-13.

Incremental Compilation Flow With Design Partitions

In the standard incremental compilation design flow, the top-level design is divided
into design partitions, which can be compiled and optimized together in the top-level
Quartus II project. You can preserve fitting results and performance for completed
partitions while other parts of the design are changing, which reduces the compilation
times for each design iteration.

Incremental compilation is recommended for large designs and high resource
densities when preserving results is important to achieve timing closure. The
incremental compilation feature also facilitates team-based design flows that allow
designers to create and optimize design blocks independently, when necessary. Refer
to “Team-Based Design Flows and IP Delivery” on page 3-6 for more information.

To take advantage of incremental compilation, start by splitting your design along
any of its hierarchical boundaries into design blocks to be compiled incrementally,
and set each block as a design partition. The Quartus II software synthesizes each
individual hierarchical design partition separately, and then merges the partitions
into a complete netlist for subsequent stages of the compilation flow. When
recompiling your design, you can use source code, post-synthesis results, or
post-fitting results to preserve satisfactory results for each partition. Refer to
“Incremental Compilation Summary” on page 3-7 for more information.

In a team-based environment, part of your design may be incomplete, or it may have
been developed by another designer or IP provider. In this scenario, you can add the
completed partitions to the design incrementally. Alternatively, other designers or IP
providers can develop and optimize partitions independently and the project lead can
later integrate the partitions into the top-level design. Refer to “Team-Based Design
Flows and IP Delivery” on page 3—6 for more information.

Table 3-1 shows a summary of the impact the Quartus II incremental compilation
feature has on compilation results.

Table 3-1. Impact Summary of Using Incremental Compilation (Part 1 of 2)

Characteristic Impact of Incremental Compilation with Design Partitions
Compilation Typically saves an average of 75% of compilation time for small design changes in large designs when
Time Savings post-fit netlists are preserved; there are savings in both Quartus Il Integrated Synthesis and the Fitter.
(1)
Performance Excellent performance preservation when timing critical paths are contained within a partition,
Preservation because you can preserve post-fitting information for unchanged partitions.
Node '\'a”?e Preserves post-fitting node names for unchanged partitions.
Preservation
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Table 3—-1. Impact Summary of Using Incremental Compilation (Part 2 of 2)

Characteristic

Impact of Incremental Compilation with Design Partitions

Area Changes

The area (logic resource utilization) might increase because cross-boundary optimizations are limited,
and placement and register packing are restricted.

fuax Changes

The design’s maximum frequency might be reduced because cross-boundary optimizations are
limited. If the design is partitioned and the floorplan location assignments are created appropriately,
there might be no negative impact on fyax.

Note to Table 3-1:

(1) Quartus Il incremental compilation does not reduce processing time for the early "pre-fitter" operations, such as determining pin locations and
clock routing, so the feature cannot reduce compilation time if runtime is dominated by those operations.

If you use the incremental compilation feature at any point in your design flow, it is
easier to accommodate the guidelines for partitioning a design and creating a
floorplan if you start planning for incremental compilation at the beginning of your
design cycle.

For more information and recommendations on how to prepare your design to use the
Quartus Il incremental compilation feature, and how to avoid negative impact on
your design results, refer to the Best Practices for Incremental Compilation Partitions and
Floorplan Assignments chapter in volume 1 of the Quartus II Handbook.
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Figure 3-1 shows a diagram of the Quartus II design flow using incremental
compilation with design partitions.

Figure 3-1. Quartus Il Design Flow Using Incremental Compilation
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Note to Figure 3-1:

(1) When you use EDIF or VOM netlists created by third-party EDA synthesis tools, Analysis and Synthesis creates the
design database, but logic synthesis and technology mapping are performed only for black boxes.

The diagram in Figure 3-1 shows a top-level partition and two lower-level partitions.
If any part of the design changes, Analysis and Synthesis processes the changed
partitions and keeps the existing netlists for the unchanged partitions. After
completion of Analysis and Synthesis, there is one post-synthesis netlist for each
partition.
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The Partition Merge step creates a single, complete netlist that consists of
post-synthesis netlists, post-fit netlists, and netlists exported from other Quartus II
projects, depending on the netlist type that you specify for each partition.

The Fitter then processes the merged netlist, preserves the placement and routing of
unchanged partitions, and refits only those partitions that have changed. The Fitter
generates the complete netlist for use in future stages of the compilation flow,
including timing analysis and programming file generation, which can take place in
parallel if more than one processor is enabled for use in the Quartus II software. The
Fitter also generates individual netlists for each partition so that the Partition Merge
stage can use the post-fit netlist to preserve the placement and routing of a partition, if
specified, for future compilations.

If you define partitions, but want to check your compilation results without partitions
in a “what if” scenario, you can direct the Compiler to ignore all partitions
assignments in your project and compile the design as a "flat" netlist. When you turn
on the Ignore partitions assignments during compilation option on the Incremental
Compilation page, the Quartus II software disables all design partition assignments
in your project and runs a full compilation ignoring all partition boundaries and
netlists. Turning off the Ignore partitions assignments during compilation option
restores all partition assignments and netlists for subsequent compilations.

For more information on incremental compilation settings, refer to Incremental
Compilation Page and Design Partition Properties Dialog Box in Quartus II Help.

Team-Based Design Flows and IP Delivery

The Quartus II software supports various design flows to enable team-based design
and third-party IP delivery. A top-level design can include one or more partitions that
are designed or optimized by different designers or IP providers, as well as partitions
that will be developed as part of a standard incremental methodology.

In a team-based environment, part of your design may be incomplete because it is
being developed elsewhere. The project lead or system architect can create empty
placeholders in the top-level design for partitions that are not yet complete. Designers
or IP providers can create and verify HDL code separately, and then the project lead
later integrates the code into the single top-level Quartus II project. In this scenario,
you can add the completed partitions to the design incrementally, however, the design
flow allows all design optimization to occur in the top-level design for easiest design
integration. Altera recommends using a single Quartus II project whenever possible
because using multiple projects can add significant up-front and debugging time to
the development cycle.

Alternatively, partition designers can design their partition in a copy of the top-level
design or in a separate Quartus II project. Designers export their completed partition
as either a post-synthesis netlist or optimized placed and routed netlist, or both, along
with assignments such as LogicLock™ regions, as appropriate. The project lead then
integrates each design block as a design partition into the top-level design. Altera
recommends that designers export and reuse post-synthesis netlists, unless optimized
post-fit results are required in the top-level design, to simplify design optimization.
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Teams with a bottom-up design approach often want to optimize placement and
routing of design partitions independently and may want to create separate
Quartus II projects for each partition. However, optimizing design partitions in
separate Quartus II projects, and then later integrating the results into a top-level
design, can have the following potential drawbacks that require careful planning:

m Achieving timing closure for the full design may be more difficult if you compile
partitions independently without information about other partitions in the design.
This problem may be avoided by careful timing budgeting and special design
rules, such as always registering the ports at the module boundaries.

B Resource budgeting and allocation may be required to avoid resource conflicts and
overuse. Creating a floorplan with LogicLock regions is recommended when
design partitions are developed independently in separate Quartus II projects.

®  Maintaining consistency of assignments and timing constraints can be more
difficult if there are separate Quartus II projects. The project lead must ensure that
the top-level design and the separate projects are consistent in their assignments.

A unique challenge of team-based design and IP delivery for FPGAs is the fact that
the partitions being developed independently must share a common set of resources.
To minimize issues that might arise from sharing a common set of resources, you can
design partitions within a single Quartus II project or a copy of the top-level design. A
common project ensures that designers have a consistent view of the top-level project
framework.

For timing-critical partitions being developed and optimized by another designer, it is
important that each designer has complete information about the top-level design in
order to maintain timing closure during integration, and to obtain the best results.
When you want to integrate partitions from separate Quartus II projects, the project
lead can perform most of the design planning, and then pass the top-level design
constraints to the partition designers. Preferably, partition designers can obtain a copy
of the top-level design by checking out the required files from a source control system.
Alternatively, the project lead can provide a copy of the top-level project framework,
or pass design information using Quartus II-generated design partition scripts. In the
case that a third-party designer has no information about the top-level design,
developers can export their partition from an independent project if required.

For more information about managing team-based design flows, refer to “Exporting
Design Partitions from Separate Quartus II Projects” on page 3-30 and “Project
Management—Making the Top-Level Design Available to Other Designers” on
page 3-32.

Incremental Compilation Summary

This section provides a summary of the standard incremental compilation design flow
and describes how to create design partitions.
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Figure 3-2 illustrates the incremental compilation design flow when all partitions are
contained in one top-level design.

Figure 3-2. Summary of Standard Incremental Compilation Design Flow
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Steps for Incremental Compilation

This section summarizes the steps in an incremental compilation flow; preparing a
design to use the incremental compilation feature, and then preserving satisfactory
results and performance in subsequent incremental compilations.

(?) For an interactive introduction to implementing an incremental compilation design
flow, refer to the Getting Started Tutorial on the Help menu in the Quartus II
software. For step-by-step instructions on how to use the incremental compilation
feature, refer to Using the Incremental Compilation Design Flow in Quartus II Help.

Preparing a Design for Incremental Compilation

To begin, elaborate your design, or run any compilation flow (such as a full
compilation) that includes the elaboration step. Elaboration is the part of the synthesis
process that identifies your design’s hierarchy.

Next, designate specific instances in the design hierarchy as design partitions, as
described in “Creating Design Partitions” on page 3-9.

If required for your design flow, create a floorplan with LogicLock regions location
assignments for timing-critical partitions that change with future compilations.
Assigning a partition to a physical region on the device can help maintain quality of
results and avoid conflicts in certain situations. For more information about
LogicLock region assignments, refer to “Creating a Design Floorplan With LogicLock
Regions” on page 3-48.
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Compiling a Design Using Incremental Compilation

The first compilation after making partition assignments is a full compilation, and
prepares the design for subsequent incremental compilations. In subsequent
compilations of your design, you can preserve satisfactory compilation results and
performance of unchanged partitions with the Netlist Type setting in the Design
Partitions window. The Netlist Type setting determines which type of netlist or
source file the Partition Merge stage uses in the next incremental compilation. You can
choose the Source File, Post-Synthesis netlist, or Post-Fit netlist. For more information
about the Netlist Type setting, refer to “Specifying the Level of Results Preservation
for Subsequent Compilations” on page 3-25.

Creating Design Partitions

There are several ways to designate a design instance as a design partition. This
section provides an overview of tools you can use to create partitions in the Quartus II
software. For more information on selecting which design blocks to assign as
partitions and how to analyze the quality of your partition assignments, refer to
“Deciding Which Design Blocks Should Be Design Partitions” on page 3-19.

Creating Design Partitions in the Project Navigator

You can right-click an instance in the list under the Hierarchy tab in the Project
Navigator and use the sub-menu to create and delete design partitions.

(@ For more information about how to create design partitions in the Quartus II Project
Navigator, refer to Creating Design Partitions in Quartus II Help.

Creating Design Partitions in the Design Partitions Window

The Design Partitions window, available from the Assignments menu, allows you to
create, delete, and merge partitions, and is the main window for setting the netlist
type to specify the level of results preservation for each partition on subsequent
compilations. For information about how to set the netlist type and the available
settings, refer to “Netlist Type for Design Partitions” on page 3-25.

The Design Partitions window also lists recommendations at the bottom of the
window with links to the Incremental Compilation Advisor, where you can view
additional recommendations about partitions. The Color column indicates the color
of each partition as it appears in the Design Partition Planner and Chip Planner.

You can right-click a partition in the window to perform various common tasks, such
as viewing property information about a partition, including the time and date of the
compilation netlists and the partition statistics.

When you create a partition, the Quartus II software automatically generates a name
based on the instance name and hierarchy path. You can edit the partition name in the
Design Partitions Window so that you avoid referring to them by their hierarchy path,
which can sometimes be long. This is especially useful when using command-line
commands or assignments, or when you merge partitions to give the partition a
meaningful name. Partition names can be from 1 to 1024 characters in length and
must be unique. The name can consist of alphanumeric characters and the pipe

('] ), colon (:), and underscore ( _ ) characters.
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@

For more information about how to create and manage design partitions in the Design
Partitions window, refer to Creating Design Partitions in Quartus II Help.

Creating Design Partitions With the Design Partition Planner

The Design Partition Planner allows you to view design connectivity and hierarchy,
and can assist you in creating effective design partitions that follow Altera’s
guidelines.

The Design Partition Planner displays a visual representation of design connectivity
and hierarchy, as well as partitions and entity relationships. You can explore the
connectivity between entities in the design, evaluate existing partitions with respect to
connectivity between entities, and try new partitioning schemes in "what if" scenarios.

When you extract design blocks from the top-level design and drag them into the
Design Partition Planner, connection bundles are drawn between entities, showing
the number of connections existing between pairs of entities. In the Design Partition
Planner, you can then set extracted design blocks as design partitions.

The Design Partition Planner also has an Auto-Partition feature that creates partitions
based on the size and connectivity of the hierarchical design blocks.

For more information about how to use the Design Partition Planner, refer to Using the
Design Partition Planner in Quartus II Help and the Best Practices for Incremental
Compilation Partitions and Floorplan Assignments chapter in volume 1 of the Quartus II
Handbook.

Creating Design Partitions With Tcl Scripting

You can also create partitions with Tcl scripting commands. For more information
about the command-line and scripting flow, refer to “Scripting Support” on
page 3-57.

Automatically-Generated Partitions

The Compiler creates some partitions automatically as part of the compilation
process, which appear in some post-compilation reports. For example, the s1d_hub
partition is created for tools that use JTAG hub connections, such as the SignalTap II
Logic Analyzer. The hard_block partition is created to contain certain "hard" or
dedicated logic blocks in the device that are implemented in a separate partition so
that they can be shared throughout the design.

Common Design Scenarios Using Incremental Compilation

This section provides recommended applications of the incremental compilation flow
after you have set up your design with partitions for incremental compilation as
described in, “Steps for Incremental Compilation” on page 3-8.

This section contains the following design scenarios:

B “Reducing Compilation Time When Changing Source Files for One Partition” on
page 3-11

B “Optimizing a Timing-Critical Partition” on page 3-11

Quartus Il Handbook Version 13.1 November 2013  Altera Corporation
Volume 1: Design and Synthesis


http://quartushelp.altera.com/current/master.htm#mergedProjects/optimize/dpp/dpp_pro_using_dpp.htm 
http://quartushelp.altera.com/current/master.htm#mergedProjects/optimize/dpp/dpp_pro_using_dpp.htm 
http://quartushelp.altera.com/current/master.htm#mergedProjects/comp/increment/comp_pro_qid_create_design_partitions.htm
http://www.altera.com/literature/hb/qts/qts_qii51017.pdf
http://www.altera.com/literature/hb/qts/qts_qii51017.pdf

Chapter 3: Quartus Il Incremental Compilation for Hierarchical and Team-Based Design 3-1
Common Design Scenarios Using Incremental Compilation

m “Adding Design Logic Incrementally or Working With an Incomplete Design” on
page 3-12

m “Debugging Incrementally With the SignalTap II Logic Analyzer” on page 3-13

Reducing Compilation Time When Changing Source Files for One Partition

Scenario background: You set up your design to include partitions for several of the
major design blocks, and now you have just performed a lengthy compilation of the
entire design. An error is found in the HDL source file for one partition and it is being
fixed. Because the design is currently meeting timing requirements, and the fix is not
expected to affect timing performance, it makes sense to compile only the affected
partition and preserve the rest of the design.

Use the flow in this example to update the source file in one partition without having
to recompile the other parts of the design. To reduce the compilation time, instruct the
software to reuse the post-fit netlists for the unchanged partitions. This flow also
preserves the performance of these blocks, which reduces additional timing closure
efforts.

Perform the following steps to update a single source file:
1. Apply and save the fix to the HDL source file.
2. On the Assignments menu, open the Design Partitions window.

3. Change the netlist type of each partition, including the top-level entity, to Post-Fit
to preserve as much as possible for the next compilation.

I'=~ The Quartus II software recompiles partitions by default when changes are
detected in a source file. You can refer to the Partition Dependent Files table
in the Analysis and Synthesis report to determine which partitions were
recompiled. If you change an assignment but do not change the logic in a
source file, you can set the netlist type to Source File for that partition to
instruct the software to recompile the partition's source design files and its
assignments.

(@ For more information about the Analysis and Synthesis report, refer to List
of Compilation and Simulation Reports in Quartus II Help.

4. Click Start Compilation to incrementally compile the fixed HDL code. This
compilation should take much less time than the initial full compilation.

5. Simulate the design to ensure that the error is fixed, and use the TimeQuest Timing
Analyzer report to ensure that timing results have not degraded.

Optimizing a Timing-Critical Partition

Scenario background: You have just performed a lengthy full compilation of a design
that consists of multiple partitions. The TimeQuest Timing Analyzer reports that the
clock timing requirement is not met, and you have to optimize one particular
partition. You want to try optimization techniques such as raising the Placement
Effort Multiplier, enabling Physical Synthesis, and running the Design Space Explorer.
Because these techniques all involve significant compilation time, you should apply
them to only the partition in question.
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Use the flow in this example to optimize the results of one partition when the other
partitions in the design have already met their requirements. You can use this flow
iteratively to lock down the performance of one partition, and then move on to
optimization of another partition.

Perform the following steps to preserve the results for partitions that meet their
timing requirements, and to recompile a timing-critical partition with new
optimization settings:

1. Open the Design Partitions window.

2. For the partition in question, set the netlist type to Source File.
=~ If you change a setting that affects only the Fitter, you can save additional
compilation time by setting the netlist type to Post-Synthesis to reuse the
synthesis results and refit the partition.

3. For the remaining partitions (including the top-level entity), set the netlist type to
Post-Fit.

=" You can optionally set the Fitter Preservation Level on the Advanced tab in
the Design Partitions Properties dialog box to Placement to allow for the
most flexibility during routing.

4. Apply the desired optimization settings.

5. Click Start Compilation to perform incremental compilation on the design with
the new settings. During this compilation, the Partition Merge stage automatically
merges the critical partition’s new synthesis netlist with the post-fit netlists of the
remaining partitions. The Fitter then refits only the required partition. Because the
effort is reduced as compared to the initial full compilation, the compilation time is
also reduced.

To use the Design Space Explorer, perform the following steps:
1. Repeat steps 1-3 of the previous procedure.

2. Save the project and run the Design Space Explorer.

Adding Design Logic Incrementally or Working With an Incomplete Design

Scenario background: You have one or more partitions that are known to be timing-
critical in your full design. You want to focus on developing and optimizing this
subset of the design first, before adding the rest of the design logic.

Use this flow to compile a timing-critical partition or partitions in isolation, optionally
with extra optimizations turned on. After timing closure is achieved for the critical
logic, you can preserve its content and placement and compile the remaining
partitions with normal or reduced optimization levels. For example, you may want to
compile an IP block that comes with instructions to perform optimization before you
incorporate the rest of your custom logic.
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To implement this design flow, perform the following steps:

1. Partition the design and create floorplan location assignments. For best results,
ensure that the top-level design includes the entire project framework, even if
some parts of the design are incomplete and are represented by an empty wrapper
file.

2. For the partitions to be compiled first, in the Design Partitions window, set the
netlist type to Source File.

3. For the remaining partitions, set the netlist type to Empty.
4. To compile with the desired optimizations turned on, click Start Compilation.

5. Check the Timing Analyzer reports to ensure that timing requirements are met. If
so, proceed to step 6. Otherwise, repeat steps 4 and 5 until the requirements are
met.

6. In the Design Partitions window, set the netlist type to Post-Fit for the first
partitions. You can set the Fitter Preservation Level on the Advanced tab in the
Design Partitions Properties dialog box to Placement to allow more flexibility
during routing if exact placement and routing preservation is not required.

7. Change the netlist type from Empty to Source File for the remaining partitions,
and ensure that the completed source files are added to the project.

8. Set the appropriate level of optimizations and compile the design. Changing the
optimizations at this point does not affect any fitted partitions, because each
partition has its netlist type set to Post-Fit.

9. Check the Timing Analyzer reports to ensure that timing requirements are met. If
not, make design or option changes and repeat step 8 and step 9 until the
requirements are met.

The flow in this example is similar to design flows in which a module is implemented
separately and is later merged into the top-level, such as in the team-based design
flow described in “Designing in a Team-Based Environment” on page 3-42. Generally,
optimization in this flow works only if each critical path is contained within a single
partition due to the effects described in “Deciding Which Design Blocks Should Be
Design Partitions” on page 3-19. Ensure that if there are any partitions representing a
design file that is missing from the project, you create a placeholder wrapper file to
define the port interface. For more information, refer to “Empty Partitions” on

page 3-32.

Debugging Incrementally With the SignalTap Il Logic Analyzer

Scenario background: Your design is not functioning as expected, and you want to
debug the design using the SignalTap II Logic Analyzer. To maintain reduced
compilation times and to ensure that you do not negatively affect the current version
of your design, you want to preserve the synthesis and fitting results and add the
SignalTap II Logic Analyzer to your design without recompiling the source code.

Use this flow to reduce compilation times when you add the logic analyzer to debug
your design, or when you want to modify the configuration of the SignalTap II File
without modifying your design logic or its placement.
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It is not necessary to create design partitions in order to use the SignalTap II
incremental compilation feature. The SignalTap II Logic Analyzer acts as its own
separate design partition.

Perform the following steps to use the SignalTap II Logic Analyzer in an incremental
compilation flow:

1. Open the Design Partitions window.

2. Set the netlist type to Post-fit for all partitions to preserve their placement.

L=~ The netlist type for the top-level partition defaults to Source File, so be sure
to change this “Top” partition in addition to any design partitions that you
have created.

3. If you have not already compiled the design with the current set of partitions,
perform a full compilation. If the design has already been compiled with the
current set of partitions, the design is ready to add the SignalTap II Logic Analyzer.

4. Set up your SignalTap II File using the post-fitting filter in the Node Finder to add
signals for logic analysis. This allows the Fitter to add the SignalTap II logic to the
post-fit netlist without modifying the design results.

To add signals from the pre-synthesis netlist, set the partition’s netlist type to
Source File and use the pre-synthesis filter in the Node Finder. This allows the
software to resynthesize the partition and to tap directly to the pre-synthesis node
names that you choose. In this case, the partition is resynthesized and refit, so the
placement is typically different from previous fitting results.

«o For more information about setting up the SignalTap II Logic Analyzer, refer to the

Design Debugging Using the Signallap II Embedded Logic Analyzer chapter in volume 3 of
the Quartus Il Handbook.

Functional Safety IP Implementation

In functional safety designs, recertification is required when logic is modified in safety
or non-safety areas of the design. Recertification is required because the FPGA
programming file has changed. You can reduce the amount of required recertification
if you use the safety /non-safety separation flow in the Quartus II software. By
partitioning your safety IP from non-safety related logic, you ensure that the safety
critical areas of the design remain the same when the non-safety areas in your design
are modified. The safety-critical areas remain the same at the bit level.

IEC61508 Compliance

The Quartus II software can partition your design into safety partitions and non-
safety partitions, but the Quartus II software does not perform any online safety-
related functionality. A bitstream is generated by the Quartus II software that
performs the safety functions and for the purposed of compliance with IEC61508, the
Quartus II software should be considered as an offline support tool.
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CAUTION

Functional Safety Separation Flow

The functional safety separation flow consists of two separate work flows. The design
creation flow (DCF) and the design modification flow (DMF) both leverage
incremental compilation, but the two flows have different use-case scenarios.

Figure 3-3. Functional Safety Separation Flow
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Design Creation Flow

The design creation flow delineates the necessary steps for initial design creation in a
way that allows modifications to be made in your design. Some of the steps are
architectural constraints and the remaining steps are steps that you need to perform in
the Quartus II software. You use DCF for the first pass certification of your product.

When you make modifications to the safety IP in your design, you are required to use
the design creation flow.

Figure 3-4. Design Creation Flow
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CAUTION

CAUTION

Design Modification Flow

The design modification flow delineates the necessary steps to make modifications to
the non-safety IP in your design. This flow ensures that the previously compiled
Safety IP (SIP) that is used in the project remains unchanged when non-safety IP
(NSIP) changes are made or compiled.

You can only use the design modification flow after your design has been qualified in
the design creation flow.

Figure 3-5. Design Modification Flow
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How to Turn On the Functional Safety Separation Flow

Every safety related IP component in your design should be implemented in a
partition(s) so the SIPs are protected from recompilation. The global assignment
PARTITION ENABLE_STRICT PRESERVATION is used to identify SIP in your design.

B set global assignment -name PARTITION ENABLE STRICT PRESERVATION
<ON/OFF> -section id <partition name>

When this global assignment is designated as ON for a partition, the partition is
protected from recompilation, exported as a SIP, and included into the SIP POF mask.
Specifying the value as ON for any partition turns on the functional safety separation
flow.

When this global assignment is designated as OFF, the partition is considered as part
of the NSIP or as not having a PARTITION ENABLE STRICT PRESERVATION assignment
at all. Logic that is not assigned to a partition is considered as part of the top partition
and treated as non-safety logic.

Only partitions and I/O pins can be assigned to SIP.
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A partition assigned to SIP can contain safety logic only. If the parent partition is
assigned to a SIP, then all the child partitions for this parent partition is considered as
part of the SIP. If a child partition is not specified explicitly as a SIP, a critical warning
is issued to notify you that the child partition is treated as part of a SIP.

A design can contain several SIPs. All the partitions containing logic that implements
a single SIP function should belong with the same top level parent partition.

The functional safety separation flow supports Cyclone IV and Cyclone V device
families.

You can also turn on the functional safety separation flow from the Design Partition
Properties dialog box.

When the functional safety separation flow is active, you can view which partitions in
your design have the Strict Preservation property turned on. The Design Partition
Window displays a on or off value for SIP in your design.

(@ For more information about the Design Partition Properties dialog box and the Design
Partitions Window, refer to the Quartus II Help.

Preservation of Device Resources

The preservation of the partition’s netlist atoms and the atoms placement and routing,
in the design modification flow, is done be setting the netlist type to Post-fit with the
Fitter preservation level set to Placement and Routing Preserved.

Preservation of Placement in the Device with LogicLock

In order to fix the SIP logic into specific areas of the device, you should define
LogicLock regions. By using preserved LogicLock regions, device placement is
reserved for the SIP to prevent NSIP logic from being placed into the unused
resources of the SIP region. You establish a fixed size and origin to ensure location
preservation. You need to use LogicLock to ensure a valid SIP POF mask is generated,
but the SIP POF mask gets generated when you turn on the functional safety
separation flow. The POF comparison tool for functional safety can check that the
safety region is unchanged between compiles. A LogicLock region assigned to a SIP
can only contain safety IP logic.

Assigning 1/0 Pins
You can use a global assignment to specify that a pin is assigned to a SIP.

set_instance assignment ENABLE STRICT PRESERVATION ON/OFF - to=<hpath> -
section _id <region name>

B <hpath> refers to an I/O pin (pad).
B <region names refers to the top level SIP partition name.

A value of ON indicates that the pin is a safety pin that should be preserved along
with the SIP. A value of OFF indicates that the pin that connects up to the SIP, should
be treated as a non-safety pin, and is not preserved along with the SIP.

All the pins that connect up to a SIP should have an explicit assighment.

An error is reported if a pin that connects up the SIP does not have an assignment or a
pin does not connect up to the specified <region names.
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If an IO_REG group contains a pin that is assigned to a SIP, then all the pins in the
IO_REG group are reserved for this SIP. All pins in the IO_REG group need to be
assigned to the same SIP and none of the pins in the group can be assigned to non-
safety signals.

General Guidelines for Implementation

B Aninternal clock source, such as a PLL, should be implemented in a safe partition.
B An /O pin driving the external clock should be indicated as a safety pin.

m To export a SIP containing several partitions, the top level partition for the SIP
should be exported. A SIP containing several partitions is flattened and converted
into a single partition during export. This hierarchical SIP is flattened to enure bit-
level settings are preserved.

m Hard blocks implemented in a safe partition needs to stay with the safe partition.

Reports for SIP

When you have the functional safety separation flow turned on, the Quartus II
software displays SIP and NSIP information in the Fitter report.

Fitter Report

The Fitter report includes information for each SIP and the respective partition and
1/0 usage. The report contains the following information:

m Partition name (with the name of the top level SIP partition used as the SIP name)
m  Number of safety /non-safety inputs to the partitions

m  Number of safety /non-safety outputs to the partitions

m LogicLock region names along with size and locations for the regions

m 1/0 pins used for the respective SIP in your design

m Safety related error messages

SIP Partial Bitstream Generation

The Programmer generates a bitstream file containing only the bits for a SIP. This
partial preserved bitstream (PPB) file is for the SIP region mask. The command lines
to generate the partial bitstream file are the following:

m quartus_cpf --gen_ppb safel.psm design.sof safel.rbf.ppb
m quartus_cpf -c safel.psm safel.rbf.ppb

The PPB file is generated in two steps.

1. Generation of partial SOF.

2. Generation of PPB file using the partial SOF.
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POF Comparison Tool for Verification

There is a separate safe/non-safe partitioning verification tool that is licensed to
safety users. Along with the PPB file, a MD5 hash signature file is generated. The MD5
hash signature can be used for verification. For more detailed verification, the POF
comparison tool should be used. This POF comparison tool is available in the Altera
Functional Safety Data Package.

Deciding Which Design Blocks Should Be Design Partitions

The incremental compilation design flow requires more planning than flat
compilations. For example, you might have to structure your source code or design
hierarchy to ensure that logic is grouped correctly for optimization.

It is a common design practice to create modular or hierarchical designs in which you
develop each design entity separately, and then instantiate them in a higher-level
entity, forming a complete design. The Quartus II software does not automatically
consider each design entity or instance to be a design partition for incremental
compilation; instead, you must designate one or more design hierarchies below the
top-level project as a design partition. Creating partitions might prevent the Compiler
from performing optimizations across partition boundaries, as discussed in “Impact
of Design Partitions on Design Optimization” on page 3-20. However, this allows for
separate synthesis and placement for each partition, making incremental compilation
possible.

Partitions must have the same boundaries as hierarchical blocks in the design because
a partition cannot be a portion of the logic within a hierarchical entity. You can merge
partitions that have the same immediate parent partition to create a single partition
that includes more than one hierarchical entity in the design. When you declare a
partition, every hierarchical instance within that partition becomes part of the same
partition. You can create new partitions for hierarchical instances within an existing
partition, in which case the instances within the new partition are no longer included
in the higher-level partition, as described in the following example.

In Figure 3-6, a complete design is made up of instances A, B, C, D, E, F, and G. The
shaded boxes in Representation i indicate design partitions in a “tree” representation
of the hierarchy. In Representation ii, the lower-level instances are represented inside
the higher-level instances, and the partitions are illustrated with different colored
shading. The top-level partition, called “Top”, automatically contains the top-level
entity in the design, and contains any logic not defined as part of another partition.
The design file for the top level may be just a wrapper for the hierarchical instances

November 2013  Altera Corporation Quartus Il Handbook Version 13.1
Volume 1: Design and Synthesis



3-20 Chapter 3: Quartus Il Incremental Compilation for Hierarchical and Team-Based Design
Deciding Which Design Blocks Should Be Design Partitions

below it, or it may contain its own logic. In this example, partition B contains the logic
in instances B, D, and E. Entities F and G were first identified as separate partitions,
and then merged together to create a partition F-G. The partition for the top-level
entity A, called “Top”, includes the logic in one of its lower-level instances, C, because
C was not defined as part of any other partition.

Figure 3-6. Partitions in a Hierarchical Design

Representation i
Partition Top
A
B c
l—l—l I
D E F G
Partition B Merged Partition F-G
Representation ii
A
B C
:
]
D E F i G
:
]

You can create partition assighments to any design instance. The instance can be

defined in HDL or schematic design, or come from a third-party synthesis tool as a
VOM or EDIF netlist instance.

To take advantage of incremental compilation when source files change, create
separate design files for each partition. If you define two different entities as separate
partitions but they are in the same design file, you cannot maintain incremental
compilation because the software would have to recompile both partitions if you
changed either entity in the design file. Similarly, if two partitions rely on the same
lower-level entity definition, changes in that lower-level affect both partitions.

The remainder of this section provides information to help you choose which design
blocks you should assign as partitions.

Impact of Design Partitions on Design Optimization

The boundaries of your design partitions can impact the design’s quality of results.
Creating partitions might prevent the Compiler from performing logic optimizations
across partition boundaries, which allows the software to synthesize and place each
partition separately in an incremental flow. Therefore, consider partitioning
guidelines to help reduce the effect of partition boundaries.

Quartus Il Handbook Version 13.1 November 2013  Altera Corporation
Volume 1: Design and Synthesis



Chapter 3: Quartus Il Incremental Compilation for Hierarchical and Team-Based Design 3-21
Deciding Which Design Blocks Should Be Design Partitions

Whenever possible, register all inputs and outputs of each partition. This helps avoid
any delay penalty on signals that cross partition boundaries and keeps each
register-to-register timing path within one partition for optimization. In addition,
minimize the number of paths that cross partition boundaries. If there are
timing-critical paths that cross partition boundaries, rework the partitions to avoid
these inter-partition paths. Including as many of the timing-critical connections as
possible inside a partition allows you to effectively apply optimizations to that
partition to improve timing, while leaving the rest of the design unchanged.

Avoid constant partition inputs and outputs. You can also merge two or more
partitions to allow cross-boundary optimizations for paths that cross between the
partitions, as long as the partitions have the same parent partition. Merging related
logic from different hierarchy blocks into one partition can be useful if you cannot
change the design hierarchy to accommodate partition assignments.

The Design Partition Planner can help you create good assignments, as described in
“Creating Design Partitions” on page 3-9. Refer to “Partition Statistics Reports” on
page 3-23 for information about the number of I/O connections and how many are
unregistered or driven by a constant value. For information on timing reports and
additional design guidelines, refer to “Partition Timing Reports” on page 3-24 and
“Incremental Compilation Advisor” on page 3-24.

If critical timing paths cross partition boundaries, you can perform timing budgeting
and make timing assignments to constrain the logic in each partition so that the entire
timing path meets its requirements. In addition, because each partition is optimized
independently during synthesis, you may have to perform resource allocation to
ensure that each partition uses an appropriate number of device resources. If design
partitions are compiled in separate Quartus II projects, there may be conflicts related
to global routing resources for clock signals when the design is integrated into the
top-level design. You can use the Global Signal logic option to specify which clocks
should use global or regional routing, use the ALTCLK_CTRL megafunction to
instantiate a clock control block and connect it appropriately in both the partitions
being developed in separate Quartus II projects, or find the compiler-generated clock
control node in your design and make clock control location assignments in the
Assignment Editor.

Turning On Supported Cross-houndary Optimizations

You can improve the optimizations performed between design partitions by turning
on supported cross-boundary optimizations. These optimizations are turned on a per
partition basis and you can select the optimizations as individual assignments. This
allows the cross-boundary optimization feature to give you more control over the
optimizations that work best for your design. You can turn on the cross-boundary
optimizations for your design partitions on the Advanced tab of the Design Partition
Properties dialog box. Once you change the optimization settings, the Quartus II
software recompiles your partition from source automatically. Cross-boundary
optimizations include the following: propagate constants, propagate inversions on
partition inputs, merge inputs fed by a common source, merge electrically equivalent
bidirectional pins, absorb internal paths, and remove logic connected to dangling
outputs.
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Cross-boundary optimizations are implemented top-down from the parent partition
into the child partition, but not vice-versa. Also, cross-boundary optimizations cannot
be enabled for partitions that allow multiple personas (partial reconfiguration
partitions).

For more information about cross-boundary optimizations in the Quartus II software,
refer to Design Partition Properties Dialog Box in Quartus II Help.

For more partitioning guidelines and specific recommendations for fixing common
design issues, as well as information on resource allocation, global signal usage, and
timing budgeting, refer to the Best Practices for Incremental Compilation Partitions and
Floorplan Assignments chapter in volume 1 of the Quartus II Handbook.

Design Partition Assignments Compared to Physical Placement
Assignments

Design partitions for incremental compilation are logical partitions, which is different
from physical placement assignments in the device floorplan. A logical design
partition does not refer to a physical area of the device and does not directly control
the placement of instances. A logical design partition sets up a virtual boundary
between design hierarchies so that each is compiled separately, preventing logical
optimizations from occurring between them. When the software compiles the design
source code, the logic in each partition can be placed anywhere in the device unless
you make additional placement assignments.

If you preserve the compilation results using a Post-Fit netlist, it is not necessary for
you to back-annotate or make any location assignments for specific logic nodes. You
should not use the incremental compilation and logic placement back-annotation
features in the same Quartus II project. The incremental compilation feature does not
use placement “assignments” to preserve placement results; it simply reuses the
netlist database that includes the placement information.

You can assign design partitions to physical regions in the device floorplan using
LogicLock region assignments. In the Quartus II software, LogicLock regions are used
to constrain blocks of a design to a particular region of the device. Altera recommends
using LogicLock regions for timing-critical design blocks that will change in
subsequent compilations, or to improve the quality of results and avoid placement
conflicts in some cases. Creating floorplan location assignments for design partitions
using LogicLock regions is discussed in “Creating a Design Floorplan With LogicLock
Regions” on page 3-48.

For more information about when and why to create a design floorplan, refer to the
Best Practices for Incremental Compilation Partitions and Floorplan Assignments chapter in
volume 1 of the Quartus II Handbook.

Using Partitions With Third-Party Synthesis Tools

If you are using a third-party synthesis tool, set up your tool to create a separate VQM
or EDIF netlist for each hierarchical partition. In the Quartus II software, assign the
top-level entity from each netlist to be a design partition. The VQM or EDIF netlist file
is treated as the source file for the partition in the Quartus II software.
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Synopsys Synplify Pro/Premier and Mentor Graphics Precision RTL Plus

The Synplify Pro and Synplify Premier software include the MultiPoint synthesis
feature to perform incremental synthesis for each design block assigned as a Compile
Point in the user interface or a script. The Precision RTL Plus software includes an
incremental synthesis feature that performs block-based synthesis based on Partition
assignments in the source HDL code. These features provide automated block-based
incremental synthesis flows and create different output netlist files for each block
when set up for an Altera device.

Using incremental synthesis within your synthesis tool ensures that only those
sections of a design that have been updated are resynthesized when the design is
compiled, reducing synthesis run time and preserving the results for the unchanged
blocks. You can change and resynthesize one section of a design without affecting
other sections of the design.

For more information about these incremental synthesis flows, refer to your tool
vendor’s documentation, or the Synopsys Synplify Support chapter or Mentor Graphics
Precision Synthesis Support chapter in volume 1 of the Quartus II Handbook.

Other Synthesis Tools

You can also partition your design and create different netlist files manually with the
basic Synplify software (non-Pro/Premier), the basic Precision RTL software
(non-Plus), or any other supported synthesis tool by creating a separate project or
implementation for each partition, including the top level. Set up each higher-level
project to instantiate the lower-level VOM/EDIF netlists as black boxes. Synplify,
Precision, and most synthesis tools automatically treat a design block as a black box if
the logic definition is missing from the project. Each tool also includes options or
attributes to specify that the design block should be treated as a black box, which you
can use to avoid warnings about the missing logic.

Assessing Partition Quality

The Quartus II software provides various tools to assess the quality of your assigned
design partitions. You can take advantage of these tools to assess your partition
quality, and use the information to improve your design or assignments as required to
achieve the best results.

Partition Statistics Reports

After compilation, you can view statistics about design partitions in the Partition
Merge Partition Statistics report, and on the Statistics tab in the Design Partitions
Properties dialog box.

The Partition Merge Partition Statistics report lists statistics about each partition. The
statistics for each partition (each row in the table) include the number of logic cells it
contains, as well as the number of input and output pins it contains, and how many
are registered or unconnected. This report is useful when optimizing your design
partitions, ensuring that the partitions meet the guidelines presented in the

Best Practices for Incremental Compilation Partitions and Floorplan Assignments chapter in
volume 1 of the Quartus II Handbook.
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You can also view post-compilation statistics about the resource usage and port
connections for a particular partition on the Statistics tab in the Design Partition
Properties dialog box.

Partition Timing Reports

You can generate a Partition Timing Overview report and a Partition Timing Details
report by clicking Report Partitions in the Tasks pane in the TimeQuest Timing
Analyzer, or using the report partitions Tcl command.

The Partition Timing Overview report shows the total number of failing paths for
each partition and the worst-case slack for any path involving the partition.

The Partition Timing Details report shows the number of failing partition-to-partition
paths and worst-case slack for partition-to-partition paths, to provide a more detailed
breakdown of where the critical paths in the design are located with respect to design
partitions.

Incremental Compilation Advisor

You can use the Incremental Compilation Advisor to check that your design follows
Altera’s recommendations for creating design partitions and floorplan location
assignments.

Recommendations are split into General Recommendations, Timing
Recommendations, and Team-Based Design Recommendations that apply to design
flows in which partitions are compiled independently in separate Quartus II projects
before being integrated into the top-level design. Each recommendation provides an
explanation, describes the effect of the recommendation, and provides the action
required to make a suggested change. In some cases, there is a link to the appropriate
Quartus II settings page where you can make a suggested change to assignments or
settings. For some items, if your design does not follow the recommendation, the
Check Recommendations operation creates a table that lists any nodes or paths in
your design that could be improved. The relevant timing-independent
recommendations for the design are also listed in the Design Partitions window and
the LogicLock Regions window.

To verify that your design follows the recommendations, go to the Timing
Independent Recommendations page or the Timing Dependent Recommendations
page, and then click Check Recommendations. For large designs, these operations
can take a few minutes.

After you perform a check operation, symbols appear next to each recommendation to
indicate whether the design or project setting follows the recommendations, or if
some or all of the design or project settings do not follow the recommendations.
Following these recommendations is not mandatory to use the incremental
compilation feature. The recommendations are most important to ensure good results
for timing-critical partitions.

For some items in the Advisor, if your design does not follow the recommendation,
the Check Recommendations operation lists any parts of the design that could be
improved. For example, if not all of the partition I/O ports follow the Register All
Non-Global Ports recommendation, the advisor displays a list of unregistered ports
with the partition name and the node name associated with the port.
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When the advisor provides a list of nodes, you can right-click a node, and then click
Locate to cross-probe to other Quartus II features, such as the RTL Viewer, Chip
Planner, or the design source code in the text editor.

Opening a new TimeQuest report resets the Incremental Compilation Advisor results,
so you must rerun the Check Recommendations process.

Specifying the Level of Results Preservation for Subsequent
Compilations

As introduced in “Incremental Compilation Summary” on page 3-7 and “Common
Design Scenarios Using Incremental Compilation” on page 3-10, the netlist type of
each design partition allows you to specify the level of results preservation. The
netlist type determines which type of netlist or source file the Partition Merge stage
uses in the next incremental compilation.

When you choose to preserve a post-fit compilation netlist, the default level of Fitter
preservation is the highest degree of placement and routing preservation supported
by the device family. The advanced Fitter Preservation Level setting allows you to
specify the amount of information that you want to preserve from the post-fit netlist
file.

Netlist Type for Design Partitions

Before starting a new compilation, ensure that the appropriate netlist type is set for
each partition to preserve the desired level of compilation results. Table 3-2 describes
the settings for the netlist type, explains the behavior of the Quartus II software for
each setting, and provides guidance on when to use each setting.

Table 3-2. Partition Netlist Type Settings (Part 1 of 2)

Netlist Type

Quartus Il Software Behavior for Partition During Compilation

Source File

Always compiles the partition using the associated design source file(s). (7
Use this netlist type to recompile a partition from the source code using new synthesis or Fitter settings.

Post-
Synthesis

Preserves post-synthesis results for the partition and reuses the post-synthesis netlist when the
following conditions are true:

m A post-synthesis netlist is available from a previous synthesis.

m No change that initiates an automatic resynthesis has been made to the partition since the previous
synthesis. (@) For details, refer to “What Changes Initiate the Automatic Resynthesis of a Partition?” on
page 3-28.

Compiles the partition from the source files if resynthesis is initiated or if a post-synthesis netlist is not
available. (7)

Use this netlist type to preserve the synthesis results unless you make design changes, but allow the
Fitter to refit the partition using any new Fitter settings.
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Table 3-2. Partition Netlist Type Settings (Part 2 of 2)

Netlist Type Quartus Il Software Behavior for Partition During Compilation

Post-Fit Preserves post-fit results for the partition and reuses the post-fit netlist when the following conditions
are true:

m A post-fit netlist is available from a previous fitting.

m No change that initiates an automatic resynthesis has been made to the partition since the previous
fitting. (2) For details, refer to “What Changes Initiate the Automatic Resynthesis of a Partition?” on
page 3-28.

When a post-fit netlist is not available, the software reuses the post-synthesis netlist if it is available, or
otherwise compiles from the source files. Compiles the partition from the source files if resynthesis is
initiated. (7)

The Fitter Preservation Level specifies what level of information is preserved from the post-fit netlist. For
details, refer to “Fitter Preservation Level for Design Partitions” on page 3-26.

Assignment changes, such as Fitter optimization settings, do not cause a partition set to Post-Fit to
recompile.

Empty Uses an empty placeholder netlist for the partition. The partition's port interface information is required
during Analysis and Synthesis to connect the partition correctly to other logic and partitions in the
design, and peripheral nodes in the source file including pins and PLLs are preserved to help connect the
empty partition to the rest of the design and preserve timing of any lower-level non-empty partitions
within empty partitions. If the source file is not available, you can create a wrapper file that defines the
design block and specifies the input, output, and bidirectional ports. In Verilog HDL: a module
declaration, and in VHDL: an entity and architecture declaration.

You can use this netlist type to skip the compilation of a partition that is incomplete or missing from the
top-level design. You can also set an empty partition if you want to compile only some partitions in the
design, such as to optimize the placement of a timing-critical block such as an IP core before
incorporating other design logic, or if the compilation time is large for one partition and you want to
exclude it.

If the project database includes a previously generated post-synthesis or post-fit netlist for an unchanged
Empty partition, you can set the netlist type from Empty directly to Post-Synthesis or Post-Fit and the
software reuses the previous netlist information without recompiling from the source files.

Notes to Table 3-2:

(1) Ifyou use Rapid Recompile, the Quartus 11 software might not recompile the entire partition from the source code as described in this table; it
will reuse compatible results if there have been only small changes to the logic in the partition. Refer to “Incremental Capabilities Available When
A Design Has No Partitions” on page 3-2 for more information.

(2) Youcanturnonthe Ignore changes in source files and strictly use the specified netlist, if available option on the Advanced tab in the Design
Partitions Properties dialog box to specify whether the Compiler should ignore source file changes when deciding whether to recompile the
partition.

Fitter Preservation Level for Design Partitions

The default Fitter Preservation Level for partitions with a Post-Fit netlist type is the
highest level of preservation available for the target device family and provides the
most compilation time reduction.
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You can change the advanced Fitter Preservation Level setting to provide more
flexibility in the Fitter during placement and routing. You can set the Fitter
Preservation Level on the Advanced tab in the Design Partitions Properties dialog
box. Table 3-3 describes the Fitter Preservation Level settings.

Table 3-3. Fitter Preservation Level Settings

Fitter Preservation
Level

Quartus Il Behavior for Partition During Compilation

Placement and
Routing

Preserves the design partition’s netlist atoms and their placement and routing.

This setting reduces compilation times compared to Placement only, but provides less flexibility to
the router to make changes if there are changes in other parts of the design.

By default, the Fitter preserves the usage of high-speed programmable power tiles contained
within the selected partition, for devices that support high-speed and low-power tiles. You can turn
off the Preserve high-speed tiles when preserving placement and routing option on the
Advanced tab in the Design Partitions Properties dialog box.

Placement

Preserves the netlist atoms and their placement in the design partition. Reroutes the design
partition and does not preserve high-speed power tile usage.

Netlist Only

Preserves the netlist atoms of the design partition, but replaces and reroutes the design partition.
A post-fit netlist with the atoms preserved can be different than the Post-Synthesis netlist because
it contains Fitter optimizations; for example, Physical Synthesis changes made during a previous

Fitting.

You can use this setting to:
m Preserve Fitter optimizations but allow the software to perform placement and routing again.

m Reapply certain Fitter optimizations that would otherwise be impossible when the placement is
locked down.

m Resolve resource conflicts between two imported partitions.

@

For more information about how to set the Netlist Type and Fitter Preservation Level
settings in the Quartus II software, refer to Setting the Netlist Type and Fitter
Preservation Level for Design Partitions in Quartus II Help.

Where Are the Netlist Databases Saved?

The incremental compilation database folder (\incremental_db) includes all the
netlist information from previous compilations. To avoid unnecessary recompilations,
these database files must not be altered or deleted.

If you archive or reproduce the project in another location, you can use a Quartus II
Archive File (.qar). Include the incremental compilation database files to preserve
post-synthesis or post-fit compilation results. For more information, refer to “Using
Incremental Compilation With Quartus II Archive Files” on page 3-52.

To manually create a project archive that preserves compilation results without
keeping the incremental compilation database, you can keep all source and settings
files, and create and save a Quartus II Settings File (.qxp) for each partition in the
design that will be integrated into the top-level design. For more information about
how to create a .qxp for a partition within your design, refer to “Exporting Design
Partitions from Separate Quartus II Projects” on page 3-30.
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Deleting Netlists

You can choose to abandon all levels of results preservation and remove all netlists
that exist for a particular partition with the Delete Netlists command in the Design
Partitions window. When you delete netlists for a partition, the partition is compiled
using the associated design source file(s) in the next compilation. Resetting the netlist
type for a partition to Source would have the same effect, though the netlists would
not be permanently deleted and would be available for use in subsequent
compilations. For an imported partition, the Delete Netlists command also optionally
allows you to remove the imported .qxp.

What Changes Initiate the Automatic Resynthesis of a Partition?

A partition is synthesized from its source files if there is no post-synthesis netlist
available from a previous synthesis, or if the netlist type is set to Source File.
Additionally, certain changes to a partition initiate an automatic resynthesis of the
partition when the netlist type is Post-Synthesis or Post-Fit. The software
resynthesizes the partition in these cases to ensure that the design description matches
the post-place-and-route programming files. If you do not want resynthesis to occur
automatically, refer to “Forcing Use of the Compilation Netlist When a Partition has
Changed” on page 3-30.

The following list explains the changes that initiate a partition’s automatic resynthesis
when the netlist type is set to Post-Synthesis or Post-Fit:

m The device family setting has changed.

®m  Any dependent source design file has changed. For more information, refer to
“Resynthesis Due to Source Code Changes” on page 3-29.

m The partition boundary was changed by an addition, removal, or change to the
port boundaries of a partition (for example, a new partition has been defined for a
lower-level instance within this partition).

B A dependent source file was compiled into a different library (so it has a different
-library argument).

m A dependent source file was added or removed; that is, the partition depends on a
different set of source files.

m The partition’s root instance has a different entity binding. In VHDL, an instance
may be bound to a specific entity and architecture. If the target entity or
architecture changes, it triggers resynthesis.

m  The partition has different parameters on its root hierarchy or on an internal
AHDL hierarchy (AHDL automatically inherits parameters from its parent
hierarchies). This occurs if you modified the parameters on the hierarchy directly,
or if you modified them indirectly by changing the parameters in a parent design
hierarchy.

® You have moved the project and compiled database between a Windows and
Linux system. Due to the differences in the way new line feeds are handled
between the operating systems, the internal checksum algorithm may detect a
design file change in this case.
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The software reuses the post-synthesis results but re-fits the design if you change the
device setting within the same device family. The software reuses the post-fitting
netlist if you change only the device speed grade.

Synthesis and Fitter assignments, such as optimization settings, timing assignments,
or Fitter location assignments including pin assignments, do not trigger automatic
recompilation in the incremental compilation flow. To recompile a partition with new
assignments, change the netlist type for that partition to one of the following;:

m Source File to recompile with all new settings

m Post-Synthesis to recompile using existing synthesis results but new Fitter
settings

m Post-Fit with the Fitter Preservation Level set to Placement to rerun routing using
existing placement results, but new routing settings (such as delay chain settings)

You can use the LogicLock Origin location assignment to change or fine-tune the
previous Fitter results from a Post-Fit netlist. For details about how you can affect
placement with LogicLock regions, refer to “Changing Partition Placement with
LogicLock Changes” on page 3-50.

Resynthesis Due to Source Code Changes

The Quartus II software uses an internal checksum algorithm to determine whether
the contents of a source file have changed. Source files are the design description files
used to create the design, and include Memory Initialization Files (.mif) as well as
.qxp from exported partitions. When design files in a partition have dependencies on
other files, changing one file may initiate an automatic recompilation of another file.
The Partition Dependent Files table in the Analysis and Synthesis report lists the
design files that contribute to each design partition. You can use this table to
determine which partitions are recompiled when a specific file is changed.

For example, if a design has file A.v that contains entity A, B.v that contains entity B,
and C.v that contains entity C, then the Partition Dependent Files table for the
partition containing entity A lists file A.v, the table for the partition containing entity
B lists file B.v, and the table for the partition containing entity C lists file C.v. Any
dependencies are transitive, so if file A.v depends on B.v, and B.v depends on C.v, the
entities in file A.v depend on files B.v and C.v. In this case, files B.v and C.v are listed
in the report table as dependent files for the partition containing entity A.

If you use Rapid Recompile, the Quartus II software might not recompile the entire
partition from the source code as described in this section; it will reuse compatible
results if there have been only small changes to the logic in the partition. Refer to
“Incremental Capabilities Available When A Design Has No Partitions” on page 3-2
for more information.

If you define module parameters in a higher-level module, the Quartus II software
checks the parameter values when determining which partitions require resynthesis.
If you change a parameter in a higher-level module that affects a lower-level module,
the lower-level module is resynthesized. Parameter dependencies are tracked
separately from source file dependencies; therefore, parameter definitions are not
listed in the Partition Dependent Files list.
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If a design contains common files, such as an includes.v file that is referenced in each
entity by the command ‘include includes.v, all partitions are dependent on this file.
A change to includes.v causes the entire design to be recompiled. The VHDL
statement use work.all also typically results in unnecessary recompilations, because
it makes all entities in the work library visible in the current entity, which results in
the current entity being dependent on all other entities in the design.

To avoid this type of problem, ensure that files common to all entities, such as a
common include file, contain only the set of information that is truly common to all
entities. Remove use work.all statements in your VHDL file or replace them by
including only the specific design units needed for each entity.

Forcing Use of the Compilation Netlist When a Partition has Changed

Forcing the use of a post-compilation netlist when the contents of a source file has
changed is recommended only for advanced users who understand when a partition
must be recompiled. You might use this assignment, for example, if you are making
source code changes but do not want to recompile the partition until you finish
debugging a different partition, or if you are adding simple comments to the source
file but you know the design logic itself is not being changed and you want to keep
the previous compilation results.

To force the Fitter to use a previously generated netlist even when there are changes to
the source files, right-click the partition in the Design Partitions window and then
click Design Partition Properties. On the Advanced tab, turn on the Ignore changes
in source files and strictly use the specified netlist, if available option.

Turning on this option can result in the generation of a functionally incorrect netlist
when source design files change, because source file updates will not be recompiled.
Use caution when setting this option.

Exporting Design Partitions from Separate Quartus Il Projects

Partitions that are developed by other designers or team members in the same
company or third-party IP providers can be exported as design partitions to a
Quartus II Exported Partition File (.qxp), and then integrated into a top-level design.
A .qxp is a binary file that contains compilation results describing the exported design
partition and includes a post-synthesis netlist, a post-fit netlist, or both, and a set of
assignments, sometimes including LogicLock placement constraints. The .qxp does
not contain the source design files from the original Quartus II project.

To enable team-based development and third-party IP delivery, you can design and
optimize partitions in separate copies of the top-level Quartus II project framework,
or even in isolation. If the designers have access to the top-level project framework
through a source control system, they can access project files as read-only and develop
their partition within the source control system. If designers do not have access to a
source control system, the project lead can provide the designer with a copy of the
top-level project framework to use as they develop their partitions. The project lead
also has the option to generate design partition scripts to manage resource and timing
budgets in the top-level design when partitions are developed outside the top-level
project framework.
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The exported compilation results of completed partitions are given to the project lead,
preferably using a source control system, who is then responsible for integrating them
into the top-level design to obtain a fully functional design. This type of design flow is
required only if partition designers want to optimize their placement and routing
independently, and pass their design to the project lead to reuse placement and
routing results. Otherwise, a project lead can integrate source HDL from several
designers in a single Quartus II project, and use the standard incremental compilation

flow described previously.

The diagram in Figure 3-7 illustrates the team-based incremental compilation design
flow using a methodology in which partitions are compiled in separate Quartus II
projects before being integrated into the top-level design. This flow can be used when
partitions are developed by other designers or IP providers.

Figure 3-7. Summary of Team-Based Incremental Compilation Flow

Prepare Top-Level Design for
Incremental Compilation

v

Provide Project Framework or
Constraints to Designers

v

Design, Compile, and
Optimize Partition(s)
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Export Lower-Level Partition(s)

v

Integrate Partition(s)
into Top-Level Design
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Perform Incremental Compilation
in Top-Level Design
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During Design, Veri
& Debugging Stage

(= You cannot export or import partitions that have been merged. For more information
about merged partitions, refer to “Deciding Which Design Blocks Should Be Design

Partitions” on page 3-19.

The topics in this section provide a description of the team-based design flow using
exported partitions, describe how to generate a .qxp for a design partition, and

explain how to integrate the .qxp into the top-level design:

There are some additional restrictions related to design flows using exported
partitions, described in “Incremental Compilation Restrictions” on page 3-51.

Preparing the Top-Level Design

To prepare your design to incorporate exported partitions, first create the top-level
project framework of the design to define the hierarchy for the subdesigns that will be
implemented by other team members, designers, or IP providers.
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In the top-level design, create project-wide settings, for example, device selection,
global assignments for clocks and device I/O ports, and any global signal constraints
to specify which signals can use global routing resources.

Next, create the appropriate design partition assignments and set the netlist type for
each design partition that will be developed in a separate Quartus II project to Empty.
Refer to “Empty Partitions” below for details. It may be necessary to constrain the
location of partitions with LogicLock region assignments if they are timing-critical
and are expected to change in future compilations, or if the designer or IP provider
wants to place and route their design partition independently, to avoid location
conflicts. For details, refer to “Creating a Design Floorplan With LogicLock Regions”
on page 3-48.

Finally, provide the top-level project framework to the partition designers, preferably
through a source control system. Refer to “Project Management—Making the Top-
Level Design Available to Other Designers” on page 3-32 for more information.

Empty Partitions

You can use a design flow in which some partitions are set to an Empty netlist type to
develop pieces of the design separately, and then integrate them into the top-level
design at a later time. In a team-based design environment, you can set the netlist type
to Empty for partitions in your design that will be developed by other designers or IP
providers. The Empty setting directs the Compiler to skip the compilation of a
partition and use an empty placeholder netlist for the partition.

When a netlist type is set to Empty, peripheral nodes including pins and PLLs are
preserved and all other logic is removed. The peripheral nodes including pins help
connect the empty partition to the design, and the PLLs help preserve timing of
non-empty partitions within empty partitions.

When you set a design partition to Empty, a design file is required during Analysis
and Synthesis to specify the port interface information so that it can connect the
partition correctly to other logic and partitions in the design. If a partition is exported
from another project, the .qxp contains this information. If there is no .qxp or design
file to represent the design entity, you must create a wrapper file that defines the
design block and specifies the input, output, and bidirectional ports. For example, in
Verilog HDL, you should include a module declaration, and in VHDL, you should
include an entity and architecture declaration.

Project Management—Making the Top-Level Design Available to Other
Designers

In team-based incremental compilation flows, whenever possible, all designers or IP
providers should work within the same top-level project framework. Using the same
project framework among team members ensures that designers have the settings and
constraints needed for their partition, and makes timing closure easier when
integrating the partitions into the top-level design. If other designers do not have
access to the top-level project framework, the Quartus II software provides tools for
passing project information to partition designers.
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Distributing the Top-Level Quartus Il Project

There are several methods that the project lead can use to distribute the “skeleton” or
top-level project framework to other partition designers or IP providers.

m If partition designers have access to the top-level project framework, the project
will already include all the settings and constraints needed for the design. This
framework should include PLLs and other interface logic if this information is
important to optimize partitions.

m If designers are part of the same design environment, they can check out the
required project files from the same source control system. This is the
recommended way to share a set of project files.

m  Otherwise, the project lead can provide a copy of the top-level project
framework so that each design develops their partition within the same project
framework.

m If a partition designer does not have access to the top-level project framework, the
project lead can give the partition designer a Tcl script or other documentation to
create the separate Quartus II project and all the assignments from the top-level
design.

For details about project management scripts you can create with the Quartus II
software, refer to”Optimizing the Placement for a Timing-Critical Partition” on
page 3-60.

If the partition designers provide the project lead with a post-synthesis .qxp and
fitting is performed in the top-level design, integrating the design partitions should be
quite easy. If you plan to develop a partition in a separate Quartus II project and
integrate the optimized post-fitting results into the top-level design, use the following
guidelines to improve the integration process:

m  Ensure that a LogicLock region constrains the partition placement and uses only
the resources allocated by the project lead.

m Ensure that you know which clocks should be allocated to global routing resources
so that there are no resource conflicts in the top-level design.

m Set the Global Signal assignment to On for the high fan-out signals that should
be routed on global routing lines.

m To avoid other signals being placed on global routing lines, turn off Auto
Global Clock and Auto Global Register Controls under More Settings on the
Fitter page in the Settings dialog box. Alternatively, you can set the Global
Signal assignment to Off for signals that should not be placed on global
routing lines.

Placement for LABs depends on whether the inputs to the logic cells within the
LAB use a global clock. You may encounter problems if signals do not use
global lines in the partition, but use global routing in the top-level design.

m Use the Virtual Pin assignment to indicate pins of a partition that do not drive pins
in the top-level design. This is critical when a partition has more output ports than
the number of pins available in the target device. Using virtual pins also helps
optimize cross-partition paths for a complete design by enabling you to provide
more information about the partition ports, such as location and timing
assignments.
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m  When partitions are compiled independently without any information about each
other, you might need to provide more information about the timing paths that
may be affected by other partitions in the top-level design. You can apply location
assignments for each pin to indicate the port location after incorporation in the
top-level design. You can also apply timing assignments to the I/O ports of the
partition to perform timing budgeting.

For more information about resource balancing and timing allocation between
partitions, refer to the Best Practices for Incremental Compilation Partitions and Floorplan
Assignments chapter in volume 1 of the Quartus II Handbook.

Generating Design Partition Scripts

If IP providers or designers on a team want to optimize their design blocks
independently and do not have access to a shared project framework, the project lead
must perform some or all of the following tasks to ensure successful integration of the
design blocks:

B Determine which assignments should be propagated from the top-level design to
the partitions. This requires detailed knowledge of which assignments are
required to set up low-level designs.

m Communicate the top-level assignments to the partitions. This requires detailed
knowledge of Tcl or other scripting languages to efficiently communicate project
constraints.

m Determine appropriate timing and location assignments that help overcome the
limitations of team-based design. This requires examination of the logic in the
partitions to determine appropriate timing constraints.

m Perform final timing closure and resource conflict avoidance in the top-level
design. Because the partitions have no information about each other, meeting
constraints at the lower levels does not guarantee they are met when integrated at
the top-level. It then becomes the project lead’s responsibility to resolve the issues,
even though information about the partition implementation may not be available.

Design partition scripts automate the process of transferring the top-level project
framework to partition designers in a flow where each design block is developed in
separate Quartus II projects before being integrated into the top-level design. If the
project lead cannot provide each designer with a copy of the top-level project
framework, the Quartus Il software provides an interface for managing resources and
timing budgets in the top-level design. Design partition scripts make it easier for
partition designers to implement the instructions from the project lead, and avoid
conflicts between projects when integrating the partitions into the top-level design.
This flow also helps to reduce the need to further optimize the designs after
integration.

You can use options in the Generate Design Partition Scripts dialog box to choose
which types of assignments you want to pass down and create in the partitions being
developed in separate Quartus II projects.

For an example design scenario using design partition scripts, refer to “Enabling
Designers on a Team to Optimize Independently” on page 3—43.
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@

For step-by-step information on how to generate design partition scripts, and a
description of each option that can be included in design partition scripts, refer to
Generating Design Partition Scripts for Project Management, and Generate Design Partition
Scripts Dialog Box in Quartus II Help.

Exporting Partitions

@

When partition designers achieve the design requirements in their separate Quartus II
projects, each designer can export their design as a partition so it can be integrated
into the top-level design by the project lead. The Export Design Partition dialog box,
available from the Project menu, allows designers to export a design partition to a
Quartus II Exported Partition File (.qxp) with a post-synthesis netlist, a post-fit netlist,
or both. The project lead then adds the .qxp to the top-level design to integrate the
partition.

A designer developing a timing-critical partition or who wants to optimize their
partition on their own would opt to export their completed partition with a post-fit
netlist, allowing for the partition to more reliably meet timing requirements after
integration. In this case, you must ensure that resources are allocated appropriately to
avoid conflicts. If the placement and routing optimization can be performed in the
top-level design, exporting a post-synthesis netlist allows the most flexibility in the
top-level design and avoids potential placement or routing conflicts with other
partitions.

When designing the partition logic to be exported into another project, you can add
logic around the design block to be exported as a design partition. You can instantiate
additional design components for the Quartus II project so that it matches the
top-level design environment, especially in cases where you do not have access to the
full top-level design project. For example, you can include a top-level PLL in the
project, outside of the partition to be exported, so that you can optimize the design
with information about the frequency multipliers, phase shifts, compensation delays,
and any other PLL parameters. The software then captures timing and resource
requirements more accurately while ensuring that the timing analysis in the partition
is complete and accurate. You can export the partition for the top-level design without
any auxiliary components that are instantiated outside the partition being exported.

If your design team uses makefiles and design partition scripts, the project lead can
use the make command with the master_makefile command created by the scripts to
export the partitions and create .qxp files. When a partition has been compiled and is
ready to be integrated into the top-level design, you can export the partition with
option on the Export Design Partition dialog box, available from the Project menu.

For more information about how to export a design partition, refer to Using a Team-
Based Incremental Compilation Design Flow in the Quartus II Help.

Viewing the Contents of a Quartus Il Exported Partition File (.qxp)

The QXP report allows you to view a summary of the contents in a .qxp when you
open the file in the Quartus II software. The .qxp is a binary file that contains
compilation results so the file cannot be read in a text editor. The QXP report opens in
the main Quartus Il window and contains summary information including a list of
the I/O ports, resource usage summary, and a list of the assignments used for the
exported partition.
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Integrating Partitions into the Top-Level Design

To integrate a partition developed in a separate Quartus II project into the top-level
design, you can simply add the .qxp as a source file in your top-level design (just like
a Verilog or VHDL source file). You can also use the Import Design Partition dialog
box to import the partition, in certain situations, described in “Advanced Importing
Options” on page 3-37.

The .qxp contains the design block exported from the partition and has the same
name as the partition. When you instantiate the design block into a top-level design
and include the .qxp as a source file, the software adds the exported netlist to the
database for the top-level design. The .qxp port names are case sensitive if the original
HDL of the partition was case sensitive.

When you use a .qxp as a source file in this way, you can choose whether you want
the .qxp to be a partition in the top-level design. If you do not designate the .qxp
instance as a partition, the software reuses just the post-synthesis compilation results
from the .qxp, removes unconnected ports and unused logic just like a regular source
file, and then performs placement and routing.

If you assigned the .qxp instance as a partition, you can set the netlist type in the
Design Partitions Window to choose the level of results to preserve from the .qxp. To
preserve the placement and routing results from the exported partition, set the netlist
type to Post-Fit for the .qxp partition in the top-level design. If you assign the instance
as a design partition, the partition boundary is preserved, as discussed in “Impact of
Design Partitions on Design Optimization” on page 3-20.

Integrating Assignments from the .qxp

The Quartus II software filters assignments from .qxp files to include appropriate
assignments in the top-level design. The assignments in the .qxp are treated like
assignments made in an HDL source file, and are not listed in the Quartus II Settings
File (.qsf) for the top-level design. Most assignments from the .qxp can be overridden
by assignments in the top-level design.

The following subsections provide more details about specific assignment types:

Design Partition Assignments Within the Exported Partition

Design partition assignments defined within a separate Quartus II project are not
added to the top-level design. All logic under the exported partition in the project
hierarchy is treated as single instance in the .qxp.

Synopsys Design Gonstraint Files for the Quartus Il TimeQuest Timing Analyzer

Timing assignments made for the Quartus II TimeQuest analyzer in a Synopsys
Design Constraint File (.sdc) in the lower-level partition project are not added to the
top-level design. Ensure that the top-level design includes all of the timing
requirements for the entire project.

“ e For recommendations about managing SDC constraints for the top-level design and
independent lower-level partition projects, refer to the Best Practices for Incremental
Compilation Partitions and Floorplan Assignments chapter in volume 1 of the Quartus 11
Handbook.
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Global Assignments

The project lead should make all global project-wide assignments in the top-level
design. Global assignments from the exported partition's project are not added to the
top-level design. When it is possible for a particular constraint, the global assignment
is converted to an instance-specific assignment for the exported design partition.

LogicLock Region Assignments

The project lead typically creates LogicLock region assignments in the top-level
design for any lower-level partition designs where designer or IP providers plan to
export post-fit information to be used in the top-level design, to help avoid placement
conflicts between partitions. When you use the .qxp as a source file, LogicLock
constraints from the exported partition are applied in the top-level design, but will
not appear in your .gsf file or LogicLock Regions window for you to view or edit. The
LogicLock region itself is not required to constrain the partition placement in the
top-level design if the netlist type is set to Post-Fit, because the netlist contains all the
placement information. For information on how to control LogicLock region
assignments for exported partitions, refer to the “Advanced Importing Options” on
page 3-37.

Integrating Encrypted IP Cores from .qxp Files

Proper license information is required to compile encrypted IP cores. If an IP core is
exported as a .qxp from another Quartus II project, the top-level designer
instantiating the .qxp must have the correct license. The software requires a full
license to generate an unrestricted programming file. If you do not have a license, but
the IP in the .qxp was compiled with OpenCore Plus hardware evaluation support,
you can generate an evaluation programming file without a license. If the IP supports
OpenCore simulation only, you can fully compile the design and generate a
simulation netlist, but you cannot create programming files unless you have a full
license.

Advanced Importing Options

You can use advanced options in the Import Design Partition dialog box to integrate
a partition developed in a separate Quartus II project into the top-level design. The
import process adds more control than using the .qxp as a source file, and is useful
only in the following circumstances:

m If you want LogicLock regions in your top-level design (.qsf)—If you have
regions in your partitions that are not also in the top-level design, the regions will
be added to your .qsf during the import process.

m If you want different settings or placement for different instantiations of the
same entity—You can control the setting import process with the advanced import
options, and specify different settings for different instances of the same .qxp
design block.

When you use the Import Design Partition dialog box to integrate a partition into the
top-level design, the import process sets the partition’s netlist type to Imported in the
Design Partitions window.
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After you compile the entire design, if you make changes to the place-and-route
results (such as movement of an imported LogicLock region), use the Post-Fit netlist
type on subsequent compilations. To discard an imported netlist and recompile from
source code, you can compile the partition with the netlist type set to Source File and
be sure to include the relevant source code in the top-level design. Refer to “Netlist
Type for Design Partitions” on page 3-25 for details. The import process sets the
partition’s Fitter Preservation Level to the setting with the highest degree of
preservation supported by the imported netlist. For example, if a post-fit netlist is
imported with placement information, the Fitter Preservation Level is set to
Placement, but you can change it to the Netlist Only value. For more information
about preserving previous compilation results, refer to “Netlist Type for Design
Partitions” on page 3-25 and “Fitter Preservation Level for Design Partitions” on
page 3-26.

When you import a partition from a .qxp, the .qxp itself is not part of the top-level
design because the netlists from the file have been imported into the project database.
Therefore if a new version of a .qxp is exported, the top-level designer must perform
another import of the .qxp.

When you import a partition into a top-level design with the Import Design Partition
dialog box, the software imports relevant assignments from the partition into the
top-level design, as described for the source file integration flow in “Integrating
Assignments from the .qxp” on page 3-36. If required, you can change the way some
assignments are imported, as described in the following subsections.

Importing LogicLock Assignments

LogicLock regions are set to a fixed size when imported. If you instantiate multiple
instances of a subdesign in the top-level design, the imported LogicLock regions are
set to a Floating location. Otherwise, they are set to a Fixed location. You can change
the location of LogicLock regions after they are imported, or change them to a
Floating location to allow the software to place each region but keep the relative
locations of nodes within the region wherever possible. For details, refer to “Changing
Partition Placement with LogicLock Changes” on page 3-50. To preserve changes
made to a partition after compilation, use the Post-Fit netlist type.

The LogicLock Member State assignment is set to Locked to signify that it is a
preserved region.

LogicLock back-annotation and node location data is not imported because the .qxp
contains all of the relevant placement information. Altera strongly recommends that
you do not add to or delete members from an imported LogicLock region.

Advanced Import Settings

The Advanced Import Settings dialog box allows you to disable assignment import
and specify additional options that control how assignments and regions are
integrated when importing a partition into a top-level design, including how to
resolve assignment conflicts.

For descriptions of the advanced import options available, refer to Advanced Import
Settings Dialog Box in Quartus II Help.
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Team-Based Design Optimization and Third-Party IP Delivery Scenarios

This section includes the following design flows with step-by-step descriptions when
you have partitions being developed in separate Quartus II projects, or by a
third-party IP provider.

m “Using an Exported Partition to Send to a Design Without Including Source Files”
on page 3-39

m “Creating Precompiled Design Blocks (or Hard-Wired Macros) for Reuse” on
page 3—40

m “Designing in a Team-Based Environment” on page 342
m “Enabling Designers on a Team to Optimize Independently” on page 3—43

m “Performing Design Iterations With Lower-Level Partitions” on page 3—47

Using an Exported Partition to Send to a Design Without Including Source

Files

Scenario background: A designer wants to produce a design block and needs to send

out their design, but to preserve their IP, they prefer to send a synthesized netlist

instead of providing the HDL source code to the recipient. You can use this flow to
implement a black box.

Use this flow to package a full design as a single source file to send to an end

customer or another design location.

As the sender in this scenario perform the following steps to export a design block:

1. Provide the device family name to the recipient. If you send placement
information with the synthesized netlist, also provide the exact device selection so
they can set up their project to match.

2. Create a black box wrapper file that defines the port interface for the design block
and provide it to the recipient for instantiating the block as an empty partition in
the top-level design.

3. Create a Quartus II project for the design block, and complete the design.

4. Export the level of hierarchy into a single .qxp. Following a successful compilation
of the project, you can generate a .qxp from the GUI, the command-line, or with
Tcl commands, as described in the following;:

m If you are using the Quartus II GUI, use the Export Design Partition dialog
box.

m If you are using command-line executables, run quartus_cdb with the
--incremental compilation export option.

m If you are using Tcl commands, use the following command:
execute_flow -incremental compilation export.

5. Select the option to include just the Post-synthesis netlist if you do not have to
send placement information. If the recipient wants to reproduce your exact Fitter
results, you can select the Post-fitting netlist option, and optionally enable Export
routing.
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6. If a partition contains sub-partitions, then the sub-partitions are automatically
flattened and merged into the partition netlist before exporting. You can change
this behavior and preserve the sub-partition hierarchy by turning off the Flatten
sub-partitions option on the Export Design Partition dialog box. Optionally, you
can use the -dont_flatten sub-option for the export_partition Tcl command.

7. Provide the .qxp to the recipient. Note that you do not have to send any of your
design source code.

As the recipient in this example, first create a Quartus II project for your top-level
design and ensure that your project targets the same device (or at least the same
device family if the .qxp does not include placement information), as specified by the
IP designer sending the design block. Instantiate the design block using the port
information provided, and then incorporate the design block into a top-level design.

Add the .qxp from the IP designer as a source file in your Quartus II project to replace
any empty wrapper file. If you want to use just the post-synthesis information, you
can choose whether you want the file to be a partition in the top-level design. To use
the post-fit information from the .qxp, assign the instance as a design partition and set
the netlist type to Post-Fit. Refer to “Creating Design Partitions” on page 3-9 and
“Netlist Type for Design Partitions” on page 3-25.

Creating Precompiled Design Blocks (or Hard-Wired Macros) for Reuse

Scenario background: An IP provider wants to produce and sell an IP core for a
component to be used in higher-level systems. The IP provider wants to optimize the
placement of their block for maximum performance in a specific Altera device and
then deliver the placement information to their end customer. To preserve their IP,
they also prefer to send a compiled netlist instead of providing the HDL source code
to their customer.

Use this design flow to create a precompiled IP block (sometimes known as a
hard-wired macro) that can be instantiated in a top-level design. This flow provides
the ability to export a design block with post-synthesis or placement (and, optionally,
routing) information and to import any number of copies of this pre-compiled block
into another design.

The customer first specifies which Altera device is being used for this project and
provides the design specifications.

As the IP provider in this example, perform the following steps to export a preplaced
IP core (or hard macro):

1. Create a black box wrapper file that defines the port interface for the IP core and
provide the file to the customer to instantiate as an empty partition in the top-level
design.

2. Create a Quartus II project for the IP core.

3. Create a LogicLock region for the design hierarchy to be exported.

=" Using a LogicLock region for the IP core allows the customer to create an
empty placeholder region to reserve space for the IP in the design floorplan
and ensures that there are no conflicts with the top-level design logic.
Reserved space also helps ensure the IP core does not affect the timing
performance of other logic in the top-level design. Additionally, with a
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LogicLock region, you can preserve placement either absolutely or relative
to the origin of the associated region. This is important when a .qxp is
imported for multiple partition hierarchies in the same project, because in
this case, the location of at least one instance in the top-level design does
not match the location used by the IP provider.

If required, add any logic (such as PLLs or other logic defined in the customer’s
top-level design) around the design hierarchy to be exported. If you do so, create a
design partition for the design hierarchy that will exported as an IP core.

Optimize the design and close timing to meet the design specifications.
Export the level of hierarchy for the IP core into a single .qxp.

Provide the .qxp to the customer. Note that you do not have to send any of your
design source code to the customer; the design netlist and placement and routing
information is contained within the .qxp.

As the customer in this example, incorporate the IP core in your design by performing
the following steps:

1.

Create a Quartus II project for the top-level design that targets the same device
and instantiate a copy or multiple copies of the IP core. Use a black box wrapper
file to define the port interface of the IP core.

Perform Analysis and Elaboration to identify the design hierarchy.

Create a design partition for each instance of the IP core (refer to “Creating Design
Partitions” on page 3-57) with the netlist type set to Empty (refer to “Netlist Type
for Design Partitions” on page 3-25).

You can now continue work on your part of the design and accept the IP core from
the IP provider when it is ready.

Include the .qxp from the IP provider in your project to replace the empty
wrapper-file for the IP instance. Or, if you are importing multiple copies of the
design block and want to import relative placement, follow these additional steps:

a. Use the Import command to select each appropriate partition hierarchy. You
can import a .qxp from the GUI, the command-line, or with Tcl commands:

m If you are using the Quartus II GUI, use the Import Design Partition
command.

m If you are using command-line executables, run quartus_cdb with the
--incremental compilation import option.

m If you are using Tcl commands, use the following command:
execute flow -incremental compilation import.

b. When you have multiple instances of the IP block, you can set the imported
LogicLock regions to floating, or move them to a new location, and the
software preserves the relative placement for each of the imported modules
(relative to the origin of the LogicLock region). Routing information is
preserved whenever possible. Refer to “Changing Partition Placement with
LogicLock Changes” on page 3-50
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L= The Fitter ignores relative placement assignments if the LogicLock region’s
location in the top-level design is not compatible with the locations
exported in the .qxp.

6. You can control the level of results preservation with the Netlist Type setting.
Refer to “Netlist Type for Design Partitions” on page 3-25.

L=~ If the IP provider did not define a LogicLock region in the exported partition, the
software preserves absolute placement locations and this leads to placement conflicts
if the partition is imported for more than one instance.

Designing in a Team-Based Environment

Scenario background: A project includes several lower-level design blocks that are
developed separately by different designers and instantiated exactly once in the
top-level design.

This scenario describes how to use incremental compilation in a team-based design
environment where each designer has access to the top-level project framework, but
wants to optimize their design in a separate Quartus II project before integrating their
design block into the top-level design.

As the project lead in this scenario, perform the following steps to prepare the
top-level design:

1. Create a new Quartus II project to ultimately contain the full implementation of
the entire design and include a "skeleton" or framework of the design that defines
the hierarchy for the subdesigns implemented by separate designers. The top-level
design implements the top-level entity in the design and instantiates wrapper files
that represent each subdesign by defining only the port interfaces but not the
implementation.

2. Make project-wide settings. Select the device, make global assignments such as
device I/0 ports, define the top-level timing constraints, and make any global
signal allocation constraints to specify which signals can use global routing
resources.

3. Make design partition assignments for each subdesign and set the netlist type for
each design partition to be imported to Empty in the Design Partitions window.

4. Create LogicLock regions to create a design floorplan for each of the partitions that
will be developed separately. This floorplan should consider the connectivity
between partitions and estimates of the size of each partition based on any initial
implementation numbers and knowledge of the design specifications.
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5. Provide the top-level project framework to partition designers using one of the
following procedures:

m  Allow access to the full project for all designers through a source control
system. Each designer can check out the projects files as read-only and work on
their blocks independently. This design flow provides each designer with the
most information about the full design, which helps avoid resource conflicts
and makes design integration easy.

m Provide a copy of the top-level Quartus II project framework for each designer.
You can use the Copy Project command on the Project menu or create a project
archive.

As the designer of a lower-level design block in this scenario, design and optimize
your partition in your copy of the top-level design, and then follow these steps when
you have achieved the desired compilation results:

1. On the Project menu, click Export Design Partition.

2. In the Export Design Partition dialog box, choose the netlist(s) to export. You can
export a Post-synthesis netlist if placement or performance preservation is not
required, to provide the most flexibility for the Fitter in the top-level design. Select
Post-fit netlist to preserve the placement and performance of the lower-level
design block, and turn on Export routing to include the routing information, if
required. One .qxp can include both post-synthesis and post-fitting netlists.

3. Provide the .qxp to the project lead.

Finally, as the project lead in this scenario, perform these steps to integrate the .qxp
files received from designers of each partition:

1. Add the .qxp as a source file in the Quartus II project, to replace any empty
wrapper file for the previously Empty partition.

2. Change the netlist type for the partition from Empty to the required level of results
preservation.

Enabling Designers on a Team to Optimize Independently

Scenario background: A project consists of several lower-level design blocks that are
developed separately by different designers who do not have access to a shared
top-level project framework. This scenario is similar to “Creating Precompiled Design
Blocks (or Hard-Wired Macros) for Reuse” on page 3-40, but assumes that there are
several design blocks being developed independently (instead of just one IP block),
and the project lead can provide some information about the design to the individual
designers. If the designers have shared access to the top-level design, use the previous
scenario “Designing in a Team-Based Environment” on page 3—42.

This scenario describes how to use incremental compilation in a team-based design
environment where designers or IP developers want to fully optimize the placement
and routing of their design independently in a separate Quartus II project before
sending the design to the project lead. This design flow requires more planning and
careful resource allocation because design blocks are developed independently.

As the project lead in this scenario, perform the following steps to prepare the
top-level design:
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1. Create a new Quartus II project to ultimately contain the full implementation of
the entire design and include a “skeleton” or framework of the design that defines
the hierarchy for the subdesigns implemented by separate designers. The top-level
design implements the top-level entity in the design and instantiates wrapper files
that represent each subdesign by defining only the port interfaces but not the
implementation.

2. Make project-wide settings. Select the device, make global assignments such as
device I/0 ports, define the top-level timing constraints, and make any global
signal constraints to specify which signals can use global routing resources.

3. Make design partition assignments for each subdesign and set the netlist type for
each design partition to be imported to Empty in the Design Partitions window.

4. Create LogicLock regions. This floorplan should consider the connectivity
between partitions and estimates of the size of each partition based on any initial
implementation numbers and knowledge of the design specifications.

5. Provide the constraints from the top-level design to partition designers using one
of the following procedures:.

m  Use design partition scripts to pass constraints and generate separate
Quartus II projects. On the Project menu, use the Generate Design Partition
Scripts command, or run the script generator from a Tcl or command prompt.
Make changes to the default script options as required for your project. Altera
recommends that you pass all the default constraints, including LogicLock
regions, for all partitions and virtual pin location assignments. If partitions
have not already been created by the other designers, use the partition script to
set up the projects so that you can easily take advantage of makefiles. Provide
each partition designer with the Tcl file to create their project with the
appropriate constraints. If you are using makefiles, provide the makefile for
each partition.

m  Use documentation or manually-created scripts to pass all constraints and
assignments to each partition designer.

As the designer of a lower-level design block in this scenario, perform the appropriate
set of steps to successfully export your design, whether the design team is using
makefiles or exporting and importing the design manually.

If you are using makefiles with the design partition scripts, perform the following
steps:

1. Use the make command and the makefile provided by the project lead to create a
Quartus II project with all design constraints, and compile the project.

2. The information about which source file should be associated with which partition
is not available to the software automatically, so you must specify this information
in the makefile. You must specify the dependencies before the software rebuilds
the project after the initial call to the makefile.

3. When you have achieved the desired compilation results and the design is ready
to be imported into the top-level design, the project lead can use the
master makefile command to export this partition and create a .qxp, and then
import it into the top-level design.

If you are not using makefiles, perform the following steps:
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6.

If you are using design partition scripts, source the Tcl script provided by the
Project Lead to create a project with the required settings:

m  To source the Tcl script in the Quartus II software, on the Tools menu, click
Utility Windows to open the Tcl console. Navigate to the script’s directory, and
type the following command: source <filename> ¢

m  To source the Tcl script at the system command prompt, type the following
command: quartus_cdb -t <filename>.tcl +

If you are not using design partition scripts, create a new Quartus II project for the
subdesign, and then apply the following settings and constraints to ensure
successful integration:

m  Make LogicLock region assignments and global assignments (including clock
settings) as specified by the project lead.

m  Make Virtual Pin assignments for ports which represent connections to core
logic instead of external device pins in the top-level design.

m  Make floorplan location assignments to the Virtual Pins so they are placed in
their corresponding regions as determined by the top-level design. This
provides the Fitter with more information about the timing constraints
between modules. Alternatively, you can apply timing I/O constraints to the
paths that connect to virtual pins.

Proceed to compile and optimize the design as needed.

When you have achieved the desired compilation results, on the Project menu,
click Export Design Partition.

In the Export Design Partition dialog box, choose the netlist(s) to export. You can
export a Post-synthesis netlist instead if placement or performance preservation is
not required, to provide the most flexibility for the Fitter in the top-level design.
Select Post-fit to preserve the placement and performance of the lower-level
design block, and turn on Export routing to include the routing information, if
required. One .qxp can include both post-synthesis and post-fitting netlists.

Provide the .qxp to the project lead.

Finally, as the project lead in this scenario, perform the appropriate set of steps to
import the .qxp files received from designers of each partition.

If you are using makefiles with the design partition scripts, perform the following
steps:

1.

Use the master makefile command to export each partition and create .qxp files,
and then import them into the top-level design.

The software does not have all the information about which source files should be
associated with which partition, so you must specify this information in the
makefile. The software cannot rebuild the project if source files change unless you
specify the dependencies.

If you are not using makefiles, perform the following steps:

1. Add the .qxp as a source file in the Quartus II project, to replace any empty
wrapper file for the previously Empty partition.
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2. Change the netlist type for the partition from Empty to the required level of results
preservation.

Resolving Assignment Conflicts During Integration

When integrating lower-level design blocks, the project lead may notice some
assignment conflicts. This can occur, for example, if the lower-level design block
designers changed their LogicLock regions to account for additional logic or
placement constraints, or if the designers applied I/O port timing constraints that
differ from constraints added to the top-level design by the project lead. The project
lead can address these conflicts by explicitly importing the partitions into the
top-level design, and using options in the Advanced Import Settings dialog box, as
described in “Advanced Importing Options” on page 3-37. After the project lead
obtains the .qxp for each lower-level design block from the other designers, use the
Import Design Partition command on the Project menu and specify the partition in
the top-level design that is represented by the lower-level design block .qxp. Repeat
this import process for each partition in the design. After you have imported each
partition once, you can select all the design partitions and use the Reimport using
latest import files at previous locations option to import all the files from their
previous locations at one time. To address assignment conflicts, the project lead can
take one or both of the following actions:

m Allow new assignments to be imported
m  Allow existing assignments to be replaced or updated

When LogicLock region assignment conflicts occur, the project lead may take one of
the following actions:

m  Allow the imported region to replace the existing region
m  Allow the imported region to update the existing region
m Skip assignment import for regions with conflicts

If the placement of different lower-level design blocks conflict, the project lead can
also set the set the partition’s Fitter Preservation Level to Netlist Only, which allows
the software to re-perform placement and routing with the imported netlist.

Importing a Partition to be Instantiated Multiple Times

In this variation of the design scenario, one of the lower-level design blocks is
instantiated more than once in the top-level design. The designer of the lower-level
design block may want to compile and optimize the entity once under a partition, and
then import the results as multiple partitions in the top-level design.

If you import multiple instances of a lower-level design block into the top-level
design, the imported LogicLock regions are automatically set to Floating status.

If you resolve conflicts manually, you can use the import options and manual
LogicLock assignments to specify the placement of each instance in the top-level
design.
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Performing Design Iterations With Lower-Level Partitions

Scenario background: A project consists of several lower-level subdesigns that have
been exported from separate Quartus II projects and imported into the top-level
design. In this example, integration at the top level has failed because the timing
requirements are not met. The timing requirements might have been met in each
individual lower-level project, but critical inter-partition paths in the top-level design
are causing timing requirements to fail.

After trying various optimizations in the top-level design, the project lead determines
that the design cannot meet the timing requirements given the current partition
placements that were imported. The project lead decides to pass additional
information to the lower-level partitions to improve the placement.

Use this flow if you re-optimize partitions exported from separate Quartus II projects
by incorporating additional constraints from the integrated top-level design.

The best way to provide top-level design information to designers of lower-level
partitions is to provide the complete top-level project framework using the following
steps:

1. For all partitions other than the one(s) being optimized by a designer(s) in a
separate Quartus II project(s), set the netlist type to Post-Fit.

2. Make the top-level design directory available in a shared source control system, if
possible. Otherwise, copy the entire top-level design project directory (including
database files), or create a project archive including the post-compilation database.

3. Provide each partition designer with a checked-out version or copy of the
top-level design.

4. The partition designers recompile their designs within the new project framework
that includes the rest of the design's placement and routing information as well
top-level resource allocations and assignments, and optimize as needed.

5. When the results are satisfactory and the timing requirements are met, export the
updated partition as a .qxp.

If this design flow is not possible, you can generate partition-specific scripts for
individual designs to provide information about the top-level project framework with
these steps:

1. In the top-level design, on the Project menu, click Generate Design Partition
Scripts, or launch the script generator from Tcl or the command line.

2. If lower-level projects have already been created for each partition, you can turn
off the Create lower-level project if one does not exist option.

3. Make additional changes to the default script options, as necessary. Altera
recommends that you pass all the default constraints, including LogicLock
regions, for all partitions and virtual pin location assignments. Altera also
recommends that you add a maximum delay timing constraint for the virtual I/O
connections in each partition.
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4. The Quartus II software generates Tcl scripts for all partitions, but in this scenario,
you would focus on the partitions that make up the cross-partition critical paths.
The following assignments are important in the script:

m Virtual pin assignments for module pins not connected to device I/O ports in
the top-level design.

m Location constraints for the virtual pins that reflect the initial top-level
placement of the pin’s source or destination. These help make the lower-level
placement “aware” of its surroundings in the top-level design, leading to a
greater chance of timing closure during integration at the top level.

m INPUT MAX DELAY and OUTPUT MAX DELAY timing constraints on the paths to and
from the I/O pins of the partition. These constrain the pins to optimize the
timing paths to and from the pins.

5. The partition designers source the file provided by the project lead.

m  To source the Tcl script from the Quartus II GUI, on the Tools menu, click
Utility Windows and open the Tcl console. Navigate to the script’s directory,
and type the following command: source <filename> +

m  To source the Tcl script at the system command prompt, type the following
command: quartus_cdb -t <filename>.tcl +

6. The partition designers recompile their designs with the new project information
or assignments and optimize as needed. When the results are satisfactory and the
timing requirements are met, export the updated partition as a .qxp.

The project lead obtains the updated .qxp files from the partition designers and adds
them to the top-level design. When a new .qxp is added to the files list, the software
will detect the change in the “source file” and use the new .qxp results during the next
compilation. If the project uses the advanced import flow, the project lead must
perform another import of the new .qxp.

You can now analyze the design to determine whether the timing requirements have
been achieved. Because the partitions were compiled with more information about
connectivity at the top level, it is more likely that the inter-partition paths have
improved placement which helps to meet the timing requirements.

Creating a Design Floorplan With LogicLock Regions

A floorplan represents the layout of the physical resources on the device. Creating a
design floorplan, or floorplanning, describe the process of mapping the logical design
hierarchy onto physical regions in the device floorplan. After you have partitioned the
design, you can create floorplan location assignments for the design to improve the
quality of results when using the incremental compilation design flow. Creating a
design floorplan is not a requirement to use an incremental compilation flow, but it is
recommended in certain cases. Floorplan location planning can be important for a
design that uses incremental compilation for the following reasons:

m To avoid resource conflicts between partitions, predominantly when partitions are
imported from another Quartus II project

m To ensure a good quality of results when recompiling individual timing-critical
partitions
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Design floorplan assignments prevent the situation in which the Fitter must place a
partition in an area of the device where most resources are already used by other
partitions. A physical region assignment provides a reasonable region to re-place logic
after a change, so the Fitter does not have to scatter logic throughout the available
space in the device.

Floorplan assignments are not required for non-critical partitions compiled as part of
the top-level design. The logic for partitions that are not timing-critical (such as
simple top-level glue logic) can be placed anywhere in the device on each
recompilation, if that is best for your design.

The simplest way to create a floorplan for a partitioned design is to create one
LogicLock region per partition (including the top-level partition). If you have a
compilation result for a partitioned design with no LogicLock regions, you can use the
Chip Planner with the Design Partition Planner to view the partition placement in the
device floorplan. You can draw regions in the floorplan that match the general
location and size of the logic in each partition. Or, initially, you can set each region
with the default settings of Auto size and Floating location to allow the Quartus II
software to determine the preliminary size and location for the regions. Then, after
compilation, use the Fitter-determined size and origin location as a starting point for
your design floorplan. Check the quality of results obtained for your floorplan
location assignments and make changes to the regions as needed. Alternatively, you
can perform synthesis, and then set the regions to the required size based on resource
estimates. In this case, use your knowledge of the connections between partitions to
place the regions in the floorplan.

Once you have created an initial floorplan, you can refine the region using tools in the
Quartus II software. You can also use advanced techniques such as creating
non-rectangular regions by merging LogicLock regions.

“ e For more information about when creating a design floorplan can be important, as
well as guidelines for creating the floorplan, refer to the Best Practices for Incremental
Compilation Partitions and Floorplan Assignments chapter in volume 1 of the Quartus II
Handbook.

You can use the Incremental Compilation Advisor to check that your LogicLock
regions meet Altera’s guidelines, as described in “Incremental Compilation Advisor”
on page 3-24.

Creating and Manipulating LogicLock Regions

Options in the LogicLock Regions Properties dialog box, available from the
Assignments menu, allow you to enter specific sizing and location requirements for a
region. You can also view and refine the size and location of LogicLock regions in the
Quartus II Chip Planner. You can select a region in the graphical interface in the Chip
Planner and use handles to move or resize the region.

Options in the Layer Settings panel in the Chip Planner allow you to create, delete,
and modify tasks to determine which objects, including LogicLock regions and design
partitions, to display in the Chip Planner.
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(?) For more information about creating and viewing LogicLock regions in the LogicLock
Regions window and Chip Planner, refer to Creating and Manipulating LogicLock
Regions in Quartus II Help.

Changing Partition Placement with LogicLock Changes

When a partition is assigned to a LogicLock region as part of a design floorplan, you
can modify the placement of a post-fit partition by moving the LogicLock region. As
described in “What Changes Initiate the Automatic Resynthesis of a Partition?” on
page 3-28, most assignment changes do not initiate a recompilation of a partition if
the netlist type specifies that Fitter results should be preserved. For example,
changing a pin assignment does not initiate a recompilation; therefore, the design
does not use the new pin assignment unless you change the netlist type to
Post-Synthesis or Source File.

Similarly, if a partition’s placement is preserved, and the partition is assigned to a
LogicLock region, the Fitter always reuses the corresponding LogicLock region size
specified in the post-fit netlist. That is, changes to the LogicLock Size setting do not
initiate refitting if a partition’s placement is preserved with the Post-Fit netlist type, or
with .qxp that includes post-fit information.

However, you can use the LogicLock Origin location assignment to change or
fine-tune the previous Fitter results. When you change the Origin setting for a region,
the Fitter can move the region in the following manner, depending upon how the
placement is preserved for that region's members:

m  When you set a new region Origin, the Fitter uses the new origin and replaces the
logic, preserving the relative placement of the member logic.

m  When you set the region Origin to Floating, the following conditions apply:

m If the region’s member placement is preserved with an imported partition, the
Fitter chooses a new Origin and re-places the logic, preserving the relative
placement of the member logic within the region.

m If the region’s member placement is preserved with a Post-Fit netlist type, the
Fitter does not change the Origin location, and reuses the previous placement
results.

Taking Advantage of the Early Timing Estimator

When creating a floorplan you can take advantage of the Early Timing Estimator to
enable quick compilations of the design while creating assignments. The Early Timing
Estimator feature provides a timing estimate for a design without having to run a full
compilation. You can use the Chip Planner to view the “placement estimate” created
by this feature, identify critical paths by locating from the timing analyzer reports,
and, if necessary, add or modify floorplan constraints. You can then rerun the Early
Timing Estimator to quickly assess the impact of any floorplan location assignments
or logic changes, enabling rapid iterations on design variants to help you find the best
solution. This faster placement has an impact on the quality of results. If getting the
best quality of results is important in a given design iteration, perform a full
compilation with the Fitter instead of using the Early Timing Estimate feature.
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Incremental Compilation Restrictions

This section documents the following restrictions and limitations that you may
encounter when using incremental compilation, including interactions with other
Quartus II features:

m “When Timing Performance May Not Be Preserved Exactly” on page 3-51

m “When Placement and Routing May Not Be Preserved Exactly” on page 3-51
m “Using Incremental Compilation With Quartus II Archive Files” on page 3-52
|

“Formal Verification Support” on page 3-52

“SignalProbe Pins and Engineering Change Orders” on page 3-52

m “SignalTap II Logic Analyzer in Exported Partitions” on page 3-53

m “External Logic Analyzer Interface in Exported Partitions” on page 3-53

m “Assignments Made in HDL Source Code in Exported Partitions” on page 3-54
m “Design Partition Script Limitations” on page 3-54

m “Restrictions on Megafunction Partitions” on page 3-56

m “Register Packing and Partition Boundaries” on page 3-56

m “I/O Register Packing” on page 3-56

When Timing Performance May Not Be Preserved Exactly

Timing performance might change slightly in a partition with placement and routing
preserved when other partitions are incorporated or re-placed and routed. Timing
changes are due to changes in parasitic loading or crosstalk introduced by the other
(changed) partitions. These timing changes are very small, typically less than 30 ps on
a timing path. Additional fan-out on routing lines when partitions are added can also
degrade timing performance.

To ensure that a partition continues to meet its timing requirements when other
partitions change, a very small timing margin might be required. The Fitter
automatically works to achieve such margin when compiling any design, so you do
not need to take any action.

When Placement and Routing May Not Be Preserved Exactly

The Fitter may have to refit affected nodes if the two nodes are assigned to the same
location, due to imported netlists or empty partitions set to re-use a previous post-fit
netlist. There are two cases in which routing information cannot be preserved exactly.
First, when multiple partitions are imported, there might be routing conflicts because
two lower-level blocks could be using the same routing wire, even if the floorplan
assignments of the lower-level blocks do not overlap. These routing conflicts are
automatically resolved by the Quartus II Fitter re-routing on the affected nets. Second,
if an imported LogicLock region is moved in the top-level design, the relative
placement of the nodes is preserved but the routing cannot be preserved, because the
routing connectivity is not perfectly uniform throughout a device.
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Using Incremental Compilation With Quartus Il Archive Files

The post-synthesis and post-fitting netlist information for each design partition is
stored in the project database, the incremental_db directory. When you archive a
project, the database information is not included in the archive unless you include the
compilation database in the .qar file.

If you want to re-use post-synthesis or post-fitting results, include the database files in
the Archive Project dialog box so compilation results are preserved. Click Advanced,
and choose a file set that includes the compilation database, or turn on Incremental
compilation database files to create a Custom file set.

When you include the database, the file size of the .qar archive file may be
significantly larger than an archive without the database.

The netlist information for imported partitions is already saved in the corresponding
.qxp. Imported .qxp files are automatically saved in a subdirectory called
imported_partitions, so you do not need to archive the project database to keep the
results for imported partitions. When you restore a project archive, the partition is
automatically reimported from the .qxp in this directory if it is available.

For new device families with advanced support, a version-compatible database might
not be available. In this case, the archive will not include the compilation database. If
you require the database files to reproduce the compilation results in the same
Quartus I version, you can use the following command-line option to archive a full
database:

quartus _sh --archive -use file set full db [-revision <revision name>]
<project name>

Formal Verification Support

You cannot use design partitions for incremental compilation if you are creating a
netlist for a formal verification tool.

SignalProbe Pins and Engineering Change Orders

ECO and SignalProbe changes are performed only during ECO and SignalProbe
compilations. Other compilation flows do not preserve these netlist changes.

When incremental compilation is turned on and your design contains one or more
design partitions, partition boundaries are ignored while making ECO changes and
SignalProbe signal settings. However, the presence of ECO and/or SignalProbe
changes does not affect partition boundaries for incremental compilation. During
subsequent compilations, ECO and SignalProbe changes are not preserved regardless
of the Netlist Type or Fitter Preservation Level settings. To recover ECO changes and
SignalProbe signals, you must use the Change Manager to re-apply the ECOs after
compilation.
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For partitions developed independently in separate Quartus II projects, the exported
netlist includes all currently saved ECO changes and SignalProbe signals. If you make
any ECO or SignalProbe changes that affect the interface to the lower-level partition,
the software issues a warning message during the export process that this netlist does
not work in the top-level design without modifying the top-level HDL code to reflect
the lower-level change. After integrating the .qxp partition into the top-level design,
the ECO changes will not appear in the Change Manager.

“ e For more information about using the SignalProbe feature to debug your design, refer
to the Quick Design Debugging Using SignalProbe chapter in volume 3 of the Quartus 11
Handbook. For more information about using the Chip Planner and the Resource
Property Editor to make ECOs, refer to the Engineering Change Management with the
Chip Planner chapter in volume 2 of the Quartus II Handbook.

SignalTap Il Logic Analyzer in Exported Partitions

You can use the SignalTap II Embedded Logic Analyzer in any project that you can
compile and program into an Altera device.

When incremental compilation is turned on, debugging logic is added to your design
incrementally and you can tap post-fitting nodes and modify triggers and
configuration without recompiling the full design. Use the appropriate filter in the
Node Finder to find your node names. Use SignalTap II: post-fitting if the netlist
type is Post-Fit to incrementally tap node names in the post-fit netlist database. Use
SignalTap II: pre-synthesis if the netlist type is Source File to make connections to
the source file (pre-synthesis) node names when you synthesize the partition from the
source code.

If incremental compilation is turned off, the debugging logic is added to the design
during Analysis and Elaboration, and you cannot tap post-fitting nodes or modify
debug settings without fully compiling the design.

For design partitions that are being developed independently in separate Quartus II
projects and contain the logic analyzer, when you export the partition, the Quartus II
software automatically removes the SignalTap II logic analyzer and related SLD_HUB
logic. You can tap any nodes in a Quartus II project, including nodes within .qxp
partitions. Therefore, you can use the logic analyzer within the full top-level design to
tap signals from the .qxp partition.

You can also instantiate the SignalTap II megafunction directly in your lower-level
design (instead of using an .stp file) and export the entire design to the top level to
include the logic analyzer in the top-level design.
“ e For details about using the SignalTap II logic analyzer in an incremental design flow,
refer to the Design Debugging Using the SignalTap II Embedded Logic Analyzer chapter in
volume 3 of the Quartus II Handbook.

External Logic Analyzer Interface in Exported Partitions

You can use the Logic Analyzer Interface in any project that you can compile and
program into an Altera device. You cannot export a partition that uses the Logic
Analyzer Interface. You must disable the Logic Analyzer Interface feature and
recompile the design before you export the design as a partition.
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e For more information about the Logic Analyzer Interface, refer to the In-System

Debugging Using External Logic Analyzers chapter in volume 3 of the Quartus II
Handbook.

Assignments Made in HDL Source Code in Exported Partitions

Assignments made with I/O primitives or the altera_attribute HDL synthesis
attribute in lower-level partitions are passed to the top-level design, but do not appear
in the top-level .gsf file or Assignment Editor. These assignments are considered part
of the source netlist files. You can override assignments made in these source files by
changing the value with an assignment in the top-level design.

Design Partition Script Limitations

The Quartus II software has some additional limitations related to the design partition
scripts described in “Generating Design Partition Scripts” on page 3-34.

Warnings About Extra Clocks Due to Design Partition Scripts

The generated scripts include applicable clock information for all clock signals in the
top-level design. Some of those clocks may not exist in the lower-level projects, so you
may see warning messages related to clocks that do not exist in the project. You can
ignore these warnings or edit your constraints so the messages are not generated.

Synopsys Design Constraint Files for the TimeQuest Timing Analyzer in
Design Partition Scripts

After you have compiled a design using TimeQuest constraints, and the timing
assignments option is turned on in the scripts, a separate Tcl script is generated to
create an .sdc file for each lower-level project. This script includes only clock
constraints and minimum and maximum delay settings for the TimeQuest Timing
Analyzer.

PLL settings and timing exceptions are not passed to lower-level designs in the
scripts. For suggestions on managing SDC constraints between top-level and
lower-level projects, refer to the Best Practices for Incremental Compilation Partitions and
Floorplan Assignments chapter in volume 1 of the Quartus II Handbook.

Wildcard Support in Design Partition Scripts

When applying constraints with wildcards, note that wildcards are not analyzed
across hierarchical boundaries. For example, an assignment could be made to these
nodes: Top |A:inst |B:inst | *, where A and B are lower-level partitions, and hierarchy
Bis a child of , that is B is instantiated in hierarchy A. This assignment is applied to
modules 3, B, and all children instances of B. However, the assignment
Top|A:inst|B:inst* is applied to hierarchy 2, but is not applied to the B instances
because the single level of hierarchy represented by B: inst* is not expanded into
multiple levels of hierarchy. To avoid this issue, ensure that you apply the wildcard to
the hierarchical boundary if it should represent multiple levels of hierarchy.

When using the wildcard to represent a level of hierarchy, only single wildcards are
supported. This means assignments such as Top|A:inst|*|B:inst|* are not
supported. The Quartus II software issues a warning in these cases.
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Derived Clocks and PLLs in Design Partition Scripts

If a clock in the top level is not directly connected to a pin of a lower-level partition,
the lower-level partition does not receive assignments and constraints from the
top-level pin in the design partition scripts.

This issue is of particular importance for clock pins that require timing constraints
and clock group settings. Problems can occur if your design uses logic or inversion to
derive a new clock from a clock input pin. Make appropriate timing assignments in
your lower-level Quartus II project to ensure that clocks are not unconstrained.

If the lower-level design uses the top-level project framework from the project lead,
the design will have all the required information about the clock and PLL settings.
Otherwise, if you use a PLL in your top-level design and connect it to lower-level
partitions, the lower-level partitions do not have information about the multiplication
or phase shift factors in the PLL. Make appropriate timing assignments in your
lower-level Quartus II project to ensure that clocks are not unconstrained or
constrained with the incorrect frequency. Alternatively, you can manually duplicate
the top-level derived clock logic or PLL in the lower-level design file to ensure that
you have the correct multiplication or phase-shift factors, compensation delays and
other PLL parameters for complete and accurate timing analysis. Create a design
partition for the rest of the lower-level design logic for export to the top level. When
the lower-level design is complete, export only the partition that contains the relevant
logic.

Pin Assignments for GXB and LVDS Blocks in Design Partition Scripts

Pin assignments for high-speed GXB transceivers and hard LVDS blocks are not
written in the scripts. You must add the pin assignments for these hard IP blocks in
the lower-level projects manually.

Virtual Pin Timing Assignments in Design Partition Scripts

Design partition scripts use INPUT_MAX DELAY and OUTPUT MAX DELAY assignments to
specify inter-partition delays associated with input and output pins, which would not
otherwise be visible to the project. These assignments require that the software specify
the clock domain for the assignment and set this clock domain to ” * ”.

This clock domain assignment means that there may be some paths constrained and
reported by the timing analysis engine that are not required.

To restrict which clock domains are included in these assignments, edit the generated
scripts or change the assignments in your lower-level Quartus II project. In addition,
because there is no known clock associated with the delay assignments, the software
assumes the worst-case skew, which makes the paths seem more timing critical than
they are in the top-level design. To make the paths appear less timing-critical, lower
the delay values from the scripts. If required, enter negative numbers for input and
output delay values.
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Top-Level Ports that Feed Multiple Lower-Level Pins in Design Partition
Scripts

When a single top-level I/O port drives multiple pins on a lower-level module, it
unnecessarily restricts the quality of the synthesis and placement at the lower-level.
This occurs because in the lower-level design, the software must maintain the
hierarchical boundary and cannot use any information about pins being logically
equivalent at the top level. In addition, because 1/O constraints are passed from the
top-level pin to each of the children, it is possible to have more pins in the lower level
than at the top level. These pins use top-level I/O constraints and placement options
that might make them impossible to place at the lower level. The software avoids this
situation whenever possible, but it is best to avoid this design practice to avoid these
potential problems. Restructure your design so that the single I/O port feeds the
design partition boundary and the single connection is split into multiple signals
within the lower-level partition.

Restrictions on Megafunction Partitions

The Quartus II software does not support partitions for megafunction instantiations.
If you use the MegaWizard " Plug-In Manager to customize a megafunction variation,
the MegaWizard-generated wrapper file instantiates the megafunction. You can create
a partition for the MegaWizard-generated megafunction custom variation wrapper
file.

The Quartus II software does not support creating a partition for inferred
megafunctions (that is, where the software infers a megafunction to implement logic
in your design). If you have a module or entity for the logic that is inferred, you can
create a partition for that hierarchy level in the design.

The Quartus II software does not support creating a partition for any Quartus II
internal hierarchy that is dynamically generated during compilation to implement the
contents of a megafunction.

Register Packing and Partition Boundaries

The Quartus II software performs register packing during compilation automatically.
However, when incremental compilation is enabled, logic in different partitions
cannot be packed together because partition boundaries might prevent cross-
boundary optimization. This restriction applies to all types of register packing,
including I/0O cells, DSP blocks, sequential logic, and unrelated logic. Similarly, logic
from two partitions cannot be packed into the same ALM.

1/0 Register Packing

Cross-partition register packing of I/O registers is allowed in certain cases where
your input and output pins exist in the top-level hierarchy (and the Top partition), but
the corresponding I/O registers exist in other partitions.

The following specific circumstances are required for input pin cross-partition register
packing:

m The input pin feeds exactly one register.

m The path between the input pin and register includes only input ports of partitions
that have one fan-out each.
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The following specific circumstances are required for output register cross-partition
register packing:

m The register feeds exactly one output pin.
m The output pin is fed by only one signal.

m The path between the register and output pin includes only output ports of
partitions that have one fan-out each.

Output pins with an output enable signal cannot be packed into the device I/0 cell if
the output enable logic is part of a different partition from the output register. To
allow register packing for output pins with an output enable signal, structure your
HDL code or design partition assignments so that the register and tri-state logic are
defined in the same partition.

Bidirectional pins are handled in the same way as output pins with an output enable
signal. If the registers that need to be packed are in the same partition as the tri-state
logic, you can perform register packing.

The restrictions on tri-state logic exist because the I/O atom (device primitive) is
created as part of the partition that contains tri-state logic. If an I/O register and its
tri-state logic are contained in the same partition, the register can always be packed
with tri-state logic into the I/O atom. The same cross-partition register packing
restrictions also apply to I/O atoms for input and output pins. The I/O atom must
feed the I/O pin directly with exactly one signal. The path between the I/O atom and
the I/O pin must include only ports of partitions that have one fan-out each.

For more information and examples of cross-partition boundary I/O packing, refer to
the Best Practices for Incremental Compilation Partitions and Floorplan Assignments
chapter in volume 1 of the Quartus II Handbook.

Scripting Support

You can run procedures and make settings described in this chapter in a Tcl script or
at a command-line prompt. This section provides scripting examples that cover some
of the topics discussed in this chapter.

Tcl Scripting and Command-Line Examples

@

For information about the : :quartus: :incremental_compilation Tcl package that
contains a set of functions for manipulating design partitions and settings related to
the incremental compilation feature, refer to ::quartus::incremental_compilation in
Quartus II Help.

For scripting support information, including design examples and training, refer to
the Quartus II Software Scripting Support page of the Altera website. For detailed Tcl
scripting and command-line information, including design examples, refer to the Tcl
Scripting and Command-Line Scripting chapters in volume 2 of the Quartus II Handbook.

Creating Design Partitions

To create a design partition to a specified hierarchy name, use the following
command:

November 2013  Altera Corporation Quartus Il Handbook Version 13.1

Volume 1: Design and Synthesis


http://www.altera.com/literature/hb/qts/qts_qii51017.pdf
http://quartushelp.altera.com/current/master.htm#mergedProjects/tafs/tafs/tcl_pkg_incremental_compilation_ver_1.1.htm 
http://www.altera.com/support/software/scripting/sof-qts-scripting.html
http://www.altera.com/literature/hb/qts/qts_qii52003.pdf
http://www.altera.com/literature/hb/qts/qts_qii52003.pdf
http://www.altera.com/literature/hb/qts/qts_qii52002.pdf

3-58 Chapter 3: Quartus Il Incremental Compilation for Hierarchical and Team-Based Design

Scripting Support
create partition [-h | -help] [-long help] -contents <hierarchy names
-partition <partition name> ¢
Table 3—-4. Tcl Script Command: create_partition

Argument Description
-h | -help Short help
-long help Long help with examples and possible return values
-contents <hierarchy names Partition contents (hierarchy assigned to Partition)
-partition <partition name> Partition name

Enabling or Disabling Design Partition Assignments During Compilation

To direct the Quartus II Compiler to enable or disable design partition assignments
during compilation, use the following command:

set_global assignment -name IGNORE_ PARTITIONS <value> ¢

Table 3-5. Tcl Script Command: set_global assignment

Value Description

The Quartus Il software recognizes the design partitions
assignments set in the current Quartus Il project and

OFF recompiles the partition in subsequent compilations
depending on their netlist status.
The Quartus Il software does not recognize design

oN partitions assignments set in the current Quartus Il project

and performs a compilation without regard to partition
boundaries or netlists.

Setting the Netlist Type
To set the partition netlist type, use the following command:

set_global assignment -name PARTITION NETLIST TYPE <value> \
-section_ id <partition name> ¢

[~ The PARTITION NETLIST TYPE command accepts the following values: SOURCE,
POST_SYNTH, POST FIT, and EMPTY. For descriptions for these values, refer to “Partition
Netlist Type Settings” on page 3-25.

Setting the Fitter Preservation Level for a Post-fit or Imported Netlist

To set the Fitter Preservation Level for a post-fit or imported netlist, use the following
command:

set_global assignment -name PARTITION FITTER PRESERVATION LEVEL \
<value> -section id <partition name> *

[l=~ The PARTITION FITTER PRESERVATION command accepts the following values:
NETLIST ONLY, PLACEMENT, and PLACEMENT AND ROUTING. For descriptions for these
values, refer to “Fitter Preservation Level Settings” on page 3-27.
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Preserving High-Speed Optimization

To preserve high-speed optimization for tiles contained within the selected partition,
use the following command:

set global assignment -name PARTITION PRESERVE HIGH SPEED TILES ON

Specifying the Software Should Use the Specified Netlist and Ignore Source
File Changes

To specify that the software should use the specified netlist and ignore source file
changes, even if the source file has changed since the netlist was created, use the
following command:

set _global assignment -name PARTITION IGNORE SOURCE FILE CHANGES ON
-section_id "<partition name>".

Reducing Opening a Project, Creating Design Partitions, and
Performing an Initial Compilation

Scenario background: You open a project called AB_project, set up two design
partitions, entities A and B, and then perform an initial full compilation.

Example 3-1. AB_project

set project AB project

load package incremental compilation
load package flow
project open $project

# Ensure that design partition assignments are not ignored
set_global assignment -name IGNORE PARTITIONS \ OFF

# Set up the partitions
create partition -contents A -name "Partition A"
create partition -contents B -name "Partition B"

Set the netlist types to post-fit for subsequent
compilations (all partitions are compiled during the
initial compilation since there are no post-fit

netlists)

set partition -partition "Partition A" -netlist type POST FIT
set partition -partition "Partition B" -netlist type POST FIT

#
#
#
#

# Run initial compilation:
export assignments
execute flow -full compile

project close
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Optimizing the Placement for a Timing-Critical Partition

Scenario background: You have run the initial compilation shown in the example
script under Example 3-1. You would like to apply Fitter optimizations, such as
physical synthesis, only to partition A. No changes have been made to the HDL files.
To ensure the previous compilation result for partition B is preserved, and to ensure
that Fitter optimizations are applied to the post-synthesis netlist of partition A, set the
netlist type of B to Post-Fit (which was already done in the initial compilation, but is
repeated here for safety), and the netlist type of A to Post-Synthesis, as shown in the
following example:

Example 3-2. AB_project (2)

set project AB project

load package flow

load package incremental compilation
load _package project

project open S$project

# Turn on Physical Synthesis Optimization
set _high effort fmax optimization assignments

# For A, set the netlist type to post-synthesis
set partition -partition "Partition A" -netlist type POST_ SYNTH

# For B, set the netlist type to post-fit
set partition -partition "Partition B" -netlist type POST FIT

# Also set Top to post-fit
set partition -partition "Top" -netlist type POST FIT

# Run incremental compilation:
export assignments

execute_flow -full compile

project close

Generating Design Partition Scripts
To generate design partition scripts, use the following script:

# load required package
load package database manager

# name and open the project
set project <project path/project names
project open s$project

# generate the design partiion scripts
generate_bottom_up_scripts <options>

#close project
project close

The options map to the same as those in the Quartus II software in the Generate
Design Partition Scripts dialog box. For detailed information about each option, refer
to Generate Design Partition Scripts Dialog Box in Quartus II Help.
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Exporting a Partition
To open a project and load the: :quartus: :incremental_compilation package before
you use the Tcl commands to export a partition to a .qxp that contains both a post-
synthesis and post-fit netlist, with routing, use the following script:
# load required package
load package incremental compilation
# open project
project open <project name>
# export partition to the .gxp and set preservation level
export partition -partition <partition name>
-gxp <.gxp file name> -<options>
#close project
project close
Importing a Partition into the Top-Level Design
To import a .qxp into a top-level design, use the following script:
# load required packages
load package incremental compilation
load package project
load package flow
# open project
project open <project name>
#import partition
import partition -partition <partition name> -gxp <.gxp file> <-options>
#close project
project close
Makefiles
For an example of how to use incremental compilation with a makefile as part of the
team-based incremental compilation design flow, refer to the read_me.txt file
that accompanies the incr comp example located in the
/qdesigns/incr_comp_makefile subdirectory.

(@) When using a team-based incremental compilation design flow, the Generate Design
Partition Scripts dialog box can write makefiles that automatically export lower-level
design partitions and import them into the top-level design whenever design files
change. For more information about the Generate Design Partition Scripts dialog
box, refer to Generate Design Partition Scripts Dialog Box in Quartus II Help.

Conclusion
With the Quartus Il incremental compilation feature described in this chapter, you can
preserve the results and performance of unchanged logic in your design as you make
changes elsewhere. The various applications of incremental compilation enable you to
improve your productivity while designing for high-density FPGAs.
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Table 3—-6 shows the revision history for this document.

Tahle 3-6. Document Revision History (Part 1 of 2)

Date Version Changes

Removed HardCopy device information. Revised information about Rapid Recompile. Added
November 2013 13.1.0 | information about functional safety. Added information about flattening sub-partition

hierarchies.
November 2012 | 12.1.0 | Added “Turning On Supported Cross-boundary Optimizations” on page 3-21.
June 2012 12.0.0 | Removed survey link.
November 2011 11.0.1 | Template update.
May 2011 11.0.0 | = Updated “Tcl Scripting and Command-Line Examples”.

m Changed to new document template.

m Reorganized Tcl scripting section. Added description for new feature: Ignore partitions
assignments during compilation option.

m Reorganized “Incremental Compilation Summary” section.

m Removed the explanation of the “bottom-up design flow” where designers work
completely independently, and replaced with Altera’s recommendations for team-based
environments where partitions are developed in the same top-level project framework,
plus an explanation of the bottom-up process for including independent partitions from
third-party IP designers.

December 2010 10.1.0

July 2010 100.0 |™ Expanded the Merge command explanation to explain how it now accommodates cross-
h partition boundary optimizations.

m Restructured Altera recommendations for when to use a floorplan.
m Added “Viewing the Contents of a Quartus Il Exported Partition File (.qxp)” section.

m Reorganized chapter to make design flow scenarios more visible; integrated into various
sections rather than at the end of the chapter.

m Redefined the bottom-up design flow as team-based and reorganized previous design
flow examples to include steps on how to pass top-level design information to lower-level
designers.

m Moved SDC Constraints from Lower-Level Partitions section to the Best Practices for
October 2009 9.1.0 Incremental Compilation Partitions and Floorplan Assignments chapter in volume 1 of the
Quartus I1 Handbook.

m Reorganized the “Conclusion” section.
m Removed HardCopy APEX and HardCopy Stratix Devices section.
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The Partial Reconfiguration (PR) feature in the Quartus II software allows you to reconfigure a portion of
the FPGA dynamically, while the remainder of® the device continues to operate. The Quartus II software
supports the PR feature for the Altera® Stratix V device family.

This chapter assumes a basic knowledge of Altera’s FPGA design flow, incremental compilation, and
LogicLock™ region features available in the Quartus II software. It also assumes knowledge of the internal
FPGA resources such as logic array blocks (LABs), memory logic array blocks (MLABs), memory types
(RAM and ROM), DSP blocks, clock networks.

Note: For assistance with support for partial reconfiguration with the Arria” V or Cyclone® V device
families, file a service request at mySupport using the link below.
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« mySupport

o Terminology on page 4-1
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« Partial Reconfiguration Project Management on page 4-28

+ Programming Files for a Partial Reconfiguration Project on page 4-30

» Partial Reconfiguration Known Limitations on page 4-35

Terminology

The following terms are commonly used in this chapter.

project: A Quartus II project contains the design files, settings, and constraints files required for the
compilation of your design.
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revision: In the Quartus II software, a revision is a set of assignments and settings for one version of your
design. A Quartus II project can have several revisions, and each revision has its own set of assignments and
settings. A revision helps you to organize several versions of your design into a single project.

incremental compilation: This is a feature of the Quartus II software that allows you to preserve results of
previous compilations of unchanged parts of the design, while changing the implementation of the parts of
your design that you have modified since your previous compilation of the project. The key benefits include
timing preservation and compile time reduction by only compiling the logic that has changed.

partition: You can partition your design along logical hierarchical boundaries. Each design partition is
independently synthesized and then merged into a complete netlist for further stages of compilation. With
the Quartus II incremental compilation flow, you can preserve results of unchanged partitions at specific
preservation levels. For example, you can set the preservation levels at post-synthesis or post-fit, for iterative
compilations in which some part of the design is changed. A partition is only a logical partition of the design,
and does not necessarily refer to a physical location on the device. However, you may associate a partition
with a specific area of the FPGA by using a floorplan assignment.

For more information on design partitions, refer to the Best Practices for Incremental Compilation Partitions
andFloorplan Assignments chapter in the Quartus II Handbook.

LogicLock region: A LogicLock region constrains the placement of logic in your design. You can associate
a design partition with a LogicLock region to constrain the placement of the logic in the partition to a specific
physical area of the FPGA.

For more information about LogicLock regions, refer to the Analyzing and Optimizing the Design Floorplan
with the Chip Planner chapter in the Quartus II Handbook.

PR project: Any Quartus II design project that uses the PR feature.

PR region: A design partition with an associated contiguous LogicLock region in a PR project. A PR project
can have one or more PR regions that can be partially reconfigured independently. A PR region may also
be referred to as a PR partition.

static region: The region outside of all the PR regions in a PR project that cannot be reprogrammed with
partial reconfiguration (unless you reprogram the entire FPGA). This region is called the static region, or
fixed region.

persona: A PR region has multiple implementations. Each implementation is called a persona. PR regions
can have multiple personas. In contrast, static regions have a single implementation or persona.

PR control block: Dedicated block in the FPGA that processes the PR requests, handshake protocols, and
verifies the CRC.

Related Information

o Best Practices for Incremental Compilation Partitions and Floorplan Assignments

« Analyzing and Optimizing the Design Floorplan with the Chip Planner

Determining Resources for Partial Reconfiguration

You can use partial reconfiguration to configure only the resources such as LABs, embedded memory blocks,
and DSP blocks in the FPGA core fabric that are controlled by configuration RAM (CRAM).
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The functions in the periphery, such as GPIOs or I/O Registers, are controlled by I/O configuration bits and
therefore cannot be partially reconfigured. Clock multiplexers for GCLK and QCLK are also not partially
reconfigurable because they are controlled by I/O periphery bits.

Figure 4-1: Partially Reconfigurable Resources

These are the types of resource blocks in a Stratix V device.

1/0, 10 Registers & Part-Hard Memory PHY

PLL
CLK
Transceivers, Core Transceivers,
PCle HIP Fabric PCle HIP
PLL
CLK

10, I/0 Registers & Part-Hard Memory PHY

D Periphery D Core Fabric

Table 4-1: Reconfiguration Modes of the FPGA Resource Block

The following table describes the reconfiguration type supported by each FPGA resource block, which are shown in

the figure.

Logic Block Partial Reconfiguration

Digital Signal Processing Partial Reconfiguration

Memory Block Partial Reconfiguration

Transceivers Dynamic Reconfiguration ALTGX_Reconfig

PLL Dynamic Reconfiguration ALTGX_Reconfig

Core Routing Partial Reconfiguration

Clock Networks Clock network sources cannot be changed, but a PLL
driving a clock network can be dynamically reconfig-
ured

I/0O Blocks and Other Periphery Not supported
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The transceivers and PLLs in Altera FPGAs can be reconfigured using dynamic reconfiguration. For more
information on dynamic reconfiguration, refer to the Dynamic Reconfiguration in Stratix V Devices chapter
in the Stratix V Handbook.

Related Information
Dynamic Reconfiguration in Stratix V Devices

An Example of a Partial Reconfiguration Design

A PR design is divided into two parts. The static region where the design logic does not change, and one or
more PR regions.

Each PR region can have different design personas, that change with partial reconfiguration.

PR Region A has three personas associated with it; A1, A2, and A3. PR Region B has two personas; B1 and
B2. Each persona for the two PR regions can implement different application specific logic, and using partial
reconfiguration, the persona for each PR region can be modified without interrupting the operation of the
device in the static or other PR region.

When a region can access more than one persona, you must create control logic to swap between personas
for a PR region.

Figure 4-2: Partial Reconfiguration Project Structure

The following figure shows the top-level of a PR design, which includes a static region and two PR regions.

Chip_top PR Module A1

PR Region A PR Module A2

PR Module A3

PR Region B PR Module B1

Static
Region

il

PR Module B2

Partial Reconfiguration Modes

When you implement a design on an Altera FPGA device, your design implementation is controlled by bits
stored in CRAM inside the FPGA.

You can use partial reconfiguration in the SCRUB mode or the AND/OR mode. The mode you select affects
your PR flow in ways detailed later in this chapter.

The CRAM bits control individual LABs, MLABs, M20K memory blocks, DSP blocks, and routing multiplexers
in a design. The CRAM bits are organized into a frame structure representing vertical areas that correspond
to specific locations on the FPGA. If you change a design and reconfigure the FPGA in a non-PR flow, the
process reloads all the CRAM bits to a new functionality.

Configuration bitstreams used in a non-PR flow are different than those used in a PR flow. In addition to
standard data and CRC check bits, configuration bitstreams for partial reconfiguration also include
instructions that direct the PR control block to process the data for partial reconfiguration.
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The configuration bitstream written into the CRAM is organized into configuration frames. Ifa LAB column
passes through multiple PR regions, those regions share some programming frames.

SCRUB Mode

In the SCRUB mode, the unchanging CRAM bits from the static region are "scrubbed" back to their original
values. They are neither erased nor reset.

The static regions controlled by the CRAM bits from the same programming frame as the PR region continue
to operate. All the CRAM bits corresponding to a PR region are overwritten with new data, regardless of
what was previously contained in the region.

The SCRUB mode of partial reconfiguration involves re-writing all the bits in an entire LAB column of the
CRAM, including bits controlling any PR regions above or below the region being reconfigured. As a result,
it is not currently possible to correctly determine the bits associated with a PR region above or below the
region being reconfigured, because those bits could have already been reconfigured and changed to an
unknown value. This restriction does not apply to static bits above or below the PR region, since those bits
never change and you can rewrite them with the same value as the current state of the configuration bit. You
cannot use the SCRUB mode when two PR regions have a vertically overlapping column in the device.

The advantage of using the SCRUB mode is that the programming file size is much smaller than the AND/OR
mode.

Figure 4-3: SCRUB Mode
This is the floorplan of a FPGA using SCRUB mode, with two PR regions, whose columns do not overlap.

Programming Frame(s)
(No Vertical Overlap)

PR1
Region

PR2
Region

AND/OR Mode

The AND/OR mode refers to how the bits are rewritten. Partial reconfiguration with AND/OR uses a two-pass
method.

Simplistically, this can be compared to bits being ANDed with a MASK, and ORed with new values, allowing
multiple PR regions to vertically overlap a single column. In the first pass, all the bits in the CRAM frame
for a column passing through a PR region are ANDed with 0's while those outside the PR region are ANDed
with 1's. After the first pass, all the CRAM bits corresponding to the PR region are reset without modifying
the static region. In the second pass for each CRAM frame, new data is ORed with the current value of 0
inside the PR region, and in the static region, the bits are ORed with 0's so they remain unchanged. The
programming file size of a PR region using the AND/OR mode could be twice the programming file size of
the same PR region using SCRUB mode.
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Figure 4-4: AND/OR Mode

This is the floorplan of a FPGA using AND/OR mode, with two PR regions, with columns that overlap.

Programming Frame(s)
(Vertical Overlap)

PR1
Region

PR2
Region

Note: If you have overlapping PR regions in your design, you must use AND/OR mode to program all PR
regions, including PR regions with no overlap. The Quartus II software will not permit the use of
SCRUB mode when there are overlapping regions. If none of your regions overlap, you can use
AND/OR, SCRUB, or a mixture of both.

Programming File Sizes for a Partial Reconfiguration Project

The programming file size for a partial reconfiguration is proportional to the area of the PR region.

The programming file size for a partial reconfiguration is proportional to the area of the PR region. A partial
reconfiguration programming bitstream for AND/OR mode makes two passes on the PR region; the first
pass clears all relevant bits, and the second pass sets the necessary bits. Due to this two-pass sequence, the
size of a partial bitstream can be larger than a full FPGA programming bitstream depending on the size of
the PR region.

When using the AND/OR mode for partial reconfiguration, the formula which describes the approximate
file size within ten percent is:

PR bitstreamsize = ((Size of region in the horizontal direction) /(full
hori zontal dinmension of the part)) * 2 * (size of full bitstream

The way the Fitter reserves routing for partial reconfiguration increases the effective size for small PR regions
from a bitstream perspective. PR bitstream sizes in designs with a single small PR region will not match the
file size computed by this equation.

Note: The PR bitstream size is approximately half of the size computed above when using SCRUB mode.

Partial Reconfiguration Design Flow

The primary building block of partial reconfiguration is the revision. Your initial design is the base revision,
where you define the boundaries of the static region and reconfigurable regions on the FPGA. From the base
revision, you create multiple revisions, which contain the static region and describe the differences in the
reconfigurable regions.
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Two types of revisions are specific to partial reconfiguration: reconfigurable and aggregate. Both import the
persona for the static region from the base revision. A reconfigurable revision generates personas for PR
regions. An aggregate revision is used to combine personas from multiple reconfigurable revisions to create
a complete design suitable for timing analysis.

The design flow for partial reconfiguration also utilizes the Quartus II incremental compilation flow. To
take advantage of incremental compilation for partial reconfiguration, you must organize your design into
logical and physical partitions for synthesis and fitting. For the PR flow, these partitions are treated as PR
regions that must also have associated LogicLock assignments.

Revisions make use of personas, which are subsidiary archives describing the characteristics of both static
and reconfigurable regions, that contain unique logic which implements a specific set of functions to
reconfigure a PR region of the FPGA. Partial reconfiguration uses personas to pass this logic from one
revision to another.

Figure 4-5: Partial Reconfiguration Design Flow

o Designate All Partial Block(s) as Design
¥~ Partition(s) for the Use with Incremental Compilation

v

Plan Your System for Partial
Reconfiguration

v

Assign All PR Partition(s) to
LogicLock Regions

v

Design Planning for Partial Reconfiguration

Identify the Design Blocks Designated Create Revisions and
to be Partially Reconfigured Compile the Design

¢ for Each Revision

4% Code the Design Using HDL P—W

Develop the Personas for the
Partial Blocks

!

Simulate the Design Functionality

A

Is Timing Met
for Each Revision?

Debug the Timing Failure | 10
& Revise the Appropriate Step

Generate
Configuration Files

A
Program the Device

Functionality is

The PR design flow requires more initial planning than a standard design flow. Planning requires setting
up the design logic for partitioning, and determining placement assignments to create a floorplan. Well-
planned partitions can help improve design area utilization and performance, and make timing closure
easier. You should also decide whether your system requires partial reconfiguration to originate from the
FPGA pins or internally, and which mode you are using; the AND/OR mode or the SCRUB mode, because
this influences some of the planning steps described in this section.

You must structure your source code or design hierarchy to ensure that logic is grouped correctly for
optimization. Implementing the correct logic grouping early in the design cycle is more efficient than
restructuring the code later. The PR flow requires you to be more rigorous about following good design
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practices. The guidelines for creating partitions for incremental compilation also include creating partitions
for partial reconfiguration.

Use the following best practice guidelines for designing in the PR flow, which are described in detail in this
section:

o Determining resources for partial reconfiguration

« Partitioning the design for partial reconfiguration

« Creating incremental compilation partitions for partial reconfiguration
 Instantiating the PR controller in the design

« Creating wrapper logic for PR regions

 Creating freeze logic for PR regions

 Planning clocks and other global signals for the PR design

+ Creating floorplan assignments for the PR design

Design Partitions for Partial Reconfiguration

You must create design partitions for each PR region that you want to partially reconfigure. Optionally, you
can also create partitions for the static parts of the design for timing preservation and/or for reducing
compilation time.

There is no limit on the number of independent partitions or PR regions you can create in your design. You
can designate any partition as a PR partition by enabling that feature in the LogicLock Regions window in
the Quartus II software.

Incremental Compilation Partitions for Partial Reconfiguration
Use the following best practices guidelines when creating partitions for PR regions in your design:

 Register all partition boundaries; register all inputs and outputs of each partition when possible. This
practice prevents any delay penalties on signals that cross partition boundaries and keeps each register-
to-register timing path within one partition for optimization.

o Minimize the number of paths that cross partition boundaries.

« Minimize the timing-critical paths passing in or out of PR regions. If there are timing-critical paths that
cross PR region boundaries, rework the PR regions to avoid these paths.

o The Quartus II software can optimize some types of paths between design partitions for non-PR designs.
However, for PR designs, such inter-partition paths are strictly not optimized.

For more information about incremental compilation, refer to the following chapter in the Quartus II
Handbook.

Related Information

Quartus II Incremental Compilation for Hierarchical and Team-Based Design

Partial Reconfiguration Controller Instantiation in the Design

You must instantiate the Stratix V PR control block and the Stratix V CRC block in your design in order to
use the PR feature in Stratix V devices. You may find that adding the PR control block and CRC block at
the top level of the design offers the most convenience.

For example, in a design named Core_Top, all the logic is contained under the Core_Top module hierarchy.
Create a wrapper (Chip_Top) at the top-level of the hierarchy that instantiates this Core_Top module, the
Stratix V PR control block, and the Stratix V CRC check modules.
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If you are performing partial reconfiguration from pins, then the required pins should be on the I/0O list for
the top-level (Chip_Top) of the project, as shown in the code in the following examples. If you are performing
partial reconfiguration from within the core, you may choose another configuration scheme, such as Active
Serial, to transmit the reconfiguration data into the core, and then assemble it to 16-bit wide data inside the
FPGA within your logic. In such cases, the PR pins are not part of the FPGA I/0.

Note: Verilog HDL does not require a component declaration. You can instantiate the PR control block
as shown in the following example.

Component Declaration of the PR Control Block and CRC Block in VHDL

This code sample has the component declaration in VHDL, showing the ports of the Stratix V PR control
block and the Stratix V CRC block. In the following example, the PR function is performed from within the
core (code located in Core_Top) and you must add additional ports to Core_Top to connect to both
components.

-- The Stratix V control block interface

conponent stratixv_prblock is

port (
corectl: in STD LOA C ;
prrequest: in STD LOd C ;
data: in STD _LOG C VECTOR(15 downto 0);
error: out STD LCd C ;
ready: out STD LOG C ;
done: out STD LCE C

)

end conponent ;
-- The Stratix V CRC block for diagnosing CRC errors

conponent stratixv_crchlock is

port (
shiftnld: in STD LOG C ;
clk: in STD LC4Q C ;
crcerror: out STD LOA C

)

end conponent ;

The following rules apply when connecting the PR control block to the rest of your design:

o Thecorect!| signal must be set to ‘1’ (when using partial reconfiguration from core) or to ‘0’ (when
using partial reconfiguration from pins).

« Thecorect| signal has to match the Enable PR pins option setting in the Device and Pin Options
dialog box on the Setting page; if you have turned on Enable PR pins, then the cor ect | signal on the
PR control block instantiation must be toggled to ‘0’.

o  When performing partial reconfiguration from pins the Quartus II software automatically assigns the
PR unassigned pins. If you so choose, you can make pin assignments to all the dedicated PR pins in Pin
Planner or Assignment Editor.

o When performing partial reconfiguration from core, you can connect the pr bl ock signals to either
core logic or I/O pins, excluding the dedicated programming pin such as DCLK.
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Instantiating the PR Control Block and CRC Block in VHDL
This code example instantiates a PR control block in VHDL, inside your top-level project, Chip_Top:

nodul e Chip_Top (
/1 User 1/0O signals (excluding PR related signals)

[/ PR interface & configuration signals
pr_request,
pr _ready,
pr _done,
crc_error
dcl k,
pr _dat a,
init_done
)
/

}user I/ O signal declaration

[/ PR interface and configuration signals declaration
i nput pr_request;

out put pr_ready;

out put pr_done;

out put crc_error;

i nput dcl k;

i nput [15:0] pr_data;

out put init_done

/1 Followi ng shows the connectivity within the Chip_Top nodul e
Core_Top : Core_Top
port _map (

)

m pr : stratixv_prblock

port map(

clk => dcl k,

corectl => "0, //1 - when using PR frominside
/10 - for PR frompins; You nust al so enable
/1l the appropriate option in Quartus Il settings

prrequest => pr_request,

data => pr_data,

error => pr_error,

ready => pr_ready,

done => pr_done

mcrc : stratixv_crchl ock

port map(

shiftnld=> "1', //If you want to read the EMR register when

cl k=> dumy_cl k, /lerror occurrs, refer to AN539 for the
/1 connectivity forthis signal. If you only want

//to detect CRC errors, but plan to take no
[/ further action, you can tie the shiftnld
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//signal to |ogical high
crcerror => crc_error

),

For more information on port connectivity for reading the Error Message Register (EMR), refer to the
following application note.

Related Information
AN539: Test Methodology of Error Detection and Recovery using CRC in Altera FPGA Devices

Instantiating the PR Control Block and CRC Block in Verilog HDL
The following example instantiates a PR control block in Verlilog HDL, inside your top-level project,
Chip_Top:

nodul e Chi p_Top (
/1 User 1/0O signals (excluding PR related signals)

/PR interface & configuration signals
pr_request,
pr _ready,
pr _done,
crc_error,
dcl k,
pr _dat a,
init_done
)
/

/user 1/0O signal declaration

/PR interface and configuration signals declaration
i nput pr_request;
out put pr_ready;
out put pr_done;
out put crc_error;
i nput dcl k;
i nput [15:0] pr_data;
output init_done

/'l Follow ng shows the connectivity within the Chi p_Top nodul e
Core_Top : Core_Top
port_map (

);”

m pr : stratixv_prbl ock
/lset corectl to 'l when using PR frominside
/lset corectl to '0" for PR frompins. You nust al so enable
[l the appropriate option in Quartus Il settings.
port map(
cl k => dcl Kk,
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corectl=>"'0",
prrequest=> pr_request,
dat a=> pr_dat a,

error=> pr_error,
ready=> pr_ready,
done=> pr_done

),

mcrc : stratixv_crcbl ock

/11f you want to read the EMR regi ster when an error occurrs, refer
to AN539 for the

/lconnectivity forthis signal. If you only want to detect CRC errors,
but plan to take no

//further action, you can tie the shiftnld signal to |ogical high.
port map(

shiftnld=> "'1",

cl k=> dumy_cl Kk,

crcerror=> crc_error

),

For more information on port connectivity for reading the Error Message Register (EMR), refer to the
following application note.

Related Information
ANS539: Test Methodology of Error Detection and Recovery using CRC in Altera FPGA Devices

Wrapper Logic for PR Regions

Each persona of a PR region must implement the same input and output boundary ports. These ports act
as the boundary between static and reconfigurable logic.

Implementing the same boundary ports ensures that all ports of a PR region remain stationary regardless
of the underlying persona, so that the routing from the static logic does not change with different PR persona
implementations.

Figure 4-6: Wire-LUTs at PR Region Boundary

The Quartus II software automatically instantiates a wire-LUT for each port of the PR region to lock down
the same location for all instances of the PR persona.

Static Region

If one persona of your PR region has a different number of ports than others, then you must create a wrapper
so that the static region always communicates with this wrapper. In this wrapper, you can create dummy
ports to ensure that all of the PR personas of a PR region have the same connection to the static region.
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The sample code below each create two personas; per sona_1 and per sona_ 2 are different functions of
one PR region. Note that one persona has a few dummy ports. The first example creates partial reconfiguration

wrapper logic in Verilog HDL:

/! Partial Reconfiguration Wapper in Verilog HDL
nodul e persona_1l
(

i nput reset,

input [2:0] a,

i nput [2:0] b,

i nput [2:0] c,

output [3:0] p,

output [7:0] ¢

reg [3:0] p, q; _
al ways@a or b) begin
p=a+hb;

end

al ways@a or b or ¢ or p)begin
q = (p*a - b*c)

end

endnodul e

nodul e persona_2
(
i nput reset,
input [2:0] a,
input [2:0] b,
input [2:0] ¢, //never used in this persona
output [3:0] p,
output [7:0] g //never assigned in this persona

reg [3:0] p, q; _

al ways@a or b) begin

p=a?* b,
/1l note q is not assigned value in this persona
end
endnodul e

The following example creates partial reconfiguration wrapper logic in VHDL.

-- Partial Reconfiguration Wapper in VHDL
entity persona_l is
port( a:in STD LOG C VECTOR (2 downto 0);

b:in STD LOA C VECTOR (2 downto 0);
c:in STD LOd C VECTOR (2 downto 0);
p: out STD LOG C VECTOR (3 downto 0);
g: out STD LOA C VECTOR (7 downto 0));

end persona_l1;

architecture synth of persona_1 is
begi n
process(a, b)
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begi n
p <= a + b;
end process;

process (a, b, c, p)
begi n
q <= (p*a - b*c);
end process;
end synt h;

entity persona 2 is
port( a:in STD_LOG C_VECTOR (2 downto 0);
b:in STD LOGd C VECTOR (2 downto 0);
c:in STD LOG C VECTOR (2 downto 0); --never used in this persona

p:out STD LOd C VECTOR (3 downto 0);
g: out STD LOE C VECTOR (7 downto 0)); --never used in this persona

end persona_2;

architecture synth of persona_2 is
begi n
process(a, b)
begin
p <= a *b; --note q is not assigned a value in this persona
end process;
end synth;

Freeze Logic for PR Regions

When you use partial reconfiguration, you must freeze all non-global inputs of a PR region except global
clocks. Locally routed signals are not considered global signals, and must also be frozen during partial
reconfiguration. Freezing refers to driving a '1' on those PR region inputs. When you start a partial
reconfiguration process, the chip is in user mode, with the device still running.

Freezing all non-global inputs for the PR region ensures there is no contention between current values that
may result in unexpected behavior of the design after partial reconfiguration is complete. Global signals
going into the PR region should not be frozen to high. The Quartus II software freezes the outputs from the
PR region; therefore the logic outside of the PR region is not affected.
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Figure 4-7: Freezing at PR Region Boundary
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During partial reconfiguration, the static region logic should not depend on the outputs from PR regions to
be at a specific logic level for the continued operation of the static region.

The easiest way to control the inputs to PR regions is by creating a wrapper around the PR region in RTL.
In addition to freezing all inputs high, you can also drive the outputs from the PR block to a specific value,
if required by your design. For example, if the output drives a signal that is active high, then your wrapper
could freeze the output to GND.

The following example implements a freeze wrapper in Verilog HDL, on a module named pr _nodul e.

nodul e freeze_wr apper

(
i nput reset,
i nput freeze, //PR process active, generated by user logic
i nput clkl, //global clock signa
i nput cl k2, // non-global clock signal
i nput [3:0] control _node, // synchronous to clkl
input [3:0] framer_ctl, [/ synchronous to cl k2
out put [15:0] data_out
);

reg [3:0]control _node_sync,
wire clk2 to_use;

framer_ctl _sync;

/linstantiate pr_nodul e
pr _nodul e pr_nodul e

(

.reset (reset), //input

.clkl (clkl), //input, global clock

.clk2 (clk2_to_use), // input, non-global clock

.control _node (control _node_sync), //input

.framer_ctl (framer_ctl_sync), //input

. pr_nmodul e_out (data_out)// collection of outputs from pr_nodul e
)

al ways @ posedge cl k1) begin
control _node_sync <= freeze ? 4'hF
end

cont rol _node;
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al ways@ posedge cl k2) begin

framer _ctl _sync <= freeze ? 4'hF. franer _ctl;
end
assign clk2 to use = freeze ? 1'bl : cl k2;

endnodul e

QII51026
2013.11.04

The following example implements a freeze wrapper in VHDL, on a module named pr _nodul e.

entity freeze wrapper is
port( reset:in STD LCA C

freeze:in STD LOA C

clkl: in STD LOd C; --global signal

clk2: in STD LOd C, --non-global signal

control _node: in STD LOGd C VECTOR (3 downto 0);

framer _ctl: in STD_LOGd C_VECTOR (3 downto 0);

data_out: out STD LOQA C VECTOR (15 downto 0));
end freeze_wrapper;

architecture behv of freeze_w apper is
component pr_nodul e
port(reset:in STD LCd C,
clkl:in STD LCA C;
clk2:in STD LOGQ C;
control _node:in STD LOA C VECTOR (3 downto 0);
framer _ctl:in STD LOA C VECTOR (3 downto 0);

pr_nmodul e_out:out STD LOGd C VECTOR (15 downto 0));

end component

sighal control _node_sync: in STD LOG C VECTOR (3 downto 0);
signal framer_ctl_sync : in STD LOd C VECTOR (3 downto 0);

signhal clk2 to use : STD LOG C

signal data_out_tenp : STD LOG C VECTOR (15 downto 0);
--signal data out : STD LOd C VECTOR (15 downto 0);
begi n

data_out (15 downto 0) <= data_out_tenp(1l5 downto 0);

m_pr _nodul e: pr_nodul e

port map (
reset => reset,
cl k1l => cl k1,
cl k2 => c| k2,

control _node =>control_node_sync,
framer _ctl => franer_ctl _sync,
pr _nmodul e_out => data_out _tenp);

-- freeze all inputs
process(cl kl) begin
if clkl'event and clkl = "'1'" then
if freeze = '1' then
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control _nmode_sync <= "1111";
el se control _nmode_sync <= control node;
end if;
end if;
end process;

-- freeze the non-gl obal clocks as well
process(cl k2, freeze) begin
if clk2' event and clk2 = '1' then
if freeze = '1' then
framer_ctl _sync <= "1111";
el se framer_ctl_sync <= framer_ctl;
end if;
end if;
end process;

Clocks and Other Global Signals for a PR Design

For non-PR designs, the Quartus II software automatically promotes high fan-out signals onto available
clocks or other forms of global signals during the pre-fitter stage of design compilation using a process called
global promotion. For PR designs, however, automatic global promotion is disabled by default for PR regions,
and you must assign the global clock resources necessary for PR partitions.

There are 16 global clock networks in a Stratix V device. However, only six unique clocks can drive a row
clock region limiting you to a maximum of six global signals in each PR region. The Quartus II software
must ensure that any global clock can feed every location in the PR region.

The limit of six global signals to a PR region includes the GCLK, QCLK and PCLKSs used inside of the PR
region. Make QSF assignments for global signals in your project's Quartus II Settings File (.qsf), based on
the clocking requirements for your design. In designs with multiple clocks that are external to the PR region,

it may be beneficial to align the PR region boundaries to be within the global clock boundary (such as QCLK
or PCLK).

If your PR region requires more than six global signals, modify the region architecture to reduce the number
of global signals within this to six or fewer. For example, you can split a PR region into multiple regions,
each of which uses only a subset of the clock domains, so that each region does not use more than six.

Every instance of a PR region that uses the global signals (for example, PCLK, QCLK, GCLK, ACLR) must
use a global signal for that input.

Global signals can only be used to route certain secondary signals into a PR region and the restrictions for
each block are listed in the following table. Data signals and other secondary signals not listed in the table,
such as synchronous clears and clock enables are not supported.

Table 4-2: Supported Signal Types for Driving Clock Networks in a PR Region

Block Types Supported Signals for Global/Periphery/Quadrant Clock
Networks

LAB d ock, ACLR
RAM Cl ock, ACLR, Wite Enabl e(VE), Read
Enabl e( RE)
DSP d ock, ACLR
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Note: PR regions are allowed to contain output ports that are used outside of the PR region as global signals.

o Ifaglobal signal feeds both static and reconfigurable logic, the restrictions in the table also apply
to destinations in the static region. For example, the same global signal cannot be used as an SCLR
in the static region and an ACLRin the PR region.

« Aglobalsignal used for a PR region should only feed core blocks inside and outside the PR region.
In particular you should not use a clock source for a PR region and additionally connect the signal
to an I/O register on the top or bottom of the device. Doing so may cause the Assembler to give
an error because it is unable to create valid programming mask files.

Floorplan Assignments for PR Designs

You must create a LogicLock region so the interface of the PR region with the static region is the same for
any persona you implement. If different personas of a PR region have different area requirements, you must
make a LogicLock region assignment that contains enough resources to fit the largest persona for the region.
The static regions in your project do not necessarily require a floorplan, but depending on any other design
requirement, you may choose to create a floorplan for a specific static region. If you create multiple PR
regions, and are using SCRUB mode, make sure you have one column or row of static region between each
PR region.

There is no minimum or maximum size for the LogicLock region assigned for a PR region. Because wire-
LUTs are added on the periphery of a PR region by the Quartus II software, the LogicLock region for a PR
region must be slightly larger than an equivalent non-PR region. Make sure the PR regions include only the
resources that can be partially reconfigured; LogicLock regions for PR can only contain only LABs, DSPs,
and RAM blocks. When creating multiple PR regions, make sure there is at least one static region column
between each PR region. When multiple PR regions are present in a design, the shape and alignment of the
region determines whether you use the SCRUB or AND/OR PR mode.

You can use the default Auto size and Floating location LogicLock region properties to estimate the
preliminary size and location for the PR region.

You can also define regions in the floorplan that match the general location and size of the logic in each
partition. You may choose to create a LogicLock region assignment that is non-rectangular, depending on
the design requirements, but disjoint LogicLock regions are not allowed for PR regions.

After compilation, use the Fitter-determined size and origin location as a starting point for your design
floorplan. Check the quality of results obtained for your floorplan location assignments and make changes
to the regions as needed.

Alternatively, you can perform Analysis and Synthesis, and then set the regions to the required size based
on resource estimates. In this case, use your knowledge of the connections between partitions to place the
regions in the floorplan.

For more information on making design partitions and using an incremental design flow, refer to the
Quartus II Incremental Compilation for Hierarchical and Team-Based Floorplan Design chapter in the
Quartus IT Handbook. For more design guidelines to ensure good quality of results, and suggestions on
making design floorplan assignments with LogicLock regions, refer to the Best Practices for Incremental
Compilation Partitions and Floorplan Floorplan Assignments chapter in the Quartus II Handbook.

Related Information

o Quartus II Incremental Compilation for Hierarchical and Team-Based Floorplan

o Best Practices for Incremental Compilation Partitions and Floorplan
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Implementation Details for Partial Reconfiguration

This section describes implementation details that help you create your PR design.

Partial Reconfiguration Pins
Partial reconfiguration can be performed through external pins or from inside the core of the FPGA.

When using PR from pins, some of the I/O pins are dedicated for implementing partial reconfiguration
functionality. If you perform partial reconfiguration from pins, then you must use the passive parallel with
16 data bits (FPPx16) configuration mode.

To enable partial reconfiguration from pins in the Quartus II software, perform the following steps:

1. From the Assignments menu, click Device, then click Device and Pin Options.

2. In the Device and Pin Options dialog box, select General in the Category list and turn on Enable PR
pins from the Options list.

3. Click Configuration in the Category list and select Passive Parallel x16 from the Configuration scheme
list.

4. Click OK, or continue to modify other settings in the Device and Pin Options dialog box.
5. Click OK.

Note: You can enable open drain on PR pins from the Device and Pin Options dialog box in the Settings
page of the Quartus II software.

Table 4-3: Partial Reconfiguration Dedicated Pins Description

PR_REQUEST Input Dedicated input when Enable PR
pins is turned on; otherwise,
available as user 1/0.

Logic high on pin indicates the PR
host is requesting partial
reconfiguration.

PR_READY Output Dedicated output when Enable
PR pins is turned on; otherwise,
available as user I/O.

Logic high on this pin indicates
the Stratix V control block is ready
to begin partial reconfiguration.

PR_DONE Output Dedicated output when Enable
PR pins is turned on; otherwise,
available as user I/O.

Logic high on this pin indicates
that partial reconfiguration is
complete.
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PR_ERROR Output Dedicated output when Enable

PR pins is turned on; otherwise,
available as user I/0O.

Logic high on this pin indicates
the device has encountered an
error during partial reconfigura-
tion.

DATA[ 15: 0] Input Dedicated input when Enable PR
pins is turned on; otherwise
available as user 1/O.

These pins provide connectivity
for PR_DATA when Enable PR
pins is turned on.

DCLK Bidirectional Dedicated input when Enable PR
pins is turned on; PR_DATA is
sent synchronous to this clock.

This is a dedicated programming
pin, and is not available as user I/
O even if Enable PR pins is turned
off.

For more information on different configuration modes for Stratix V devices, and specifically about FPPx16
mode, refer to the Configuration, Design Security, and Remote System Upgrades in Stratix V Devices chapter
of the Stratix V Handbook.

Related Information
Configuration, Design Security, and Remote System Upgrades in Stratix V Devices

Interface with the PR Control Block through a PR Host

You communicate between your PR control IP and the PR Control Block (CB) via control signals, while
executing partial reconfiguration.

You can communicate with the PR control block via an internal host which communicates with the CB
through internal control signals. You can also use an external host with handshake signals accessed via
external pins. The internal PR host can be user logic or a Nios® II processor.
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Figure 4-8: Managing Partial Reconfiguration with an Internal or External Host

The figure shows how these blocks should be connected to the PR control block (CB). In your system, you
will have either the External Host or the Internal Host, but not both.

PR Program PR Program
file (rbf)in |« file (.rbf) in
external memory external memory
y
PR Control k ¢ PR Control
Block (CB) |4 | Internal Block (CB)
Host External [ |
Host
PR | > PR
Region Region

The PR mode is independent of the full chip programming mode. For example, you can configure the full

chip using a JTAG download cable, or other supported configuration modes. When configuring PR regions,
you must use the FPPx16 interface to the PR control block whether you choose to partially reconfigure the
chip from an external or internal host.

When using an external host, you must implement the control logic for managing system aspects of partial
reconfiguration on an external device. By using an internal host, you can implement all of your logic necessary
for partial reconfiguration in the FPGA, therefore external devices are not required to support partial
reconfiguration. When using an internal host, you can use any interface to load the PR bitstream data to the
FPGA, for example, from a serial or a parallel flash device, and then format the PR bitstream data to fit the
FPPx16 interface on the PR Control Block.

To use the external host for your design, turn on the Enable PR Pins option in the Device and Pin Options
dialog box in the Quartus II software when you compile your design. If this setting is turned off, then you
must use an internal host. Also, you must tie the cor ect | port on the PR control block instance in the
top-level of the design to the appropriate level for the selected mode.

Related Information

Partial Reconfiguration Pins on page 4-19
Partial Reconfiguration Dedicated Pins Table

PR Control Signals Interface

The Quartus II Programmer allows you to generate the different bit-streams necessary for full chip
configuration and for partial reconfiguration. The programming bit-stream for partial reconfiguration
contains the instructions (opcodes) as well as the configuration bits, necessary for reconfiguring each of the
partial regions. When using an external host, the interface ports on the control block are mapped to FPGA
pins. When using an internal host, these signals are within the core of the FPGA.
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Figure 4-9: Partial Reconfiguration Interface Signals

These handshaking control signals are used for partial reconfiguration.

PR_Data[15:0]
PR_done ¢——
PR_ready 4——

From Pins or
<+
FPGA Core CRC_error
PR_error ¢——
PR_request
Clk

Yv \ 4

PR Control Block (CB) «——— corectl

PR_DATA: The configuration bitstream is sent on PR_ DATA[ 15: 0] , synchronous to the Cl k.
PR_DONE: Sent from CB to control logic indicating the PR process is complete.

PR_READY: Sent from CB to control logic indicating the CB is ready to accept PR data from the control
logic.

CRC_Er r or : The CRC_Error generated from the device’s CRC block, is used to determine whether to
partially reconfigure a region again, when encountering a CRC_Error.

PR_ERROR: Sent from CB to control logic indicating an error during partial reconfiguration.
PR_REQUEST: Sent from your control logic to CB indicating readiness to begin the PR process.

cor ect | : Determines whether partial reconfiguration is performed internally or through pins.

Reconfiguring a PR Region

The figure below shows a system in which your PR Control logic is implemented inside the FPGA. However,
this section is also applicable for partial reconfiguration with an external host.

The PR control block (CB) represents the Stratix V PR controller inside the FPGA. PR1 and PR2 are two
PR regions in a user design. In addition to the four control signals (PR_REQUEST, PR_READY, PR_DONE,
PR_ERRCR) and the data/clock signals interfacing with the PR control block, your PR Control IP should
also send a control signal (PR_CONTRQOL) to each PR region. This signal implements the freezing and
unfreezing of the PR Interface signals. This is necessary to avoid contention on the FPGA routing fabric.

Figure 4-10: Example of a PR System with Two PR Regions

Implementation of PR Control logic in the FPGA.

Static Region
PR1 PR2
Region Region
A y
PR1_Control PR2_Control
PR_Request
PR Control [ PR Control Logic
Block (CB) >
A PR_Ready, PR_Error,
PR_Done, CRC_Error Partial Reconfiguration
Data/Clock via FPPx16
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After the FPGA device has been configured with a full chip configuration at least once, the | NI T_DONE
signal is released, and the signal is asserted high due to the external resistor on this pin. The | NI T_DONE
signal must be assigned to a pin to monitor it externally. When a full chip configuration is complete, and
the device is in user mode, the following steps describe the PR sequence:

1. Begin a partial reconfiguration process from your PR Control logic, which initiates the PR process for
one or more of the PR regions (asserting PR1_Control or PR2_Control in the figure). The wrapper HDL
described earlier freezes (pulls high) all non-global inputs of the PR region before the PR process.

2. Send PR_REQUEST signal from your control logic to the PR Control Block (CB). If your design uses an
external controller, monitor | NI T_DONE to verify that the chip is in user mode before asserting the
PR_REQUEST signal. The CB initializes itself to accept the PR data and clock stream. After that, the CB
asserts a PR_READY signal to indicate it can accept PR data. Exactly four clock cycles must occur before
sending the PR data to make sure the PR process progresses correctly. Data and clock signals are sent to
the PR control block to partially reconfigure the PR region interface.

o If there are multiple PR personas for the PR region, your PR Control IP must determine the
programming file data for partial reconfiguration.

o When there are multiple PR regions in the design, then the same PR control IP determines which
regions require reconfiguration based on system requirements.

« Atthe end of the PR process, the PR control block asserts a PR_DONE signal and de-asserts the
PR_READY signal.

« If you want to suspend sending data, you can implement logic to pause the clock at any point.

3. Your PR control logic must de-assert the PR_REQUEST signal within eight clock cycles after the PR_DONE
signal goes high. If your logic does not de-assert the PR_REQUEST signal within eight clock cycles, a
new PR cycle starts.

4. If your design includes additional PR regions, repeat steps 2 — 3 for each region. Otherwise, proceed to
step 5.

5. Your PR Control logic de-asserts the PR_CONTRCL signal(s) to the PR region. The freeze wrapper releases
all input signals of the PR region, thus the PR region is ready for normal user operation.

6. You must perform a reset cycle to the PR region to bring all logic in the region to a known state. After
partial reconfiguration is complete for a PR region, the states in which the logic in the region come up
is unknown.

The PR event is now complete, and you can resume operation of the FPGA with the newly configured PR
region.

At any time after the start of a partial reconfiguration cycle, the PR host can suspend sending the PR_DATA,
but the host must suspend sending the PR_CLK at the same time. If the PR_CLK s suspended after a PR
process, there must be at least 20 clock cycles after the PR_DONE or PR_ERRCR signal is asserted to prevent
incorrect behavior.

For an overview of different reset schemes in Altera devices, refer to the Recommended Design Practices
chapter in the Quartus II Handbook.

Related Information

« Partial Reconfiguration Cycle Waveform on page 4-23
For more information on clock requirements for partial reconfiguration.

o Recommended Design Practices

Partial Reconfiguration Cycle Waveform

The PR host initiates the PR request, transfers the data to the FPGA device when it is ready, and monitors
the PR process for any errors or until it is done.
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A PR cycle is initiated by the host (internal or external) by asserting the PR_REQUEST signal high. When
the FPGA device is ready to begin partial reconfiguration, it responds by asserting the PR_READY signal
high. The PR host responds by sending configuration data on DATA [ 15: 0] . The data is sent synchronous
to PR_CLK. When the FPGA device receives all PR data successfully, it asserts the PR_DONE high, and de-
asserts PR_READY to indicate the completion of the PR cycle.

Figure 4-11: Partial Reconfiguration Timing Diagram

The partial reconfiguration cycle waveform with a hand-shaking protocol.
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PR_ERROR
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If there is an error encountered during partial reconfiguration, the FPGA device asserts the PR_ERROR
signal high and de-asserts the PR_READY signal low.

The PR host must continuously monitor the PR_DONE and PR_ERROR signals status. Whenever either of
these two signals are asserted, the host must de-assert PR_REQUEST within eight PR_CLK cycles. As a
response to PR_ERRORerror, the host can optionally request another partial reconfiguration or perform a

full FPGA configuration.

To prevent incorrect behavior, the PR_CLK signal must be active a minimum of twenty clock cycles after
PR_DONE or PR_ERROR signal is asserted high. Once PR_DONE is asserted, PR_REQUEST must be de-
asserted within eight clock cycles. PR_DONE is de-asserted by the device within twenty PR_CLK cycles. The
host can assert PR_REQUEST again after the 20 clocks after PR_DONE is de-asserted.

Table 4-4: Partial Reconfiguration Clock Requirements

Signal timing requirements for partial reconfiguration.

Timing Parameters Value (clock cycles)

PR_READY to first data

4 (exact)

PR_ERRORto last clock

20 (minimum)

PR_DONE to last clock

20 (minimum)

DONE t o REQ | ow

8 (maximum)

Compressed PR_READY to first data

4 (exact)

Encrypted PR_READY to first data (when using
double PR)

8 (exact)
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Timing Parameters Value (clock cycles)

Encrypted and Compressed PR_READY to first data | 12 (exact)
(when using double PR)

At any time during partial reconfiguration, to pause sending PR_DATA, the PR host can stop toggling
PR_CLK. The clock can be stopped either high or low.

At any time during partial reconfiguration, the PR host can terminate the process by de-asserting the PR
request. A partially completed PR process results in a PR error. You can have the PR host restart the PR
process after a failed process by sending out a new PR request 20 cycles later.

In case you terminate a PR process before completion, and follow it up with a FPGA reset using the nConf i g
signal, you must keep the PR_CLK signal running through the FPGA reset cycle to avoid causing the partial
reconfiguration to lock up.

During these steps, the PR control block might assert a PR_ERROR or a CRC_ERRCR signal to indicate
that there was an error during the partial reconfiguration process. Assertion of PR_ERROR indicates that
the PR bitstream data was corrupt, and the assertion of CRC error indicates a CRAM CRC error either
during or after completion of PR process. If the PR_ERROR or CRC_ERROR signals are asserted, you must
plan whether to reconfigure the PR region or reconfigure the whole FPGA, or leave it unconfigured.

Important: The PR_CLKsignal has different a nominal maximum frequency for each device. Most Stratix
V devices have a nominal maximum frequency of at least 62.5 MHz. Refer to the following
solution for your specific device for accurate information.

Related Information

Stratix V Maximum Frequencies

Partial Reconfiguration with an External Host

For partial reconfiguration using an external host, you must set the MSEL [ 4: O] pins for FPPx16
configuration scheme.

You can use a microcontroller, another FPGA, or a CPLD such as a MAX V device, to implement the
configuration and PR controller. In this setup, the Stratix V device configures in FPPx16 mode during power-
up. Alternatively, you can use a JTAG interface to configure the Stratix V device.

At any time during user-mode, the external host can initiate partial reconfiguration and monitor the status
using the external PR dedicated pins: PR_REQUEST, PR_READY, PR_DONE, and PR_ERROR In this mode,
the external host must respond appropriately to the hand-shaking signals for a successful partial reconfigu-
ration. This includes acquiring the data from the flash memory and loading it into the Stratix V device on
DATA[ 15:0].
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Figure 4-12: Connecting to an External Host

The connection setup for partial reconfiguration with an external host in the FPPx16 configuration scheme.
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< CRC_ERROR
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Using an External Host with Multiple Devices

You must design the external host to accommodate the arbitration scheme that is required for your system,
as well as the partial reconfiguration interface requirement for each device.
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Figure 4-13: Connecting Multiple FPGAs to an External Host

An example of an external host controlling multiple Stratix V devices on a board.
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PR_READY
PR_ERROR FPGAL
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PR_ERROR1 PR_DONE
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PR_ERROR FPGA2
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PR_READY2
PR_ERROR2
. »| DATA[15:0]
. nCE
: &
PR_REQUEST5 »| PR_REQUEST
PR_DONE5 PR_DONE
PR_READY5 PR_READY
PR_ERROR5 PR_ERROR FPGA5

Partial Reconfiguration with an Internal Host

Design Planning for Partial Reconfiguration

The PR internal host is a piece of soft logic implemented in the FPGA that you must design to accommodate
the hand-shaking protocol with the PR control block.

For example, PR programming bitstream(s) stored in an external flash device can be routed through the
regular I/Os of the FPGA device, or received through the high speed transceiver channel (PCI Express, SRIO
or Gigabit Ethernet), and can be stored in on-chip memory such as MLABs or M20K blocks, for processing
by the internal logic. This data must be formatted into the 16 bit wide data so that it can be transmitted to
the PR control block by the internal IP, because the PR control block can only accept PR data via its FPPx16
interface.

The PR dedicated pins (PR_REQUEST, PR_READY, PR_DONE, and PR_ERROR) can be used as regular
I/Os when performing partial reconfiguration with an internal host. For the full FPGA configuration upon
power-up, you can set the MSEL[ 4: O] pins to match the configuration scheme, for example, AS, PS, FPPx8,
FPPx16, or FPPx32. Alternatively, you can use the JTAG interface to configure the FPGA device. At any
time during user-mode, you can initiate partial reconfiguration through the FPGA core fabric using the PR
internal host.

In the following figure, the programming bitstream for partial reconfiguration is received through the PCI
Express link, and your logic converts the data to the FPPx16 mode.
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Figure 4-14: Connecting to an Internal Host

An example of the configuration setup when performing partial reconfiguration using the internal host.
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DCLK [« DCLK User Loaic
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Partial Reconfiguration Data
Received through PCI Express Link

Partial Reconfiguration Project Management

When compiling your PR project, you must create a base revision, and one or more reconfigurable revisions.
The project revision you start out is termed the base revision.

Create Reconfigurable Revisions

To create a reconfigurable revision, use the Revisions tab of the Project Navigator window in the Quartus
IT software. When you create a reconfigurable revision, the Quartus II software adds the required assignments
to associate the reconfigurable revision with the base revision of the PR project. You can add the necessary
files to each revision with the Add/Remove Files option in the Project option under the Project menu in
the Quartus II software. With this step, you can associate the right implementation files for each revision of
the PR project.

Compiling Reconfigurable Revisions
Altera recommends that you use the largest persona of the PR region for the base compilation so that the
Quartus II software can automatically budget sufficient routing.

Here are the typical steps involved in a PR design flow.

1. Compile the base revision with the largest persona for each PR region.
2. Create reconfigurable revisions for other personas of the PR regions by right-clicking in the Revisions
tab in the Project Navigator.

3. Compile your reconfigurable revisions.
4. Analyze timing on each reconfigurable revision to make sure the design performs correctly to specifications.
5. Create aggregate revisions as needed.
6. Create programming files.
Altera Corporation Design Planning for Partial Reconfiguration
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For more information on compiling a partial reconfiguration project, refer to Performing Partial
Reconfiguration in Quartus II Help.

Related Information
Performing Partial Reconfiguration

Timing Closure for a Partial Reconfiguration Project

As with any other FPGA design project, simulate the functionality of various PR personas to make sure they
perform to your system specifications. You must also make sure there are no timing violations in the
implementation of any of the personas for every PR region in your design project.

In the Quartus II software, this process is manual, and you must run multiple timing analyses, on the base,
reconfigurable, and aggregate revisions. The different timing requirements for each PR persona can be met
by using different SDC constraints for each of the personas.

The interface between the partial and static partitions remains identical for each reconfigurable and aggregate
revision in the PR flow. If all the interface signals between the static and the PR regions are registered, and
there are no timing violations within the static region as well as within the PR regions, the reconfigurable
and aggregate revisions should not have any timing violations.

However, you should perform timing analysis on the reconfigurable and aggregate revisions, in case you
have any unregistered signals on the interface between partial reconfiguration and static regions.

Bitstream Compression and Encryption for PR Designs

You can choose to independently compress and encrypt the base bitstream as well as the PR bitstream for
your PR project using options available in the Quartus II software.

When you choose to compress the bitstreams, you can compress the base and PR programming bitstreams
independently, based on your design requirements. However, if you want to encrypt only the base image,
you can choose wether or not to encrypt the PR images.

o When you want to encrypt the bitstreams, you can encrypt the PR images only when the base image is
encrypted.

o The Encryption Key Programming ( .ekp) file generated when encrypting the base image must be used
for encrypting PR bitstream.

o When you compress the bitstream, you must present each PR_DATA[ 15: 0] word for exactly four clock
cycles.

Table 4-5: Partial Reconfiguration Clock Requirements for Bitstream Compression

Timing Parameters Value (clock cycles)

PR_READY to first data 4 (exact)
PR_ERRORto last clock 80 (minimum)
PR _DONE to last clock 80 (minimum)
DONE_t o_REQ | ow 8 (maximum)

Related Information

« Enable Bitstream Decompression Option on page 4-34
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« Enable Bitstream Decryption Option on page 4-34

+ Generate PR Programming Files with the Convert Programming Files Dialog Box on page 4-32

Programming Files for a Partial Reconfiguration Project

You must generate PR bitstream(s) based on the designs and send them to the control block for partial
reconfiguration.

Compile the PR project, including the base revision and at least one reconfigurable revision before generating
the PR bitstreams. The Quartus II Programmer generates PR bitstreams. This generated bitstream can be
sent to the PR ports on the control block for partial reconfiguration.

Figure 4-15: PR Project with Three Revisions

Consider a partial reconfiguration design that has three revisions and one PR region, a base revision with
persona a, one PR revision with persona b, and a second PR revision with persona c.

Base
Revision with
Persona a

pr_region.msf
static.msf
base.sof

Partial
Reconfiguration
Design

Revision b b.sof
b.msf

c.sof
c.msf

When these individual revisions are compiled in the Quartus II software, the assembler produces Masked
SRAM Object Files (.msf) and the SRAM Object Files ( .sof) for each revision. The .sof files are created as
before (for non-PR designs). Additionally, .msf files are created specifically for partial reconfiguration, one
for each revision. The pr_region.mfsf file is the one of interest for generating the PR bitstream. It contains
the mask bits for the PR region. Similarly, the static.msf file has the mask bits for the static region. The .sof
files have the information on how to configure the static region as well as the corresponding PR region. The
pr_region.msf file is used to mask out the static region so that the bitstream can be computed for the PR
region. The default file name of the pr region .msf corresponds to the LogicLock region name, unless the
name is not alphanumeric. In the case of a non-alphanumeric region name, the .msf file is named after the
location of the lower left most coordinate of the region.

Note: Altera recommends naming all LogicLock regions to enhance documenting your design.
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Figure 4-16: Generation of Partial-Masked SRAM Object Files (.pmsf)

You can convert files in the Convert Programming Files window or run the quar t us_cpf - p command
to process the pr_region.msf and .sof files to generate the Partial-Masked SRAM Object File (.pmsf).

pr_region.msf b_pr_region

C_pr_region

.msf

.msf

: —>‘ : —>‘

base.sof

The .msf file helps determine the PR region from each of the .sof files during the PR bitstream computation.

Once all the .pmsf files are created, process the PR bitstreams by running the quar t us_cpf - 0 command
to produce the raw binary .rbf files for reconfiguration.

If one wishes to partially reconfigure the PR region with persona a, use the a.rbf bitstream file, and so on for
the other personas.

Figure 4-17: Generating PR Bitstreams

This figure shows how three bitstreams can be created to partially reconfigure the region with persona a,
persona b, or persona c as desired.

In the Quartus II software, the Convert Programming Files window supports the generation of the required

programming bitstreams. When using the quar t us_cpf from the command line, the following options
for generating the programming files are read from an option text file, for example, option.txt.

« If you want to use SCRUB mode, before generating the bitstreams create an option text file, with the
following line:

use_scrub=on

« If you have initialized M20K blocks in the PR region (ROM/Initialized RAM), then add the following
line in the option text file, before generating the bitstreams:
write_bl ock_nmenory_cont ent s=on

« If you want to compress the programming bitstream files, add the following line in the option text file.

This option is available when converting base .sof to any supported programming file types, such as .rbf,
.pof and JTAG Indirect Configuration File (. jic).

bi t st ream _conpr essi on=0n

Related Information
Generate PR Programming Files with the Convert Programming Files Dialog Box on page 4-32
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Generating Required Programming Files

1. Generate .sof and .msf files (part of a full compilation of the base and PR revisions).
2. Generate a Partial-Masked SRAM Object File (.pmsf) using the following commands:

quartus_cpf -p <pr_revision> nsf <pr_revision> sof <new fil enanme>. pnsf
for example:

guartus_cpf -p x7y48. msf swi t chPRBS. sof x7y48 new. pnsf

3. Convert the .pmsf file for every PR region in your design to .rbf file format. The .rbf format is used to
store the bitstream in an external flash memory. This command should be run in the same directory
where the files are located:

quartus_cpf -0 scrub.txt -c <pr_revision > pnsf <pr_revision>. rbf
for example:
quartus_cpf -o scrub.txt -c x7y48_new. pnsf x7y48.rbf

When you do not have an option text file such as scrub.txt, the files generated would be for AND/OR mode
of PR, rather than SCRUB mode.

Generate PR Programming Files with the Convert Programming Files Dialog Box

In the Quartus II software, the flow to generate PR programming files is supported in the Convert
Programming Files dialog box. You can specify how the Quartus II software processes file types such as .msf,
.pmsf, and .sof to create .rbf and merged .msf and .pmsf files.

You can create

o A .pmsf output file, from .msf and .sof input files

o A .rbf output file from a .pmsf input file

o A merged .msf file from two or more .msf input files

o A merged .pmsf file from two or more .pmsf input files

Convert Programming Files dialog box also allows you to enable the option bit for bitstream decompression
during partial reconfiguration, when converting the base .sof (full design .sof) to any supported file type.

For additional details, refer to the Quartus II Programmer chapter in the Quartus II Handbook.

Related Information

Quartus II Programmer

Generating a .pmsf File from a .msf and .sof Input File

Perform the following steps in the Quartus II software to generate the .pmsf file in the Convert Programming
Files dialog box.

Open the Convert Programming Files dialog box.
Specify the programming file type as Partial-Masked SRAM Object File (.pmsf).

Specify the output file name.
Select input files to convert (only a single .msf and .sof file are allowed). Click Add.

AN

Click Generate to generate the .pmsf file.
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Generating a .rbf File from a .pmsf Input File

Perform the following steps in the Quartus II software to generate the partial reconfiguration .rbf file in the
Convert Programming Files dialog box.

1. From the File menu, click Convert Programming Files.

Specify the programming file type as Raw Binary File for Partial Reconfiguration (.rbf).
Specify the output file name.

Select input file to convert. Only a single .pmsf input file is allowed. Click Add.
Select the new .pmsf and click Properties.

Turn the Compression, Enable SCRUB mode, Write memory contents, and Generate encrypted
bitstream options on or off depending on the requirements of your design. Click Generate to generate
the .rbf file for partial reconfiguration.

A

o Compression: Enables compression on the PR bitstream.
« Enable SCRUB mode: Default is based on AND/OR mode. This option is valid only when your design
does not contain vertically overlapped PR masks. The .rbf generation fails otherwise.

« Write memory contents: Turn this on when you have a .mif that was used during compilation. Otherwise,
turning this option on forces you to use double PR in AND/OR mode.

 Generate encrypted bitstream: If this option is enabled, you must specify the Encrypted Key Programming
(.ekp) file, which generated when converting a base .sof to an encrypted bitstream. The same .ekp must
be used to encrypt the PR bitstream.

When you turn on Compression, you must present each PR_DATA[ 15: 0] word for exactly four clock
cycles.

Turn on the Write memory contents option only if you are using AND/OR mode and have M20K blocks
in your PR design that need to be initialized. When you check this box, you must to perform double PR for
regions with initialized M20K blocks.

Related Information
« Initializing M20K Blocks with a Double PR Cycle on page 4-40
« Initializing M20K Blocks with a Double PR Cycle on page 4-40

Create a Merged .msf File from Multiple .msf Files
You can merge two or more .msf files in the Convert Programming Files window.

Open the Convert Programming Files window.

Specify the programming file type as Merged Mask Settings File (.msf).

Specify the output file name.

Select MSF Data in the Input files to convert window.

Click Add File to add input files. You must specify two or more files for merging.

SIS e

Click Generateto generate the merged file.

To merge two or more .msf files from the command line, type:

qguartus_cpf --nerge_nsf=<nunber of merged files> <nmsf _input_file 1>
<nsf _input file 2> <nsf _input _file etc> <nsf _output file>
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For example, to merge two .msf files, type:

quartus_cpf --nmerge_nsf=<2> <nsf _input _file_1> <nsf_input_file_2>
<nsf _output file>

Generating a Merged .pmsf File from Multiple .pmsf Files
You can merge two or more .pmsf files in the Convert Programming Files window.

Open the Convert Programming Files window.

Specify the programming file type as Merged Partial-Mask SRAM Object File (.pmsf).
Specify the output file name.

Select PMSF Data in the Input files to convert window.

Click Add File to add input files. You must specify two or more files for merging.
Click Generate to generate the merged file.

SN S e

To merge two or more .pmsf files from the command line, type:

guartus_cpf --nerge_pnsf=<nunber of nerged fil es>
<pnsf _input file 1> <pnsf _input file 2> <pmsf _input file etc>
<pmnsf_out put _file>

For example, to merge two .pmsf files, type:

guartus_cpf --merge_ pnsf=<2> <pnsf_input _file 1> <pnsf _input file 2>
<pmnsf_out put _file>

The merge operation checks for any bit conflict on the input files, and the operation fails with error message
if a bit conflict is detected. In most cases, a successful file merge operation indicates input files do not have
any bit conflict.

Enable Bitstream Decompression Option
In the Quartus II software, the Convert Programming Files window provides the option in the .sof file
properties to enable bitstream decompression during partial reconfiguration.

This option is available when converting base .sof to any supported programming file types, such as .rbf,
.pof, and .jic.

In order to view this option, the base .sof must be targeted on Stratix V devices in the .sof File Properties.

This option must be turned on if you turned on the Compression option during .pmsf to .rbf file generation.

Enable Bitstream Decryption Option
The Convert Programming Files window provides the option in the .sof file properties to enable bitstream
decryption during partial reconfiguration.

This option is available when converting base .sof to any supported programming file types, such as .rbf,
.pof, and .jic.

The base .sof must have partial reconfiguration enabled and the base .sof generated from a design that has
a PR Control Block instantiated, to view this option in the .sof File Properties. This option must be turned
on if you wants to turn on the Generate encrypted bitstream option during .pmsf to .rbf file generation.
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On-Chip Debug for PR Designs

You cannot instantiate a SignalTap II block inside a PR region. If you must monitor signals within a PR
region for debug purposes, bring those signals to the ports of the PR region.

The Quartus II software does not support the Incremental SignalTap feature for PR designs. After you
instantiate the SignalTap II block inside the static region, you must recompile your design. When you
recompile your design, the static region may have a modified implementation and you must also recompile
your PR revisions. If you modify an existing SignalTap II instance you must also recompile your entire
design; base revision and reconfigurable revisions.

Figure 4-18: Using SignalTap Il with a PR Design

You can instantiate the SignalTap II block in the static region of the design and probe the signals you want

to monitor.
Static Region
SignalTap Il | PR Region
Module "] with Signals to
Be Probed
Brought Out
on the Ports

You can use other on-chip debug features in the Quartus II software, such as the In-System Sources and
Probes or SignalProbe, to debug a PR design. As in the case of SignalTap, In-System Sources and Probes can
only be instantiated within the static region of a PR design. If you have to probe any signal inside the PR
region, you must bring those signals to the ports of the PR region in order to monitor them within the static
region of the design.

Partial Reconfiguration Known Limitations

There are restrictions that derive from hardware limitations in specific Stratix V devices.
The restrictions in the following sections apply only if your design uses M20K blocks as RAMs or ROMs in
your PR project.

Memory Blocks Initialization Requirement for PR Designs

For a non-PR design, the power up value for the contents of a M20K RAM or a MLAB RAM are all set at
zero. However, at the end of performing a partial reconfiguration, the contents of a M20K or MLAB memory
block are unknown. You must intentionally initialize the contents of all the memory to zero, if required by
the functionality of the design, and not rely upon the power on values.

M20K RAM Blocks in PR Designs

When your PR design uses M20K RAM blocks in Stratix V devices, there are some restrictions which limit
how you utilize the respective memory blocks as ROMs or as RAMs with initial content.
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Related Information

Implementing Memories with Initialized Content on page 4-39
If your design requires initialized memory content either as a ROM or a RAM inside a PR region, you must
follow these guidelines.

Limitations When Using Stratix V Production Devices
These workarounds allow your design to use M20K blocks with PR.

Figure 4-19: Limitations for Using M20Ks in PR Regions
If you implement a M20K block in your PR region as a ROM or a RAM with initialized content, when the

PR region is reconfigured, any data read from the memory blocks in static regions in columns that cross the
PR region is incorrect.

Stratix V Device

PR Static
Region Region

.................... P P . No Restncuons for RAM/ROM
.| Implementation in These M20K Columns

RAM/ROM Implementation in These M20K
Columns Has Restrictions

If the functionality of the static region depends on any data read out from M20K RAMs in the static region,
the design will malfunction.

Use one of the following workarounds, which are applicable to both AND/OR and SCRUB modes of partial
reconfiguration:

« Do not use ROMs or RAMs with initialized content inside PR regions.

o Ifthis is not possible for your design, you can program the memory content for M20K blocks with a .mif
using the suggested workarounds.

» Make sure your PR region extends vertically all the way through the device, in such a way that the M20K
column lies entirely inside a PR region.
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Figure 4-20: Workaround for Using M20Ks in PR Regions

This figure shows the LogicLock region extended as a rectangle reducing the area available for the static
region. However, you can create non-rectangular LogicLock regions to allocate the resources required for
the partition more optimally. If saving area is a concern, extend the LogicLock region to include M20K
columns entirely.

Stratix V Device

[ M20K as Uninitialized RAM
[ M20K as Initialized RAM/ROM

PR Static
Region Region

Workaroun#8xtend the LogicLock Region
to Include the Entire M20K Column

Figure 4-21: Alternative Workaround for Using M20Ks in PR Region

Using Reserved LogicLock Regions, block all the M20K columns that are not inside a PR region, but that
are in columns above or below a PR region. In this case, you may choose to under-utilize M20K resources,
in order to gain ROM functionality within the PR region.

Stratix V Device

[ M20K as Uninitialized RAM

I [ M20K as Initialized RAMIROM

PR
Region

Static
Region

L— Workaround: Reserved LogicLock Regior
No RAM/ROM In These Areas

For more information including a list of the Stratix V production devices, refer to the Stratix V Errata Sheet
and Guidelines.

Related Information
Stratix V Errata Sheet and Guidelines
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MLAB Blocks in PR designs

Stratix V devices include dual-purpose blocks called MLABs, which can be used to implement RAMs or
LABs for user logic.

This section describes the restrictions while using MLAB blocks (sometimes also referred to as LUT-RAM)
in Stratix V devices for your PR designs.

If your design uses MLABS as LUT RAM, you must use all available MLAB bits within the region.
Table 4-6: RAM Implementation Restrictions Summary

The following table shows a summary of the LUT-RAM Restrictions.

PR Mode Type of memory in PR region Stratix V Production

LUT RAM (no initial content) OK
SCRUB mode LUT ROM and LUT RAM with your | OK
initial content
LUT RAM (no initial content) While design is running: Write 1s
to all locations before partial
reconfiguration

At compile time: Explicitly
AND/OR mode initialize all memory locations in
each new persona to 1 via initial-
ization file (. mif).

LUT ROM and LUT RAM with your | No
initial content

If your design does not use any MLAB blocks as RAMs, the following discussion does not apply. The
restrictions listed below are the result of hardware limitations in specific devices.

Limitations with Stratix V Production Devices
When using SCRUB mode:

o LUT-RAMs without initialized content, LUT-RAMSs with initialized content, and LUT-ROMSs can be
implemented in MLABs within PR regions without any restriction.

When using AND/OR mode:

o LUT-RAMs with initialized content or LUT-ROMs cannot be implemented in a PR region.
o LUT-RAMs without initialized content in MLABs inside PR regions are supported with the following
restrictions.

« MLAB blocks contain 640 bits of memory. The LUT RAMs in PR regions in your design must occupy
all MLAB bits, you should not use partial MLABs.

« Youmustinclude controllogic in your design with which you can write to all MLAB locations used inside
PR region.

« Using this control logic, write '1' at each MLAB RAM bit location in the PR region before starting the PR
process. This is to work around a false EDCRC error during partial reconfiguration.
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« You must also specify a .mif that sets all MLAB RAM bits to '1' immediately after PR is complete.
o ROMs cannot be implemented in MLABs (LUT-ROMs).
o There are no restrictions to using MLABs in the static region of your PR design.

For more information, refer to the following documents in the Stratix V Handbook:

Related Information

Stratix V Errata Sheet and Guidelines

Implementing Memories with Initialized Content

If your Stratix V PR design implements ROMs, RAMs with initialization, or ROMs within the PR regions,
using either M20K blocks or LUT-RAMs, then you must follow the following design guidelines to determine
what is applicable in your case.

Table 4-7: Implementing Memory with Initialized Content in PR Designs

AND/OR SCRUB

Suggested Method While design is running: No special method
Write ‘1” to all locations required
before partial reconfigura-
tion.
At compile time: Explicitly
initialize all memory
LUT-RAM without locations in each new
initialization persona to ‘1’ via initializa-
tion file (.mif)
Make sure no spurious
write on PR entry @
Without Suggested CRC Error N/A
Method
Suggested Method Make sure no spurious
LUT-RAM with initial- ot o write on PR exit
ot ot supporte
1zation Without Suggested Incorrect results
Method
Suggested Method No special method required
M20K without initial-
ization Without Suggested N/A
Method
Suggested Method Use double PR cycle @ N/A
M20K with initializa- Me}ke sure no sp u(rll)ous
: write on PR exit
tion
Without Suggested Incorrect results
Method
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AND/OR SCRUB

Note to table:

1. Use the circuit shown in the M20K/LUTRAM figure to create clock enable logic to safely exit partial
reconfiguration without spurious writes.

2. Double partial reconfiguration is described in Using Double PR Cycle for Initializing M20K blocks.

Figure 4-22: M20K/LUTRAM

To avoid spurious writes during PR entry and exit, implement the following clock enable circuit in the same

PR region as the RAM.
M20K/LUTRAM
Clock Enable p SET Q— cE
Logic
[ cr®
1 bSET, bSETo C[)
’f ctr? ’f ctr@

Clear Signal to
Safely Exit PR

The circuit depends on an active- high clear signal from the static region. Before entering PR, freeze this
signal in the same manner as all PR inputs. Your host control logic should de-assert the clear signal as the
final step in the PR process.

Related Information
Initializing M20K Blocks with a Double PR Cycle on page 4-40

Initializing M20K Blocks with a Double PR Cycle

When a PR region in your PR design contains an initialized M20K block and is reconfigured via AND/OR
mode, your host logic must complete a double PR cycle, instead of a single PR cycle.
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Figure 4-23: Next PR Request Assertion During Double PR Cycle

This figure displays the second phase of a double PR cycle, where the host logic must issue another
PR_REQUEST signal after exactly seven clock cycles after the PR_DONE signal is asserted.

PR_REQUEST

PR_CLK _[7]_[ee mmmmﬂmmmmm: J_LI—\_I—U_LI—\_I_\_I_Ii_LI_U
READY to_NEXT_DAT,

PRDATAS) (e e )X
DONE _to_NEXT_REQ

PR_READY | |/

)

PR_DONE |

PR_ERROR

CRC_ERROR

If the PR encryption feature (without compression) is enabled , the host logic must issue another
PR_REQUEST signal exactly six clock cycles after PR_DONE is asserted.

If the PR compression feature is enabled (with or without encryption), the host logic must issue another
PR_REQUEST signal exactly two clock cycles after PR_DONE is asserted. The FPGA responds with
PR_READY signal to the second PR_REQUEST signal assertion.

The PR host must continue sending PR_DATA signal exactly four clock cycles after the PR_READY signal,
just as in the first PR cycle. The data on PR_DATA pins can be don't care between the first PR_DONE signal
and until four clock cycles after the PR_READY signal is asserted for the second PR cycle.

The host must continue sending a PR_DATA signal for the second PR cycle, until it receives the PR_DONE
signal for the second request, similar to the first PR cycle. After the PR_DONE signal is asserted for the second
time, the host should de-assert the PR_REQUEST signal and continue with other operations needed for
region bring up, such as issuing a reset to bring the region to a known state.

Double PR with Compressed Programming Bitstream
You can use bitstream compression along with PR designs that also require memory initialization for M20K
blocks.

For a compressed bitstream requiring a double PR cycle, the PR host must stop sending the PR_DATA signal
in the bitstream as soon as the first PR_DONE is asserted. The PR host must resume sending the PR_DATA
signal immediately after the second PR_READY signal is asserted.
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Document Revision History

Table 4-8: Document Revision History

November 2013 13.1.0 Added support for merging
multiple .msf and .pmsf files.

Added support for PR Megafunc-
tion.

Updated for revisions on timing
requirements.

May 2013 13.0.0 Added support for encrypted
bitstreams.

Updated support for double PR.

November 2012 12.1.0 Initial release.
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This chapter contains rules and guidelines for creating a floorplan with the design
separation flow, and assumes familiarity with the Quartus® II incremental
compilation flow and floorplanning with the LogicLock™ feature.

The basic principle of a secure and reliable system is that critical subsystems in the
design have physical and functional independence. Systems with redundancy require
physical independence to ensure fault isolation—that a failure or corruption of any
single subsystem does not affect any other part of the system adversely. Furthermore,
if errors occur, physical independence simplifies analysis by allowing developers to
evaluate each subsystem separately.

Traditionally, systems that require redundancy implement critical IP structures using
multiple devices. The Quartus II design separation flow, used in Cyclone® III LS
devices, allows you to design physically independent structures on a single device.
This functionality allows system designers to achieve a higher level of integration on a
single FPGA, and alleviates increasingly strict Size Weight and Power (SWaP)
requirements. Figure 5-1 shows this concept.

Figure 5-1. Achieving Higher Level Integration on a Single Cyclone III LS Device

Critical Critical Critical Critical
Subsystem Subsystem Function Function
1 2 1 2
—>
Other subsystems Other user logic
Complex System Cyclone Il LS FPGA

Other subsystems

The Quartus II design separation flow introduces the constraints necessary to create
secured regions and floorplan a secured system. When implemented in Cyclone III LS
devices, a secured region provides physical independence through controlled routing
and a boundary of unused resources. Restricting routing resources and providing a
physical guard band of unused logic array blocks (LABs) prevent faults or unintended
signals originating in one secured region from adversely affecting other design blocks
on the device.

[l=~ The Quartus II design separation flow features require specific licensing in addition to
licensing the Quartus II software. For more information, contact your local Altera
sales representative or Altera distributor.
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Chapter 5: Quartus Il Design Separation Flow
Design Flow Overview

The Quartus II design separation flow incorporates additional LogicLock and
floorplanning features into the incremental compilation flow. The following three
chapters in the Quartus II Handbook serve as companion references to this chapter:

m  Quartus Il Incremental Compilation for Hierarchical and Team-Based Design—Describes
the Quartus II incremental compilation flow

m Best Practices for Incremental Compilation Partitions and Floorplan Assignments—
Contains guidelines for using the incremental compilation flow and creating a
design floorplan

m  Analyzing and Optimizing the Design Floorplan with the Chip Planner—Describes
various attributes associated with LogicLock location constraints and introduces
the Chip Planner for creating and modifying a floorplan

Design Flow Overview

The design separation flow is based on the incremental compilation flow. You begin
with an incremental compilation design flow and then apply design separation
constraints to each design partition that you want to physically isolate from the rest of
your design. This section provides an overview of the design separation flow steps.

Figure 5-2 shows a flow chart of the design separation flow. Red boxes in the flow
chart highlight steps that are specific to the design separation flow, while the
remaining boxes in the flow chart are common to both the design separation and
incremental compilation flows. This section provides a brief description for each step
in Figure 5-2 and serves as a quick-start guide for the design separation flow.
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Design Flow Overview

Figure 5-2. Design Separation Compilation Flow
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Set up design hierarchy for secured partitioning—Prepare your design for
implementation of the design separation flow, by setting up your design hierarchy
for secured partitioning along logical hierarchical boundaries. If necessary, create
wrapper files to create logical boundaries in the design hierarchy to support the
design entities that you must separate from the remainder of the design.

Perform analysis and elaboration—Run analysis and elaboration to identify the
hierarchy in your design.

Create design partitions for secured regions—For each design entity that requires
physical independence, create a logical design partition for each design entity.
Partition logic using guidelines from the incremental compilation flow.
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For more information, refer to “Creating Design Partitions for the Design
Separation Flow” on page 5-5.

4. Create a design floorplan with security attributes—After creating design
partitions, create LogicLock location assignments and a floorplan to secure all the
entities in your design. Use the security attributes in the LogicLock Regions
window to specify the security level of each LogicLock region. These attributes
create fencing regions in your floorplan to isolate the secured LogicLock regions.
For more information, refer to “Creating a Design Floorplan with Secured
Regions” on page 5-6.

5. Assign design partitions to secured regions—Assign design partitions to secured
LogicLock regions to separate them from each other and from all other hierarchy
blocks. Refer to “Using Secured Regions” on page 5-9 for more information.

6. Add I/O pins that directly interface with a secured region as a member of the
secured region—If a secured region interfaces with one or more I/O pins, make
the I/O pins members of the secured region. If a secured region has I/O pins as
members, that region must overlap the I/O pads. Refer to “Adding I/O Pins as
Members of Secured Regions” on page 5-9 for more information.

7. Create security routing interfaces to and from secured regions—Create security
routing interfaces by applying the security routing interface attribute to LogicLock
regions.

You can use only routing resources in a security routing interface; you cannot
place any logic. Each security routing interface must abut one or two secured
regions. After you create an interface region for each signal or group of signals
entering or exiting a secured region, assign the signals to the appropriate routing
interfaces.

For signals routing between secured regions with different security attributes or
between a secured region and an unsecured region, you must lower the security
attribute for the signal exiting the stricter security region. For more information,
refer to “Making Signal Security Assignments” on page 5-19.

8. Assign I/O pins—After creating secured regions and security routing interfaces, if
the secured regions contain I/O pins as members, assign I/O pins to meet design
separation flow requirements. For example, secured regions cannot share I/O
banks. If a secured region contains I/O pins as members, the entire I/O bank is
usable only by the secured region that sinks or sources the I/O pin. For more
information, refer to “Assigning I/O Pins” on page 5-25.

9. Make design changes, set the netlist type for each design partition, and compile
the design—After making the necessary I/O pin assignments, you complete the
design separation flow-specific steps, and you can start the iterative process of
making design changes, setting the netlist type for each design partition, and then
compiling your design until you achieve a floorplan that meets your design
requirements.

Il= Subsequent sections in this chapter describes the design separation flow-specific steps
(step 1 and steps 4 through 8).
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Creating Design Partitions for the Design Separation Flow

After setting up your design to support secured partitioning and running analysis
and elaboration, you can create design partitions.

Each secured region floorplan assignment uses a single design partition in the
incremental compilation flow to identify the functional elements that belong to a
secured region. You can make design partition assignments along entity boundaries in
the RTL design hierarchy.

Only a single partition may be used in a secure region. Plan your design entities such
that logic that requires physical isolation from the rest of your design are contained in
a single design entity. Additionally, you must create wrapper files where necessary to
reorganize your hierarchy, so that a single entity or module in your RTL contains all
your secured regions. The incremental compilation feature allows functional
independence of each design partition because it disables netlist optimizations across
partition boundaries.

Most of the rules, guidelines, and tools for creating design partitions used in the
incremental compilation flow are applicable in the design separation flow. You can
use the Incremental Compilation Advisor, the Design Partition Planner, and the Chip
Planner features in the Quartus II software to help you create design partition
assignments.

When creating design partitions, the following considerations are important:

m Register the inputs and outputs of a design partition to avoid cross-boundary logic
optimizations and to maintain timing performance along the signal path.

® Minimize the number of I/O paths that cross partition boundaries to keep logic
paths in a single partition for optimization. Minimizing the number of
cross-boundary I/O paths makes partitions more independent for both logic and
placement optimization.

m  Avoid logic that requires cross-boundary logic optimizations.
“ e For more information about guidelines for creating design partitions, refer to the Best
Practices for Incremental Compilation Partitions and Floorplan Assignments chapter in
volume 1 of the Quartus II Handbook.

When creating your design in the design separation flow, you must be aware of some
restrictions and special considerations that differ from the incremental compilation
flow. For more information about these considerations, refer to the “Merging PLL
Resources” and “Avoiding Multiple Design Partitions With a Secured Region”
sections.

Merging PLL Resources

In the Quartus Il incremental compilation flow without design separation constraints,
the Fitter can use the same PLL resource on the device when multiple design
partitions instantiate a PLL with the same parameters. When you enable the design
separation flow and a design contains one or more secured regions, the Quartus II
software disables PLL merging across design partitions, which helps to maintain the
physical separation between design partitions. The Quartus II software also disables
PLL merging for the entire design, even if LogicLock regions in a Cyclone III LS
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design contain no security attributes. For partitions that require shared PLL resources,
you must instantiate the PLL outside of the design partitions.

Avoiding Multiple Design Partitions With a Secured Region

The Quartus II software does not allow multiple design partitions, including child
partitions and multi-hierarchy partitions. Each secured region, which you designate
after creating design partitions, must contain only a single design partition.

Child partitions are design partitions from a subentity of an existing design partition
and would potentially create multiple design partitions in a secured region, so they
are not allowed in the design separation flow.

You can create multi-hierarchy partitions by merging multiple design partitions from
different branches of the hierarchy. Merge these partitions into a single netlist during
elaboration to enable cross-boundary optimizations during synthesis and fitting, and
result in a single incremental result for each multi-hierarchy partition. Multi-hierarchy
partitions function similarly as single-hierarchy partitions, but must contain
hierarchies from a common parent partition. The Quartus II software does not allow
multi-hierarchy partitions in the design separation flow.

Creating a Design Floorplan with Secured Regions

After creating design partitions, you can create a design floorplan with secured
regions with the Chip Planner and security attributes in the LogicLock Regions
window.

The Quartus II software uses LogicLock location assignments to map logic in your
design hierarchy to physical resources on the device. The Chip Planner provides a
visual floorplan of the entire device and allows you to move and resize your
LogicLock location constraints on the floorplan of the device. The design separation
flow adds a security attribute constraint to each LogicLock region to further constrain
routing to achieve physical isolation between LogicLock regions. Assign signals that
require connectivity between two secured regions or between a secured region and
unsecured logic to a special LogicLock region known as a security routing interface. A
security routing interface is a controlled region that limits the routing of the contained
signals to only the one or two LogicLock regions that this region abuts.

To create fault isolation between secured regions, the design separation flow
selectively shuts off routing around the periphery of a secured region. Because signal
connectivity at the boundary of the secured region is unused, any faults that occur in
the secured region are prevented from adversely affecting neighboring regions. Fault
isolation, when using the design separation flow, is possible because no physical
connection exists to propagate the fault outside of the region.

Cyclone III LS devices use a MultiTrack interconnect architecture that consists of row
and column interconnects that span fixed distances to achieve signal connectivity
between LABs. In the horizontal direction, row interconnects use wire resources that
span 1 LAB, 4 LABs, and 24 LABs. These row-routing resources are direct link
interconnects, R4 interconnects, and R24 interconnects, respectively. In the vertical
direction, routing resources span distances of 1 LAB, 4 LABs, and 16 LABs. These
column routing resources are register chain interconnects, C4 interconnects, and

C16 interconnects, respectively. In the design separation flow, the Quartus II software
disables LogicLock region routing wires (C4, C16, R4, and R16) that cross outside the
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border of a boundary. Each secured region uses an unused boundary (or a fence) of
LABs to guard against the faults from wire resources spanning a length of one LAB
(direct link and register chain routing resources) from affecting a neighboring region.

The rules and guidelines for floorplanning in the design separation flow are similar to
those in a typical compilation flow. However, there are some special considerations
for the relative placement of secured regions in your design floorplan. Because each
secured region is a keep-out region for routing resources from other LogicLock
regions, ensure that a routing path with valid communication interfaces exists
between secured regions. Furthermore, the routing path (encapsulated in a security
routing interface) should not follow a circuitous path and must be simple enough to
meet your timing requirements.

The Fitter cannot generate a placement for LogicLock regions with security attributes.
You must manually place LogicLock regions with security attributes; that is, the size
attribute cannot be Auto, and the state attribute cannot be Floating for any LogicLock
region in a secured design.

L=~  You can use a Fitter-generated floorplan, created without security attributes, as a
starting point to create a final floorplan for the design separation flow.

To use a Fitter-generated floorplan as an initial floorplan, apply Reserved attributes to
LogicLock regions that must be physically isolated from the rest of your design. A
Fitter-generated floorplan with Reserved attributes generates non-overlapping
LogicLock regions. You can modify the initial floorplan by adjusting the relative
placement for each secured region, taking into account the connectivity requirements
for each region.
“ e For more information about using the Chip Planner settings and options, refer to the
Analyzing and Optimizing the Design Floorplan with the Chip Planner chapter in volume 2
of the Quartus II Handbook.

Using Security Attributes

The Security Attributes column in the LogicLock Regions window and the Security
tab in the LogicLock Regions Properties dialog box are available when you license
your version of the Quartus II software specifically for the design separation feature.
Setting the Security attribute applies a constraint to a LogicLock region, making the
region either a secured region or a security routing interface, from where signals enter
or exit a secured region.

The software populates the Signals list with the inputs and outputs of secured regions
after analysis and synthesis. Columns in the Signals list describe the Security Level,
the security routing interface the signal is assigned to, and whether the signal is an
output or input to the region.
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Figure 5-3 and Figure 5-4 show the design separation flow security features in the
LogicLock Regions window and the LogicLock Regions Properties dialog box.

Figure 5-3. Security Attribute Golumn Available in the Design Separation Flow

Region Mame | Size | Width | Height | State | Origin | Reserved Security Attribute
£ CPU_to_top Fixed g 7 Locked #96_Y2 On Security routing interface
51 CPU_wiap 2 Pattern_gen Fixed 18 3 Locked HIT_59 On Securily routing interface
) Ethl_to_Eth2 Fixed o] | Locked K24 32 On Security routing interface
B Eth2_to Pattern_check Fixed 17 8 Lacked HE9NY On Security routing interface
o 51 Ethemet_1_wiapEthemst_1_wrap.. Fixed Locked On 1
.E (1 Ethemet_2_wiapEthemet_2_wrap. Fixed 53 25 Locked =0T On 1
&H £ Pattem_checke_wiap:Patten_ch... Fixed 19 8 Locked HIEYT On 1
ﬁ (21 Pattem_gen_to_Etherl Fixed 1 B Lacked HTE_TE3 On Security routing interface
d
E @ ‘Hecommendalloﬂ. Tof1 for |CPU_to_top j J J |F|un Fitter with Full Incremental Compilation on to obtain mare recommendations

Figure 5-4. Security Tab Availahle in the Design Separation Flow

LogicLock Regions Properties -- CPU

‘General | Size 8Orign | Statistics | Security |

Specify the security settings of the LogicLock region and its signals. A dassified region must either contain exactly one design partition, or pins, or both, as its members.
Signals of a region inherit the region's security level, unless manually lowered. Signals going out of or into a dassified region must do so via a security routing interface.
A security routing interface is a user-created region placed adjacently to at least one dassified region, and has one or more signals assigned to it a5 members.

Security attribute: I1 v|
Signals:
| Signal Security Level | Security Routing Interface | Type i Add...
1 wrap:Ethernet 1 1|Ethernet 1 2
|Ethernet 1 wrap:Ethernet 1 wrap 1jEthernet 1 control port readdatal10] Auto CPU to Ethernstl Region input
|Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal1i] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal12] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal13] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal14] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal15] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal16] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal17] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal18] Auto CPU to Ethernetl Region input
|Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdata[19] Auto CPU to Ethernetl Region input
|Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatali] Auto CPU to Ethernetl Region input
|Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdata[20] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal21] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdata[22] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:Ethernet 1 wrap 1|Ethernet 1 control port readdatal23] Auto CPU to Ethernetl Region input
Ethernet 1 wrap:E et 1 wrap 1JEthernet 1 control port readdata[24] Auto CPU to Ethernetl Region input
Ethernet 1 wrapiEthernet 1 wrap 1IEthernet 1 control port readdatal25] Auto CPU to Ethernetl Redion input ||

Note: List is automatically populated after Analysis & Synthesis and Partition Merge.

oK H Cancel ] Apply

Table 5-1 lists a summary of the Security Attributes available for the design
separation flow.

Table 5-1. Security Attributes for LogicLock Regions (Part 1 of 2)

Security o
Attribute Description

Unsecured Removes the constraint for physical isolation.

Creates a secured region. Physically isolates the LogicLock region by restricting routing resources from
leaving the region. Creates a one-LAB width border of unused logic (LABs, DSP blocks, or embedded
1 memory blocks) around the LogicLock region.

Applying this attribute to a LogicLock region sets the global assignment
LL REGION SECURITY LEVEL 1 forthe LogicLock region.
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Table 5-1. Security Attributes for LogicLock Regions (Part 2 of 2)

Security
Attribute

Description

Creates a secured region. Security attribute 2 represents a stricter level of fault isolation than security
attribute 1. For GCyclone 1l LS devices, implementation of security attribute 2 creates a fence that is two
units tall and one unit wide along the vertical and horizontal dimensions, respectively.

Applying this attribute to a LogicLock region sets the global assignment
LL REGION SECURITY LEVEL 2 for the LogicLock region.

Security
Routing
Interface

Creates a routing interface for signals entering or exiting a secured region. You may use only routing
resources (no logic) in a security routing interface.

Applying this attribute to a LogicLock region sets the global assignment
LL SECURITY ROUTING INTERFACE ON for the LogicLock region.

Using Secured Regions

When you apply a secured region attribute (1 or 2) to an existing LogicLock region,
the LogicLock region must have a fixed size with a locked origin. Each secured region
must have a minimum size of eight-LABs in both the horizontal and vertical
dimensions. A region smaller than 8 x 8 LABs may be non-routable when using the
design separation flow.

The Quartus II software does not allow child regions when creating a secured region
because a secured region contains only a single partition.

Adding 1/0 Pins as Members of Secured Regions

A secured region must contain all required physical device resources to complete
compilation. I/O pads that are members of a secured region must be contained in the
boundaries of the secured region that sources or sinks it. That is, a secured region
must overlap the I/O pads that are members of the region. If the logic in the secured
region instantiates a PLL or a clock block, those physical device resources must also be
overlapped by the region.

You can add I/O pins as members of a secured region using the LogicLock Region
Properties dialog box.

Using Security Routing Interfaces

A LogicLock region with the security routing interface security attribute creates a
routing channel for signals to and from a secured region. You may not place logic in a
security routing interface. Each security routing interface can connect two secured
regions, or a secured region with one or more unsecured regions. If you are
connecting two secured regions, the Quartus II software places a fencing region
around the interface region automatically. You can assign each signal entering or
exiting a secured region to a security routing interface on the Security tab in the
LogicLock Regions Properties dialog box.

For information about assigning signals to a security routing interface, refer to
“Making Signal Security Assignments” on page 5-19.

For information about the number of signals that you can contain in a security routing
interface, refer to “Routing Restrictions” on page 5-27.
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Making Design Separation Flow Location Assignments in the Chip Planner

The Chip Planner allows you to modify the size and location of LogicLock regions
visually. This section describes the attributes of LogicLock regions in the context of the
design separation flow.

When you enable the design separation flow, the Chip Planner shades the fencing
region around each secured region in gray and security routing interfaces in green.
The Chip Planner highlights illegal placements that violate secured region boundaries
in red at the location in which the violation occurs. Figure 5-5 shows the LogicLock
regions with security attributes in the Chip Planner.

Figure 5-5. LogicLock Regions With Security Attributes
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Notes to Figure 5-5:

(1) Floorplan Editing Mode task.

(2) Unused fence around a secured region.

(3) Security violation, created by a LogicLock region placement in a fencing region of a secured region.
(4) Security routing interface region connecting two secured regions.

(5) Security routing interface region connecting secured region and unsecured logic.
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Understanding Fencing Regions

The Quartus II software automatically adds a fencing region, which is a border of
unused logic (LABs, DSP blocks, or embedded memory blocks) when you apply
security attribute 1 or security attribute 2 to a LogicLock region. You may not place
any logic into a fencing region. The Fitter does not use any routing wires that exit the
fence boundary of a secured region. Because you can use direct drive and carry chains
at the edge of a secured region, the fencing region prevents signals driven on one
length one wires (in the horizontal and vertical directions) from exiting the secured
region.

The fencing region around a secured region uses one unit of unused logic horizontally
and one unit of unused logic vertically for security attribute 1. A fencing region for
LogicLock regions of security attribute 2 uses one unused logic block horizontally and
two unused logic blocks vertically. The following regions require special fencing
regions:

m Vertical I/O regions
m Areas around the configuration engine

I/0 banks along the top and bottom of the chip use only vertical routing wires to and
from the I/O Elements (IOEs). The heavy use of C4 wires from IOEs creates a

four- LAB fence between the vertical I/O banks and a secured region. Secured regions
requiring a connection to I/O in the top or bottom banks of the device optimally use
resources if you add the I/O signals as members of the secured region and overlap the
corresponding I/O pads in the floorplan. In Figure 5-6, Secured_Region?2 is five
LABs away from the bottom of the device and Secured-Region1 is four LABs away
from the bottom of the device.

Figure 5-6. Vertical Fencing Near 1/0 Banks

Secured_Regionl Secured_Region2
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A configuration engine is a hard IP block that manages the configuration of the
device. Additionally, the configuration engine routes the control signals for the CRC
detection circuit and the internal oscillator into the core logic on the device. In the
design separation flow, the Quartus II software automatically adds a one-LAB fence
around the configuration engine whenever a secured region occupies the same LAB
column as the configuration engine. The configuration engine is a region notched out
of the left side in the middle of the device.

All control signals to and from the configuration engine route from its right edge. If
you use an instantiated WYSIWYG that uses any control signals to and from the
configuration engine, the signals must either interface with unsecured logic or they
must interface with a secured region through a security routing interface.

L=~ 1If your design routes signals to and from the configuration engine, then do not place a
secured region that directly abuts the configuration engine signal interface (along the
right side of the configuration engine) to avoid a Fitter error.

Figure 5-7 shows a configuration engine with a fencing region in the floorplan.

Figure 5-7. Configuration Engine

Configuration Engine

Configuration Engine
Signal Interface

Secured_Regionl

You can overlap fencing regions between two secured regions. That is, you can
separate two adjacent secured regions by a one-row fence. The Chip Planner issues a
security warning violation if you place a LogicLock region in the boundary of a
secured region. The Chip Planner highlights security violations in red and the tooltip
of a secured region indicates the locations of all security violations. You may receive
an error if you try to compile a design with a security violation. Figure 5-8 shows two
regions with overlapping fences and a security violation from an unsecured region.
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Figure 5-8. Overlapping Regions
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Creating Non-Rectangular Regions

You can create non-rectangular regions by creating multiple rectangular regions and
then merging them.

(@) For more information about creating non-rectangular regions in the Chip Planner in
the Quartus II software, refer to Creating and Manipulating LogicLock Regions in
Quartus II Help.

Non-rectangular LogicLock regions in the design separation flow make circuitous
routes more likely. As such, non-rectangular regions can have an adverse affect on
performance when used with the design separation flow.

If a secured non-rectangular region contains a subregion that is less than 8 x 8 LABs,
the chances of a non-routable situation occurring increases. Subregions that
deterministically require the use of certain routing resources may not fit successfully
if a violation of the secured region occurs. As a general guideline, each subregion
should be 8 x 8 LABs or larger, to ensure that routing resources with a length of four
LABs are readily available. In Figure 5-9, each subregion of Region 2 (labeled A, B, C,
and D) are less than 8 x 8 LABs in dimension. These subregions can potentially cause
a no-fit error. Depending on the placement and connectivity of LABs, certain routes
may be difficult to achieve. For example, the Fitter would not be able to route a
connection from LAB 1 to LAB 2 in region A directly. While another path may be
possible, a series of hops that do not leave the LogicLock region may not be available
and may not satisfy the timing requirements of the route.
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Figure 5-9. Non-Rectangular LogicLock Regions

Guidelines for the Relative Placement of Secured LogicLock Regions

Because each secured region is a keep-out region for placement and routing of any
logic that is not a member of the secured region, you must be aware of the guidelines
in this section as you lay out your floorplan. Placement that does not account for the
connectivity requirements between LogicLock regions may cause poor performance
or a non-routable design. The guidelines for floorplanning when using the design
separation flow include:

m Create a complete floorplan, including location assignments for unsecured logic.

m Create a non-circuitous route between secured regions requiring a routing region.
Routing regions between secured regions should be rectangular.

m Create security routing interfaces between secured regions that do not intersect
with other routing regions; secured regions and their routing edges must fit on a
single plane. A secured region must overlap any physical resources (such as I/Os,
PLLs, and CLKCTRL) that the design partition in the secured region instantiates.

m  Abut the secured region to the edge of the device whenever possible.

Creating a Complete Floorplan

You must allocate a region for all logic in your design. If you have a large secured
region that divides the device into multiple disjointed regions, and you have
unsecured logic that is not floorplanned, the design may not be routable.

If an unsecured partition does not contain any location assignments, the placement
algorithms may make logic assignments on any unallocated space on the device. In
the floorplan shown in Figure 5-10, the source and sink registers do not have a valid
path through the device, because Secured Region 1 and Secured Region 2 occupy all
routing channels.
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Figure 5-10. Non-Routable Placement Example

If a complete floorplan is impossible for all partitions in your design, you can use
empty LogicLock regions with the Reserved attribute to prevent the Fitter from
placing any logic in a region that can potentially cause a no-fit error. For the example
provided in Figure 5-10, you can place an empty region in the upper-left corner of
your device to prevent the Quartus II software from placing any logic that has not
been floorplanned there, as shown in Figure 5-11.
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Figure 5-11. Empty Reserved Region Preventing Fitter From Placing Logic

Ensuring Routability Between Regions

The Quartus II software cannot create auto-generated location constraints for any
region with a security attribute. If you use a Fitter-generated placement as a starting
point for a floorplan with security attributes, an optimal floorplan in a design without
separation may not work in the same design. In a floorplan without secured regions,
the Quartus II software restricts only the placement of logic. The Fitter may use all
routing resources on your device, and may route through a LogicLock region to reach
a destination. Secured regions reserve all routing resources in the LogicLock
boundary to the design partition contained in the region.

Having a circuitous route between two regions degrades performance and may cause
a non-routable design. Modify any regions that have signal connectivity and must
route around a secured region to achieve a connection. Figure 5-12 shows a floorplan
that does not contain disjointed parts. However, the source region must route around
a secured region to connect to the sink region.
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Figure 5-12. Relative Placement of Regions Containing a Circuitous Path

Secure
Region

Source | Sink
Region Region

Ensuring Planarity

The Quartus II software automatically creates a fence around a security routing
interface connecting two secured regions. Because no other routing resources may
pass through a security routing interface connecting two secured regions, you must
model all secured regions as nodes in a routing graph and all security routing
interfaces as the edges, and all nodes and their edges must fit on a planar graph (that
is, none of the edges can intersect). If you have five or more secured regions on the
device, and each secured region contains signals that fan out to multiple secured
regions, a planar floorplan may not be possible. Figure 5-13 shows a routing graph
with five nodes. A complete graph with each pair of distinct vertices connected by an
edge is impossible without having any of the edges cross. If the topology of your
floorplan contains such a non-routable arrangement, you must rearrange your design
hierarchy to collapse related design partitions into a single design partition.

Figure 5-13. Non-Planar Routing Graph: Connection BD Not Possible

If you can model your secured regions and security routing interfaces as a planar
graph, but have a high degree of connectivity between the components, then you may
have to rearrange the shape, size, or location of the secured regions to generate a
routable floorplan. For instance, the hypothetical floorplan shown in Figure 5-14 does
not have a valid routing path BD (between region B and region D). The modified
floorplan in Figure 5-15 shows how you can achieve all the required connections on a
planar surface.
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Figure 5-14. Floorplan with Non-Routahle Connection BD
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You can use the Design Partition Planner for a visual representation of the
connectivity between design partitions. This tool helps you determine if you can
arrange the secured regions in your design on a planar floorplan. Figure 5-16 shows
the Design Partition Planner.

Quartus Il Handbook Version 13.1 June 2012  Altera Corporation
Volume 1: Design and Synthesis



Chapter 5: Quartus Il Design Separation Flow 5-19
Making Signal Security Assignments

Figure 5-16. Design Partition Planner
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Placing Physical Resources

You must contain all physical resources that the secured region requires inside the
boundary of the secured region, including I/O pins that connect to the secured region
and primitives that you instantiate in the secured region, such as PLLs and clock
control blocks.

Making Signal Security Assignments

Each signal that enters or exits a secured region must have a security level attribute.
You must also explicitly assign the signal to a security routing interface. The
Quartus II software automatically assigns the security level for each signal a default
value. The default value matches the secured region that is the source of the signal.
Possible security levels of a signal include: Auto, Unsecured, 1, and 2. Auto sets the
default security level for the signal.

A signal with a security attribute may connect to a region with an equivalent or higher
security level. For example, a signal with a security level of Unsecured can drive logic
in a region set to Unsecured, 1, or 2 and a signal with a security level of 1 can drive
logic in a region set to 1 or 2. A signal originating from a secured region may not drive
logic in a region with a lower security level. If you have a signal from a higher security
level that must drive logic in a lower security level, you can direct the Fitter to honor
the connection by explicitly lowering the security level of the signal.

At most, each security routing interface connects two regions. If a signal fans out to
multiple regions, assign the signal to multiple security routing interface regions; one
interface region per destination.

You can assign signals to security routing interfaces and the security level of signals
with the Security tab in the LogicLock Region Properties dialog box, as shown in
Figure 5-4.
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To assign a signal to a security routing interface, follow these steps:

1. On the Security tab of the LogicLock Regions Properties dialog box, select a
signal name in the Signals list, and then click Edit. The Edit Security
Assignments for Signal dialog box appears, as shown in Figure 5-17.

"=~ Alternatively, you can select multiple names in the Signal list by pressing
the Ctrl key, clicking multiple names, and then clicking Edit.

The Quartus II software populates the Signals list with the names of signals
entering and exiting the secured region after analysis and synthesis and after
completing a successful partition merge.

Figure 5-17. Edit Security Assignments for Signal Dialog Box
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2. If necessary, lower the security level of the signal by specifying the Security level.

3. Select the security routing interface for signal or signals assignment. You can
assign signals that fan-out or fan-in to multiple regions to multiple security
routing interfaces.

Understanding Signal Names

The list of signals entering and exiting a secured region consists of signal names from
the post-map netlist. Signal outputs from a secured region derive from the output port
name, as specified in the top-level RTL entity in the secured region. Signal inputs to a
secured region derive from the name of the output port name that feeds the secured
region. In the design separation flow, the Quartus II software preserves output port
names through the compilation process. The output port name is also an alias for the
logic or register that feed them.

The post-map region output signals listed in the signal list coincide with the signal
name in the post-fit netlist. However, combinational signal names from unsecured or
unpartitioned logic that feed a secured region may change through the compilation
process. The Quartus II software optimizes many of the RTL signals during synthesis
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and placement and routing. Frequently, RTL signal names may not appear in the
post-fit netlist after optimization. For example, the compilation process can add tildes
(~) to nets that fan-out from a node, making it difficult to decipher which signal nets
they actually represent. Use the post-compilation filter in the node finder to add
additional signals to a security routing interface. When possible, use registered signals
as inputs into a secured region, and register the output signals from a secured design
partition.

Working with Global Signals

Global signals are low-skew routing lines that drive throughout the device. Global
signals do not require an interface region to drive into a secured region. Cyclone III LS
devices contain 20 global routing resources for use with high fan-out signals, such as
clocks or control signals. A clock control block accesses each global signal. You can
drive each clock control block directly by external clock pins, PLL outputs, or a signal
generated from internal logic. You can locate a clock control block on the periphery
boundary of your device.

For more information about the clock networks in Cyclone III LS devices, refer to the
Clock Networks and PLLs in Cyclone 11l Device Family chapter in volume 1 of the
Cyclone 11I Device Handbook.

In a compilation flow without security assignments, the Quartus II software
automatically promotes signals with a high fan-out (such as clock pins and control
signals) to use global clock resources. In the design separation flow, the Quartus II
software disables automatic global promotion. You must manually promote signals
with high fan-out requiring global routing resources to drive a clock control block.

The Quartus II software cannot promote signals onto a global routing resource
through a global signal assignment from within a secured region. The Fitter only
allows a clock promotion assignment to a signal if the signal is in an unsecured region.
If you have a signal inside of a secured region that must use a global routing resource,
you must first route the signal outside of the secured region before applying a global
promotion assignment. You must assign the signal to a security routing interface and
lower the security level of the signal.
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To honor a global promotion assignment, a clock control block that is not overlapped
by a secured region and a routing path to the clock control block must be available.
There are five clock control blocks located on each side of the device, along the
horizontal and vertical axes that run through the center of the device. Figure 5-18
shows the location of the clock control blocks and the PLLs for a 3CLS70 device in the
Chip Planner floorplan.

Figure 5-18. PLL and Clock Control Block Location on a EPC3SL70 Device
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You can manually instantiate PLLs and clock control blocks in the design partition of
a secured region using the ALTPLL and ALTCLKCTRL megafunctions, respectively.
Instantiation of the ALTCLKCTRL megafunction in a secured partition forces the
global promotion of the signal driving the clock control block. To generate a valid
placement when you instantiate PLLs or a clock control block, the secured region

containing the physical resource must overlap a free PLL, a free clock control block, or
both.

You must be aware of certain restrictions when you instantiate a PLL in a secured
region. Secured regions with a PLL fed by an external clock pin must contain the PLL
and a valid clock pin that can drive the PLL. Each PLL has a set of dedicated clock
control blocks that it can access, located to the right (clockwise) of the PLL in the
device floorplan.

Because automatic promotion of signals onto a global resource is not allowed, you
must not place a PLL and the clock control block that the PLL drives in the same
secured region. If your design has a PLL inside of a secured region, you must assign
the PLL output to a security routing interface and then lower the security level of the
PLL output.

A secured region must not cover the clock control block associated with the PLL.
There are two sets of dedicated clock pins that can drive a PLL input. The pads for the
clock input pins are co-located with the clock control blocks. If you use the clock input
pin that is co-located with the clock control block associated with the PLL, you cannot
add the clock pin as a member of the secured region. Instead, you must either assign
the clock pin to a security routing interface that connects with the secured region, or
you can apply the LL._IGNORE_IO PIN_SECURITY CONSTRAINT assignment to relax the
fitter restriction on the clock input pin.

For more information about the LL,_ IGNORE IO PIN SECURITY CONSTRAINT
assignment, refer to “Assigning I/O Pins” on page 5-25.

Figure 5-19 shows examples of valid placement and invalid placement of secured
regions that instantiate PLLs, before applying the
LL IGNORE IO PIN SECURITY CONSTRAINT assignment.
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Figure 5-19. Location of Valid and Invalid PLL, Clock Pin, and Clock Control Block Placement in a Cyclone Il LS Device
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This secured region contains a PLL whose output drives a clock control block in the same secured region. This placement is invalid.

This secured region contains a PLL that an external clock pin feeds, whose outputs drive the clock control block through an unsecured region.
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Assigning I/0 Pins

CAUTION

After ensuring that signals that enter or exit a secured region contain a security level
attribute and after you have explicitly assign the signals to a security routing
interface, you must also ensure that I/O pin assignments adhere to design separation
flow guidelines. Consider the following three rules, in addition to the typical pin
assignment rules, when assigning I/O pins with the design separation flow enabled:

®  You must assign I/O pins that connect to a secured region as a member of that
secured region or to a security routing interface region that abuts the secured
region.

B You must ensure that secured regions with I/O pins as members do not share I/O
banks with any other region.

B You must ensure that I/O pins associated with different secured regions or
security levels do not use adjacent pins.

When /0 pins directly connect to the secured region, you may add I/O pins as
members of a secured region. To add I/O pins as members of a secured region, in the
LogicLock Regions Properties dialog box, on the General tab, click Add node. If an
I/0 pinis a member of a secured region, the I/O pad must be physically in the region,
and the secured region must overlap the I/O resource.

If you do not add the I/O pin as a member of the secured region, you must assign the
I/0 signal to a security routing interface that abuts the secured region. This security
routing interface must connect the secured region to the root region or another
unsecured region. Explicitly lower the security level of any output signals from the
secured region that connects to I/O pins.

1/0 signals that route out to unsecured logic are no longer guaranteed to be
physically isolated from other signals in your design.

Each I/0 pin is adjacent to eight other pins: four along the horizontal and vertical
axes, and four in the two diagonal axes, as shown in Figure 5-20.

Figure 5-20. Pin Adjacency
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Pins from different I/O banks may not share an adjacent I/O pin if one of the I/O
banks contains pins that are members of a secured region. You must assign user I/O
pins that are adjacent to a signal in a secured region, which belong to a different I/O
bank than the secured signal, to GND in the Quartus II software. For example, in
Figure 5-20, pin E4 is assigned a signal from a secured region, and I/O banks 1 and 7
belong to different LogicLock regions. Pins D4 and D5 are assigned to GND to ensure
that no signal adjacencies exist between the I/O banks.

As a rule, you must assign all unused I/0 pins to GND in the Quartus II software and
to a ground plane on the PCB. By default, the Quartus II software assigns unused pins
to GND. You can configure this option in the Unused Pins page of the Device and Pin
Options dialog box.

If you must relax a particular I/O restriction for specific signals to meet your design
requirements, you may use the LL_IGNORE_IO PIN_ SECURITY CONSTRAINT assighment.
The Quartus II software uses the assignment to bypass normal I/O pin checks for a
specific signal. For example, you can apply this assignment to a clock pin assigned to
one of the dedicated clock inputs.

['=~ Apply the LL_IGNORE IO PIN SECURITY CONSTRAINT assignment in the Quartus
Settings File (.qsf) located in the project directory of the active design. Each project
revision contains a single .qsf.

To disable the I/O signal rule check for the specified pin name in the .qsf, add the
assignment line:

set instance assignment -name LL IGNORE IO PIN SECURITY CONSTRAINT ON -to
<pin name>
“ e For more information about the pinouts and pin adjacencies for Cyclone ITT LS
devices, refer to the Cyclone I1I Device Pin-Out tables. For more information and
guidance about I/O assignments, refer to the Cyclone III Device Family Pin Connection
Guidelines for Cyclone III LS devices and the [/O Management chapter in volume 2 of
the Quartus I Handbook.

Making Post Compilation Edits

Engineering Change Orders (ECOs) and the rapid recompile feature make
incremental changes to routing in a post-fit netlist. ECOs are small changes made to
the functionality of a design after the design has been fully compiled. A design is fully
compiled when synthesis and placement and routing are completed.

The design separation flow supports any ECOs that do not affect routing, such as
changing the LUT mask on an ALM. The design separation flow does not permit
ECOs that affect routing or make incremental changes to the routing in a post-fit

netlist.

(@ For more information about Rapid Recompile option in the Quartus I software, refer
to Incremental Compilation Page (Settings Dialog Box) in Quartus II Help.
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Routing Restrictions

During the overall planning of your design, you must be aware of specific design

separation flow routing restrictions, especially during the floorplanning stages. This
section discusses these routing restrictions.

Column and row interconnect routing resources on Cyclone III LS devices are

staggered, with a group of routing elements that starts at each LAB location. The LAB
location in which the wire starts drives each routing element. The routing element can
reach any LAB destination along the length of the routing element. Figure 5-21 shows
a set of staggered R4 interconnects.

Figure 5-21. Staggered R4 Interconnects
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The Fitter disables routing wires near the edge of a secured region, in which routing is
confined in the region. Figure 5-22 shows the Chip Planner displaying used routing
elements in a design with secured regions, using options in the Layer Settings dialog
box and using the background color map I/O banks, with only the Global Routing
and Used Resources options turned on.

Figure 5-22. Chip Planner View of Used Resources

Figure 5-22 shows that no routing resources reach outside of LogicLock region
boundaries, except for global routing signals and signals through interface regions.

Long wires are often unusable in secured regions because their length extends beyond
the border of the region. If a secured region abuts the device boundary, you can often
attain an increase in routability, because you can use all the routing interconnects that
start inside the region and drive toward the edge of your device.

I/0 pads along the top and bottom of the device can only use column interconnects to
drive into the device fabric. The shortest routing element from the I/O to core logic is
a C4 routing wire. I/O pads on the left and right sides of the device can use both C4
and R4 routing elements to reach their LAB destinations. Because the Quartus II
software restricts column I/Os from using C4 interconnects going into your device,
the Quartus II software creates a four-LAB fence around secured regions when the
boundary of the secured region is in four-LABs of the top and bottom 1/0O pads.
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Secured regions should be sized at a minimum of 8 x 8 LABs. If a region is smaller
than 8 x 8 LABs, a connection between two LABs that violates the secured region
boundary may occur. For example, in Figure 5-23, any elements along the middle axis
of the 7 x 7 LAB array cannot use any C4 or R4 routing elements, because a C4 routing
element would reach outside the secured region.

Figure 5-23. 7x7 LAB Array
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Number of Signals in Routing Interfaces

In Cyclone III LS devices, every LAB location has 68 routing elements (R4) driving
horizontally in each direction and 48 routing elements (C4) driving vertically in each
direction. An individual LAB can directly drive 17 connections in the horizontal
direction and 12 in the vertical direction. To guarantee routability, Altera recommends
that you have a routing interface height of at least one LAB for every 17 signals
routing either left or right, and a routing interface width of one LAB for every

12 signals routing either up or down.

Figure 5-24, Table 5-2, and Table 5-3 illustrate this concept. Figure 5-24 shows three
secured regions with two security routing regions; one routing signals horizontally
and the other routing signals vertically. Table 5-2 and Table 5-3 list the maximum and
the recommended number of signals crossing each security region.
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In Figure 5-24, Hpis both the smaller of the height of the region and the height of the
routing interface. The minimum W is one LAB. Wy is both the smaller width of the
region and the width of the routing interface. The minimum Hpc is one LAB.
Changing W or Hpc does not affect the values in Table 5-3.

Figure 5-24. Signals Crossing a Routing Interface
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Table 5-2. Maximum Number of Signals Assigned in an Interface Region

From
To
A B H
— 68 x Hpg —
68 X HAB - 48 X WBC
- 48 X VVBC —
Table 5-3. Recommended Number of Signals to Ensure Routability
From
To
A B C
A - 17 X HAB —
B 17 X HAB - 12 X WBC
- 12 X VVBC —_—

As a general guideline, keep the security routing interface channel width between the
two connecting secured regions as short as possible and the depth of the channel as
wide as possible. The channel width is the number of LABs that a security routing
interface abuts and the depth of the channel is the number of LABs a signal passes as
it goes through the routing channel.
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In Figure 5-25, an optimal security interface for routing AB would have a channel
width equal to the height of secured region A (H,p) and a channel depth of one LAB
(Wap). Having a wide channel with a short depth increases the number of routing
resources available between two secured regions.

You can use the Routing Congestion task in the Chip Planner for a visual
representation of the routing utilization between secured regions. The Routing
Congestion task filters routing resources by type. Utilization of each routing resource
type is highlighted on a color gradient over the range that you specify. This tool can
help you adjust region sizes and security routing interface channel widths to help you
achieve an optimal floorplan. Figure 5-25 shows a design with the Routing
Congestion task in the Chip Planner and R24 routing utilization.

Figure 5-25. Routing Congestion
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Application Example: Modifying a Fitter-Generated Floorplan for the
Design Separation Flow

In this application example, the design contains five partitions that you must pack
into secured regions. Figure 5-26 shows a block diagram of the design, the entities of
the design, and the connectivity between the five secured partitions.

Figure 5-26. Connectivity hetween Five Secured Partitions
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Connection to /O <¢—® Secure Region 3

Secure Region 5

The following steps outline a recommended design flow for creating a floorplan for
this design:

1. Create a LogicLock region for each partition that you must pack into a secured
region.

2. Set each LogicLock region with the following settings:
m Size set to Auto,
m State set to Floating,
m Reserved set to On, and
m Security Attributes set to Unsecured.

& Running an initial placement with these settings generates non-overlapping
LogicLock regions that can be used as an initial floorplan.

3. On the Processing menu, point to Start and click Start Early Timing Estimate to
run an initial placement and routing. The initial placement and routing
approximates the size of each region and the general placement of the LogicLock
regions relative to other LogicLock regions to achieve timing closure. Figure 5-27
shows the floorplan that the early timing estimate generates.

Quartus Il Handbook Version 13.1 June 2012  Altera Corporation
Volume 1: Design and Synthesis



Chapter 5: Quartus Il Design Separation Flow 5-33
Application Example: Modifying a Fitter-Generated Floorplan for the Design Separation Flow

Figure 5-27. Initial Fitter-Generated Floorplan
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In the LogicLock Regions window, select the LogicLock regions, right-click, and
then click Set Size and Origin to Previous Fitter Results.

Use the Design Partition Planner to view the connectivity between the different
regions. You can experiment with the relative placement of the blocks by dragging
and dropping each design partition. The wire bundles between design partitions
help you to determine a placement that has non-overlapping routing channels.

"=~ You must also consider the connectivity to the I/O banks when arranging
your floorplan. You can toggle the display of the connections between the
partitions and the I/O banks in the Design Partition Planner to help you
properly allocate I/O resources and to avoid conflicts between I/O
connections and inter-partition signals. To display routing between
partitions and the I/O banks, turn on Display connections to I/O banks in
the Bundle Configuration dialog box.

Set each LogicLock region to the necessary security attribute.

In the Chip Planner, adjust the size and placement of each LogicLock region using
the relative placement you created with the Design Partition Planner. Altera
recommends the following considerations when modifying your floorplan:

m  The floorplan must be complete. If unsecured logic that is non-contiguous due
to the placement of a secured region is present, use an empty reserved
LogicLock region to prevent a non-routable placement.

m  Each secured region must be a minimum of 8 x 8 LABs.

m  Each region that has I/O pins added as members of the LogicLock region
should overlap the I/O bank to which it is connected. You can use the I/O
bank background color map to visualize the boundaries between the I/O
banks (Figure 5-28).

m A secured region must not cover all global resources that unsecured logic
require (such as clock pins and PLLs).
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Figure 5-28. 1/0 Banks Layers Setting for Viewing Connectivity of LogicLock Regions to 1/0 Banks

e T ¥V B | F 3D L

[ Etemett | Patiern Gencrai{_cru___|

Layers Settings

|Rnuhng Congestion™ v| |Z|

[ Delete ][ Reset ][ Reset Al ]

Enter new task name to save:

|Rnuﬁng Congestion | [ Save

= iBackaround
None
Block Utlization
Routing Utilization

| 1j0 Banks
High-zpeed/Low-power Tiles
Design Partition Planner

= id.un:k Regions

User-assigned LogicLock Regions
Fitter-placed LogicLock Regions
= Clock Regions

| Global Clock Region
| Local Clock Region

il

+| LVDS Clock Region
v| Quadrant Clock Region

-

ww
=1

ifi | @ | %

8. Create security routing interfaces between each of the secured regions. Assign all
signals entering or exiting a region to a security routing interface.

Figure 5-29 shows the final floorplan result for this application example.

Figure 5-29. Final Floorplan
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Report Panels

After the Fitter successfully places and routes your design with secured regions, the
Quartus II software generates security reports. Use the security reports to review the
secured regions, their associated routing interfaces, all inputs and outputs from each
secured region, and the I/O bank usage for each secured region. You can locate the
security reports in the Fitter section of the Compilation reports.

Secured LogicLock Region Summary

This report provides a summary of all secured regions in your design. Table 5-4
describes each column in the Secured LogicLock Region Summary report.

Table 5-4. Secured LogicLock Region Report

Column Name

Description

Secured LogicLock Region

Lists all secured LogicLock regions in the design.

Security Attribute

Lists the security attribute (unsecured,1, 2, or security routing interface) of the LogicLock
region.

Partition Assigned

Lists the design partition assigned to the secured region.

Number of Input Signals
(Total Fanout)

Lists the number of inputs and fan-outs into a region. The input counts the number of unique
drivers that feed a secured region. The fan-out counts the total number of unique destinations
being fed by the input signals into the secured region. Figure 5-30 shows input signals and
fan-outs to a region.

Number of Qutput Signals
(Total Fanout)

Lists the number of outputs and fan-outs from a region. The output counts the number of
unique drivers sourcing a signal from the secured region. The fan-out counts the total number
of unique destinations fed by the output signal.

Figure 5-30. Input Signals and Fan-Outs to a Region

Secured Region B

Secured Region A Set

CLRN

Secured Region A - Number of Output Signals (Total Fanout) : 1
Secured Region B - Number of Input Signals (Total Fanout) : 1

Security Routing Interfaces

This report summarizes the security routing interfaces. Table 5-5 describes each
column in the Security Routing Interfaces report.
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Table 5-5. Security Routing Interface Report

Column Name

Description

Interface Name

Lists all security routing interfaces in the design.

Abutting Region A

First region that the security routing interface abuts (touches the border of the secured
region).

Abutting Region B

Second region that the security routing interface abuts (touches the border of the secured
region).

Number of Signals A to B
(Total Fanout in B)

Lists the number of signal connections between region A and region B. The counts are shown
as signals and fan-outs. Signals list the number of unique drivers from region A. Fan-out lists
the number of unique destinations in region B that are fed by region A.

Number of Signals B to A
(Total Fanout in A)

Lists the number of signal connections between region B and region A. The counts are shown
as signals and fan-outs. Signals list the number of unique drivers from region B. Fan-out lists
the number of unique destinations in region A that are fed by region B.
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Secured LogicLock Region Inputs and Outputs

This set of reports provides a detailed list of every signal that enters or exits a secured
region. There is one report per secured region.

Security 1/0 Bank Usage

This report displays the secured LogicLock region associated with each I/O bank, lists
the number of pins within each region, and lists the number of pins in use. Table 5-6
describes each column in the Secured LogicLock Region Inputs and Outputs report.

Table 5-6. Secured LogicLock Region Input and Output Report

Column Name Description
I/0 Bank Lists all available 1/0 banks on the device.

An 1/0 bank becomes associated with a secured LogicLock region if any portion of the 1/0 bank
Associated Region is covered by the region. If no secured region covers an |/0 bank, “Unsecured Logic” is

displayed, and all pins of the I/0 bank are available for unsecured use.

Pin Locations Used /
Pin Locations Covered
by Region

Displays the ratio of pins with a signal assignment in the I/0 bank to the number of possible 1/0
pin assignments.

Quartus Settings File Syntax

This section contains the syntax description for each Quartus Settings File (.qsf)
assignment in the design separation flow.

LL_SECURITY_ROUTING_INTERFACE
This command changes a LogicLock region assignment to a security routing interface.
Type: Boolean; (ON/OFF—Defaults to OFF)
Syntax:

set_global assignment -name LL SECURITY ROUTING INTERFACE <value> \ -section id
<section identifier> LL, REGION SECURITY LEVEL

LL_REGION_SECURITY_LEVEL

This command identifies the security level of a LogicLock region.
Type: Enumeration—Defaults to UNSECURED

m 1

m 2

m UNSECURED
Syntax:

set_global_assignment -name LL_REGION_SECURITY LEVEL <value> \
-section id <section identifiers>
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LL_MEMBER_OF_SECURITY_ROUTING_INTERFACE

This command assigns an I/O pin from a secured region to a security routing
interface. <value> and <section_id> denote the name of the routing interface region.
<to> specifies the name of the signal.

Type: String

Syntax:

set_instance assignment -name \ LL MEMBER OF SECURITY ROUTING INTERFACE
<value> -to <to> \
-section id <section id>

LL_SIGNAL_SECURITY_LEVEL

This command sets the security level of a signal. The default value is the security level
of the region that generates the signal. This assignment may be used only to lower a
security level.

Type: Enumeration
m UNSECURED
1
m 2

Syntax:

set_instance assignment -name LL SIGNAL SECURITY LEVEL <value> \
-to <to> -section_id <section_id>

Document Revision History

Table 5-7 lists the revision history for this chapter.

Table 5-7. Document Revision History (Part 1 of 2)

Date Version Changes

June 2012 12.0.0 | = Removed survey link.
m Updated Table 51 on page 5-8.
m Updated “Using Secured Regions” on page 5-9 and “Understanding Fencing Regions” on

November 2011 11.1.0 page 5-11.

m General editorial update.
m Template update.
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Table 5-7. Document Revision History (Part 2 of 2)

Date Version Changes

m Modified the former “Avoiding Child Partitions” section into the new “Avoiding Multiple
Design Partitions With a Secured Region” on page 46 section and added information
about multi-hierarchy partitions.

m Updated the “Using Secured Regions” on page 4-9 section.

m Updated the “Making Design Separation Flow Location Assignments in the Chip Planner’
on page 4-10 section.

m Updated the “Creating a Complete Floorplan” on page 4-14.

December 2010 10.1.0 | = Updated the “Working with Global Signals” on page 4-21 and “Assigning 1/0 Pins” on
page 5-25 sections with information about the
LL_IGNORE_IO_PIN_SECURITY_CONSTRAINT assignment.

m Added the “Making Post Compilation Edits” on page 4-26.
m Updated the “Number of Signals in Routing Interfaces” on page 4-29.
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A |:| =0/ Section 2. System Design with Qsys

This section provides information about Qsys. Qsys is a powerful system integration
tool which is included as part of the Quartus II software. Qsys automates the task of
capturing of integrating customized HDL components, which may include IP cores,
verification IP, and other design modules. You can use Qsys to integrate your own
components with the components that Altera® or third-party developers provide. In
some cases, you can implement an entire design using components from the Qsys
component library.

This section includes the following chapters:
m Chapter 6, Creating a System With Qsys

This chapter provides an overview of the Qsys system integration tool, including
an introduction to hierarchical system design.

m Chapter 7, Creating Qsys Components

This chapter introduces Qsys components and the Qsys component library. It also
provides an overview of the Qsys component editor which you can use to define
custom components.

m  Chapter 8, Qsys Interconnect

This chapter discusses the Qsys interconnect, a high-bandwidth structure for
connecting components that use Avalon® interfaces.

m  Chapter 9, Optimizing Qsys System Performance

This chapter provides information on optimizing system performance with the
Qsys system integration tool. Following the design practices recommended in this
chapter can improve the maximum clock frequency, concurrency and throughput,
logic utilization, or even power utilization of your system.

m Chapter 10, Component Interface Tcl Reference

This chapter describes an alternative method for defining Qsys components by
declaring their properties and behaviors in a Hardware Component Description
File (_hw.tcl). It also provides a reference for the Tool Command Language (Icl)
commands that describe Qsys components.

m Chapter 11, Qsys System Design Components

This chapter describes the structure of Qsys components, with an emphasis on
using the Qsys Component Editor to create the Hardware Component Description
File (_hw.tcl), which describe and package components that you can use in a Qsys
system.
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Qsys is a system integration tool included as part of the Quartus” II software. Qsys captures system-level
hardware designs at a high level of abstraction and automates the task of defining and integrating customized
HDL components. These components include IP cores, verification IP, and other design modules. Qsys
facilitates design reuse by packaging and integrating your custom components with Altera” and third-party
IP components. Qsys automatically creates interconnect logic from the high-level connectivity you specify,
thereby eliminating the error-prone and time-consuming task of writing HDL to specify system-level
connections.

Qsys is more powerful if you design your custom components using standard interfaces. By using standard
interfaces, your components inter-operate with the components in the Qsys Library. In addition, you can
take advantage of bus functional models (BFMs), monitors, and other verification IP to verify your design.

Qsys supports Avalon®, AMBA" AXI3 (version 1.0), AMBA AXI4 (version 2.0), and AMBA APB 3
(version 1.0) interface specifications. Qsys does not support AXI4-Lite.

Qsys provides the following advantages when designing a system:

o Automates the process of customizing and integrating components

« Supports up to 64-bit addressing

+ Supports modular system design

+ Supports visualization of systems

« Supports optimization of interconnect and pipelining within the system
« Fully integrated with the Quartus II software

Related Information

o Avalon Interface Specifications
o AMBA Protocol Specifications
o Creating Qsys Components

e Qsys Interconnect

Component Interface Support

Components can have any number of interfaces in any combination. Each interface represents a set of signals
that you can connect within a Qsys system, or export outside of a Qsys system.
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Qsys components can include the following types of interfaces:

o Memory-Mapped—Implements a partial crossbar interconnect structure (Avalon-MM, AXI, and APB)
that provides concurrent paths between master and slaves. Interconnect consists of synchronous logic
and routing resources inside the FPGA, and implementation is based on a network-on-chip architecture.

+ Streaming—Connects Avalon Streaming (Avalon-ST) sources and sinks that stream unidirectional data,
as well as high-bandwidth, low-latency components. Streaming creates datapaths for unidirectional traffic,
including multichannel streams, packets, and DSP data. The Avalon-ST interconnect is flexible and can
implement on-chip interfaces for industry standard telecommunications and data communications cores,
such as Ethernet, Interlaken, and video. You can define bus widths, packets, and error conditions.

 Interrupts—Connects interrupt senders and the interrupt receivers of the component that serves them.
Qsys supports individual, single-bit interrupt requests (IRQs). In the event that multiple senders assert
their IRQs simultaneously, the receiver logic (typically under software control) determines which IRQ
has highest priority, then responds appropriately.

o Clocks—Connects clock output interfaces with clock input interfaces. Clock outputs can fan-out without
the use of a bridge. A bridge is required only when a clock from an external (exported) source connects
internally to more than one source.

+ Resets—Connects reset sources with reset input interfaces. If your system requires a particular positive-
edge or negative-edge synchronized reset, Qsys inserts a reset controller to create the appropriate reset
signal. If you design a system with multiple reset inputs, the reset controller ORs all reset inputs and
generates a single reset output.

+ Conduits—Connects point-to-point conduit interfaces, or represent signals that are exported from the
Qsys system. Qsys uses conduits for component I/O signals that are not part of any supported standard
interface. You can connect two conduits directly within a Qsys system as a point-to-point connection,
or conduit interfaces can be exported and brought to the top-level of the system as top-level system I/O.
You can use conduits to connect to external devices, for example external DDR SDRAM memory, and
to FPGA logic defined outside of the Qsys system.

Understanding the Qsys Design Flow

Figure 6-1 illustrates a Qsys design flow in which you create a custom IP component and package your
custom HDL as a component using the Component Editor or manually creating a _hw_tcl file. In this
bottom-up design flow, you simulate your custom IP before integrating it with other components as a Qsys
system and complete Quartus II project.
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Figure 6-1: Qsys Design Flow
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In an alternative design flow, you can begin by designing the Qsys system, and then define and instantiate
custom Qsys components, clarifying system requirements earlier in the design process.

Related Information

Creating Qsys Components

Creating a Qsys System

You can create a Qsys system in the Quartus II software by selecting Qsys System File in the New dialog

box, or clicking Tools > Qsys. To open a previously created Qsys design, click Open on the File menu in
the Quartus II software window, or the Qsys window.
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Related Information

Creating Qsys Components

Component Interface Tcl Reference

Adding and Connecting System Contents

The System Contents tab displays the components that you add to your system, and allows you to connect
the interfaces of the modules.

Adding Components

To add a component to your system, select the component in the Library, and then click Add.

When you select a component type and click Add, the new instance is added to your system, and a parameter
editor opens that allows you to customize the new instance. The new instance appears in the System Contents
tab, as well as the Hierarchy tab

You can type some or all of the component’s name in the Library search box to help locate a particular
component type. For example, you can type menor y to locate memory-mapped components, or axi to
locate AXI interconnect components.

Connecting Components
When you add connections to a Qsys system, you can connect the interfaces of the modules in the System
Contents tab. The individual signals in each interface are connected by the Qsys interconnect when the
HDL for the system generates. You connect interfaces of compatible types and opposite directions. For
example, you can connect a memory-mapped master interface to a slave interface, and an interrupt sender
interface to an interrupt receiver interface.

Possible connections between interfaces in the system show as gray lines and open circles. When you make
a connection, Qsys draws the connection line in black, and fills the connection circle. To make a connection,
click the open circle at the intersection of the two interface names. Clicking a filled-in circle removes the
connection.

When you are done adding connections in your system, you can deselect Allow Connection Editing in the
right-click menu, which puts the Connections column into read-only mode and hides the possible
connections. Figure 6-2 illustrates the Connections column.
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Figure 6-2: Connections Column in the Systems Contents Tab
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Related Information

Connecting Components

Filtering Components

You can use the Filters dialog box to filter the display of your system in the System Contents tab. You can
filter the display of your system by interface type, instance name, or by using custom tags. For example, you
can view only instances that include memory-mapped interfaces, instances that are connected to a particular
Nios II processor, or temporarily hide clock and reset interfaces to simplify the display.

Related Information

Filters Dialog Box

Managing Views

Creating a System With Qsys

The View menu allows you to select and open any view (tab). Qsys views allow you to review your design
from different perspectives. Some views allow you to focus on a particular part of the system, while other
views show the same data in another way. Making selections in the system-level views updates other views,
and shows the other views in the context of the system-level selection.

For example, selecting cpu_0 in the Hierarchy tab updates the Parameters tab to show the parameters for
cpu_O.

Note: When you double-click a message in the Messages tab, Qsys selects the associated element in the
relevant view to facilitate debugging.

When you create a new Qsys system, the Library, Hierarchy, and System Contents tabs appear by default.
You can arrange your system workspace by dragging and dropping, and then grouping tabs in an order
appropriate to your design process. All tabs are dockable and you can close, hide, or minimize tabs that you
are not using. Minimized tabs appear minimized in the docking area below the menu bar. Tool tips on tab
corners display possible workspace arrangements, for example, disconnecting or restoring a tab to the Qsys
workspace.
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When you save the Qsys system, the current view arrangement is saved, and when you open the Qsys system,
the last saved view arrangement is restored. You can use the Reset View Layout command on the View
menu to restore the Qsys workspace to its default configuration.

Note: Qsys contains some views which are not documented and appear on the View menu as "Beta". The
purpose in presenting these views is to allow designers to explore their usefulness in Qsys system

development.

Using the Hierarchy Tab
The Hierarchy tab is a full system hierarchical navigator, which expands the system contents to show modules,
interfaces, signals, contents of subsystems, and connections.

The graphical interface of the Hierarchy tab displays a unique icon for each element represented in the

system, including interfaces, directional pins, IP blocks, and system icons that show exported interfaces and
the instances of components that make up a system, as shown in Figure 6-3. In this figure, context sensitivity
between the views is also shown with the r am_nmast er selection highlighted in both the System Contents

and Hierarchy tabs.

Figure 6-3: Hierarchy Tab Expanding Elements in the System Contents Tab
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You can use the Hierarchy tab to browse, connect, and parameterize IP in your system. The Hierarchy tab
allows you to drive changes in other views and interact with your system in more detail. As shown in Figure
6-3, the Hierarchy tab expands each interface that appears on the System Contents tab and allows you to
view the subcomponents, associated elements, and signals for each interface. Use the Hierarchy tab to focus
on a particular area of your system; coordinating selections in the Hierarchy tab with open views in your
workspace. Reviewing your system using the Hierarchy tab in conjunction with relevant views is also useful
during the debugging phase because you can contain and focus your debugging efforts to a single element
in your system.

The Hierarchy tab provides the following information and functionality:

o The connections between signals.
« The names of signals included in exported interfaces.
+ Right-click menu to connect, edit, add, remove, or duplicate elements in the hierarchy.

o The internal connections of Qsys subsystems that are included as components. In contrast, the System
Contents tab displays only the exported interfaces of Qsys subsystems included as components.

Using the Parameters Tab

The Parameters tab allows you to review and change component parameters.

In the Parameters tab, Qsys displays the parameter editor for the current selection in the Hierarchy tab.
When you double-click a component in the System Contents tab, Qsys opens a new window and displays
the Parameters, Block Symbol, and Presets tabs together in a single window.

With the Parameters tab open, when you click an element in the Hierarchy tab, Qsys displays the parameter
editor for the selected element.

In the parameter editor, you can change the name as it appears on the System Contents tab for top-level
instances. Changes you make on the Parameters tab are immediately reflected on open views in your
workspace.

If the current selection is for an interface in the system, the Parameters tab also allows you to review interface
timing. Figure 6-4 shows the timing for the Avalon-MM DMA write master for the PCI Express Subsystem
Example. Qsys display the the read and write waveforms at the bottom of the Parameters tab.
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Figure 6-4: Avalon-MM Write Master Timing Waveforms Available on the Parameters Tab
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Related Information

« PCI Express Subsystem Example on page 6-32

Using the Presets Tab

In this view, Qsys displays the presets for the currently selected component.

The Presets tab allows you to create, modify, and save custom component or IP core parameter values as a
preset file. You can then apply the parameter values in the preset file to the current component that you are
parameterizing.

Related Information

o Presets Editor (Qsys)

Working With Presets for Supported IP Components
Some components provide preset configurations. If the component you are adding has presets available,
then the Presets Editor appears in the editor window and lists presets that you can apply to your component,
depending on the design protocol. When you apply a preset to a component, the parameters with specific
required values for the protocol are automatically set for you.

Note: You can also access the Presets Editor by clicking View > Presets.

You can search for text to filter the Presets list. For example, if you select the DDR3 SDRAM Controller
with UniPHY component, and then type 1g mi cron 256, the Presets list shows only those presets that
apply to the 1g micron 256filter request. Presets whose parameter values match the current parameter settings
are shown in bold.
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Selecting a preset does not prevent you from changing any parameter to meet the requirements of your
design. Clicking Update allows you to update parameter values for a custom preset. The Update Preset
dialog box displays the default value, which you can edit, and the current value, which is static.

You can also create your own preset by clicking New. When you create a preset, you specify a name,
description and the list of parameters whose values are set by the preset. You can remove a preset from the
Quartus II project directory by clicking Delete.

Related Information
Presets Editor

Using the Block Symbol Tab

In this view, Qsys displays the block symbol for the currently selected element.

When the Block Symbol view is open, Qsys displays a graphical representation of the element selected in
the Hierarchy or System Contents tabs. In the Block Symbol tab, the Show signals options allows you to
turn on of off signal graphics, if applicable.

The Block Symbol tab reflects changes made in other views.

Using the Address Map Tab

The Address Map tab provides a table including the memory-mapped slaves in your design and the address
range that each connected memory-mapped master uses to address each slave.

The table shows the slaves on the left and masters across the top, with the address span of the connection
shown in each cell. If there is no connection between a master and a slave, the table cell is empty.

You can design a system where two masters access a slave at different addresses. If you use this feature, the
Base and End address columns of the System Contents tab are labeled "mixed" rather than providing the
address range.

Follow these steps to change or create a connection between master and slave components:

1. In Qsys, click the Address Map tab.

2. Locate the table cell that represents the connection between the master and slave component pair.

3. Either type in a base address, or update the current base address in the cell.

Note: The base address of a slave component must be a multiple of the address span of the component.

This restriction is part of the Qsys interconnect to allow the address decoding logic to be efficient,
and to achieve the best possible fy5x.

Using the Clock Tab

The Clocks tab defines the Name, Source, and frequency (MHz) of each clock in your system.
Click Add to add a new clock to the system.

Using the Project Settings Tab

The Project Settings tab allows you to view and change the properties of your Qsys system.

Table 6-1: System-Level Parameters Available on the Project Settings Tab

Device Family ‘ Specifies the Altera device family.
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Device Specifies the target device for the selected device family.
Clock crossing adapter | Specifies the default implementation for automatically inserted clock crossing
type adapters. The following choices are available:

« Handshake-This adapter uses a simple hand-shaking protocol to propagate
transfer control signals and responses across the clock boundary. This
methodology uses fewer hardware resources than the FIFO type because each
transfer is safely propagated to the target domain before the next transfer can
begin. The Handshake adapter is appropriate for systems with low throughput
requirements.

o FIFO-This adapter uses dual-clock FIFOs for synchronization. The latency of
the FIFO-based adapter is a couple of clock cycles more than the handshaking
clock crossing component. However, the FIFO-based adapter can sustain higher
throughput because it supports multiple transactions at any given time. The
FIFO-based clock crossers require more resources. The FIFO adapter is
appropriate for memory-mapped transfers requiring high throughput across
clock domains.

o Auto-If you select Auto, Qsys specifies the FIFO adapter for bursting links,
and the Handshake adapter for all other links.

Limit interconnect
pipeline stages to

Specifies the maximum number of pipeline stages that Qsys may insert in each
command and response path to increase the fy;,x at the expense of additional
latency. You can specify between 0-4 pipeline stages, where 0 means that the
interconnect has a combinational data path. Choosing 3 or 4 pipeline stages may
significantly increase the logic utilization of the system. This setting is specific for
each Qsys system or subsystem, meaning that each subsystem can have a different
setting. Note that the additional latency is for both the command and response
directions.

Note: You can manually adjust this setting in the Memory-Mapped
Interconnect tab accessed by clicking Show System With Qsys
Interconnect command on the System menu.

Generation Id

A unique integer value that is set to a timestamp just before Qsys system generation
that Qsys uses to check for software compatibility.

Note: Qsys generates a warning message if the selected device family and target device do not match the
Quartus II software project settings. Also, when you open Qsys from within the Quartus II software,
the device type in your Qsys project is replaced with the selected device in your open Quartus II
software project.

Related Information

Manually Controlling Pipelining in the Qsys Interconnect on page 6-20
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Using the Instance Parameters Tab
The Instance Parameters tab allows you to define parameters for a Qsys system. You can use instance
parameters to modify a Qsys system when you use the system as a subcomponent in another Qsys system.
The higher-level Qsys system can assign values to these instance parameters.

The Instance Script on the Instance Parameters tab defines how the specified values for the instance
parameters should affect your Qsys design subcomponents. The instance script allows you to make queries
about the instance parameters you define and set the values of the parameters for the subcomponents in
your design.

When you click Preview Instance, Qsys creates a preview of the current Qsys system with the specified
parameters and instance script, and shows the parameter editor for the instance. This command allows you
to see how an instance of this system appears when you use it in another system. The preview instance does
not affect your saved system.

To use instance parameters, the components or subsystems in your Qsys system must have parameters that
can be set when they are instantiated in a higher-level system. Many components in the Library have
parameters that you can set when adding the component to your system. If you create your own IP
components, you use the _hw.tcl file to specify which parameters can be set when the component is added
to a system. If you create hierarchical Qsys systems, each Qsys system in the hierarchy can include instance
parameters to pass parameter values through multiple levels of hierarchy.

Related Information

Working with Instance Parameters in Qsys

Creating an Instance Script
The first command in an instance script must specify the Tcl command version for the script. This command
ensures the Tcl commands behave identically in future versions of the tool. Use the following Tcl command
to specify the version of the Tcl commands, where <version> is the Quartus II software version number,
such as 13.1:

package require -exact gsys <version>

To use Tcl commands that work with instance parameters in the instance script, you must specify the
commands within a Tl procedure called a composition callback. In the instance script, you specify the name
for the composition callback with the following command:

set _nodul e_property COVPCSI TI ON_CALLBACK <nane of call back procedure>

Specify the appropriate Tcl commands inside the Tcl procedure with the following syntax:

proc <nane of procedure defined in previous command> {}
{#Tcl commands to query and set paraneters go here}

Use Tcl commands in the procedure to query the parameters of a Qsys system, or to set the values of the
parameters of the subcomponents instantiated in the system.
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Table 6-2: Supported Tcl Commands Used in Instance Scripts

get _paraneters None Get the names of all defined
parameters (as a space-separated
list).

get par anet er _val ue <parameter name > Get the value of a parameter.

get _i nst ance_par anet er s | <instance name> Get the names of parameters on a

child instance that can be
manipulated by the parent (as a
space-separated list).

get _i nst ance_par anet er _ | <instance name> Get the value of a parameter for a
val ue child instance.
send_nessage <message level> <message text> Send a message to the user of the

component, using one of the
message levels Error, Warning,
Info, or Debug. Enclose text with
multiple words in quotation
marks.

set _i nst ance_par anet er _ | <instance name> <parameter name> | Set a parameter value for a child
val ue <parameter value> instance.

You can use standard Tcl commands to manipulate parameters in the script, such as the set command to
create variables, or the expr command for mathematical manipulation of the parameter values.

Example 6-1 shows an instance script of a system that uses a parameter called pi 0_w dt h to setthewi dt h
parameter of a parallel I/O (PIO) component. Note that the script combines the get _par anet er _val ue
and set _i nst ance_par anet er _val ue commands using brackets.

Example 6-1: Instance Script Example

# Request a specific version of the scripting API
package require -exact gsys 13.1

# Set the nanme of the procedure to mani pul ate paraneters:
set _nodul e_property COVPCSI TI ON_CALLBACK conpose

proc conpose {} {

# Get the pio_width paranmeter value fromthis ys system and
# pass the value to the width paraneter of the pio_0 instance

set _instance_paraneter_value pio_0 width \
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[ get _paramet er _val ue pi o_wi dt h]

Related Information

Component Interface Tcl Reference

Using the Interconnect Requirements Tab
The Interconnect Requirements tab allows you to assign interconnect requirements for the system or an
interface. The Interconnect Requirements assignments influence Qsys interconnect generation.

Interconnect Requirements settings also appear in other tabs. For instance, the Limit interconnect pipeline
stages option appears on the Project Settings tab.

Selections in the Setting and Value lists vary depending on your selection in the Identifier column.

Configuring Interconnect Requirements for the System
Selecting $syst emin the Identifier list on the Interconnect Requirements tab allows you to apply
system-wide interconnect assignments.

Table 6-3: Settings and Values for the $system Identifier

Limit interconnect pipeline stages to—Specifies the | You can specify between 0-4 pipeline stages, where 0
maximum number of pipeline stages that Qsys may |means that the interconnect has a combinational data
insert in each command and response path to increase | path. Choosing 3 or 4 pipeline stages may significantly
the fyax at the expense of additional latency. increase the logic utilization of the system. This setting
is specific for each Qsys system or subsystem, meaning
that each subsystem can have a different setting. Note
that the additional latency is added once on the

command path, and once on the response path.
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Clock crossing adapter type—Specifies the default |« Handshake-This adapter uses a simple hand-

implementation for automatically inserted clock shaking protocol to propagate transfer control

crossing adapters. signals and responses across the clock boundary.
This methodology uses fewer hardware resources
because each transfer is safely propagated to the
target domain before the next transfer can begin.
The Handshake adapter is appropriate for systems
with low throughput requirements.

o FIFO-This adapter uses dual-clock FIFOs for
synchronization. The latency of the FIFO-based
adapter is a couple of clock cycles more than the
handshaking clock crossing component. However,
the FIFO-based adapter can sustain higher
throughput because it supports multiple transac-
tions at any given time. The FIFO-based clock
crossers require more resources. The FIFO adapter
is appropriate for memory-mapped transfers
requiring high throughput across clock domains.

« Auto-If you select Auto, Qsys specifies the FIFO
adapter for bursting links, and the Handshake
adapter for all other links.

Automate default slave insertion—Specifies whether | True or False
you want Qsys to automatically insert a default slave
for undefined memory region accesses during system
generation.

Configuring Interconnect Requirements for an Interface
Selecting an interface in the Identifier list on the Interconnect Requirements tab allows you to apply
interface interconnect assignments.

Security » Non-secure

« Secure

» Secure ranges

o TrustZone-aware

Note: You can also set these valuess in the Security
column in the System Contents tab.

Secure address ranges Allows you to type in an address valid range.

Add performance monitor True or False

Creating Hierarchical Systems

Qsys supports team-based and hierarchical system design.
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You can include any Qsys system as a component in another Qsys system. In a team-based design flow, you
can have one or more systems in your design developed simultaneously by other team members, decreasing
time-to-market for the complete design.

Figure 6-5 shows the top-level of a Qsys hierarchical design that implements a PCI Express'" to Ethernet
bridge. This example combines separate PCI Express and Ethernet subsystems with Altera’s DDR3 SDRAM
Controller with UniPHY IP core.

Figure 6-5: Top-Level for a PCl Express to Ethernet Bridge
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Hierarchical system design in Qsys offers the following advantages:

 Enables team-based, modular design by dividing large designs into subsystems.
+ Enables design reuse by allowing you to use any Qsys system as a component.

« Enables scalability by allowing you to instantiate multiple instances of a Qsys system.

Adding Systems to the Library

Any Qsys system is available for use as a component in other Qsys systems.

Figure 6-6 shows the library, including the pci €_subsyst emasacomponent in the library for the Figure
6-10 example system. To include systems as components in other designs, you can add the system to the
library, or include the directory for the system in the IP search path for Qsys.
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Figure 6-6: Qsys Library
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Creating a Component Based on a System

The Export System as hw.tcl Component command on the File menu allows you to save the system currently
openin Qsys as an _hw.tcl file in the current working directory. The saved system appears as a new component
in the System category under Project in the Qsys Library.

Qsys 64-Bit Addressing Support

Altera Corporation

Qsys interconnect supports up to 64-bit addressing for all Qsys interfaces and components, with a range of:
0x0000 0000 0000 0000 to OXFFFF FFFF FFFF FFFF, inclusive.

In Qsys, address parameters appear in the Base and End columns on the System Contents tab, on the
Address Map tab, in the parameter editor, and in validation messages. The Qsys GUI displays as many digits
as needed in order to display the top-most set bit, for example, 12 hex digits for a 48-bit address.

A Qsys system can have multiple 64-bit masters, with every master having its own address space. You can
share slaves among masters and masters can map slaves in different ways; for example, one master can
interact with slave O at base address 0000_0000_0000, and another master can see the same slave at base
address c000_000_000.

Qsys supports 64-bit addresses for narrow-to-wide and wide-to-narrow transactions across Avalon-MM
and AXI interfaces.

Quartus II debug tools that provide access to the state of an addressable system via the Avalon-MM
interconnect are also 64-bit compatible and process within a 64-bit address space, including a JTAG to
Avalon master bridge.

For more information about 64-bit support, refer to Address Span Extender in Creating a System with Qsys.
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Related Information

+ Creating a System with Qsys

Creating Secure Systems (TrustZones)

TrustZone is the security extension of the ARM architecture. It includes the concept of secure and non-secure
transactions, and a protocol for processing between the designations. TrustZone security support is a part
of the Qsys interconnect.

In Qsys, you can set memory-mapped interfaces to secure, non-secure, or TrustZone-aware. AXI masters
are always treated as TrustZone-aware. Unless specified, all other master and slave interfaces (such as Avalon-
MM) are treated as non-secure, by default.

Qsys provides compilation-time TrustZone support for non-TrustZone-aware components, for example,
when an Avalon master needs to communicate with a secure AXI slave. For example, the designer can specify
whether the connection point is secure or non-secure at compilation time. You can specify secure address
ranges on memory slaves, if a per-interface security setting is not sufficient.

For TrustZone-aware masters, the interconnect uses the master's AXPROT signal to determine the security
status of each transaction.

Table 6-4 summarizes secure and non-secure access between master, slave, and memory components in
Qsys. Per-access refers to allowing a TrustZone-aware master to allow or disallow a particular access (or
transactions).

Table 6-4: Secure and Non-Secure Access Between Master, Slave, and Memory Components

Transaction Type TrustZone-aware Master | Non-TrustZone-aware Master | Non-TrustZone-aware Master
Secure Non-Secure
TrustZone-aware slave/ | OK OK OK
memory
Non-TrustZone-aware | Per-access OK Not allowed

slave (secure)

Non-TrustZone-aware | OK OK OK
slave (non-secure)

Non-TrustZone-aware |Per-access OK Not allowed
memory (secure region)

Non-TrustZone-aware |OK OK OK
memory (non-secure
region)

If a master issues transactions that fall into the per-access or not allowed cells, as described in the table above,
your design must contain a default slave. A transaction that violates security is rerouted to the default slave
and subsequently terminated with an error. You can connect any slave as the default slave, which allows it
to respond to the master with errors. You can share the default slave between multiple masters. You have
one default slave for each interconnect domain, which is a group of connected memory-mapped masters
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and slaves that share the same interconnect. Use the al t er a_axi _def aul t _s| ave component as the
default slave because this component has the required TrustZone features.

Note: For more information about interconnect domains, refer to Qsys Interconnect.

In Qsys, you can achieve an optimized secure system by partitioning your design. For example, for masters
and slaves under the same hierarchy, it is possible for a non-secure master to initiate continuous transactions
resulting in unsuccessful transfer to a secure slave. In the case of memory aliasing, you must carefully designate
secure or non-secure address maps to maintain reliable data.

Related Information

¢ Qsys Interconnect

Managing Secure Settings in Qsys
To create a secure design, you must first add masters and slaves and the connections between them. After
you establish connections between the masters and slaves, you can then set the security options, as required,
with options in the Security column.

On the System Contents tab, in the Security column, the following selections are available for master, slave,
and memory components:

» Non-secure—Master issues only non-secure transactions. There is no security available for the slave.

» Secure—Master issues only secure transactions. For the slave, Qsys prevents non-secure transactions
from reaching the slave, and routes them to the default slave for the master that issued the transaction.

« Secure Ranges—Slave only, the specified address ranges within the slave's address span are secure; all
others are not. The format is a comma-separated list of inclusiveLow:inclusiveHigh addresses, for example,
Ox0: Oxfff, Ox2000: Ox20f f.

o TrustZone-aware—Master issues either secure or non-secure transactions at run-time. The slave accepts
either secure or non-secure transactions at run-time.

After setting security options for the masters and slaves, you must identify those masters that require a
default slave before generation. To designate a slave as the default slave, turn on Default Slave in the Systems
Contents tab. A master can have only one default slave.

Note: The Security and Default Slave columns in the System Contents tab are hidden by default. You can
turn them on with the right-click menu in the System Contents header.

Understanding Compilation-Time Security Configuration Options
The following compile-time configurations are available when creating secure designs that have mixed secure
and non-secure components:

« Masters that support TrustZone and are connected to slaves that are compile-time secure. This configu-
ration requires a default slave.

o Slaves that support TrustZone and are connected to masters that have compile-time secure settings. This
configuration does not require a default slave.

o Master connected to slaves with secure address ranges. This configuration requires a default slave.

Accessing Undefined Memory Regions
When a transaction from a master targets a memory region that is not specified in the slave memory map,
it is known as an "access to an undefined memory region." To ensure predictable response behavior when
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this occurs, you can add a default slave to the design. All undefined memory region accesses are then routed
to the default slave, which then terminates the transaction with an error response.

You can connect any memory-mapped slave as a default slave. Altera recommends that you have only one
default slave for each domain in your design. Accessing undefined memory regions can occur in the following
cases:

o When there are gaps within the accessible memory map region that are within the addressable range of
slaves, but are not mapped.

o Accesses by a master to a region that does not belong to any slaves that is mapped to the master.

«  When a non-secured transaction is accessing a secured slave. This applies to only slaves that are secured
at compilation time.

o  When a read-only slave is accessed with a write command, or a write-only slave is accessed with a read
command.

To designate a slave as the default slave, for the selected component, turn on Default Slave on the Systems
Content tab.

Note: If you do not specify the default slave, Qsys automatically assigns the slave at the lowest address
within the memory map for the master that issues the request as the default slave.

Viewing the Qsys Interconnect

The System with Qsys Interconnect window allows you to see the contents of the Qsys interconnect before
you generate your system. In this view of your system, you can view a graphical representation of the generated
interconnect. Qsys converts connections between interfaces to interconnect logic during system generation.

You access the System with Qsys Interconnect window by clicking Show System With Qsys Interconnect
command on the System menu.

The system with Qsys Interconnect window consists of the following tabs:

+ System Contents—Displays the original instances in your system, as well as the inserted interconnect
instances. Connections between interfaces are replaced by connections to interconnect where applicable.

« System Inspector—Displays a system hierarchical navigator, expanding the system contents to show
modules, interfaces, signals, contents of subsystems, and connections.

« Memory-Mapped Interconnect—allows you to select a memory-mapped interconnect module and view
its internal command and response networks. You can also insert pipeline stages to achieve timing closure.

The System Contents and System Inspector tabs are read-only. Edits that you apply on the Memory-Mapped
Interconnect tab are automatically updated on the Interconnect Requirements tab.

Using the Memory-Mapped Interconnect Tab

The Memory-Mapped Interconnect tab in the System with Qsys Interconnect window is a graphical
representation of command and response datapaths in your system. These datapaths allow you finer control
over pipelining in the interconnect. Qsys displays separate graphs for the command and response datapaths.
You can access the datapaths by clicking their respective tabs in the Memory-Mapped Interconnect tab.

Each node element in a graph can represent either a master or slave that communicates over the interconnect,
or an interconnect sub-module. Each edge in a graph is an abstraction of connectivity between elements,
and its direction represents the flow of the commands or responses.
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Click Highlight Path to better identify edges and paths between modules. Turn on Show Pipeline Locations
to add greyed-out registers on edges where pipelining is allowed in the interconnect.

Note: You must have more than one module selected in order to highlight a path.

Manually Controlling Pipelining in the Qsys Interconnect
The Memory-Mapped Interconnect tab allows you to manipulate pipleline connections in the Qsys
interconnect. You access the Memory-Mapped Interconnect tab by clicking Show System With Qsys
Interconnect command on the System menu.

Note: To increase interconnect frequency, you should first try increasing the value of the Limit interconnect
pipeline stages to option on the Project Settings tab. You should only consider manually pipelining
the interconnect if changes to this option do not improve frequency, and you have tried all other
options to achieve timing closure, including the use of a bridge. Manually pipelining the interconnect
should only be applied to complete systems.

1. In the Project Settings tab, first try increasing the value of the Limit interconnect pipeline stages to
option until it no longer gives significant improvements in frequency, or until it causes unacceptable
effects on other parts of the system.

2. In the Quartus II software, compile your design and run timing analysis.

3. Identify the critical path through the interconnect and determine the approximate mid-point. The
following is an example of a timing report where the critical path is located in the interconnect.

2.800 0.000 cpu_instruction_master|out_shifter[63]]|q

3.004 0.204 nm domei n_0O| addr _rout er _001| Equal 5~0| dat ac

3.246 0.242 nmm donai n_0| addr _r out er _001| Equal 5~0| conbout

3.346 0.100 nm domai n_0O| addr _rout er _001| Equal 5~1| dat aa

3.685 0.339 nm domai n_0| addr _r out er _001| Equal 5~1| conbout

4.153 0. 468 mm domai n_0| addr _router _001| src_channel [ 5] ~0| dat ad
4.373 0.220 mm domai n_0| addr _r out er _001| src_channel [ 5] ~0|] conbout

4. System > Show System With Qsys Interconnect.

5. Inthe Memory-Mapped Interconnect tab, select the interconnect module that has the critical path. You
can determine the name of the interconnect module from the hierarchical node names in the timing
report.

6. Click Show Pipelinable Locations. Qsys display all pipelinable locations in the interconnect. You can
right-click a pipelinable location to open a menu that allows you to insert or remove a pipeline stage.

7. Find the pipelinable location that is closest to the mid-point of the critical path. The names of blocks in
the memory-mapped interconnect view correspond to the module instance names in the timing report.

8. Right-click the location where you want to insert a pipeline stage, and then click Insert Pipeline.

9. Regenerate the Qsys system, recompile the design, and then rerun timing analysis. If necessary, repeat
the manual pipelining process again until timing requirements are met.

Altera Corporation Creating a System With Qsys

(] Send Feedback


mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Creating%20a%20System%20With%20Qsys%20(QII51020%202013.11.4)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

QI151020
2013.11.4

Integrating Your Qsys Design with the Quartus Il Software 6-21

Manual pipelining has the following limitations:

« If you make changes to your original system's connectivity after manually pipelining an interconnect,
your inserted pipelines may become invalid. Warning messages are displayed at generation time if invalid
pipeline stages are detected. You can remove invalid pipeline stages with the Remove Stale Pipelines
option button in the Memory-Mapped Interconnect tab. Altera recommends not making changes to
the system's connectivity after manual pipeline insertion.

« Review manually-inserted pipelines when upgrading to newer versions of Qsys. Manually-inserted
pipelines in one version of Qsys might not be valid in a future version.

Related Information

Qsys System Design Components

Configuring Interconnect Requirements for the System on page 6-13

Integrating Your Qsys Design with the Quartus Il Software

To integrate a Qsys system into a Quartus II project, you must add one of the following files to your Quartus
IT project (but not both) on the Files tab in the Settings dialog box.

o Quartus II IP File (.qip)—Qsys generates a .qip file when you generate your Qsys design. Integrating
your Qsys design with your Quartus II project using the .qip file is preferable when you want full control
over generated files and Quartus II compilation phases. If you want to manage the HDL generation for
your Qsys system, you generate your Qsys system first, then add the .qip file to your Quartus II project.

o Qsys System File (.qsys)—Integrating your Qsys design with your Quartus II project by adding the .qsys
design file to your Quartus II project is more convenient for cases when there is no customization or
scripts in the design flow. If you do not want to generate your Qsys system manually, add the .qsys file
to your Quartus II project. You can add one or more top-level .qsys files to your Quartus II project.

Note: When integrating your Qsys designs with your Quartus II software project, you should decide on
which integration flow you want to use (either adding the .qsys file, or the .qip file to your Quartus
II project, but not both), and then maintain a consistent integration flow throughout development.
Mixing integration flows might result in two sets of generated output files, at which point you would
then have to keep track of which one is currently in use. The Quartus II software generates an error
message during compilation if you add both the .qip and .qsys files to your Quartus II project.

Related Information

« Managing Files in a Project

+ Searching for Component Files to Add to the Library on page 6-39
o Generating a Qsys System on page 6-23

Integrating with the .gsys File

To integrate your Qsys designs with the Quartus II software using the .qsys files, you create your designs in
Qsys, save the design files as <gsys design name>.qsys, and then add the .qsys file(s) to your Quartus II
project. When the Quartus II software starts the Analysis & Synthesis phase, it processes the .qsys files and
generates the necessary HDL and system description files needed to compile your design.

You can add multiple .qsys files to a Quartus II project. Qsys stores the files generated from each .qsys file
in the /db/<gsys file name> directory under the Quartus II project directory.

Creating a System With Qsys Altera Corporation

() send Feedback


http://www.altera.com/literature/hb/qts/qsys_system_components.pdf
http://quartushelp.altera.com/current/mergedProjects/global/pjn/pjn_pro_add_delete_files.htm
mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Creating%20a%20System%20With%20Qsys%20(QII51020%202013.11.4)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

QI151020

6-22 Integrating with the .qip File 2013.11.4

When a Qsys design file includes an IP component which is outside of the project directory, the directory
of the .qsys file, or the /ip subdirectoy, you must add these dependency paths to the Qsys IP Search Path
before compilation.

Note: The following are design guidelines and warnings when integrating your Qsys designs with the
Quartus II software:

«  When you integrate your Qsys designs with the Quartus II software using the .qsys file, you must manually
run any IP customization scripts at the appropriate stages of the Quartus II compilation process. There
is no automation support for running scripts between the Quartus II software compilation stages. The
Implementing and Parameterizing Memory IP reference describes running placement scripts for embedded
memory IP interfaces.

« Do not edit the files generated under the /ip/<gsys file name> directory, as they are overwritten during
subsequent runs of Analysis & Synthesis.

Related Information

o Implementing and Parameterizing Memory IP

Integrating with the .qip File
Qsys generates the Quartus II IP File (.qip) during system generation. If you choose to integrate your Qsys

design with your Quartus II project using the .qip file, after you generate your Qsys design, you must add
the .qip file to your Quartus II project.

The .qip file lists the files necessary for compilation and provides the Quartus II software with the required
information about your Qsys system. The .qip file is saved in the <gsys file name>/synthesis directory, and
includes references to the following information:

« HDL files in the Qsys system

« TimeQuest Timing Analyzer Synopsys Design Constraint Files (.sdc)
« Component definition files for archiving purposes

Setting Clock Constraints

Many IP cores include Synopsys Design Constraint (.sdc) files that provide timing constraints for the logic
in the IP design. Generated .sdc files are included in your Quartus II project with the .qip file. For your
top-level clocks and PLLs, you must provide clock and timing constraints in SDC format to direct synthesis
and fitting to optimize the design appropriately, and to evaluate performance against timing constraints.

You can specify a base clock assignment for each clock input in the TimeQuest GUI or with the
creat e_cl ock command, and then you can use the deri ve_pl | _cl ocks command to define the
PLL clock output frequencies and phase shifts for all PLLs in the Quartus II project.

Figure 6-7 illustrates the .sdc commands required for the case of a single clock input signal called cl k, and
one PLL with a single output.
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Figure 6-7: Single Clock Input Signal
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For this system, use the following commands in your .sdc file for the TimeQuest Timing Analyzer:

create_clock -nane naster_clk -period 20 [get _ports {cl k}]

derive_pll _cl ocks

Related Information

o The Quartus II TimeQuest Timing Analyzer

Generating a Qsys System

The Generation dialog box allows you to choose options for generation of synthesis and simulation files.

Generating Output Files
Qsys system generation creates the interconnect between components and generates synthesis and simulation
files. You specify the files that you want to generate in the Generation dialog box. You can generate simulation
models, simulation testbench files, as well as HDL files for Quartus II synthesis, or a Block Symbol File (.bsf)
for schematic design.

For your simulation model and testbench system, you can select Verilog HDL or VHDL for the top-level
module language, which applies to the system's top-level definition and child instances that support generation
for the selected target language.
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For synthesis, you can select the top-level module language as Verilog HDL or VHDL, which applies to the
system’s top-level definition.

Qsys places the generated output files in a subdirectory of your project directory, along with an HTML report
file. To change the default behavior, on the Generation tab, specify a new directory under Output Directory.

Figure 6-8: Qsys Generated Files Directory Structure

<gsys_design>
synthesis
—{ ] submodules

(] simulation
— ] submodules

(] testbench

simulation

submodules

Each time you generate your system, Qsys overwrites these files, therefore, you should not edit Qsys-generated
output files. If you have constraints, such as board-level timing constraints, Altera recommends that you
create a separate Synopsys Design Constraints File (.sdc) and include that file in your Quartus II project. If
you need to change top-level I/O pin names or instance name, Altera recommends you create a top-level
HDL file that instantiates the Qsys system, so that the Qsys-generated output is instantiated in your design
without any changes to the Qsys output files.

Note: Qsys generates the files in listed in Table 6-5 to the <gsys design>/simulation folder.

Table 6-5: Qsys Generated Files

<Qsys system> The top-level Qsys system directory, in the Quartus II project
directory
<Qsys system>.bst A Block Symbol File (.bsf) representation of the top-level Qsys

system for use in Quartus II Block Diagram Files (.bdf).

<Qsys system>.html A report for the system, which provides a system overview
including the following information:

 External connections for the system

o A memory map showing the address of each slave with respect
to each master to which it is connected

o Parameter assignments for each component
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Generating Output Files

<Qsys system>.sopcinfo

Describes the components and connections in your system. This
file is a complete system description and is used by downstream
tools such as the Nios II tool chain. It also describes the
parameterization of each component in the system; consequently,
you can parse its contents to get requirements when developing
software drivers for Qsys components.

This file and the system.h file generated for the Nios II tool chain
include address map information for each slave relative to each
master that accesses the slave. Different masters may have a
different address map to access a particular slave component.

<Qsys system>.spd

Required input file for i p- make- si nscri pt to generate
simulation script for supported simulators. The .spd file contains
a list of files generated for simulation, along with information
about initializable memories.

<Qsys system>/synthesis

This directory includes the Qsys-generated output files that the
Quartus II software uses to synthesize your design.

<Qsys system>/synthesis/
<Qsys system>.v

or

<Qsys system>/synthesis

<Qsys system>.vhd

An HDL file for the top-level Qsys system that instantiates each
submodule in the system for synthesis.

<Qsys_system>/synthesis/

<Qsys system>.regmap

If IP in the system contains register information, Qsys generates
a .regmap file. The .regmap file describes the register map
information on master and slave interfaces. This file complements
the .sopcinfo file by providing more detailed register information
about the system. This enables register display views and user
customizable statistics providers in the SystemConsole.

<Qsys system>/synthesis/
<Qsys system>.qip

This file this file includes all the info you need to synthesize the
IP components in your system.

<Qsys system>/synthesis/submodules

Contains Verilog HDL or VHDL submodule files for synthesis.

<Qsys system>/simulation

This directory includes the Qsys-generated output files to simulate
your Qsys design or testbench system.

<Qsys system>/simulation/

<Qsys system>.sip

This file contains information reqiured for NativeLink simulation
of IP components in your system. You must add the .sip file to
your Quartus II project.
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<Qsys system>/simulation/ An HDL file for the top-level Qsys system that instantiates each

submodule in the system for simulation.
<Qsys system>.v

or
<Qsys system>/simulation/

<Qsys system>.vhd

<Qsys system>/simulation/submodules | Contains Verilog HDL or VHDL submodule files for simulation.

<Qsys system>/simulation/mentor Contains a ModelSim® script msim_setup.tcl to set up and run
a simulation.

<Qsys system>/simulation/aldec Contains Riviera-PRO script rivierapro_setup.tcl to setup and
run a simulation.

<Qsys system>/simulation/synopsys/vcs | Contains a shell script ves_setup.sh to set up and run a VCS®

simulation.

<Qsys system>/simulation Contains a shell script vesmx_setup.sh and synopsys_sim.setup
to set up and run a VCS MX simulation.

/synopsys/vcsmx

<Qsys system>/simulation/cadence Contains a shell script ncsim_setup.sh and other setup files to
set up and run an NCSIM simulation.

<Qsys system>/testbench Contains a Qsys testbench system.

<Qsys system> [testbench/ A Qsys testbench system.

<Qsys system>_tb.qsys

<Qsys system>/testbench/ The top-level testbench file, which connects BFMs to the top-level
<Qsys sysyem>_tb.v interfaces of <gsys_design> .qsys.

or

<Qsys system>/testbench/

<Qsys sysyem>_tb.vhd

<Qsys system>/testbench/<module name> | Allows HPS System Debug tools to view the register maps of
_<master interface name>.svd peripherals connected to the HPS within a Qsys design.

Similarly, during synthesis the .svd files for slave interfaces visible
to System Console masters are stored in the .sof file in the debug
section. System Console reads this section, which Qsys can query
for register map information. When a slave is open, Qsys can
access the registers by name.
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CMSIS Support for Qsys Systems With An HPS Component
Qsys systems that contain a Hard Processor System (HPS) component generate a System View Description
(.svd) file that lists peripherals connected to the ARM processor.

The System View Description File ( .svd) (or CMSIS-SVD) file format is an XML schema specified as part
of the Cortex Microcontroller Software Interface Standard (CMSIS) provided by ARM. The CMSIS-SVD
file allows HPS System Debug tools (such as the DS-5 Debugger) to gain visibility into the register maps of
peripherals connected to the HPS within a Qsys system.

Related Information
o Component Interface Tcl Reference

e« CMSIS - Cortex Microcontroller Software

Viewing the HDL Example

The HDL Example dialog box, accessed from the Generate menu, provides the top-level HDL definition of
your system in either Verilog HDL or VHDL, and also displays VHDL component declarations.

You can copy and paste the example into a top-level HDL file that instantiates the Qsys system, if the system
is not the top-level module in your Quartus II project.

Simulating a Qsys System
The Qsys Generation dialog box provides options for generating Qsys simulation.
The following options are available in the Generate dialog box.

o Generate the Verilog HDL, VHDL, or mixed-language simulation model for your system to use in your
own simulation environment.

» Generate a standard or simple testbench system with BFM or Mentor Verification IP (for AXI3/AXI4)
components that drive the external interfaces of your system, and generate a Verilog HDL or VHDL
simulation model for the testbench system to use in your simulation tool.

o First generate a testbench system, and then modify the testbench system in Qsys before generating its
simulation model.

In most cases, you should select only one of the simulation model options, that is generate a simulation
model for the original system, or for the testbench system. Table 6-6 summarizes the options in the Generate
dialog box that correspond to the simulation files described above.
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Table 6-6: Summary of Settings Simulation and Synthesis in the Generate Dialog Box

Create simulation model None Generates simulation model files
. and simulation scripts. Use this
Verilog . . . .
option to include the simulation
VHDL model in your own custom
testbench or simulation environ-
ment. You can also use this option
to generate models for a testbench
system that you have modified.
Allow mixed-language On Generates a mixed language
simulation Off simulation model generation. If

you have a mixed-language
simulator license, generating for
mixed-language simulation can
shorten the generation time, and
produce files that may simulate
faster. When turned off, all
simulation files are generated in
the selected simulation model
language.

Create testbench Qsys system

Standard, BFMs for standard Qsys
Interconnect

Creates a testbench Qsys system
with BEM components attached
to exported Avalon and AXI3
interfaces. Includes any simulation
partner modules specified by IP
cores in the system.

The testbench generator supports
AXT interfaces and can connect
AXI3/AXI4 interfaces to Mentor
Graphics AXI3/AXI4 master/slave
BFM. However, BFMs support
address widths only up to 32-bits.

Simple, BFMs for clocks and resets

Creates a testbench Qsys system
with BFM components driving
only clock and reset interfaces.
Includes any simulation partner
modules specified by IP cores in
the system.
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Create testbench simulation None Creates simulation model files and
model . simulation scripts for the

Verilog .
testbench Qsys system specified
VHDL in the setting above. Use this
option if you do not need to
modify the Qsys-generated
testbench before running the
simulation.
Create HDL design files for On Creates Verilog HDL or VHDL
synthesis Off design files.
Top-level module language for | Verilog Creates the top-level module in
synthesis VHDL the system in the selected
language.
Create block symbol files (.bsf) | On You can optionally create a (.bsf)
Off file to use in schematic Block
Diagram File (.bdf) designs.
Output Directory < directory name > Allows you to browse and locate
an alternate directory than the
project directory for each
generation target.
Related Information

o Avalon Verification IP Suite User Guide
o Mentor Verification IP (VIP) Altera Edition (AE)
« Generating a System for Synthesis or Simulation

+ Generation Dialog Box (Qsys)

Generate and Modify the Testbench System

You can use the following steps to create a testbench system of your design.

1. Create a Qsys system.
2. Generate a testbench system in the Qsys Generate dialog box.

3. Open the testbench system in Qsys. Make changes, as needed, to the BFMs, such as changing the BFM
instance names and BFM VHDL ID value. You can modify the VHDL ID value in the Altera Avalon
Interrupt Source component.

4. If you modified a BFM, generate the simulation model for the testbench system on the Qsys Generation
tab. You can generate your simulation model in either Verilog HDL or VHDL.

5. Create a custom test program for the BFMs.
6. Compile and load the Qsys design and testbench in your simulator, and then run the simulation.
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Generate the Testbench System and a Simulation model at the Same Time (Verilog HDL
only)

You can use the following design flow to create a testbench system and a simulation model of your Verilog
HDL design.

1. Create a Qsys system.

2. Generate a testbench system and the simulation model for the testbench system in the Qsys Generate
dialog box.

3. Create a custom test program for the BFMs.

4. Compile and load the Qsys design and testbench in your simulator, and then run the simulation.

Adding Assertion Monitors

You can add monitors to Avalon-MM, AXI, and Avalon-ST interfaces in your system to verify protocol
correctness and test coverage with a simulator that supports SystemVerilog assertions.

Note: Modelsim Altera Edition does not support SystemVerilog assertions. If you want to use assertion
monitors, you will need to use an advanced simulator such as Mentor Questasim, Synopsys VCS, or
Cadence Incisive.

Figure 6-9 demonstrates the use of monitors with an Avalon-MM monitor between the previously connected
pci e_conpil er barl 0 Prefetchabl e Avalon-MM master interface and the
dma_0 control _port_sl ave Avalon-MM slave interface.

Figure 6-9: Inserting an Avalon-MM Monitor between Avalon-MM Master and Slave Interfaces

B pcie_compiler_0 PCl Express Compiler

Control_Register_A...

avalon_clk Clock Input
—> cal_blk_clk Clock Input
— barl_0_Prefetchable |Avalon Memory Mapped Master

Avalon Memory Mapped Slave

7 Tx_Interface Avalon Memory Mapped Slave
exported_connection |Conduit Endpoint
E mm_monitor_0 Altera Avalon MM Monitor
~ . clk Clock Input
s0 Avalon Memory Mapped Slave
mo Avalon Memory Mapped Master
B dma_0 DMA Controller
= clk Clock Input
7 control_port_slave Avalon Memory Mapped Slave
> read_master Avalon Memory Mapped Master
[ be write_master k |Avalon Memory Mapped Master

Similarly, you can insert an Avalon-ST monitor between Avalon-ST source and sink interfaces.

Simulation Scripts

Qsys generates simulation scripts to script the simulation environment set up for Mentor Graphics Modelsim®
and Questasim®, Synopsys VCS® and VCS MX®, Cadence Incisive Enterprise Simulator® (NCSIM), and
the Aldec Riviera-PRO® Simulator.

You can use the scripts to compile the required device libraries and system design files in the correct order
and elaborate or load the top-level design for simulation.
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The simulation scripts provide the following variables that allow flexibility in your simulation environment:

TOP_LEVEL_NAME—If the Qsys testbench system is not the top-level instance in your simulation
environment because you instantiate the Qsys testbench within your own top-level simulation file, set
the TOP_LEVEL_ NAME variable to the top-level hierarchy name.

QSYS_SI MDI R—If the simulation files generated by Qsys are not in the simulation working directory,
use the QSYS_SI MDI Rvariable to specify the directory location of the Qsys simulation files.
QUARTUS_I NSTALL_DI R—Points to the device family library.

Example 6-2 shows a simple top-level simulation HDL file for a testbench system

pat t er n_gener at or _t b, which was generated for a Qsys system called pat t er n_gener at or . The
top.sv file defines the top-level module that instantiates the pat t er n_gener at or _t b simulation model
as well as a custom SystemVerilog test program with BFM transactions, called t est _pr ogr am

Example 6-2: Top-Level Simulation HDL File Example

nmodul e top();

pattern_generator tbh tb();
test _program pgm();

endnodul e

Note: The VHDL version of the Altera Tristate Conduit BFM is not supported in Synopsys VCS, NCSim,

and Riviera-PRO in the Quartus II software version 13.1. These simulators do not support the VHDL
protected type, which is used to implement the BEM. For a workaround, use a simulator that supports
the VHDL protected type.

Related Information

ModelSim-Altera software, Mentor Graphics ModelSim support
Synopsys VCS and VCS MX support
Cadence Incisive Enterprise Simulator (IES) support

Aldec Active-HDL and Rivera-PRO support

Simulating Software Running on a Nios Il Processor

To simulate the software in a system driven by a Nios II embedded processor, generate the simulation model
for a simple Qsys testbench system by completing the following steps:

NNk wbdb =

On the Generation tab, set Create testbench Qsys system to Simple, BFMs for clocks and resets.
Set Create testbench simulation model to Verilog or VHDL.

Click Generate.

Open the Nios II Software Build Tools for Eclipse.

Set up an application project and board support package (BSP) for the <gsys_system> .sopcinfo file.
Set up an application project and board support package (BSP) for the <gsys_system> .sopcinfo file.

To simulate, right-click the application project in Eclipse, point to Run as,and then click 4 Nios IT
ModelSim. The Run As Nios IT ModelSim command sets up the ModelSim simulation environment,
compiles and loads the Nios II software simulation.
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8. To run the simulation in ModelSim, typer un -al | in the ModelSim transcript window.

9. If prompted, set ModelSim configuration settings and select the correct Qsys Testbench Simulation
Package Descriptor (.spd) file, < gsys_system > _tb.spd. The .spd file is generated with the testbench
simulation model for Nios II designs and specifies all the files required for the Nios II software simulation.

Related Information
o Getting Started with the Graphical User Interface (Nios II)

+ Getting Started from the Command-Line (Nios II)

System Examples

The following system examples demonstrate various design features and flows that you can replicate in your
design.

PCI Express Subsystem Example on page 6-32
Ethernet Subsystem Example on page 6-34
PCI Express to Ethernet Bridge Example on page 6-36

Hierarchical System Using Instance Parameters Example on page 6-38

PCI Express Subsystem Example

Figure 6-10 and Figure 6-11 show an example PCI Express subsystem. The application running on the root
complex processor programs the DMA controller. The DMA controller’s Avalon-MM read and write master
interfaces initiate transfers to and from the DDR3 memory and to the PCI Express Avalon-MM TX data
port. The system exports the DMA master interfaces through an Avalon-MM pipeline bridge. In the figure
below, all three masters connect to a single slave interface. During system generation, Qsys automatically
inserts arbitration logic to control access to this slave interface.

By default, the arbiter provides equal access to all requesting masters; however, you can weight the arbitration
by changing the number of arbitration shares for the requesting masters. The second pipeline bridge allows
an external master, such as a host processor, to also issue transactions to the CSR interfaces.
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Figure 6-10: PCl Express Subsystem
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Figure 6-11: Qsys Representation of the PCl Express Subsystem

t: System Contents &2 Address Map ¥ | Project Settings 3 M
|| Use Connections Marme Description
B pcie_hard_ip_0 IP_Caorpiler for PCI Express
——— prie_core_clk Clock Qutput
— prie_core_reset Reset Output
A cal_blk_clk Clock Input
135 Avalon Mermory Mapped slave
< refrlk Conduit
< test_in Conduit
< prie_rstn Conduit
< clocks_sim Conduit
7 < reconfig_busy Conduit
< pipe_ext Conduit
< powerdouen Conduit
< Test_out Conduit
< msi_interface Conduit
harl_0 Avalon Mermory Mapped Master
cra Avalon Mermory Mapped slave
< ri_in Conduit
< 13 _out Conduit
< reconfig_togxh Conduit
[my reconfig_gxbclk Clock Input
< reconfig_fromgsxb_0 Conduit
A fixedcllk Clock Input
B dma_0 DA Controller
Clk Clock Input
reset Reset Input
control_port_slave Awalon Merory Mapped Slave
read_rnaster Avalon Mernory Mapped Master
— write_rnaster Awalon Mernory Mapped Master
B mm_bridge_0 Avalon-MM Pipeline Bridge
clk Clock Input
reset Reset [nput
50 Avalon Mermory Mapped slave
H mao Avalon Mermory Mapped Master
B mm_bridge_1 Analon-MM Pipeline Bridge
Clk Clock Input
reset Reset Input
[ 50 Awalon Merory Mapped Slave
— mao Awalon Mernory Mapped Master
Related Information

Qsys Interconnect

Ethernet Subsystem Example

In this example subsystem, the transmit (TX) DMA receives data from the DDR3 memory and writes it to
the Altera Triple-Speed Ethernet IP core using an Avalon-ST source interface. The receive (RX) DMA accepts
data from the Triple-Speed Ethernet IP core on its Avalon-ST sink interface and writes it to DDR3 memory.

The read and write masters of both Scatter-Gather DMA controllers and the Triple-Speed Ethernet IP core
connect to the DDR3 memory through an Avalon-MM pipeline bridge. This Ethernet example subsystem
exports all three control and status interfaces through an Avalon-MM pipeline bridge, which connects to a
controller outside of the Qsys system, as shown in Figure 6-12 and Figure 6-13.
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Figure 6-12: Scatter-Gather DMA-to-Ethernet Subsystem
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Figure 6-13: Qsys Representation of the Ethernet Subsystem

tf System Cantents &3 Address Map ¥ | Project Settings
[qm![ Use Connections Marne Description
o M B clk_0 Clack Source
3"‘ O clk_in Clock [nput
|G| s clk_in_reset Feset Input
- = clk Clock Qutput
i Clk_reset Reset Qutput
lall ¥ Bl sgdma_D Scatter-Gather DMA Cantroller
& clk Clack Input
resat Feset Input
—; = csr Awalon Memory Mapped Slawve
‘f descriptor_read Avalon Memory Mapped Master
- descriptor_write Awalon Memory Mapped Master
m_read Awalon Memory Mapped Master
out Awalon Streaming Source
[v] Bl triple_speed_ethernet_0 Triple-Speed Ethernet
contral_port _clock_connection Clock: Input
reset_connection Eeset Input
y— contral_port Awalon Memory Mapped Slave
O receive_clock_connection Clock: Input
O transmit_clock_connection Clock: Input
receive Awalon Streaming Source
Transmit Awalon Streaming Sink
< mac_misc_connection Conduit
O pos_ref_clk_clock_connection Clock: Input
O cal_hilk_clk Clock: Input
< status_led_connection Conduit
< serdes_control_connection Conduit
< serial_connection Conduit
[¥] Bl sgdma_1 Scatter-Gather DMA Cantroller
clk Clock: Input
reset FEeset Input
csr Awalon Memory Mapped Slawve
descriptor_read Awalon Memory Mapped Master
descriptor_write Awalon Memory Mapped Master
in Awalon Streaming Sink
m_write Awalon Memory Mapped Master
[w] El avmm_bridge_0 Awalon-MM Bridge
clk Clock: Input
reset Eeset Input
awvalon_master( Awalon Memory Mapped Master
N awvalon_masterl Awalon Memory Mapped Master
— awvalon_master2 Awalon Memory Mapped Master
O awvalon_slawve Awalon Memory Mapped Slawve
[¥] El mm_bridge_0 Awalon-MM Pipeline Bridge
clk Clock: Input
reset FEeset Input
=0 Awalon Memory Mapped Slawve
H mo Awalon Memory Mapped Master

PCl Express to Ethernet Bridge Example
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The PCI Express and Ethernet example subsystems run at 125 MHz and includes two clock domains and
an ethernet subsystem. The DDR3 SDRAM controller runs at 200 MHz. Qsys automatically inserts clock
crossing logic to synchronize the DDR3 SDRAM Controller with the PCI Express and Ethernet subsystems,

as shown in Figure 6-14 and Figure 6-15.
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Figure 6-14: PCl Express-to-Ethernet Bridge Example System
Qsys System
Qsys inserts PCI Express
arbitration and Subsystem
DDR3 Clock crossing 125 MHz
SDRAM logic pclelink [l >
400 MHz (125 MHz-200MHz)
DDR3 \ CSR Avalon-MM
SDRAM Plpeline
Controller Bridge (Qsys)
to CPU
200 MHz DDR3 CSR 125 MHz
Calibration ¢ |
Ethernet
Subsystem
Ethernet ¢ >
125 MHz
Figure 6-15: Qsys Representation of the Complete PCl Express to Ethernet Bridge
I: System Contents 52 Address Map 22 | Froject Settings &L |
[oul| Use | Connections rame Description
[1] Bl uniphy_ddr3_0 uniphy_ddr3
avalon_slawe Awalon Memory Mapped Slave
= memory_phy Cancuit
| Other Conduit
FLL_Sharing Zancuit
[] El ethernet_dma_suhsystem_0 ethermet_dma_subsystiem
ko cal_blk_if Conduit
e drma_if Ayalon Memory Mapped Master
Car_if Ayalon Memory Mapped Slave
e ethernet_if Conduit
1] El pcie_subsystem_0 prie_subsysiem
= pcie_link Cancuit
—_ ddrz _sdram_master Ayalon Memory Mapped Master
L dma_control_slawe Ayalon Memory Mapped Slawve
[] El mm_bridge_0 Ayalon-m bl Fipeline Bridge
A Clk Clock Ingut
A reset Feset Input
A 18] Ayalon Memory Mapped Slave
mo Ayalon Memory Mapped Master
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Pipeline Bridges
The PCI Express to Ethernet bridge example system uses several pipeline bridges. You must configure bridges
to accommodate the address range of all of connected components, including the components in the
originating subsystem and the components in the next higher level of the system hierarchy.

The pipeline bridge inserts a pipeline stage between the connected components. You should register signals
at the subsystem interface level for the following reasons:

 Registering interface signals decreases the amount of combinational logic that must be completed in one
cycle, making it easier to meet timing constraints.

+ Registering interface signals raises the potential frequency, or fy(5x, of your design at the expense of an
additional cycle of latency, which might adversely affect system throughput.

o The Quartus IT incremental compilation feature can achieve better fy;5x results if the subsystem boundary
is registered.

Note: Connections between AXI and Avalon interfaces are made without requiring the use of explicitly
instantiated bridges; the interconnect provides the necessary bridging logic.

Related Information
« Optimizing System Performance for Qsys

e Qsys System Design Components

Hierarchical System Using Instance Parameters Example

You can use an instance parameter to control the implementation of system components from a higher-level
Qsys system. You define instance parameters on the Instance Parameters tab in Qsys.

In Example 6-3, the my_system.qsys system has two instances of the same IP component, My_| P.My_I| P
is a Qsyscomponent with a system identification parameter called MY_SYSTEM | D. When my_system.qsys
is instantiated within another higher-level Qsys system, the two My_| P subcomponents require different
values for their MY_SYSTEM | D parameters based on a value determined by the higher-level system. In
this example, the value specified by the top-level system is designated t op_i d and in my_system.qsys, the
component instance CONMPO requires MY_SYSTEM | Dsettot op_i d + 1,andinstance conpl requires
MY_SYSTEM | Dsettot op_i d + 2. Example 6-3 defines the MY_SYSTEM | D system ID parameter
in the IP component My _| P:

Example 6-3: System ID Parameter Example

add_paraneter MY_SYSTEMID int 8

set _parameter_property MY SYSTEM | D DI SPLAY_NAME \
MY_SYSTEM | D_PARAM

set _parameter_property MY_SYSTEM ID UNI TS None
To satisfy the design requirements for this example, you define an instance parameter in my_system.qsys
that is set by the higher-level system, and then define an instance script to specify how the values of the
parameters of the My_| P components instantiated in my_system.qsys are affected by the value set on the
instance parameter.

Altera Corporation Creating a System With Qsys

() send Feedback


http://www.altera.com/literature/hb/qts/qts_optimize.pdf
http://www.altera.com/literature/hb/qts/qsys_system_components.pdf
mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Creating%20a%20System%20With%20Qsys%20(QII51020%202013.11.4)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

QlI51020
2013.11.4

Searching for Component Files to Add to the Library 6-39

To do this, in Qsys, open the my_system.qsys Qsys system that instantiates the two instances of the My_| P
components. On the Instance Parameters tab, create a parameter called Syst em i d. For this example,
you can set this parameter to be of type Integer and choose 0 as the default value.

Next, you provide a Tcl Instance Script that defines how the value of the Syst em i d parameter should
affect the parameters of conp0O and conpl subcomponents in my_system.qsys.

In Example 6-4 Qsys gets the value of the parameter Syst em i d from the top-level system and saves it as
t op_i d, and then increments the value by 1 and 2. The script then uses the new calculated values to set the
MY_SYSTEM | Dparameter in the My_| P component for the instances conpO and conpl. The script
uses informational messages to print the status of the parameter settings when the my_system.qsys system
is added to the higher-level system.

Example 6-4: Tcl Instance Script Example

package require qsys 13.1
set _nodul e_property Conposition_call back My_cal |l back
proc My_call back { } {

# Get The Value OF system.id paranmeter fromthe

# hi gher-1level system

set top_id [get paranmeter_val ue system. d]

# Print Info Message
send_nessage Info "system.id Value Specified: $top_ id"

# Use Above Value To Set Paraneter Values For The Subconponents

set child_id_O [expr {$top_id + 1} ]
set child_id_ 1 [expr {$top_id + 2} ]

# Set The Paraneter Val ues On The Subconponent | nstances
set i nstance_paraneter_val ue conp0O My_system.id $child_id O
set _instance_paraneter_value conpl My_systemid $child id 1

# Print Info Messages
send _nessage Info "systemid Value Used In conpO: $child id 0"
send_nessage Info "system.id Value Used In conpl: $child_ id_ 1"

You can click Preview Instance to modify the parameter value interactively and see the effect of the scripts
in the message panel which can be useful for debugging the script. In this example, if you change the parameter
value in the Preview screen, the component generates messages to report the top-level | D parameter value
and the parameter values used for the two instances of the component.

Related Information

Working with Instance Parameters in Qsys

Searching for Component Files to Add to the Library

The Qsys Library lists design components available for use in Qsys systems. Components can include
Altera-provided IP cores, third-party IP cores, and custom IP cores that you provide. Previously created
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Qsys systems can also appear in the library, and you can use these systems in other designs if they have
exported interfaces.

Altera and third-party developers provide ready-to-use components, which are installed automatically with
the Quartus II software and are available in the Qsys Library. The Qsys Library includes the following
components:

o Microprocessors, such as the Nios" II processor

o DSP IP cores, such as the Reed Solomon II core

 Interface protocols, such as the IP Compiler for PCI Express

o Memory controllers, such as the RLDRAM II Controller with UniPHY

+ Avalon® Streaming (Avalon-ST) components, such as the Avalon-ST Multiplexer IP core
o Qsys Interconnect components

o Verification IP (VIP) Bus Functional Models (BFMs)

You can set the IP Search Path option to specify the installed locations for custom and third-party components
that you want to appear in the component library. Qsys searches for component files each time you open
the tool, and locates and displays the list of available components in the component library.

Qsys searches the directories listed in the IP Search Path for the following component file types:

» Hardware Component Description File (_hw.tcl)—Each _hw.tcl file defines a single component.

o [P Index File (.ipx)—Each .ipx file indexes a collection of available components, or a reference to other
directories to search. In general, .ipx files facilitate faster startup for Qsys and other tools because fewer
directories are searched and analyzed.

Qsys searches some directories recursively and other directories only to a specific depth. When a directory
is recursively searched, the search stops at any directory containing an _hw.tcl or .ipx file; subdirectories
are not searched. In the following list of search locations, a recursive descent is annotated by **. A single *
signifies any file.

Note: If youadd a component to you search path, you must refresh your system by clicking File > Refresh
to update the Qsys library.

« PRQJIECT_DI R/ * —Finds components and index files in the Quartus II project directory.

« PRQIECT_D R/i p/ **/ * —Finds components and index files in any subdirectory of the /ip subdirectory
of the Quartus project directory.

o QUARTUS_I NSTALLDI R/ . . /i p/ **/ * —In this IP directory, you can create your own subdirectories
that are available for any project using this Quartus II installation directory.

Adding Components to the Library

You can use one of the following methods to add components to the library.

« Save components in your project directory.

« Save components in the /ip subdirectory of your project directory.
« Copy components to the install directory.

o Reference components in an IP Index File (.ipx).

« Integrate third-party components.

Copy Components to a Directory Searched by Default on page 6-41

Reference Components in an IP Index File (.ipx) on page 6-42
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Extending the Default Search Path on page 6-44

Copy Components to a Directory Searched by Default

The simplest method to add a new component to the Qsys Library is to copy your components into one of
the directories Qsys searches by default. You can save component files in your project directory, or in the
/ip subdirectory of your project directory. These approaches are useful if you want to associate your
components with a specific Quartus II project.

If you save the component in the project directory, the component appears in the Library in the group you
specified under Project. Alternatively, if you save the component in the Quartus II installation directory,
the component appears in the specified group under Library.

You can also save the component files into the default Quartus II <install_dir> /ip/ directory. This approach
is useful in the following situations and is shown in Figure 6-16.

» You want to associate your components with a specific release of the Quartus II software.
« You want to have the same components available across multiple projects.

Figure 6-16: User Library Included In Subdirectory <install_dir>/ip/

<install_dir>

quartus

ip

altera
altera_components.ipx

@ <components>

[:I user_components

@ " component1

componentl_hw.tcl
componentl.v

@ —CI component2

component2_hw.tcl
component2.v

In Figure 6-16, the circled numbers identify a typical directory structure for the Quartus II software. For
the directory structure above, Qsys performs the component discovery algorithm described below to locate
.ipx and_hw.tcl files.

1. Qsys recursively searches the <install_dir> /ip/ directory by default. The recursive search stops when
Qsys finds an .ipx file.

2. As part of the recursive search, Qsys also looks in the user_components directory. Qsys finds the
componentl directory, which contains componentl_hw.tcl. When Qsys finds the component1_hw.tcl
component, the recursive search ends, and no components in subdirectories of component] are found.

3. Qsys then searches the component2 directory, because this directory path also appears as an IP Search
Path, and discovers component2_hw.tcl. When Qsys finds component2_hw.tcl, the recursive search
ends.
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Note: Ifyousave your _hw.tclfile in the <install_dir> /ip/ directory, Qsys finds your _hw.tcl file and does
not search subdirectories adjacent to the _hw.tcl file.

Reference Components in an IP Index File (.ipx)

You can specify the search path in a user_components.ipx file under the <install_dir> /ip directory. This
method allows you to add a location that is independent of the default search path. You can also save the
.ipx file in any of the default search locations, for example, the Quartus II project directory, or the /ip directory
in the project directory. The user_components.ipx file includes a single line of code redirecting Qsys to the
location of each user library. The path below shows a redirection example:

<library> <path path="<user_lib_dir>/user_ip/**/*"/> </library>
You can verify that components are available with the i p- cat al 0g command. You can use thei p- make-

i px command to create an .ipx file for a directory tree, which can reduce the startup time for Qsys.

Understanding the IP Index File (.ipx) Syntax
An IP Index File (.ipx) is an XML file that describes the search path used to discover components that are
available for a Qsys system. A <path> entry specifies a directory in which components may be found. A
<component> entry specifies the path to a single component.

Example 6-5: .ipx File Structure

<library>
<pat h pat h="..<user directory>" />
<pat h pat h=".<user directory>" />

<component ...file=".<user directory>" />

</1ibr ary>

A <path> element contains a path attribute, which specifies the path to a directory, or the path to another
.ipx file, and can use wildcards in its definition. An asterisk matches any file name. If you use an asterisk as
a directory name, it matches any number of subdirectories.

When searching the specified path, the following three types of files are identified:

« .ipx—Additional index files.
o _hw.tcd—Qsys component definitions.
o _sw.tcl—Nios II board support package (BSP) software component definitions.

A <component> element contains several attributes to define a component. If you provide the required
details for each component in an .ipx file, the startup time for Qsys is less than if Qsys must discover the
files in a directory. Example 6-6 shows two <component> elements. Note that the paths for file names are
specified relative to the .ipx file.

Example 6-6: Component Element in an .ipx File

<library>
<conponent
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name="A ys Conponent"
di spl ayName="Qsys FIR Filter Conponent"
version="2. 1"
file="./conponents/qgsys filters/fir_hwtcl"
/>
<conponent
nane="r gb2cnmyk_conponent "
di spl ayNanme="RGB2CMYK Converter (Col or Conversion Category!)"

versi on="0. 9"
file="./components/gsys_converters/color/rgb2cmyk_hw tcl"
/>
</library>

ip-catalog

The i p- cat al 0g command displays the catalog of available components relative to the current project
directory in either plain text or XML format.

Usage

i p-catal og [--project-dir=<directory>][--nanme=<val ue>][--verhose]
[--xm][--hel p]

Options

e --project-dir=<directory>—Optional. Components are found in locations relative to the
project, if any. By default, the current directory, *." is used. To exclude a project directory, leave the value
empty.

« --nanme=<val ue>—Optional. This argument provides a pattern to filter the names of the components
found. To show all components, use a * or “ . By default, all components are shown. The argument is not
case sensitive.

« --ver bose—Optional. If set, reports the progress of the command.

o --xm —Optional. If set, generates the output in XML format, instead of a line and colon-delimited
format.

o --hel p—Shows help for the i p- cat al 0g command.

ip-make-ipx

The i p- make- i px command creates an .ipx file and is a convenient way to include a collection of
components from an arbitrary directory in the Qsys search path. You can also edit the .ipx file to disable
visibility of one or more components in the Qsys Library.

Usage

i p-make-i px [--source-directory=<directory>] [--output=<file>]
[--relative-vars=<val ue>] [--thorough-descent] [--nessage-before=<val ue>]
[ --nmessage- aft er=<val ue>] [--hel p]

Options
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e --source-directory=<directory>—Optional. Specifies the root director(ies) that Qsys uses
to find the component files. The default directory is “.”. You can also provide a comma-separated list of

directories.

o --output=<fil e>—Optional. Specifies the name of the file to generate. The default name is
/components.ipx.

o --relative-vars=<val ue>—Optional. Causes the output file to include references relative to

the specified variable(s) where possible. You can specify multiple variables as a comma-separated list.

« --thorough-descent —Optional. If set, a component or .ipx file in a directory does not prevent
subdirectories from being searched.

+ --message- bef or e= <val ue>—Optional. A message to print to St dout when indexing begins.
« --nessage- af t er =<val ue>—Optional. A message to send to St dout when indexing completes.
o --hel p—Shows help for this command.

Extending the Default Search Path
he following steps allow you to extend the default search path by specifying additional directories.

1. In Qsys, in the Tools menu, click Options.
2. In the Category list, click IP Search Path.
3. Click Add.

4. Browse to locate additional directories and click Open to add them to your search path.

You do not need to include the components specified in the IP Search Path as part of your Quartus II project.

Integrating Third-Party Components

You can use Qsys components created by third-party IP developers. Altera awards the Qsys Compliant label
to IP cores that are fully supported in Qsys. These cores have interfaces that are supported by Qsys, such as
Avalon-MM or AXI, and may include timing and placement constraints, software drivers, simulation models,
and reference designs.

To find supported third-party Qsys components on Altera's web page, navigate to the Intellectual Property
& Reference Designs page, and then type @sys Certi f i ed inthe Search box, select IP Core & Reference
Designs, and then press Enter.

Refer to Altera's Intellectual Property & Reference Designs page for more information.

Related Information

Intellectual Property & Reference Designs

Using Qsys Command-Line with Utilities and Scripts

You can perform many of the functions available in the Qsys GUI from the command-line with the
gsys- gener at e and qsys- scri pt utilities.

You run these command-line executables from the following Quartus II installation directory:
<Quartus II installation directory>\quartus\sopc_builder\bin

You can use SYS- gener at e to generate Qsys output files outside of the Qsys GUIL You can use qSys-
SCri pt to create, manipulate or manage a Qsys system with command-line scripting.
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For command-line help listing all options for these executables, type the following command:

<Quartus II installation directory>\quartus\sopc_builder\bin\<executable name> --help

Example 6-7: Qsys Command-Line Scripting Example

gsys-script --script=nmy_script.tcl \
--systemfil e=fancy. qsys my_script.tcl contains:
package require -exact gsys 13.1
# get all instance nanes in the systemand print one by one
set instances [ get_instances ]
foreach instance $instances {
send_nessage I nfo "$instance"
}

6-45

Related Information

Working with Instance Parameters in Qsys

Altera Wiki Qsys Scripts

Running the Qsys Editor from the Command-Line
You can use the qsys- edi t utility to run the Qsys Editor from the command-line.

The following is a list of options that you can use with the qsys- edi t utility:

<1st arg fil e>—Optional. The name of the .qsys system or .qvar variation file to edit.

- - sear ch- pat h[ =<val ue>] —Optional. If omitted, Qsys uses a standard default path. If provided,
Qsys searches a comma-separated list of paths. To include the standard path in your replacement, use
"$", for example: / extra/ dir. $.

--project-directory=<directory>—Optional. Allows you to find components in certain
locations relative to the project, if any. By default, the current directory is:' . ' . To exclude any project
directory, use " '

- - new conponent - t ype=<val ue>—Optional. Allows you to specify the kind of instance that is
parameterized in a variation.

- - debug—Optional. Enables debugging features and output.

- - host - cont r ol | er —Optional. Launches the application with an XML host controller interface
on standard input/output.

- - j vm max- heap- si ze=<val ue>—Optional. The maximum memory size Qsys uses for allocations
when running qsys- edi t . You specify this value as <Si ze><uni t >, where unit is m(or M for
multiples of megabytes, or g (or G) for multiples of gigabytes. The default value is 512m

- - hel p—Optional. Display help for qsys-edi t.

Launching Qsys with Additional Computer Memory
If the Qsys sytem you are creating requires more than the 512 megabytes of default memory, you may need
to launch the Qsys GUI from the command-line with additional memory. For example, the following
gsys- edi t command allows you to launch Qsys from the command-line with 2 gigabytes of memory.

gsys-edit --jvm nax-heap-si ze=2g
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Generating Qsys Systems with the gsys-generate Utility

Generating Qsys Systems with the gsys-generate Utility

You can use the qSys- gener at e utility to generate RTL for your Qsys system, simulation models and
scripts, and to create testbench systems for testing your Qsys system in a simulator using BEMs. Output
from the gsys-generate command is the same as when generating using the Qsys GUI.

The following is a list of options that you can use with the qsys- gener at e utility:

<1st arg fil e>—Required. The name of the .qsys system file to generate.

- - synt hesi s=<VERI LOF VHDL>—Optional. Creates synthesis HDL files that Qsys uses to compile
the system in a Quartus II project. You must specify the preferred generation language for the top-level
RTL file for the generated Qsys system.

- - bl ock-synbol - fi | e—Optional. Creates a block symbol file (.bsf) for the system.

- -si mul at i on=<VERI LOF VHDL>—Optional. Creates a simulation model for the system. The
simulation model contains generated HDL files for the simulator, and may include simulation-only
features. You must specify the preferred simulation language.

- - t est bench=<SI MPLE| STANDARD>—Optional. Creates a testbench system. The testbench system
instantiates the original system, adding bus functional models to drive the top-level interfaces. Once
generated, the bus functional models interact with the system in the simulator.

--test bench-si mul at i on=<VERI LOG VHDL>—Optional. After creating the testbench system,
also create a simulation model for the testbench system.

- - out put - di r ect or y=<val ue>—Optional. Sets the output directory. Each generation target is
created in a subdirectory of the output directory. If you do not specify the output directory, a subdirectory
of the current working directory matching the name of the system is used.

- - sear ch- pat h=<val ue>—Optional. If omitted, a standard default path is used. If provided, a
comma-separated list of paths is searched. To include the standard path in your replacement, use "$",
for example, "/ extra/ dir, $".

- -j vm max- heap- si ze=<val ue>—Optional. The maximum memory size that Qsys uses for
allocations when running this tool. The value is specified as <size><uni t > where unit can be m (or M)
for multiples of megabytes or g (or G) for multiples of gigabytes. The default value is 512m.

--fam | y=<val ue>—Optional. Sets the device family.

- - par t =<val ue>—Optional. Sets the device part number. If set, this option overrides the - - f ami | y
option.

--al | ow- m xed- | anguage- si mul at i on—Optional. Enables a mixed language simulation model
generation. If true, if a preferred simulation language is set, Qsys uses a fileset of the component for the
simulation model generation. When false, which is the default, Qsys uses the language specified with
--fil e-set =<val ue> for all components for simulation model generation.

--fil e-set =<val ue>—Optional. Allows you to choose the type output to generate, for example,
QUARTUS_SYNTH, SI M_VERLOG or VHDL.

Creating and Managing a System with qsys-script

You can use the qSys- Scri pt tool to create and manipulate a Qsys system with Tcl scripting commands.

Note: You must provide a package version for the gsys-script. If you do not specify the - - package-

ver si on=<val ue> gsys-script command, you must then provide a Tcl script and request the
system scripting API directly with the package require -exact gsys<version>
command.
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The following is a list of options that you can use with the qsys- scri pt utility:

o --systemfil e=<fil e>—Optional. Specifies the path to a .qsys system file. This system is loaded
before running scripting commands.

« --script=<fil e>—Optional. A file containing Tcl scripting commands for creating or manipulating
Qsys systems. If you specify both - - cnd and - - scri pt, the - - cnmd commands are run before the
script specified by - - scri pt.

o --cnd=<val ue>—Optional. A string that contains Tcl scripting commands to create or manipulate
a Qsys system. If you specify both - - cnd and - - scri pt, the - - cnd commands are run before the
script specified by - - scri pt.

« --package-ver si on=<val ue>—Optional. Specifies which system scripting Tcl API version to
use and determines the functionality and behavior of the Tcl commands. The Quartus II software supports
the Tcl API scripting commands. If you do not specify the version on the command-line, your Tcl script
must request the system scripting API directly with the package require -exact gsys <
ver si on > command.

o --hel p—Optional. Displays help for the qsys- scri pt tool.

« --search- pat h=<val ue>—Optional. If omitted, a standard default path is used. If provided, a
comma-separated list of paths is searched. To include the standard path in your replacement, use " $",
for example,/ < di rectory pat h>/dir, $. Multiple directory references are separated with a
comma.

e --jvm max- heap- si ze=<val ue>—Optional. The maximum memory size that is used by the
gsys-scri pt tool. You specify this value as <si ze><uni t > where unit can be mor Mfor multiples
of megabytes or g or Gfor multiples of gigabytes.

Qsys Scripting Command Reference

Interface properties work differently for gsys scripting than with _hw.tcl scripting. In _hw.tcl, interfaces do
not distinguish between properties and parameters; in gsys scripting, properties and parameters are unique.

add_connection <start> [<end>] on page 6-52

This command connects interfaces using an appropriate connection type. Interface names consist of a child
instance name, followed by the name of an interface provided by that module, for example, Mux0. out is
the interface out on the instance named nuxo0.

add_instance <name> <type> [<version>] on page 6-52
This command adds an instance of a component, referred to as a child or child instance, to the system.

add_interface <name> <type> <direction> on page 6-53

This command adds an interface to your system, which you can use to export an interface from within the
system. You specify the exported interface with the commandset _i nt er f ace_property EXPORT_CF
<instance.interface>.

auto_assign_base_addresses <instance> on page 6-53

This command assigns base addresses to memory-mapped interfaces on an instance in the system. Instance
interfaces that are locked with lock_avalon_base_address command keep their addresses during address
auto-assignment.

auto_assign_irqs <instance> on page 6-53
This command assigns interrupt numbers to all connected interrupt senders on an instance in the system.
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auto_connect <element> on page 6-54
This command creates connections from an instance or instance interface to matching interfaces in other
instances in the system. For example, Avalon-MM slaves are connected to Avalon-MM masters.

create_system [<name>] on page 6-54
This command replaces the current system in the system script with a new system with the specified name.

get_instance_interface_parameter_value <instance> <interface> <parameter> on page 6-54
This command returns the value of a parameter of an interface in a child instance.

get_composed_connection_parameters <instance> <childConnection> on page 6-55
This command returns a list of parameters on a connection in the subsystem, for an instance that contains
a subsystem.

get_composed_connections <instance> on page 6-55
This command returns a list of all connections in a subsystem, for an instance that contains a subsystem.

get_composed_instance_assignment <instance> <childInstance> <key> on page 6-55
This command returns the value of an assignment on an instance of a subsystem, for an instance that models
a subsystem.

get_composed_instance_assignments <instance> <childInstance> on page 6-56
This command returns a list of assignments on an instance of a subsystem, for an instance that contains a
subsystem.

get_composed_instance_parameter_value <instance> <childInstance> <parameter> on page 6-56
This command returns the value of a parameters on an instance in a subsystem, for an instance that contains
a subsystem.

get_composed_instance_parameters <instance> <childInstance> on page 6-57
This command returns a list of parameters on an instance of a subsystem, for an instance that contains a
subsystem.

get_composed_instances <instance> on page 6-57
This command returns a list of child instances in the subsystem, for an instance that contains a subsystem.

get_connection_parameter_property <connection> <parameter> <property> on page 6-57
This command returns the value of a parameter property in a connection.

get_connection_parameter_value <connection> <parameter> on page 6-58
This command gets the value of a parameter on the connection. Parameters represent aspects of the connection
that can be modified once the connection is created, such as the base address for an Avalon-MM connection.

get_connection_parameters <connection> on page 6-58
This command returns a list of parameters found on a connection. The list of connection parameters is the
same for all connections of the same type.

get_connection_properties on page 6-58
This command returns a list of properties found on a connection. The list of connection properties is the
same for all connections, regardless of type.

get_connection_property <connection> <property> on page 6-59
This command returns the value of a connection property.
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get_connections [<element>] on page 6-59

This command returns a list of connections in the system if no element is specified. If a child instance is
specified, for example Cpu, all connections to any interface on the instance are returned. If an interface on
a child instance is specified, for examplecpu. i nst r uct i on_mast er, only connections to that interface
are returned.

get_instance_assignment <instance> <key> on page 6-59
This command returns the value of an assignment on a child instance.

get_instance_assignments <instance> on page 6-60
This command returns a list of assignment keys for any assignments defined for the instance.

get_instance_interface_assignment <instance> <interface> <key> on page 6-60
This command returns the value of an assignment on an interface of a child instance.

get_instance_interface_assignments <instance> <interface> on page 6-60
This command returns the value of an assignment on an interface of a child instance.

get_instance_interface_parameter_property <instance> <interface> <parameter> <property> on page
6-61
This command returns the property value on a parameter in an interface of a child instance.

get_instance_interface_parameter_value <instance> <interface> <parameter> on page 6-61
This command returns the value of a parameter of an interface in a child instance.

get_instance_interface_parameters <instance> <interface> on page 6-62
This command returns a list of parameters for an interface in a child instance.

get_instance_interface_port_property <instance> <interface> <port> <property> on page 6-62
This command returns the property value of a port in the interface of a child instance.

get_instance_interface_ports <instance> <interface> on page 6-62
This command returns a list of ports in an interface of a child instance.

get_instance_interface_properties on page 6-63
This command returns a list of properties that you can be query for an interface in a child instance.

get_instance_interface_property <instance> <interface> <property> on page 6-63
This command returns the property value for an interface in a child instance.

get_instance_interfaces <instance> on page 6-63
This command returns a list of interfaces in a child instance.

get_instance_parameter_property <instance> <parameter> <property> on page 6-64
This command returns the value of a parameter in a connection in the subsystem, for an instance that
contains a subsystem.

get_instance_parameter_value <instance> <parameter> on page 6-64
This command returns the value of a property in a child instance.

get_instance_parameters <instance> on page 6-64
This command returns a list of parameters in a child instance.

get_instance_port_property <instance> <port> <property> on page 6-65
This command returns the value of a property of a port contained by an interface in a child instance.

get_instance_properties on page 6-65
This command returns a list of properties for a child instance.
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get_instance_property <instance> <property> on page 6-65
This command returns the value of a property for a child instance.

get_instances on page 6-66
This command returns a list of the instance names for all child instances in the system.

get_interface_port_property <interface ><port ><property> on page 6-66
This command returns the value of a property of a port contained by an interface in a child instance.

get_interface_ports <inferface> on page 6-66
This command returns the names of all of the ports that have been added to an interface.

get_interface_properties on page 6-67
This command returns the names of all the available interface properties. The list of interface properties is
the same for all interface types.

get_interface_property <interface> <property> on page 6-67
This command returns the value of a property from the specified interface.

get_interfaces on page 6-67
This command returns a list of top-level interfaces in the system.

get_module_properties on page 6-68
This command returns the properties that you can manage for the top-level module.

get_module_property <property> on page 6-68
This command returns the value of a top-level system property.

get_parameter_properties on page 6-68
This command returns a list of properties that you can query on parameters. These properties can be queried
on any parameter, such as parameters on instances, interfaces, instance interfaces, and connections.

get_port_properties on page 6-68
This command returns a list of properties that you can query on ports.

get_project_properties on page 6-69
This command returns a list of properties that you can query for the Quartus II project.

get_project_property <property> on page 6-69
This command returns the value of a Quartus II project property.

load_system <file> on page 6-69
This command loads a Qsys system from a file, and uses the system as the current system for scripting
commands.

lock_avalon_base_address <instance.interface> on page 6-69

This command prevents the memory-mapped base address from being changed for connections to an
interface on an instance when the aut 0_assi gn_base_addr esses or

aut o_assi gn_system base_addr esses commands are run.

preview_insert_avalon_streaming adapters on page 6-70
This command runs the adapter insertion for Avalon-ST connections, which adapt connections with
mismatched configuration, such as mismatched data widths.

remove_connection <connection> on page 6-70
This command removes a connection from the system.
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remove_instance <instance> on page 6-70
This command removes a child instance from the system.
remove_interface <interface> on page 6-70
This command removes an exported top-level interface from the system.
save_system [<file>] on page 6-71
This command saves the current in-memory system to the named file. If the file is not specified, the system
saves to the same file that was opened with the | oad_syst em command.
send_message <level> <message> on page 6-71
This command sends a message to the user of the script. The message text is normally interpreted as HTML.
You can use the <b> element to provide emphasis.
set_connection_parameter_value <connection> <parameter> <value> on page 6-72
This command sets the parameter value for a connection.
set_instance_parameter_value <instance> <parameter> <value> on page 6-72
This command set the parameter value for a child instance. Derived parameters and SYSTEM | NFO
parameters for the child instance can not be set with this command.
set_instance_property <instance> <property> <value> on page 6-73
This command sets the property value of a child instance. Most instance properties are read-only and can
only be set by the instance itself. The primary use for this command is to update the ENABLED parameter,
which includes or excludes a child instance when generating the system.
set_interface_property <interface> <property> <value> on page 6-73
This command sets the property value on an exported top-level interface. This command is used to set the
EXPORT_OF property to specify which interface of a child instance is exported by the top-level interface.
set_module_property <property> <value> on page 6-73
This command sets the system property value, such as the name of the system using the NAME property.
set_project_property <property> <value> on page 6-74
This command sets the project property value, such as the device family.
set_validation_property <property> <value> on page 6-74
This command sets a property that affects how and when validation is run during system scripting. To disable
system validation after each scripting command, set AUTOVATI C_VALI DATI ONto false.
unlock_avalon_base_address <instance.interface> on page 6-74
This command allows the memory-mapped base address to be changed for connections to an interface on
an instance when the aut 0_assi gn_base_addr esses or
aut o_assi gn_system base_addr esses commands are run.
upgrade_sopc_system <filename> on page 6-75
This command loads the specified .sopc file, which then upgrades the file as a Qsys-compatible system. Some
child instances and interconnect are replaced so that the system functions in Qsys. You must save the new
Qsys-compatible system with the save_syst emcommand.
validate_connection <connection> on page 6-75
This command validates the specified connection, and returns the during validation messages.
validate_instance <instance> on page 6-75
This command validates the specified child instance, and returns the validation messages.
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validate_instance_interface <instance> <interface> on page 6-76
This command validates an interface on a child instance, and returns the validation messages.

validate_system on page 6-76
This command validates the system, and returns the validation messages.

add_connection <start> [<end>]
This command connects interfaces using an appropriate connection type. Interface names consist of a child
instance name, followed by the name of an interface provided by that module, for example, mux0. out is
the interface out on the instance named nmux0.

add_connection

Usage add_connection <start> [<end>]
Returns None
start The start interface to be
connected, in <i nst ance_
name>. <i nt erface_nane>
Arguments format.
end The end interface to be connected
<i nst ance_nane>
. <i nterface_nane>. format.
Example add_connection dna.read_naster sdram sl

add_instance <name> <type> [<version>]
This command adds an instance of a component, referred to as a child or child instance, to the system.

Usage add_i nst ance<nane> <type> [ <versi on>]

Returns None

name Specifies a unique local name that
you can use to manipulate the
instance. This name is used in the
generated HDL to identify the
instance.

type The type refers to a kind of
instance available in a library, for
example altera_avalon_uart.

Arguments

ver si on (optional) The required version of the
specified instance type. If no
version is specified, the latest
version is used.

Example add_i nstance uart_0O altera_aval on_uart
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add_interface <name> <type> <direction>
This command adds an interface to your system, which you can use to export an interface from within the

system. You specify the exported interface with the commandset _i nt er f ace_pr operty EXPORT_CF
<instance.interface>.

Usage add_i nterface <name> <type> <direction>
Returns None
name The name of the interface that will
be exported from the system.
Arguments type The type of interface.
direction The interface direction.
Example add_interface ny_export conduit end

add_interface ny_export conduit end

set _interface_property ny_export EXPORT_OF uart _
0. external _connection

auto_assign_base_addresses <instance>
This command assigns base addresses to memory-mapped interfaces on an instance in the system. Instance
interfaces that are locked with lock_avalon_base_address command keep their addresses during address
auto-assignment.

auto_assign_base_addresses

Usage aut o_assi gn_base_addresses <i nstance>
Returns None
Arguments i nstance The name of the instance with

memory mapped interfaces.

Example aut o_assi gn_base_addresses sdram

auto_assign_irqs <instance>
This command assigns interrupt numbers to all connected interrupt senders on an instance in the system.

auto_assign_irgs

Usage auto_assign_irgs <instance>
Returns None
Arguments i nstance The name of the instance with an

interrupt sender.

Example aut o_assign_irgs sdram
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This command creates connections from an instance or instance interface to matching interfaces in other
instances in the system. For example, Avalon-MM slaves are connected to Avalon-MM masters.

auto_connect

Usage aut o_connect <el ement >

Returns None

Arguments el enent The name of the instance
interface, or the name of an
instance.

Example aut o_connect sdram

aut o_connect uart_0.sl

create_system [<name>]

This command replaces the current system in the system script with a new system with the specified name.

create_system

Usage create_system [ <nane>]

Returns None

Arguments name (optional) The name of the new system.
Example create_system ny_new system nane

get_instance_interface_parameter_value <instance> <interface> <parameter>
This command returns the value of a parameter of an interface in a child instance.

get_composed_connection_parameter_value

Usage get _i nstance_i nterface_paranet er_val ue <i nstance>
<i nterface> <paraneter>
Return various The value of the parameter.
i nstance The name of the child instance.
i nterface The name of an interface on the
Arguments child instance.
par anmet er The name of the parameter on the
interface.
Example get _instance_interface_parameter_value uart_0 sO

set upTi nme
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get_composed_connection_parameters <instance> <childConnection>
This command returns a list of parameters on a connection in the subsystem, for an instance that contains
a subsystem.

get_composed_connection_parameters

Usage get _conposed_connecti on_paraneters <i nstance>
<chi | dConnecti on>
Returns string[ ] A list of parameter names.
i nstance The child instance containing a
subsystem.
Arguments
chi | dConnecti on The name of the connection in the
subsystem.
Example get _conposed_connecti on_paraneters subsystem O
cpu. dat a_mast er/ nenory. s0O

get_composed_connections <instance>
This command returns a list of all connections in a subsystem, for an instance that contains a subsystem.

get_composed_connections

Usage get _conposed_connecti ons <i nstance>

Returns string[ ] A list of connection names in the
subsystem. These connection
names are not qualified with the
instance name.

Arguments i nstance The child instance containing a
subsystem.
Example get _conposed_connecti ons subsystem O

get_composed_instance_assignment <instance> <childInstance> <key>
This command returns the value of an assignment on an instance of a subsystem, for an instance that models
a subsystem.

get_composed_instance_assignment

Usage get _conposed_i nst ance_assi gnment <i nst ance>
<chi I dl nst ance> <key>
Returns string[ ] The value of the assignment.
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get_composed_instance_assignment

i nstance The child instance containing a
subsystem.
Arguments chi I dl nstance The name of a child instance

found in the subsystem.

key The assignment key.

Example get _conposed_i nst ance_assi gnnent subsystem O
vi deo_0 "enbeddedsw. CVvacr o. col or Space"

get_composed_instance_assignments <instance> <childinstance>
This command returns a list of assignments on an instance of a subsystem, for an instance that contains a
subsystem.

get_composed_instance_assignments

Usage get _conposed_i nstance_assi gnnent s <i nstance>
<chi I dl nst ance>
Returns string[ ] A list of assignment names.
i nstance The child instance containing a
subsystem.
Arguments
chi | dl nst ance The name of a child instance
found in the subsystem.

Example get _conposed_i nstance_assi gnnents subsystem 0 cpu

get_composed_instance_parameter_value <instance> <childInstance> <parameter>
This command returns the value of a parameters on an instance in a subsystem, for an instance that contains
a subsystem.

get_composed_instance_parameter_value

Usage get _conposed_i nst ance_par anet er _val ue <i nstance>
<chi | dl nst ance> <par anet er >
Returns string [ ] The value of a parameter on an
instance of a subsystem.
i nstance The child instance containing a
subsystem.
chi | dl nst ance The name of a child instance
Arguments found in the subsystem.
par anet er The name of the parameter to
query on an instance of a
subsystem.
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get_composed_instance_parameter_value

Example get _conposed_i nstance_par anet er _val ue subsystem_
0 cpu DATA W DTH

get_composed_instance_parameters <instance> <childInstance>
This command returns a list of parameters on an instance of a subsystem, for an instance that contains a
subsystem.

get_composed_instance_parameters

Usage get _conposed_i nstance_paraneters <i nstance>
<chi I dl nst ance>
Returns string [ ] A list of parameter names.
i nstance The child instance containing a
subsystem.
Arguments
childl I nstance The name of a child instance
found in the subsystem.

Example get _conposed_i nst ance_paraneters subsystem 0 cpu

get_composed_instances <instance>
This command returns a list of child instances in the subsystem, for an instance that contains a subsystem.

get_composed_instances

Usage get _conposed_i nst ances <i nstance>

Returns string [ ] A list of instance names found in
the subsystem.

Arguments i nstance The child instance containing a
subsystem.
Example get _conposed_i nstances subsystem O

get_connection_parameter_property <connection> <parameter> <property>
This command returns the value of a parameter property in a connection.

get_connection_parameter_property

Usage get _connection_paraneter _property <connection>
<par anet er > <property>
Returns various The value of the parameter
property.
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get_connection_parameter_property

connection The connection to query.
Arguments par anet er The name of the parameter.
property The property of the connection.
Example get _connecti on_paraneter_property cpu. data_master/
dma0. csr baseAddress UNI TS

get_connection_parameter_value <connection> <parameter>
This command gets the value of a parameter on the connection. Parameters represent aspects of the connection
that can be modified once the connection is created, such as the base address for an Avalon-MM connection.

get_connection_parameter_value

Usage get _connection_paraneter_val ue <connecti on>
<par anet er >
Returns various The value of the parameter.
connection The connection to query.
Arguments
par amet er The name of the parameter.
Example get _connection_paraneter_val ue cpu. data_master/

dma0. csr baseAddr ess

get_connection_parameters <connection>
This command returns a list of parameters found on a connection. The list of connection parameters is the
same for all connections of the same type.

get_connection_parameters

Usage get _connection_paranmeters <connection>

Returns string [ ] A list of parameter names.
Arguments connection The connection to query.
Example get _connecti on_paraneters cpu. dat a_nast er/ dnma0. csr

get_connection_properties
This command returns a list of properties found on a connection. The list of connection properties is the
same for all connections, regardless of type.

get_connection_properties

Usage get _connection_properties
Returns string [ ] A list of connection properties.
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get_connection_properties

Arguments None ‘

Example get _connection_properties

get_connection_property <connection> <property>
This command returns the value of a connection property.

get_connection_property

Usage get _connection_property <connection> <property>
Returns string[ ] The value of a connection
property.
connection The connection to query.
Arguments property The name of the connection
property.
Example get _connection_property cpu. data_mast er/ dna0. csr
TYPE

get_connections [<element>]
This command returns a list of connections in the system if no element is specified. If a child instance is
specified, for example cpu, all connections to any interface on the instance are returned. If an interface on
achild instance is specified, for example cpu. i nst ruct i on_mast er, only connections to that interface
are returned.

get_connections

Usage get _connections [<el ement >]
Returns string[ ] A list of connections.
Arguments el ement (optional) The name of a child instance, or

the qualified name of an interface
on a child instance.

Example get _connecti ons
get _connections cpu

get _connections cpu.instruction_naster

get_instance_assignment <instance> <key>
This command returns the value of an assignment on a child instance.

get_instance_assignment

Usage ‘get _instance_assi gnment <i nstance> <key>
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get_instance_assignment

Returns string[ ] The value of the specified
assignment.
i nstance The name of the child instance.
Arguments
key The assignment key to query.
Example get _i nstance_assi gnnent vi deo_processor
enbeddedsw. CMacr 0. col or Space

get_instance_assignments <instance>
This command returns a list of assignment keys for any assignments defined for the instance.

get_instance_assignments

Usage get i nstance_assi gnnents <instance>

Returns string[ ] A list of assignment keys.
Arguments i nstance The name of the child instance.
Example get _i nstance_assi gnnents sdram

get_instance_interface_assignment <instance> <interface> <key>
This command returns the value of an assignment on an interface of a child instance.

get_instance_interface_assignment

Usage get _instance_interface_assi gnnent <instance>
<interface> <key>
Returns string [ ] The value of the specified
assignment.
i nstance The name of the child instance.
interface The name of an interface on the
Arguments 7
child instance.
key The assignment key to query.
Example get _instance_interface_assi gnnent sdram sl

enbeddedsw. configuration.isFl ash

get_instance_interface_assignments <instance> <interface>
This command returns the value of an assignment on an interface of a child instance.

get_instance_interface_assignments

get _instance_interface_assi gnnents <instance>
<interface>

Usage
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Returns string[ ] A list of assignment keys.
i nstance The name of the child instance.
Arguments interface The name of an interface on the
child instance.

Example get _instance_interface_assi gnments sdram sl

get_instance_interface_parameter_property <instance> <interface> <parameter> <property>
This command returns the property value on a parameter in an interface of a child instance.

get_instance_interface_parameter_property

Usage get _instance_i nterface_paranet er_property
<i nstance> <i nterface> <paraneter> <property>

Returns various The value of the parameter
property.
i nstance The name of the child instance.
interface The name of an interface on the
child instance.
Arguments par anet er The name of the parameter on the
interface.
property The name of the property on the
parameter.
Example get _instance_interface_paranmeter_property uart_0O

sO setupTi me ENABLED

get_instance_interface_parameter_value <instance> <interface> <parameter>
This command returns the value of a parameter of an interface in a child instance.

get_composed_connection_parameter_value

Usage get _instance_i nterface_paranet er _val ue <i nstance>
<i nterface> <paraneter>
Return various The value of the parameter.
i nstance The name of the child instance.
interface The name of an interface on the
Arguments child instance.
par anet er The name of the parameter on the
instance.
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get_composed_connection_parameter_value

Example get _instance_interface_parameter_value uart_0 sO
set upTi ne

get_instance_interface_parameters <instance> <interface>
This command returns a list of parameters for an interface in a child instance.

get_instance_interface_parameters

Usage get _instance_interface_paraneters <instance>
<interface>

Returns string[ ] A list of parameter names for
parameters in the interface.

i nst ance The name of the child instance.
Arguments interface The name of an interface on the
child instance.
Example get _instance_interface paraneters uart_0 sO

get_instance_interface_port_property <instance> <interface> <port> <property>
This command returns the property value of a port in the interface of a child instance.

get_instance_interface_port_property

Usage get _instance_interface_port_property <instance>
<interface> <port> <property>

Returns various The value of the port property.
i nstance The name of the child instance.
interface The name of an interface on the

child instance.

Arguments

port The name of the port in the
interface.
property The name of the property of the
port.
Example get _instance_interface_port_property uart_0O

exports tx WDTH

get_instance_interface_ports <instance> <interface>
This command returns a list of ports in an interface of a child instance.
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get_instance_interface_properties

get_instance_interface_ports

Usage get _instance_interface ports <instance>
<interface>
Returns string[ ] A list of port names found in the
interface.
i nstance The name of the child instance.
Arguments interface The name of an interface on the
child instance.
Example get _instance_interface_ports uart_0 sO

get_instance_interface_properties
This command returns a list of properties that you can be query for an interface in a child instance.

get_instance_interface_properties

Usage get __instance_interface_properties

Returns string[ ] A list of property names.
Arguments None

Example get _instance_interface_properties

get_instance_interface_property <instance> <interface> <property>
This command returns the property value for an interface in a child instance.

get_instance_interface_property

Usage get _instance_interface_property <instance>
<interface> <property>
Return string [ ] The value of the property.
i nstance The name of the child instance.
i nterface The name of an interface on the
Arguments child instance.
property he name of the property of the
interface.
Example get __instance_interface_property uart_0 sO

DESCRI PTI ON

get_instance_interfaces <instance>
This command returns a list of interfaces in a child instance.
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get_instance_interfaces

Usage get _instance_interfaces <instance>

Returns string[ ] A list of interface names.
Arguments i nstance The name of the child instance.
Example get _instance_interfaces uart_0O

get_instance_parameter_property <instance> <parameter> <property>
This command returns the value of a parameter in a connection in the subsystem, for an instance that
contains a subsystem.

get_instance_parameter_property

Usage get _instance_parameter_property <instance>
<par amet er > <property>
Return various The name of the child instance.
i nstance The child instance containing a
subsystem.
par anet er The name of the parameter in the
Arguments .
instance.
property The name of the property of the
parameter.
Example get _instance_paraneter_property uart_ 0O baudRate
ENABLED

get_instance_parameter_value <instance> <parameter>
This command returns the value of a property in a child instance.

get_instance_parameter_value

Usage get _i nstance_paranet er _val ue <i nstance>
<par anet er >
Returns various The value of the parameter.
i nstance The name of the child instance.
Arguments par anet er The name of the parameter in the
instance.
Example get _instance_paraneter_val ue uart_0 baudRate

get_instance_parameters <instance>
This command returns a list of parameters in a child instance.
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get_instance_port_property <instance> <port> <property>

get_instance_parameters

Usage get _instance_paraneters <instance>

Returns string[ ] A list of parameters in the
instance.

Arguments i nstance The name of the child instance.

Example get _i nstance_paraneters uart_0O

get_instance_port_property <instance> <port> <property>
This command returns the value of a property of a port contained by an interface in a child instance.

get_instance_port_property

Usage get _instance_port_property <instance> <port>
<property>
Return various The value of the property for the
port.
i nstance The name of the child instance.
port The name of a port in one of the
interfaces on the child instance.
Arguments
property The name of a property found on
the port; DI RECTI ON, RCLE,
W DTH.
Example get _instance_port_property uart_0 tx WDTH

get_instance_properties

This command returns a list of properties for a child instance.

get_instance_properties

Usage get _instance_properties

Returns string[ ] A list of property names for the
child instance.

Arguments None

Example get _i nstance_properties

get_instance_property <instance> <property>

6-65

This command returns the value of a property for a child instance.

get_instance_property

Usage ‘get _instance_property <instance> <property>
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Returns string[ ] The value of the property.
i nstance The name of the child instance.
Arguments property The name of a property found on
the instance.
Example get _instance_property cpu ENABLED

get_instances

This command returns a list of the instance names for all child instances in the system.

get_instances

Usage get _i nstances

Returns string[ ] A list of child instance names.
Arguments None

Example get i nstances

get_interface_port_property <interface ><port ><property>

This command returns the value of a property of a port contained by an interface in a child instance.

get_interface_port_property

Usage get _interface port_property <interface><port>
<property>
Return various The value of the property.
i nstance The name of a top-level interface
on the system.
Arguments port The name of a port found in the
interface.
property The name of a property found on
the port.
Example get _interface_port_property uart_exports tx

DI RECTI ON

get_interface_ports <interface>

This command returns the names of all of the ports that have been added to an interface.

get_interface_ports

Usage

‘get _interface_ports <interface>
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get_interface_ports

Returns string[ ] A list of port names.

Arguments interface The name of a top-level interface
on the system.

Example get _interface ports export_cl k_out

get_interface_properties
This command returns the names of all the available interface properties. The list of interface properties is
the same for all interface types.

get_interface_properties

Usage get __interface_properties

Returns string[ ] A list of interface properties.
Arguments None

Example get _interface_properties

get_interface_property <interface> <property>
This command returns the value of a property from the specified interface.

get_interface_property

Usage get _interface property <interface> <property>
Return various The property value.
interface The name of a top-level interface
on the system.
Arguments
property The name of the property,
EXPORT_OF.
Example get _interface _property export_clk_out EXPORT_COF

get_interfaces
This command returns a list of top-level interfaces in the system.

get_interfaces

Usage get _interfaces
Returns string[ | A list of the top-level interfaces
exported from the system.
Arguments None
Example get _interfaces
Creating a System With Qsys Altera Corporation

CJ Send Feedback


mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Creating%20a%20System%20With%20Qsys%20(QII51020%202013.11.4)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

1151020
6-68 get_module_properties 2(())1 3.11.4

get_module_properties
This command returns the properties that you can manage for the top-level module.

get_module_properties

Usage get _nodul e_properties

Returns string[ ] A list of property names.
Arguments None

Example get _nodul e_properties

get_module_property <property>

This command returns the value of a top-level system property.

get_module_property

Usage get _nodul e_property <property>

Returns string[ ] The value of the property.

Arguments property The name of the property to
query; NAME.

Example get _nodul e_property NAVE

get_parameter_properties

This command returns a list of properties that you can query on parameters. These properties can be queried
on any parameter, such as parameters on instances, interfaces, instance interfaces, and connections.

get_parameter_properties

Usage get _paraneter_properties

Returns string[ ] A list of parameter properties.
Arguments None

Example get paraneter _properties

get_port_properties

This command returns a list of properties that you can query on ports.

get_port_properties

Usage get _port_properties

Returns string[ ] A list of port properties.
Arguments None

Example get _port _properties
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get_project_properties
This command returns a list of properties that you can query for the Quartus II project.

get_project_properties

Usage get _project_properties

Returns string[ ] A list of project properties.
Arguments None

Example get _proj ect_properties

get_project_property <property>
This command returns the value of a Quartus II project property.

get_project_property

Usage get _proj ect _property <property>

Returns string[ ] The value of the property.

Arguments property The name of the project property;
DEVI CE_FAM LY.

Example get _proj ect_property DEVICE_FAM LY

load_system <file>
This command loads a Qsys system from a file, and uses the system as the current system for scripting

commands.
Usage | oad_system <file>
Returns None
Arguments file The path to a .qsys file.
Example | oad_syst em exanpl e. qsys

lock_avalon_base_address <instance.interface>
This command prevents the memory-mapped base address from being changed for connections to an
interface on an instance when the aut 0_assi gn_base_addr esses or
aut o_assi gn_system base_addr esses commands are run.

lock_avalon_base_address

Usage | ock_aval on_base address <instance.interface>
Returns None
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lock_avalon_base address

Arguments i nstance.interface The qualified name of the
interface of an instance, in
<instance>.<interface> format.

Example | ock_aval on_base_address sdram sl

preview_insert_avalon_streaming_adapters
This command runs the adapter insertion for Avalon-ST connections, which adapt connections with
mismatched configuration, such as mismatched data widths.

preview_insert_avalon_streaming_adapters

Usage previ ew_ i nsert_aval on_stream ng_adapters
Returns None
Arguments None
Example previ ew_ i nsert _aval on_streani ng_adapters

remove_connection <connection>
This command removes a connection from the system.

remove_connection

Usage renove_connecti on <connection>

Returns None

Arguments connection The name of the connection to
remove.

Example renmove_connecti on cpu. data_naster/sdram sO

remove_instance <instance>
This command removes a child instance from the system.

remove_instance

Usage renove_i nstance <instance>

Returns None

Arguments i nstance The name of the child instance to
remove.

Example renove_i nstance cpu

remove_interface <interface>
This command removes an exported top-level interface from the system.
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remove_interface

Usage renove_i nterface <interface>
Returns None
Arguments interface The name of the exported top-

level interface.

Example remove_interface cl k_out

save_system [<file>]
This command saves the current in-memory system to the named file. If the file is not specified, the system
saves to the same file that was opened with the | oad_syst em command.

save_system

Usage save_system [<fil e>]
Returns None
Arguments fil e optional If present, the path of the .qsys file
to save.
Example save_system
save_syst em exanpl e. gsys

send_message </evel> <message>
This command sends a message to the user of the script. The message text is normally interpreted as HTML.
You can use the <b> element to provide emphasis.

send_message

Usage send_nessage <l evel > <nessage>
Return None
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| evel The following message levels are
supported:
o ERROR—Provides an error
message.

« WARNI NG—Provides a
warning message.

« | NFO—Provides an informa-
tional message.

« PROGRESS—Provides a
progress message.

« DEBUG—Provides a debug

message when debug mode is
enabled.

Arguments

nmessage The text of the message.

Example send_nessage ERROR "The systemis down!"

set_connection_parameter_value <connection> <parameter> <value>
This command sets the parameter value for a connection.

set_connection_parameter_value

Usage set _connection_paraneter_val ue <connecti on>
<par anet er > <val ue>

Return None
connection The connection.

Arguments par amet er The name of the parameter.
val ue The new parameter value.

Example set _connecti on_paranet er_val ue cpu. data_master/
dma0. csr baseAddress "0x000a0000"

set_instance_parameter_value <instance> <parameter> <value>
This command set the parameter value for a child instance. Derived parameters and SYSTEM | NFO
parameters for the child instance can not be set with this command.

set_instance_parameter_value

Usage set _i nstance_paranet er _val ue <i nstance>
<par anet er> <val ue>
Return None
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set_instance_parameter_value

i nstance The name of the child instance.
Arguments par anet er The name of the parameter.

val ue The new parameter value.
Example set _i nstance_paranet er _val ue uart_0 baudRat e 9600

set_instance_property <instance> <property> <value>
This command sets the property value of a child instance. Most instance properties are read-only and can
only be set by the instance itself. The primary use for this command is to update the ENABLED parameter,
which includes or excludes a child instance when generating the system.

set_instance_property

Usage set _instance_property <instance> <property>
<val ue>
Return None
i nstance The name of the child instance.
Arguments property The name of the property.
val ue The new parameter value.
Example set _instance_property cpu ENABLED fal se

set_interface_property <interface> <property> <value>
This command sets the property value on an exported top-level interface. This command is used to set the
EXPORT_OF property to specify which interface of a child instance is exported by the top-level interface.

set_interface_property

Usage set _interface property <interface> <property>
<val ue>
Return None
interface The name of an exported top-level
interface.
Arguments property The name of the property.
val ue The new parameter value.
Example set _interface_property cl k_out EXPORT_OF cl k. cl k_
out

set_module_property <property> <value>
This command sets the system property value, such as the name of the system using the NAME property.

Creating a System With Qsys Altera Corporation

CJ Send Feedback


mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Creating%20a%20System%20With%20Qsys%20(QII51020%202013.11.4)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

Q151020

6-74 set_project_property <property> <value> 2013.11.4

set_module_property

Usage set _nodul e_property <property> <val ue>
Return None

property The name of the property.
Arguments

val ue The new property value.
Example set _nodul e_property NAME "new_system nane"

set_project_property <property> <value>
This command sets the project property value, such as the device family.

set_project_property

Usage set _project_property <property> <val ue>
Return None
property The name of the property.
Arguments
val ue The new property value.
Example set _project _property DEVICE FAMLY "Cyclone 1V
mll

set_validation_property <property> <value>
This command sets a property that affects how and when validation is run during system scripting. To disable
system validation after each scripting command, set AUTOVATI C_VALI DATI ONto false.

set_validation_property

Usage set _val i dati on_property <property> <val ue>
Return None

property The name of the property.
Arguments

val ue The new property value.
Example set _validati on_property AUTQVATI C_VALI DATI ON f al se

unlock_avalon_base_address <instance.interface>
This command allows the memory-mapped base address to be changed for connections to an interface on
an instance when the aut o_assi gn_base_addr esses or
aut o_assi gn_system base_addr esses commands are run.

unlock_avalon_base_address

Usage ‘unl ock_aval on_base_address <instance.interface>
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unlock_avalon_base_address

Return None

Arguments i nstance.interface The qualified name of the
interface of an instance, in
<instance>.<interface> format

Example unl ock_aval on_base_address sdram sl

upgrade_sopc_system <filename>
This command loads the specified .sopc file, which then upgrades the file as a Qsys-compatible system. Some
child instances and interconnect are replaced so that the system functions in Qsys. You must save the new
Qsys-compatible system with the save_syst emcommand.

upgrade_sopc_system

Usage upgr ade_sopc_system <fi | enane>
Return None
Arguments filenane The path to the .sopc file being

upgraded. The upgrade moves the
.sopc file and related generation
files to a backup directory.

Example upgr ade_sopc_system ol d_system sopc

validate_connection <connection>
This command validates the specified connection, and returns the during validation messages.

validate_connection

Usage val i dat e_connecti on <connecti on>

Return string [ ] A list of messages produced
validation.

Arguments connecti on The path to the .sopc file being

upgraded. The upgrade moves the
.sopc file and related generation
files to a backup directory.

Example val i dat e_connecti on cpu. data_master/sdram sl

validate_instance <instance>
This command validates the specified child instance, and returns the validation messages.

validate_instance

Usage ‘val i dat e_i nstance <i nstance>
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Return string [ ] A list of messages produced
validation.

Arguments i nstance The name of the child instance to
validate.

Example val i date_i nstance cpu

validate_instance_interface <instance> <interface>
This command validates an interface on a child instance, and returns the validation messages.

validate_instance_interface

Usage val i dat e_i nstance_i nterface <i nstance> <interface>
Return string [ ] A list of messages produced
validation.
i nstance The name of the child instance.
Arguments i nterface The name of the instance on the
child instance to validate.
Example val i date_i nstance_interface cpu data_naster

validate_system

This command validates the system, and returns the validation messages.

validate_system

Usage val i dat e_system

Return string [ ] A list of messages produced
validation.

Arguments None

Example val i dat e_system

Document Revision History

Table 6-7 indicates edits made to the Creating a System With Qsys content since its creation.
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Table 6-7: Document Revision History

November 2013 | 13.1.0 o Added: Integrating with the .gqsys File.

o Added: Using the Hierarchy Tab.

o Added: Managing Interconnect Requirements.
o Added: Viewing Qsys Interconnect.

May 2013 13.0.0 o Added AMBA APB support.
o Added gsys-generate utility.
o Added VHDL BF

May 2013

M ID support.
o Added Creating Secure Systems (TrustZones) .

« Added CMSIS Support for Qsys Systems With An HPS
Component.

o Added VHDL language support options.

November 2012 |12.1.0 o Added AMBA AXI4 support.

June 2012 12.0.0 o Added AMBA AX3I support.
o Added Preset Editor updates.
o Added command-line utilities, and scripts.

November 2011  |11.1.0 » Added Synopsys VCS and VCS MX Simulation Shell Script.

o Added Cadence Incisive Enterprise (NCSIM) Simulation Shell
Script.

o Added Using Instance Parameters and Example Hierarchical
System Using Parameters.

May 2011 11.0.0 o Added simulation support in Verilog HDL and VHDL.
o Added testbench generation support.
» Updated simulation and file generation sections.

December 2010 | 10.1.0 Initial release.

Related Information
Quartus IT Handbook Archive

Creating a System With Qsys Altera Corporation

() send Feedback


http://www.altera.com/literature/lit-qts_archive.jsp
mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Creating%20a%20System%20With%20Qsys%20(QII51020%202013.11.4)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

Creating Qsys Components

2013.11.4

Q151022 B< Subscribe (] Send Feedback

In order to describe and package IP components for use in a Qsys system, you must create a Hardware
Component Definition File (_hw.tcl) which will describes your component, its interfaces and HDL files.
Qsys provides the Component Editor to help you create a simple _hw.tcl file.

The Demo AXI Memory example on the Qsys Design Examples page of the Altera” web site provides the
full code examples that appear in the following topics.

Qsys supports standard Avalon®, AMBA"” AXI3" (version 1.0), AMBA AXI4 (version 2.0), and AMBA
APB 3 (version 1.0) interface specifications.

Related Information
o Avalon Interface Specifications
o AMBA Protocol Specifications

« Demo AXI Memory Example

Qsys Components

A Qsys component includes the following elements:

 Information about the component type, such as name, version, and author.
« HDL description of the component’s hardware, including SystemVerilog, Verilog HDL, or VHDL files

+ Constraint files (Synopsys Design Constraints File (.sdc) and/or Quartus II IP File (.qip)) that define the
component for synthesis and simulation.

« A component’s interfaces, including I/O signals.
o The parameters that configure the operation of the component.

Component Interface Support

Components can have any number of interfaces in any combination. Each interface represents a set of signals
that you can connect within a Qsys system, or export outside of a Qsys system.
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Qsys components can include the following types of interfaces:

o Memory-Mapped—Implements a partial crossbar interconnect structure (Avalon-MM, AXI, and APB)
that provides concurrent paths between master and slaves. Interconnect consists of synchronous logic
and routing resources inside the FPGA, and implementation is based on a network-on-chip architecture.

+ Streaming—Connects Avalon Streaming (Avalon-ST) sources and sinks that stream unidirectional data,
as well as high-bandwidth, low-latency components. Streaming creates datapaths for unidirectional traffic,
including multichannel streams, packets, and DSP data. The Avalon-ST interconnect is flexible and can
implement on-chip interfaces for industry standard telecommunications and data communications cores,
such as Ethernet, Interlaken, and video. You can define bus widths, packets, and error conditions.

 Interrupts—Connects interrupt senders and the interrupt receivers of the component that serves them.
Qsys supports individual, single-bit interrupt requests (IRQs). In the event that multiple senders assert
their IRQs simultaneously, the receiver logic (typically under software control) determines which IRQ
has highest priority, then responds appropriately.

o Clocks—Connects clock output interfaces with clock input interfaces. Clock outputs can fan-out without
the use of a bridge. A bridge is required only when a clock from an external (exported) source connects
internally to more than one source.

+ Resets—Connects reset sources with reset input interfaces. If your system requires a particular positive-
edge or negative-edge synchronized reset, Qsys inserts a reset controller to create the appropriate reset
signal. If you design a system with multiple reset inputs, the reset controller ORs all reset inputs and
generates a single reset output.

+ Conduits—Connects point-to-point conduit interfaces, or represent signals that are exported from the
Qsys system. Qsys uses conduits for component I/O signals that are not part of any supported standard
interface. You can connect two conduits directly within a Qsys system as a point-to-point connection,
or conduit interfaces can be exported and brought to the top-level of the system as top-level system I/O.
You can use conduits to connect to external devices, for example external DDR SDRAM memory, and
to FPGA logic defined outside of the Qsys system.

Component Structure

Altera provides components automatically installed with the Quartus” II software. You can obtain a list of
Qsys-compliant components provided by third-party IP developers on Altera's Intellectual Property &
Reference Designs page by typing: qsys certified in the Search box, and then selecting IP Core & Reference
Designs. Components are also provided with Altera development kits, which are listed on the All
Development Kits page.

Every component is defined with a < component_name >_hw.tcl file, a text file written in the Tcl scripting
language that describes the component to Qsys. When you design your own custom component, you can
create the _hw.tcl file manually, or by using the Qsys Component Editor.

The Component Editor simplifies the process of creating _hw.tcl files by creating a file that you can edit
outside of the Component Editor to add advanced procedures. When you edit a previously saved _hw.tcl
tile, Qsys automatically backs up the earlier version as _hw.tcl~.

You can move component files into a new directory, such as a network location, so that other users can use
the component in their systems. The _hw.tcl file contains relative paths to the other files, so if you move an
_hw.tcl file, you should also move all the HDL and other files associated with it.
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There are three component types:

« Static— Static components always generate the same output, regardless of their parameterization.
Components that instantiate static components must have only static children.

+ Generated—A generated component's fileset callback allows an instance of the component to create
unique HDL design files based on the instance's parameter values.

« Composed—Composed components are subsystems constructed from instances of other components.
You can use a composition callback to manage the subsystem in a composed component.

Related Information
 Intellectual Property & Reference Designs
+ Creating a Composed Component or Subsystem on page 7-28

o Adding Component Instances to a Static or Generated Component on page 7-32

Component File Organization

A typical component uses the following directory structure where the names of the directories are not
significant:

<component_directory>/

o <hdl>/—Contains the component HDL design files, for example .v, .sv, or .vhd files that contain the
top-level module, along with any required constraint files.

o <component_name> _hw.tcl—The component description file.

o <component_name> _sw.tcl—The software driver configuration file. This file specifies the paths for the
.cand .h files associated with the component, when required.

» <software>/—Contains software drivers or libraries related to the component.

Note: Refer to the Nios II Software Developer’s Handbook for information about writing a device driver or
software package suitable for use with the Nios II processor.

Related Information
o Hardware Abstraction LayerTool Reference (Nios II Software Developer’s Handbook)

o Nios II Software Build Tool Reference (Nios II Software Developer’s Handbook)

Component Versions

Qsys systems support multiple versions of the same component within the same system; you can create and
maintain multiple versions of the same component.

If you have multiple _hw.tcl files for components with the same NAME module properties and different
VERSION module properties, both versions of the component are available.

If multiple versions of the component are available in the Qsys Library, you can add a specific version of a
component by right-clicking the component, and then selecting Add version <version_number>.

Upgrading IP Components to the Latest Version
When you open a Qsys design, if Qsys detects IP components that require regeneration, the Upgrade IP
Cores dialog box appears and allows you to upgrade outdated components.
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Components that you must upgrade in order to successfully compile your design appear in red. Status icons
indicate whether a component is currently being regenerated, the component is encrypted, or that there is
not enough information to determine the status of component. To upgrade a component, in the Upgrade
IP Cores dialog box, select the component that you want to upgrade, and then click Upgrade. The Quartus
IT software maintains a list of all IP components associated with your design on the Components tab in the
Project Navigator.

Related Information
Upgrade IP Components Dialog Box

Life Cycle of a Component

When you define a component with the Qsys Component Editor, or a custom _hw.tcl file, you specify the
information that Qsys requires to instantiate the component in a Qsys system and to generate the appropriate
output files for synthesis and simulation.

The following phases describe the process when working with components in Qsys:

» Discovery—During the discovery phase, Qsys reads the _hw.tcl file to identify information that appears
in the Qsys Library, such as the component's name, version, and documentation URLs. Each time you
open Qsys, the tool searches for the following file types using the default search locations and entries in
the IP Search Path:

o _hw.tcl files—Each _hw.tcl file defines a single component.
o IP Index (.ipx) files—Each .ipx file indexes a collection of available components, or a reference to
other directories to search.

+ Static Component Definition—During the static component definition phase, Qsys reads the _hw.tcl
file to identify static parameter declarations, interface properties, interface signals, and HDL files that
define the component. At this stage of the life cycle, the component interfaces might be only partially
defined.

o Parameterization—During the parameterization phase, after an instance of the component is added to
a Qsys system, the user of the component specifies parameters with the component’s parameter editor.

 Validation—During the validation phase, Qsys validates the values of each instance's parameters against
the allowed ranges specified for each parameter. You can use callback procedures that run during the
validation phase to provide validation messages. For example, if there are dependencies between parameters
where only certain combinations of values are supported, you can report errors for the unsupported
values.
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 Elaboration—During the elaboration phase, Qsys queries the component for its interface information.
Elaboration is triggered when an instance of a component is added to a system, when its parameters are
changed, or when a system property changes. You can use callback procedures that run during the
elaboration phase to dynamically control interfaces, signals, and HDL files based on the values of
parameters. For example, interfaces defined with static declarations can be enabled or disabled during
elaboration. When elaboration is complete, the component's interfaces and design logic must be completely
defined.

« Composition—During the composition phase, a component can manipulate the instances in the
component's subsystem. The _hw.tcl file uses a callback procedure to provide parameterization and
connectivity of subcomponents.

+ Generation—During the generation phase, Qsys generates synthesis or simulation files for each component
in the system into the appropriate output directories, as well as any additional files that support associated
tools.

Creating Qsys Components in the Component Editor

The Qsys Component Editor, accessed by clicking New Component in the Qsys Library, allows you to create
and package a component for use in Qsys. When you use the Component Editor to define a component, the
Component Editor writes the information to the _hw.tcl file.

The Component Editor allows you to perform the following tasks:

o Specify component’s identifying information, such as name, version, author, etc.

o Specify the SystemVerilog, Verilog HDL, or VHDL files, and constraint files that define the component
for synthesis and simulation.

+ Create an HDL template for a component by first defining its parameters, signals, and interfaces.

« Associate and define signals for a component’s interfaces.

« Set parameters on interfaces, which specify characteristics.

o Specify relationships between interfaces.

o Declare parameters that alter the component structure or functionality.

If the component is HDL-based, you must define the parameters and signals in the HDL file, and cannot
add or remove them in the Component Editor. If you have not yet created the top-level HDL file, you declare
the parameters and signals in the Component Editor, and they are then included in the HDL template file
that Qsys creates.

In a Qsys system, the interfaces of a component are connected within the system, or exported as top-level
signals from the system.

If you are creating the component using an existing HDL file, the order in which the tabs appear in the
Component Editor reflects the recommended design flow for component development. You can use the
Prev and Next buttons at the bottom of the Component Editor window to guide you through the tabs.

If the component is not based on an existing HDL file, enter the parameters, signals, and interfaces first, and
then return to the Files tab to create the top-level HDL file template. When you click Finish, Qsys creates
the component _hw.tcl file with the details provided on the Component Editor tabs.

After the component is saved, it is available in the Qsys Library.

If you require features in the component that are not supported by the Component Editor, such as callback
procedures, you can use the Component Editor to create the _hw.tcl file, and then manually edit the file to

Creating Qsys Components Altera Corporation

() send Feedback


mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Creating%20Qsys%20Components%20(QII51022%202013.11.4)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

1151022
7-6 Saving a Component and Creating an _hw.tcl File 2%13_1 1.4

complete the component definition. Subsequent topics document the _hw.tcl commands that are generated
by the Component Editor, as well as some of the advanced features that you can add with your own _hw.tcl
commands.

Related Information
Component Interface Tcl Reference

Saving a Component and Creating an _hw.tcl File
You save a component by clicking Finish in the Component Editor. The Component Editor saves the

component to a file with the file name <component_name> _hw.tcl.

Altera recommends that you save _hw.tcl files and their associated files in an ip/ <class-name> directory
within your Quartus II project directory. You can also publish component information for use by software,
such as a C compiler and a board support package (BSP) generator.

Refer to Creating a System with Qsys for information on how to search for and add components to the Qsys
library for use in your designs.

Related Information
Publishing Component Information to Embedded Software (Nios II Software Developer’s Handbook)
Creating a System with Qsys

Editing a Component with the Component Editor

In Qsys, you make changes to a component by right-clicking the component in the Library, and then clicking
Edit. After making changes, click Finish to save the changes to the _hw.tcl file. You can open the _hw.tcl
file in a text editor to view the hardware Tcl for the component. If you edit the _hw.tcl file to customize the
component with advanced features, you cannot use the Component Editor to make further changes without
over-writing your customized file.

You cannot use the Component Editor to edit components installed with the Quartus II software, such as
Altera-provided components. If you edit the HDL for a component and change the interface to the top-level
module, you must edit the component to reflect the changes you made to the HDL.

Related Information
Creating Qsys Components (Quartus IT Help)

Specifying Basic Component Information

The Component Type tab in the Component Editor allows you to specify the following information about
the component:
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Name—Specifies the name used in the _hw.tcl filename, as well as in the top-level module name when
you create a synthesis wrapper file for a non HDL-based component.

Display name—Identifies the component in the parameter editor, which you use to configure and instance
of the component, and also appears in the Library under Project and on the System Contents tab.
Version—Specifies the version number of the component.

Group—Represents the category of the component in the list of available components in the Library.
You can select an existing group from the list, or define a new group by typing a name in the Group box.
Separating entries in the Group box with a slash defines a subcategory. For example, if you type Memories
and Memory Controllers/On-Chip, the component appears in the Library under the On-Chip group,
which is a subcategory of the Memories and Memory Controllers group. If you save the component in
the project directory, the component appears in the Library in the group you specified under Project.
Alternatively, if you save the component in the Quartus II installation directory, the component appears
in the specified group under Library.

Description—Allows you to describe the component. This description appears when the user views the
component details.

Created By—Allows you to specify the author of the component.

Icon—Allows you to enter the relative path to an icon file (.gif, .jpg, or .png format) that represents the
component and appears as the header in the parameter editor for the component. The default image is
the Altera MegaCore function icon.

Documentation—Allows you to add links to documentation for the component, and appears when you
right-click the component in the Library, and then select Details.

« To specify an Internet file, begin your path with http://, for example:
http://mydomain.com/datasheets/my_memory_controller.html.

« To specify a file in the file system, begin your path with file:/// for Linux, and file://// for Windows;
for example (Windows): file:////company_server/datasheets my_memory_controller.pdf.

The Display name, Group, Description, Created By, Icon, and Documentation entries are optional. Figure
7-1 shows the Component Type tab with the component information.
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Figure 7-1: Component Type Tab in the Component Editor
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-
% Component Editor - demo_axi_memory_hw.tcl*

File Templates

Component Type | File.sl Parametersl Signals-l Interfaces

¥ About Component Type

Name: deme_axi_memory
Display name: |pemo AXI Memory
Version: 1.0

Group: My Components

Description: Demonstration AX-3 memory with optional Avalon-ST port
Created by: Anerﬂ|

lzon:

Documentation: Title URL

-

When you use the Component Editor to create a component, it writes this basic component information in
the _hw.tcl file. The example below shows the component hardware Tcl code related to the entries for the
Component Type tab in figure above. The package r equi r e command specifies the Quartus II software
version that Qsys uses to create the _hw.tcl file, and ensures compatibility with this version of the Qsys API

in future ACDS releases.

The component defines its basic information with various module properties using the

set _nodul e_pr operty command. Forexample,set _nodul e_property NAMEspecifies the name
of the component, while set _nodul e_pr operty VERSI ONallows you to specify the version of the
component. When you apply a version to the _hw.tcl file, it allows the file to behave exactly the same way

in future releases of the Quartus II software.

Example 7-1: _hw.tcl Created from Entries in the Component Type tab

# request TCL package from ACDS 13.1
package require -exact gsys 13.1
# deno_axi _nenory

set _nodul e_property DESCRI PTI ON \
"Denmo AXI-3 nmenory with optional Aval on-ST port"

set _modul e_property NAME denp_axi _menory

set _nodul e_property VERSION 1.0

set _nodul e_property GROUP "My Conponents”

set _nodul e_property AUTHOR Altera

set _nodul e_property DI SPLAY NAME "Deno AXI Menory"
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Related Information

Component Interface Tcl Reference

Specifying Files for Synthesis and Simulation

The Files tab in the Component Editor allows you to specitfy files for synthesis and simulation. If you already
have HDL code that describes the Qsys component that you want to create, you can specify the files on the
Files tab. If you have not yet created the HDL code that describes the component, but you have identified
the signals and parameters that you want in the component, you can use the Files tab to create a top-level
HDL template file. The Component Editor generates the appropriate _hw.tcl commands to specify the files.
You can also write your own hw.tcl file with the same commands, if you are not using the Component Editor.

A component uses filesets to specify the different sets of files that can be generated for an instance of the
component. The supported fileset types are: QUARTUS_SYNTH, for synthesis and compilation in the Quartus
IT software, SI M_VERI LOG for Verilog HDL simulation, and SI M_VHDL, for VHDL simulation.

Ina_hw.tcl file, you add a fileset to a component with theadd_f i | eset command. You then list specific
fileswiththeadd_fi | eset _fi | e command, which adds the specified files to the most recently declared
fileset. The add_f i | eset _property command allows you to add properties such as TOP_LEVEL,
which specifies the top-level HDL module for the component.

You can populate a fileset with a a fixed list of files, add different files based on a parameter value, or even
generate an HDL file with a custom HDL generator function outside of the _hw.tcl file.

Specifying HDL Files for Synthesis

In the Component Editor, you can add HDL files and other support files that should be included when this
component is created to the list of Synthesis Files by clicking +, and then selecting the files in the Open
dialog box.

A component must specify an HDL file as the top-level file, which contains the top-level module. The
Synthesis Files list might also include supporting HDL files, such as timing constraints, or other files required
to successfully synthesize and compile in the Quartus II software. The synthesis files for a component are
copied to the generation output directory during Qsys system generation.

Figure 7-2 indicates the demo_axi_memory.sv file as the top-level file for the component in the Synthesis
Files section on the Files tab.

Creating Qsys Components Altera Corporation

() send Feedback


http://www.altera.com/literature/hb/qts/qsys_tcl.pdf
mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Creating%20Qsys%20Components%20(QII51022%202013.11.4)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

1151022
7-10 Creating a New HDL File for Synthesis 2?)13.1 1.4

Figure 7-2: Using HDL Files to Define a Component

- ~
%= Component Editor - demo_axi_memory_hw.tcl* Iﬁ

File Templates

CDmpDnentType| Files | Parametersl Signals-l Interfaces

+ About Files

Synthesis Files
These files describe this component's implementation, and will be created when a Quartus |l synthesis model is generated.
The parameters and signals found in the top-level module will be used for this compoenent's parameters and signals.

Output Path Source File Type Aftributes

demo_axi_memory.sv deme_axi_memory.sv System Verilog HDL Top-level File
single_clk_ram.v =ingle_clk_ram.v Verilog HOL no attributes

E] [ Analyze Synthesis Files | Create Synthesis File from Signals

Top-level Module: | demo_axi_memory |

Creating a New HDL File for Synthesis

If you do not already have an HDL implementation of the component, you can use the Component Editor
to define the component, and then create a simple top-level synthesis file containing the signals and parameters
for the component. You can then edit this HDL file to add the logic that directs the component's behavior.

To begin, you first specify the information about the component on the Parameters, Signals, and Interfaces
tabs. Then, you return to the Files tab to create an HDL file by clicking Create Synthesis File from Signals.
The Component Editor creates an HDL file from the specified parameters and signals.

Analyzing Synthesis Files

After the top-level HDL file is specified in the Component Editor, click Analyze Synthesis Files to analyze
the parameters and signals in the top-level, and then select the top-level module from the Top Level Module
list. If there is a single module or entity in the HDL file, Qsys automatically populates the Top-level Module
list.

Once analysis is complete and the top-level module is selected, the parameters and signals found in the top-
level module are used as the parameters and signals for the component, and you can view them on the
Parameters and Signals tabs. The Component Editor might report errors or warnings at this stage, because
the signals and interfaces are not yet fully defined.

Note: At this stage in the Component Editor flow, you cannot add or remove parameters or signals created
from a specified HDL file without editing the HDL file itself.

The synthesis files are added to a fileset with the name QUARTUS_SYNTH and type QUARTUS_SYNTHin
the _hw.tcl file created by the Component Editor. The top-level module is used to specify the TOP_LEVEL
fileset property. Each synthesis file is individually added to the fileset. If the source files are saved in a different
directory from the working directory where the Component Editor is launched and the _hw.tcl is located,

you can use standard fixed or relative path notation to identify the file location for the PATH variable.
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Example 7-2 shows the component hardware Tcl code related to the entries for the Files Type tab in the
Synthesis Files section shown in Figure 7-2.

Example 7-2: _hw.tcl Created from Entries in the Files tab in the Synthesis Files Section

# file sets

add_fil eset QUARTUS_SYNTH QUARTUS_SYNTH "" ""
set _fileset_property QUARTUS SYNTH TOP_LEVEL deno_axi _nmenory

add_fileset _file deno_axi _nmenory.sv
SYSTEM VERI LOG PATH denp_axi _nenory. sv

add fileset file single clk ramv VERI LOG PATH single clk ramyv

Related Information

o Component Interface Tcl Reference

+ Specifying HDL Files for Synthesis on page 7-9

Naming HDL Signals for Automatic Interface and Type Recognition

If you create the component's top-level HDL file before using the Component Editor, the Component Editor
recognizes the interface and signal types based on the signal names in the source HDL file. This
auto-recognition feature eliminates the task of manually assigning each interface and signal type in the
Component Editor.

To enable this auto-recognition feature, you must create signal names using the following naming convention:
<interface type prefix>_<interface name>_<signal type>

Specifying an interface name with <interface name> is optional if you have only one interface of each type
in the component definition. For interfaces with only one signal, such as clock and reset inputs, the <interface
type prefix> is also optional. When the Component Editor recognizes a valid prefix and signal type for a
signal, it automatically assigns an interface and signal type to the signal based on the naming convention. If
no interface name is specified for a signal, you can choose an interface name on the Interfaces tab in the
Component Editor.

Table 7-1: Interface Type Prefixes for Automatic Signal Recognition

Interface Prefix Interface Type

asi Avalon-ST sink (input)
aso Avalon-ST source (output)
avm Avalon-MM master
avs Avalon-MM slave
axm AXI master
Creating Qsys Components Altera Corporation
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Interface Prefix Interface Type

axs AXI slave

apm APB master

aps APB slave

coe Conduit

csi Clock Sink (input)

cso Clock Source (output)

inr Interrupt receiver

ins Interrupt sender

ncm Nios II custom instruction master
ncs Nios IT custom instruction slave
rsi Reset sink (input)

rso Reset source (output)

tcm Avalon-TC master

tcs Avalon-TC slave

Refer to the Avalon Interface Specifications or the AMBA Protocol Specification for the signal types available

for each interface type.

Related Information

o Avalon Interface SpecificationsProtocol Specification

o AMBA Protocol Specification

Specifying Files for Simulation

To support Qsys system generation for simulation, a component must specify the VHDL or Verilog simulation
files. Simulation files are generated when a user adds the component to a Qsys system and chooses to generate
Verilog or VHDL simulation files. In most cases, these files are the same as the synthesis files. If there are
simulation-specific HDL files or simulation models, you can use them in addition to, or in place of the
synthesis files. To use your synthesis files as your simulation files in the Component Editor, on the Files tab,
click Copy From Synthesis Files to copy the list of synthesis files to the Verilog Simulation Files or VHDL

Simulation Files lists.

You specify the simulation files in a similar way as the synthesis files with the fileset commands in a _hw.tcl
file. The code example below shows SI M_VERI LOGand SI M_VHDL filesets for Verilog and VHDL
simulation output files. In this example, the same Verilog files are used for both Verilog and VHDL outputs,
and there is one additional System Verilog file added. This method works for designers of Verilog IP to
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support users who want to generate a VHDL top-level simulation file when they have a mixed-language
simulation tool and license that can read the Verilog output for the component. Figure 7-3 shows the files
specified for simulation on the Files tab.

Figure 7-3: Specifying the Simulation Output Files

Verilog Simulation Files

These files will be produced when a Verilog simulation model is generated.

Qutput Path Source File Type Adtributes.
demo_axi_memory.sv demo_axi_memory.sv System Verilog HDL no attributes
"} |single_clk_ram.v =single_clk_ram.v Verilog HDL no attributes

verbosity_pkg.sv verification_libfverbosity_pkg.sv  System Verilog HDL

B Copy from Synthesis Files

VHDL Simulation Files
These files wil be produced when a WHDL simulation model is generated.

Qutput Path Source File Type Adtributes.
demo_axi_memory.sv demo_axi_memory.sv System Verilog HDL no attributes
single_clk_ram.v =single_clk_ram.v Verilog HDL no attributes

verbosity_pkg.sv verification_libfverbosity_pkg.sv  System Verilog HDL

B Copy from Synthesis Files

Example 7-3: _hw.tcl Created from Entries in the Files tab in the Simulation Files Section

add _fileset SIMVERI LOG SIMVERI LOG "" ""
set fileset property SIMVERI LOG TOP_LEVEL deno_axi _nenory
add _fileset file single clk ramv VERI LOG PATH single_clk ramyv

add fileset file verbosity pkg.sv SYSTEM VERI LOG PATH \
verification_|lib/verbosity_pkg.sv

add_fileset _file deno_axi _menory.sv SYSTEM VERI LOG PATH \
deno_axi _menory. sv

add fileset SSMVHDL SIMVHDL "" ™"
set fileset property SIMVHDL TOP_LEVEL denpb_axi _nenory
set _fileset_property SIMVHDL ENABLE RELATI VE_| NCLUDE_PATHS f al se

add_fileset file deno_axi _nmenory.sv SYSTEM VERI LOG PATH \
deno_axi _nmenory. sv

add_fileset _file single_clk _ ramv VERI LOG PATH single_clk ramyv

add_fileset _file verbosity_pkg.sv SYSTEM VERI LOG PATH \
verification_lib/verbosity_pkg.sv
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Related Information
Component Interface Tcl Reference

Including Internal Register Map Description in the .svd for Slave Interfaces Connected

to an HPS Component

Qsys supports the ability for IP component designers to specify register map information on their slave
interfaces. This allows components with slave interfaces that are connected to an HPS component to include
their internal register description in the generated .svd file.

To specify their internal register map, the IP component designer must write and generate their own .svd
file and attach it to the slave interface using the following command:

set _i nterface_property <slave interface> CMSI S_SVD_FI LE <file path>

The CVSBI S_SVD_VARI ABLES interface property allows for variable substitution inside the .svd file. You
can dynamically modify the character data of the .svd file by using the CMSIS_SVD_VARIABLES property.

For example, if you set the CM5I S_SVD_VARI ABLES as shown in Example 7-4 in the _hw tcl file, then
in the .svd file if there is a variable { Wi dt h} that describes the element <si ze>${wi dt h} </ si ze>, it
is replaced by <si ze>23</ si ze> during generation of the .svd file. Note that substitution works only
within character data (the data enclosed by <element>...</element>) and not on element attributes.

Example 7-4: Setting the CMSIS_SVD_VARIBLES Interface Property

set _interface_property <interface nanme> \
Cvsl S _SVD VARI ABLES "{wi dth} {23}"

Related Information
o Component Interface Tcl Reference

o« CMSIS - Cortex Microcontroller Software

Specifying Component Parameters

Components can include parameterized HDL, which allows users of the component flexibility in meeting
their system requirements. For example, a component might have a configurable memory size or data width,
where one HDL implementation can be used in many different systems, each with unique parameters values.

The Parameters tab in the Component Editor allows you specify the parameters that are used to configure
instances of the component in a Qsys system. You can specify various properties for each parameter that
describe how the parameter is displayed and used. You can also specify a range of allowed values that are
checked during the Validation phase. The Parameters table displays the HDL parameters that are declared
in the top-level HDL module. If you have not yet created the top-level HDL file, the parameters that you
create on the Parameters tab are included in the top-level synthesis file template created from the Files tab.

When the component includes HDL files, the parameters match those defined in the top-level module, and
you cannot be add or remove them on the Parameters tab. To add or remove the parameters, edit your HDL
source, and then re-analyze the file.
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If you used the Component Editor to create a top-level template HDL file for synthesis, you can remove the
newly-created file from the Synthesis Files list on the Files tab, make your parameter changes, and then re-
analyze the top-level synthesis file.

You can use the Parameters table to specify the following information about each parameter:
o Name—Specifies the name of the parameter.
o Default Value—Sets the default value used in new instances of the component.
« Editable—Specifies whether or not the user can edit the parameter value.
o Type—Defines the parameter type as string, integer, boolean, std_logic, logic vector, natural, or positive.
» Group—Allows you to group parameters in parameter editor.
« Tooltip—Allows you to add a description of the parameter that appears when the user of the component
points to the parameter in the parameter editor.
On the Parameters tab, you can click Preview the GUI at any time to see how the declared parameters
appear in the parameter editor. Figure 7-4 shows parameters with their default values defined, with checks
in the Editable column indicating that users of this component are allowed to modify the parameter value.
Editable parameters cannot contain computed expressions. You can group parameters under a common
heading or section in the parameter editor with the Group column, and a tooltip helps users of the component
understand the function of the parameter. Various parameter properties allow you to customize the
component’s parameter editor, such as using radio buttons for parameter selections, or displaying an image.
Figure 7-4: Parameters Tab in the Components Editor
[ % Component Editor - axi_component_hw.tcl* . &Jﬂ
File Templates
Component Typel File.5-|§ Parameters;| Signalsl Interfaces
¥ About Parameters
Name Default Value Edita.. Type Group Toolip
AX_ID_W 4 integer AXl Port Wi... |Width of ID fields. -
n . |AXI_ADDRESS_W|[12 integer AXl Port Wi... |Address width. A...
arameters: ) . I =
AX_DATA_W 32 integer AXl Port Wi... |Width of data buse...|
AX| NUMBYTES |4 integer AXl Port Wi... |Number of bytes i...
AV_ADDRESS W|2 integer Avalon Slav... |Address width of .. [ _
| [
If a parameter <n> defines the width of a signal, the signal width must follow the format: <n-1>:0.
In Example 7-5, the first add_par amet er command includes commonly-specified properties. The
set _par amet er _pr operty command specifies each property individually. The Tooltip column on
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the Parameters tab maps to the DESCRI PTI ONproperty, and there is an additional unused UNI TS property
created in the code. The HDL_ PARANMETER property specifies that the value of the parameter is specified
in the HDL instance wrapper when creating instances of the component. The Group column in the
Parameters tab maps to the display items section with the add_di spl ay_i t emcommands.

Example 7-5: _hw.tcl Created from Entries in the Parameters Tab

#

# paraneters

#

add_paraneter AXI _ID WINTEGER 4 "Wdth of ID fields"
set _paraneter _property AXI | D WDEFAULT VALUE 4

set _parameter_property AXI _| D WD SPLAY_NAVE AXI _ID W
set _paraneter_property AXI | D WTYPE | NTEGER

set _paraneter_property AXI _ID WUN TS None

set _parameter_property AXI _| D WDESCRI PTION "Wdth of 1D fields"
set _paraneter_property AXI | D WHDL_PARAMETER true
add_par anet er AXI _ADDRESS W | NTEGER 12

set _paraneter _property AXI _ADDRESS W DEFAULT_VALUE 12

add_par anet er AXI _DATA W I NTEGER 32

#.
# display itens
#

add_display_item"AXI Port Wdths" AXl _| D W PARAMVETER ""

Note: Ifan AXI slave's ID bit width is smaller than required for your system, the AXI slave response might
not reach all AXI masters. The formula of an AXI slave ID bit width is calculated as follows:

maximum_master_id_width_in_the_interconnect + log2
(number_of_masters_in_the_same_interconnect)

For example, if an AXI slave connects to three AXI masters and the maximum AXI master ID length
of the three masters is 5 bits, then the AXI slave ID is 7 bits, and is calculated as follows:

5 bits + 2 bits (log,(3 masters)) =7

Related Information
Component Interface Tcl Reference

Allowed Ranges Parameter Property

In a component's hw.tcl file, you can specify valid ranges for parameters. In Qsys, validation checks each
parameter value against the ALLONED_RANGES property. If the values specified are outside of the allowed
ranges, Qsys displays an error message. Specifying choices for the allowed values enables users of the
component to choose the parameter value from a drop-down list or radio button in the parameter editor
GUI instead of entering a value.

The ALLONED_RANGES property is a list of valid ranges, where each range is a single value, or a range of
values defined by a start and end value. Table 7-2 shows examples of the ALLOAED_RANGES property.
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Table 7-2: ALLOWED_RANGES Property

Types of Parameters 7-17

{a b c}

{"No Control"™ "Single Control" "Dual
Control s"}

{12 4 8 16}
{1: 3}
{1 2 3 7:10}

a,b,orc

Unique string values. Quotation marks are required
if the strings include spaces

1,2,4,8,0r 16
1 through 3, inclusive

1, 2, 3, or 7 through 10 inclusive

For GUI and code example for the ALLONED RANGES property, refer to Declaring Parameters with Custom

hw.tcl Commands.

Related Information

Declaring Parameters with Custom hw.tcl Commands on page 7-18

Types of Parameters

Qsys uses the following parameter types: user parameters, system information parameters, and derived

parameters.

Related Information

Declaring Parameters with Custom hw.tcl Commands on page 7-18

User Parameters

User parameters are parameters that users of a component can control, and appear in the parameter editor
for instances of the component. User parameters map directly to parameters in the component HDL.

For user parameter code examples, such as AXI _DATA_ Wand ENABLE _STREAM OUTPUT, refer to
Declaring Parameters with Custom hw.tcl Commands.

System Information Parameters

A SYSTEM | NFOparameter is a parameter whose value is set automatically by the Qsys system. When you
define a SYSTEM | NFOparameter, you provide an i nf or mat i on type, and additional arguments.

For example, you can configure a parameter to store the clock frequency driving a clock input for your
component. To do this, define the parameter as SYSTEM_| NFOof type CLOCK_RATE:

set _parameter _property <param> SYSTEM | NFO CLOCK RATE

You then set the name of the clock interface as the SYSTEM | NFOargument:

set _parameter_property <paranm> SYSTEM | NFO_ARG <cl knane>

Derived Parameters

Derived parameter values are calculated from other parameters during the Elaboration phase, and are

specified in the hw.tcl file with the DERI VED property. Derived parameter values are calculated from other
parameters during the Elaboration phase, and are specified in the hw.tcl file with the DERI VED property.
For example, you can derive a clock period parameter from a data rate parameter. Derived parameters are
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sometimes used to perform operations that are difficult to perform in HDL, such as using logarithmic
functions to determine the number of address bits that a component requires.

For GUI and code example of derived parameters, refer to Declaring Parameters with Custom hw.tcl
Commands.

Parameterized Parameter Widths
Qsysallowsast d_| ogi c_vect or parameter to have a width that is defined by another parameter, similar
to derived parameters. The width can be a constant or the name of another parameter.

Declaring Parameters with Custom hw.tcl Commands

The example below illustrates a custom _hw.tcl file, with more advanced parameter commands than those
generated when you specify parameters in the Component Editor. Commands include the ALLOANED _RANGES
property to provide a range of values for the AXI _ ADDRESS_W(Address Width) parameter, and a list of
parameter values for the AXI _DATA_W(Data Width) parameter. This example also shows the parameter
AXI _NUMBYTES (Data width in bytes) parameter; that uses the DERI VED property. In addition, these
commands illustrate the use of the GROUP property, which groups some parameters under a heading in the
parameter editor GUI. You use the ENABLE_STREAM OUTPUT_CGROUP (Include Avalon streaming
source port) parameter to enable or disable the optional Avalon-ST interface in this design, and is displayed
as a check box in the parameter editor GUI because the parameter is of type BOOLEAN. Refer to figure
below to see the parameter editor GUI resulting from these hw.tcl commands.

Example 7-6 illustrates parameter declaration statements and includes a parameter whose value is derived
during the Elaboration phase based on another parameter, instead of being assigned to a specific value.
AXI _NUMBYTES describes the number of bytes in a word of data. Qsys calculates the AXI _ NUMBYTES
parameter from the DATA W DTHparameter by dividing by 8. The _hw.tcl code defines the AXI _NUVBYTES
parameter as a derived parameter, since its value is calculated in an elaboration callback procedure.

The AXI _NUMBYTES parameter value is not editable, because its value is based on another parameter value.

Example 7-6: Parameter Declaration Statements

add_par anet er AXI _ADDRESS W | NTEGER 12

set _paraneter_property AXI _ADDRESS W DI SPLAY_ NAME \
"AXI Sl ave Address Wdth"

set _paraneter_property AXI _ADDRESS W DESCRI PTI ON \
"Address wi dth."

set _parameter _property AXI _ADDRESS WUNI TS bits
set _paraneter_property AXI _ADDRESS W ALLONED RANCES 4: 16
set _parameter_property AXl _ADDRESS W HDL_PARAMETER true

set _paraneter_property AXI _ADDRESS W GROUP \
"AXI Port W dths"

add_par anet er AXI _DATA W I NTEGER 32
set _paraneter_property AXI _DATA W DI SPLAY NAME "Data W dth"
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set _parameter_property AXI _DATA W DESCRI PTI ON \
"Wdth of data buses."

set _paraneter _property AXI _DATA WUNI TS bits

set _paraneter_property AXI _DATA W ALLOAED RANGES \
{8 16 32 64 128 256 512 1024}

set _paraneter_property AXI DATA W HDL_ PARAVMETER true
set _paraneter_property AXI _DATA WGROUP "AXlI Port W dths"

add_par anet er AXI _NUMBYTES | NTEGER 4
set _paraneter_property AXI _NUMBYTES DERI VED true

set _paraneter_property AXI _NUVMBYTES DI SPLAY_NAME \
"Data Wdth in bytes; Data Wdth/8"

set _paraneter_property AXI _NUVMBYTES DESCRI PTI ON \
"Nunber of bytes in one word"

set paraneter_property AXI _NUMBYTES UNI TS byt es

set _paraneter_property AXI _NUVBYTES HDL_PARAMETER true

set _paraneter_property AXI _NUMBYTES GROUP "AXI Port W dths"
add_par anet er ENABLE_STREAM OUTPUT BOOLEAN true

set _paranet er _property ENABLE STREAM OUTPUT DI SPLAY_NAME \
"I ncl ude Aval on Streani ng Source Port"

set _paraneter_property ENABLE STREAM OQUTPUT DESCRI PTI ON \
"Include optional Aval on-ST source (default),\
or hide the interface"

set _paranet er _property ENABLE STREAM OUTPUT GROUP \
"Stream ng Port Control™

Figure 7-5 shows the parameter editor GUI generated from Example 7-6.
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Figure 7-5: Parameter Editor lllustrating Parameter Declarations

[* Port Widths
I Port Widths: 4 -
Address Width: 12
Data Width: v .

Data width in bytes: |4

|' Streaming Port Control
Include Avalon Streaming Source Port

Related Information
o Component Interface Tcl Reference

« Controlling Interfaces Dynamically with an Elaboration Callback on page 7-26

Validating Parameter Values with a Validation Callback

You can use a validation callback procedure to validate parameter values with more complex validation
operations than the ALLONED_RANGES property allows. You define a validation callback by setting the
VALI DATI ON_CALLBACK module property to the name of the Tcl callback procedure that runs during
the validation phase. In the validation callback procedure, the current parameter values is queried, and
warnings or errors are reported about the component's configuration.

In Example 7-7, if the optional Avalon streaming interface is enabled, then the control registers must be
wide enough to hold an AXI RAM address, so the designer can add an error message to ensure that the user
enters allowable parameter values.

Example 7-7: Demo AXI Memory Example

set _nodul e_property VALI DATI ON_CALLBACK val i date
proc validate {} {
if {
[ get _paramet er _val ue ENABLE_STREAM OQUTPUT | &&
([ get _paraneter_val ue AXI _ADDRESS W >
[ get _paramnet er_val ue AV_DATA W)

send_nessage error "If the optional Aval on stream ng port\
is enabled, the AXI Data Wdth nust be equal to or greater\
than the Aval on control port Address W dth"

}
}

Related Information

o Component Interface Tcl Reference
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o Demo AXI Memory Example

Specifying Interface and Signal Types

The Signals tab in the Components Editor allows you to specify the interface and signal type of each signal
in the component. When you add HDL files to the Synthesis Files table on the Files tab, and then click
Analyze Synthesis Files, the signals on the top-level module appear on the Signals tab.

If you have not yet created your top-level HDL file, you can click Add Signal to specify each top-level signal
in the component. For each signal that you add, you must provide the appropriate values in the Name,
Interface, Signal Type, Width, and Direction columns. You can use the error and warning messages at the
bottom of the window to guide your selections. You can edit the signal name by double-clicking the Name
column, and then typing the new name.

After you have analyzed the component's top-level HDL file on the Files tab, you cannot add or remove
signals or change the signal names on the Signals tab. To change the signals, edit your HDL source, and
then click Generate Synthesis File from Signals.

If you used the Component Editor to create a top-level template HDL file for synthesis, you can remove the
newly-created file from the Synthesis Files list on the Files tab, make your signal changes, and then re-
analyze the top-level synthesis file.

The Interface column allows you assign a signal to an interface. Each signal must belong to an interface and
be assigned a legal signal type for that interface. To create a new interface of a specific type, select new
<interface type> from the list; this new interface then become available in the list for subsequent signal
assignments. You can highlight all of the signals in an interface and then select an Interface from the list to
apply the Interface name to each signal in the interface.

You edit the interface name on the Interface tab; you cannot edit the interface name on the Signals tab.

Figure 7-6 shows the altera_axi_slave selection available for the axs_awaddr signal. Example 7-8 in the
Adding Interfaces and Managing Interface Settings section shows the _hw.tcl that Qsys generates from these
entries along with other interface information.
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Figure 7-6: Signals Tab in the Components Editor
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| Component Typel Filesl Pararneter5-| Signalsl Interfaces|

F  About Signals

Name

clk
reset_n
axs_awid
add
axs_awlen
axs_awsize
axs_awburst
axs_awlock
axs_awcache
axs_awprot
axs_awvalid
axs_awready
axs_wid
axs_wdata
axs_wsirb
axs_wilast
axs_walid
axs_wready
axs_bid
axs_bresp
axs_bwvalid
axs_bready
axs_arid
axs_araddr

Related Information

Interface

clock

reset
altera_axi_slave
[ake.ra axi slave

Signal Type
clk
reset_n
awid

)

clock
reset
avalon_streaming_source 0

new Avalon Mei pped Master..
new Avalon Memory Mapped Slave...
new Avalon Streaming Source...

new Avalon Streaming Sink...

new AXI Master...

new AXI Slave...

new AXi4 Master..

new AXi4 Slave...

new Clock Output...

new Clock Input..

new Conduit...

new Interrupt Receiver...

new Interrupt Sender...

new Custom Instruction Master...

new Avalon Memory Msapped Tristate Slave...
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m

awlen
awsize
awburst
awlock
awcache
awprot
awvalid
awready
wid
wdata
wstrb
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walid
wready
bid
bresp
bvalid
bready
arid

new Custom Instruction Slave...
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m

The Interfaces tab in the Component Editor allows you to manage settings for each interface of the
component. The interface name appears on the Signals tab, and in the Qsys System Contents tab when the
component is added to a system.

You can configure the typ